How can we help you?
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
questions about Sage ERP Accpac.
I'm setting up Sage ERP Accpac and need information or assistance
I'm looking for instructions to complete a task within Sage ERP Accpac
I think something is broken, or I'm getting error messages
I'm looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage ERP Accpac
I want to share knowledge with other Sage ERP Accpac users
I want to contact a Sage ERP Accpac representative

What's New in Inventory Control 6.0?
Inventory Control version 6.0 includes the following new features and
improvements:
Changes in Processing to Respect New Fiscal Period Locks
Inventory Control supports changes to Common Services' Fiscal
Calendar.
Fiscal periods are now locked separately for each Sage ERP Accpac
program, including Inventory Control. Although this change does not
affect the way you enter transactions, you should note the following
points:
The program checks the status of a fiscal period when you enter
certain dates in Inventory Control transactions.
Day End Processing is not affected by locked fiscal periods.
Day End Processing creates transactions and updates costs for
General Ledger, Accounts Payable, Accounts Receivable, and
Project and Job Costing (depending on your system and settings),
as usual. However, if a fiscal period is locked for a ledger receiving
these transactions from Inventory Control, the transactions may
fail to post in the other ledger.
If a fiscal period is locked for General Ledger but not for Inventory
Control, you can create transaction batches for General Ledger
during Day End Processing or using the Create G/L Batch icon
(depending on Inventory Control's G/L Integration settings).
However, when you try to post transactions to a locked period in
General Ledger, the transactions will be placed in an error batch.
You can avoid this situation if you create and post General Ledger
batches for outstanding Inventory Control transactions before
locking the period for General Ledger.
New Portal-Related Security Authorization
We have added a new authorization, Item Developer Inquiry, for
Inventory Control to support the new Inquiry feature in the Sage ERP
Accpac portal. Developers of third-party programs, including macros,

need to incorporate this resource in their security structures.

Upgrading from an Earlier Version?
If you are upgrading from version 5.5, see Changes in Inventory Control 5.6.
If you are upgrading from version 5.4, also see Changes in Inventory Control 5.4.
If you are upgrading from version 5.3, also see Changes in Inventory Control 5.4.

Steps for Setting Up Inventory Control
This topic lists all the steps for setting up a new Inventory Control ledger.

Install and set up the Sage ERP Accpac System
Manager and General Ledger (if you use it) first
Before you can set up Inventory Control, you must install the Sage ERP
Accpac System Manager (with Tax Services, if needed) and Sage ERP
Accpac General Ledger (if you have it), and then install Inventory Control.
You must also create a company database and choose company-wide
options in Common Services, and activate the Tax Services (if needed).
If needed, add tax information and currencies used in your inventory
control system. If you have General Ledger, set it up before setting up
Inventory Control.
Step 1: Activate Inventory Control, select options, and add
background information
Activate the Inventory Control program for your data.
Use the Options form to specify how your system will operate.
Use the G/L Integration form to specify how your system sends
transactions to the General Ledger module.
Design coding schemes for your Inventory Control records.
Add records and print reports for:
Segment Codes
Item Structures
Account Sets
Unit Of Measure
Weight Units of Measure
Price List Codes
Categories
Locations

Optional Fields

(requires installation of the Serialized Inventory and Lot
Tracking license)
Mask Structures

(requires installation of the Serialized Inventory and Lot
Tracking license)
Warranty Codes

(requires installation of the Serialized Inventory and Lot
Tracking license)
Contract Codes

Step 2: Add inventory items
You can use the Items Wizard to add all of the information for new
inventory items, or you can use the individual forms in the Items and
Price Lists folder to perform these tasks separately.
Add item records
Assign items to price lists
Add location details for items
Add bills of material
Add vendor details

(optional)
(optional)

Add reorder quantities

(optional)

Add manufacturers' item numbers/bar codes

(optional)

Add current item quantities and costs
Print reports of the records you added
Add customer details
Add kitting items

(optional)

(optional)

(optional)

Step 3: Transfer your accounting data to Inventory Control
Add historical sales statistics for items
Add historical transaction statistics

(optional)

(optional)

Print Sales Statistics and Transaction Statistics reports

(optional)

Step 4: Design label formats for your preprinted forms
Design and test formats for printing item labels, bin/shelf labels, and

transfer slips, or adapt the sample formats to print on your own forms.

Planning Your Item Numbers
Before you begin to set up your item numbering system, you need to
design formats that will meet your needs for identifying items as well as
for sorting and grouping items for inventory reports and lists. Once you
decide on the types of item numbers you need, you create one or more
item structures in Inventory Control to use for formatting item numbers.
For example, you may want all your item numbers to have the pattern
#XX-XXXX. A sample item number using this pattern is #01-2C45.
To plan item numbers and item number formats, you need to be familiar
with the following terms:
Item number
Item number segment
Separator and prefix characters
Item number structure

Follow these steps when planning your item
number formats
1.List all your items.
2.Design an item numbering scheme that suits your inventory reporting
needs.
Tips for item number formats

See also
Defining item number formats
Setting up inventory item records
Steps for setting up Inventory Control

Importing and Exporting Inventory Control Records
If you have a computerized inventory control system, you may be able to
transfer records directly into Inventory Control by importing them.
You can also export records from another Sage ERP Accpac Inventory
Control database, edit them in a spreadsheet or other program to change
codes, amounts, and other information, then import them into the new
Sage ERP Accpac Inventory Control system you are setting up.
What you can import or export
Import only
Export only
Export formats
Import formats

For information about importing and exporting Inventory Control records,
see System Manager Help.
See also
Steps for setting up Inventory Control

Inventory Control Security: Overview
If security is turned on for your Sage ERP Accpac system, users without Inventory Control
security assignments have no access to Inventory Control.
To view records and to print reports in Inventory Control, users must
belong to a security group with Common Inquiry permission.
Common Inquiry permission by itself does not let users edit any Inventory
Control records. To allow users in a security group to edit records or
perform processing tasks, you must grant the group access to additional
tasks from the following list:
Price/Sales Analysis Inquiry
Stock Control Inquiry
Transaction Inquiry
Cost Inquiry
Stock Control Inquiry (gives Cost Inquiry rights)
Price/Sales Analysis Inquiry (gives Cost Inquiry rights)
Setup Maintenance
Transaction Optional Fields
Item Maintenance
Price List Maintenance
Physical Inventory Maintenance (gives Cost Inquiry rights)
Adjustment Posting
Assembly Posting
Internal Usage Posting
Receipt Posting
Shipment Posting
Transfer Posting
Day End Processing

Clear History/ Inactive Records
Import I/C Data (combine with other security rights)
Export I/C Data (combine with other security rights)
Dashboard
Item Developer Inquiry

The following permissions are available if you have a license for
Serialized Inventory and Lot Tracking:
Lot Recalls
Lot Splits/Combines
Serial/Lot Reconciliation
Quarantine Release
Serial Registration
Warranty Update

Entering Inventory Control Setup Information
Before you can add your inventory item records to Inventory Control, you
must set up other records to assign to your items. This topic describes
the records you need, and explains the options you can select when
setting up each type of record.
Click these icons in the Setup folder to add records:
Account Sets
Bills of Material
Categories
G/L Integration
Item Structures
Locations
Optional Fields
Price List Codes
Segment Codes
Units of Measure form
Weight Units of Measure form

(requires installation of the Serialized Inventory and Lot
Tracking license)
Mask Structures

(requires installation of the Serialized Inventory and Lot
Tracking license)
Warranty Codes

(requires installation of the Serialized Inventory and Lot
Tracking license)
Contract Codes

See also
Choosing Inventory Control Options
Steps for Setting up Inventory Control

Account Sets Form
The Accounts Set form appears when you select I/C Setup > Account
Sets. This form lets you define groups of general ledger accounts to
which you post Inventory Control transactions. By creating more than one
set of control accounts you can:
Maintain separate inventory control accounts for different types of
inventory items.
Use different inventory valuation methods for different groups of
items.
You can use just one account set for all your inventory items, or you can
have as many as you need. For example, you may wish to use separate
account sets for items assembled in different areas or items obtained
from different suppliers.
Before using

Editing account sets
You can change all of the information in an account set except the
identifying code. To change the code, you first add an account set with
the code you want to use, then delete the account set with the code you
do not want.

Deleting account sets
You can delete account sets only when they are not assigned to
inventory items.
If you want to delete a code that is assigned to an inventory item, you
must first assign a different account set to the inventory item, then delete
the unwanted code.
Specifying different account segments for locations

Note: Sales, returns, and COGS accounts are specified in categories
� not in account sets
Account sets do not specify all of the accounts that are used with an item.
You specify the following account codes for sales and COGS with

inventory categories. Sage ERP Accpac Order Entry uses the Sales
account and Returns account � Inventory Control does not use them:
Sales
Returns
Cost of Goods Sold
Cost Variance
Damaged Goods
Internal Usage
Click the Field List button at the top of this topic for information about
fields on the Account Sets form.
Click here for hints on using forms.

See Also
FIFO and LIFO costing methods
Most recent cost costing method
Setting up account sets
Standard costing method
Steps for setting up Inventory Control
User-specified costing method
Weighted moving average costing method
Serial and Lot costing

Categories Form
This form lets you:
Set up a record for each category you want to use for grouping
inventory items. For example, you can use categories to:
Classify items into logical groups for reporting purposes.
Allocate the sales, returns, cost of goods sold, cost variance, and
damaged goods amounts for different kinds of items to different
sets of general ledger accounts.
You must add at least one category to Inventory Control before you can
add item records (you assign each item to a category).
Click the links below for information about using the Category form:
Options

Taxes

The Taxes tab appears on your screen only if you have activated Tax
Services for your Inventory Control company.
Before adding categories

Click the Field List button at the top of this topic for information about
fields on the Categories form.
Click here for hints on using forms.
See also
Setting up categories
Steps for setting up Inventory Control

Setting Up Categories
You use categories in Inventory Control to group inventory items with
similar characteristics.
You can use categories to:
Classify items into logical groups for reporting purposes.
For example, a furniture company might use categories like those in
the following table.
Category/Description
C2Chairs - steno
D1Desks - executive
D2Desks - secretarial
F1Filing cabinets
Allocate the cost of goods sold and revenue by category.
When you add a category, you specify the general ledger cost of
goods sold and revenue account numbers for that category. All items
sold in the category use the specified accounts, unless you change
the category when entering transactions.
Specify whether commissions can be earned on sales and, if so, the
maximum commission rate allowed. Commission information is used
by Order Entry.
Specify tax authorities and sales tax classes for use by Order Entry,
and purchase tax classes for use by Purchase Orders.
Adding categories
Using Sage ERP Accpac Order Entry

Using Sage ERP Accpac Purchase Orders. If you use Purchase
Orders, the Inventory Control categories assign a taxing authority and tax
classes for purchases.
Changes to category records. If you change the tax classes or the
price list code in a category after assigning the category to inventory
items, the changes appear only in the item records to which you assign
the category after the changes.

See also
Categories form
Steps for setting up Inventory Control

Categories Form — Taxes Tab
The Taxes tab appears only if you have activated Tax Services for your
Inventory Control company.
Use the fields on this tab to specify the tax authorities and associated
sales and purchase tax classes that apply to items in the category.
Click the link below for information about the Options tab:
Options

See also
Categories
Inventory Control icons

Categories Form — Options Tab
Use the Options tab on the Categories form to:
Aassign a default price list for items that you add to each category.
Specify whether your sales staff earns commissions on sales in the
category, and enter the maximum commission rate for the category.
Enter the numbers of the general ledger sales, returns, cost of goods
sold, cost variance, damaged goods, and internal usage accounts for
which to create journal entries from transactions for items in the
category.
Click the link below for information about the Taxes tab:
Taxes

The Taxes tab appears on your screen only if you have activated Tax
Services for your company.
See also
Categories
Inventory Control icons

Contract Codes Form
If you have a license to use Serialized Inventory and Lot Tracking
license, your vendors likely offer you various guarantees on the quality
and durability of the serialized/lotted items that you purchase from them.
These are similar to the warranties provided to retail customers, except
the guarantee is provided by the supplier to the retailer.
Use the Contract Codes form to enter the terms of your sales
agreements you have with your suppliers. Each contract code can have
up to five periods, and you can define the number of days in each period
of the contract. The number of days in the periods are cumulative. For
example, for a 90-day contract, you can have three periods set to 30
days.
To add contract codes
1.Open I/C Setup > Contract Codes.
2.Enter a Contract Code of up to six characters and a description of the
contract code.
3.Add a line in the grid for each period in the contract code:
If the period has a Lifetime contract, double-click this field to
change it to Yes. Otherwise, leave it as No.
Enter the number of contract days in this period (not available for a
period where the Lifetime field is set to Yes).
Enter the number of days after the sold date that the contract
period becomes effective.
Enter a description of the contract period, up to 60 characters.
To add the next period, press the Insert key.
To delete a period, highlight the line and press the Delete key on your
keyboard.
4.Click Save to save the contract code.
Click the Field List button at the top of this topic for information about
fields on the Contract Codes form.

Using the G/L Integration Form
Use this form to:
Specify whether to add general ledger transactions to the G/L batch
during posting or each time you run Day End Processing, or to
create the transactions at a later date.
Note: This choice can have a large impact on the speed of
processing inventory transactions and transactions in Order Entry. If
you are costing inventory during posting, you may want to create
transactions at a later date.
Choose whether to create a separate G/L batch each time you
create the G/L batch (and optionally automatically post the batch) or
add new transactions to the existing batch. (This option applies only
if you use Sage Accpac General Ledger with Inventory Control at the
same location.)
Choose whether to consolidate the G/L batch when you post, or
always enter full transaction details in the batch.
Assign different source codes to general ledger transactions created
by Inventory Control and added to G/L batches. (New source codes
are automatically added to G/L, but you will have to update G/L
source journal profiles to include transactions on source journals.)
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in G/L
transactions. (This information appears for transactions in the G/L
Transactions report.)
Look up the last Day End Number for which you have created
general ledger batches.
Click the field list button or on of the links shown below for more
information on selecting G/L integration options.
Transactions tab

Changing Settings
You can change any of your choices on the G/L Integration Options page

at any time. However, you should be aware that any changes you make
will apply only to general ledger transactions created after the change,
and will not affect existing general ledger batches.
If you want to change from using the Create G/L Batch form to produce
your general ledger transactions to creating them during day-end
processing, be sure to run Create G/L Batch to process any outstanding
transactions first, to avoid accidentally omitting transactions from your
general ledger batches.

Before using the G/L Integration form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact that G/L
integration options have on processing within Inventory Control.
Note: You cannot change settings on the Integration tab of the G/L
Integration form if other Inventory Control forms are open, or other users
are working with the Inventory Control database.
Make sure that no one else is using the Inventory Control data and that
no other Inventory Control forms are open for the company before you
save changes to the G/L Integration form.
See also
Account Sets
Categories
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure

Selecting G/L Integration Options
This topic discusses the options you can select on the Integration tab of
the G/L Integration form, to specify how your Inventory Control system
creates transactions for your general ledger. To find out more about their
effects on the program, click the following links.
(overview)

Creating G/L Transactions
Using Inventory Control and General Ledger at the same site
Specifying the number of General Ledger batches to produce.
Using Inventory Control without Sage ERP Accpac General Ledger at the same site
Choosing Consolidation Options for General Ledger Transactions
Creating detailed general ledger transactions.
Selecting References and Descriptions for General Ledger Transactions

See also
Selecting Processing Options
Steps for setting up Inventory Control

Item Structures Form
This form lets you:
Specify the length and number of characters in your inventory item
numbers.
Format your item numbers for sorting and grouping items for reports
and lists.
You can have as many different item structures as you need to
accommodate different item number formats. However, you must add at
least one item structure to Inventory Control before you can add item
records.
You create item structures from the segments you have added to the
Options form.

Before adding item structures
Add segments in the Options form.
Choose a code of up to six characters (letters and numbers) to
identify each item structure you plan to add.
Design the item structures you plan to add, based on what you want
your item numbers to look like.
If you have more than one item structure, decide which one you will
use the most, and mark it as the default item structure.
Click the Field List button at the top of this topic for information about
fields on the Item Structures form.
Click here for hints on using forms.

See also
Defining item number formats
Planning your item numbers
Inventory Control icons

Locations Form
This form lets you:
Set up a record for each location where you stock inventory items.
Designate locations as physical or logical (that is, used as goods-intransit locations).
Override general ledger account segments for an item's category
and account set with General Ledger segment codes (typically to
indicate the location of the item).
Assign items to locations (if you do not use the Allow Items At All
Locations option).

Before adding locations
Choose a code of up to six characters to identify each location you
plan to add.
Decide which general ledger account segments (if any) you plan to
override with General Ledger segment codes.
Click the links below for more information on the individual location tabs
(you see the Items tab only if you do not select the Allow Items At All
Locations option on the I/C Options form):
Address

Contact

Items

Integration

Click the Field List button at the top of this topic for information about
fields on the Locations form.
Click here for hints on using forms.

See also
Inventory Control icons
Setting up locations
Units of Measure
Weight Units of Measure

Setting Up Locations
A location is a place, such as a warehouse or retail store, where you
keep some or all of your inventory. For each location, you set up a
location record in Inventory Control.
You must set up at least one location for your inventory items.
Adding locations
If you use Sage ERP Accpac General Ledger
Assign items to locations

See also
Assigning items to locations
Locations form
Steps for setting up Inventory Control

Locations Form — Address Tab
Use the Address tab to enter the name, address, phone and fax numbers
of the location, and to set the location's status to inactive.
You also use this tab to specify whether an inventory site is a physical or
logical location. (A logical location cannot receive or ship goods. It can
only be used as a goods-in-transit location.)
Click the following links for information about the other tabs on this form:
Contact

Items

Integration

The Items tab appears only if you do not select the option, "Allow Items
At All Locations," on the I/C Options form.
See also
Setting up locations
Steps for setting up Inventory Control

Locations Form — Items Tab
This tab is displayed only if you do not use the Allow Items At All
Locations option on the I/C Options form.
On this tab, you assign item numbers to a location and specify which of
the assigned items can be used in transactions at the location.
Click the following links for information about adding or deleting items
and about the other tabs in the Locations form:
To add items to a location
To delete items from a location

Address

Contact

See also
Inventory Control icons
Setting up locations

Integration

Locations Form — Integration Tab
On this tab, you specify whether to replace (override) segments in
general ledger accounts when you generate Inventory Control
transactions involving items stocked at a location.
Click the following links for information about other tabs in the Locations
form (you see the Items tab only if you do not select the Allow Items At
All Locations option on the I/C Options form):
Address

Contact

See also
Inventory Control icons
Setting up locations

Items

Mask Structures Form
If you use Serialized Inventory and Lot Tracking, you will need to create
formats for your serial and/or lot numbers.
Select I/C Setup > Mask Structures to open the Mask Structures form to
define structures for your serial numbers and lot numbers.
You can define multiple serial number masks that can be applied against
different serialized inventory items, but one item can only have one mask
applied, and once applied, another serial mask cannot be used for that
serialized item. The same rules exist for lot number masks and lotted
items.

Before adding mask structures
Mask structures cannot be changed for an item after you have already
started assigning numbers to it, so be sure to plan your mask structures
before setting them up with this form.
Design the mask structures you plan to add, based on what you want
your serial numbers and/or lot numbers to look like. You can have up
to 40 characters total in a mask that consists of up to five segments,
one of which you can increment.
Choose a code of up to six characters (letters and numbers) to
identify your serial number structure and/or lot number structure.
If you want to ensure that your mask structures will never use specific
characters for segment separators, set these characters to No on the
Options/Serials form.
Click the Field List button at the top of this topic for information about
fields on the Mask Structures form.
To add mask structures
To change or delete mask structures
To print a report of existing mask structures
Click here for hints on using forms.

See also
Defining item number formats
Planning your item numbers
Inventory Control icons

Adding Mask Structures
When adding a mask structure, you are defining a format for your serial
or lot numbers. A mask structure can:
Include up to 5 numeric or alphanumeric segments
Have one segment that increments automatically, and it must be a
numeric segment
Include a prefix
Use a total of 40 characters, including all segments, separators, and
prefixes
Refer to the information in Mask Structures Form topic, and plan out the structure
before you try to add mask structures. Click here for information about the
fields in the following procedure.
To add mask structures:
1.Open I/C Setup > Mask Structures.
2.Enter a code of up to six characters to identify the mask structure.
3.Select the type of mask, either Serial (for serial number) or Lot (for lot
number).
4.Enter a description for the mask structure.
5.Optionally, you can select a prefix character from the drop-down list.
6.For each segment you want in the mask structure, select the segment
type and enter the length of the segment. If desired, select a segment
separator, or leave it at None.
7.If you want a segment that increments automatically, make one
segment numeric, and change the increment setting to Yes. You can
only increment one segment.
When you enter a segment, the Mask Structure and Total Length
fields are updated to display the current structure and length of the
mask.
To delete a segment from the mask, highlight the line and press the
Delete key.

8.Click Save to add the mask structure.
Click here for hints on using forms.

Changing or Deleting Mask Structures
Use the Mask Structures form to create formats for the serial and/or lot
numbers that you assign to applicable items in inventory. You cannot edit
or delete a mask if any serial numbers or lot numbers have been
assigned to inventory units using that mask structure.
To change mask structures
1.Select I/C Setup > Mask Structures to display the mask structures
form.
2.Use the Finder to select the structure code to edit.
3.Enter the changes to the mask structure. Click here for information about
the fields.
4.Click Save.
To delete mask structures
1.Open the Inventory Control module, and go to I/C Setup > Mask
Structures.
2.Use the Finder to select the structure code to edit.
3.Click Delete and confirm the deletion.
Click here for hints on using forms.

Choosing Inventory Control Options
Once you have activated Inventory Control, your first task is to use
Inventory Control’s Options form to choose which Inventory Control
processing options you want to use.
Your choices determine how your Inventory Control system operates and
the types of data that it stores and displays. You can also use the form
after setup to review your entries and, as needed, change most of them.
The following topics explain the purposes and effects of the choices you
make in the Options form.
Company tab
Processing tab
Items tab
Documents tab
Costing tab

(if Serialized Inventory and Lot Tracking license is installed)
Lots tab (if Serialized Inventory and Lot Tracking license is installed)
Serials tab

When you are ready to create your Inventory Control system, follow the
online help instructions for Setting Up Inventory Control.
See also
Selecting Processing Options
Selecting G/L Integration Options
Steps for setting up Inventory Control

Using the Options Form
You select options when you create your Inventory Control ledger. Once
you have set up your ledger, use this form when you need to change your
selections.
This form lets you:
Specify the contact name, telephone number, and fax number for
your Inventory Control ledger. (Use the Company tab.)
Select the Multicurrency option and other options that determine how
your Inventory Control system operates. (Use the Processing tab.)
Define up to ten item number segments, any number of which you
can then combine to define item structures, which are used to format
item numbers. (Use the Items tab.)
Note: Sage Accpac 100 allows up to 4 item number segments.
Select separators to be used in item structures. (Use the Items tab.)
Specify the prefix and sequence of all numbers used to identify
documents in your system (shipments, receipts, returns, transfers,
adjustments, assemblies, and disassemblies).
If you have the Serialized Inventory and Lot Tracking license
installed, the Serials and Lots tabs appear allowing you to set options for
allocation, expiration and formatting of serial/lot numbers.

Before using the Options form
Before changing any of the settings or other information in the Options
form, make sure you understand the impact the options have on
processing within Inventory Control.
Note: You cannot change most of your choices in the Options form if
other Inventory Control forms are open, or other users are working with
the Inventory Control database.
Make sure that no one else is using the Inventory Control data and that
no other Inventory Control forms are open for the company before you
save changes to the Options form.

To use the Options form
1.Click each tab to work in this form.
2.Click Save to keep any changes you make.
3.Click Close to leave the form without changing any information.
For information about the tabs on this form, click these links:
Company

Processing

Items

Documents

Costing

Serials

Lots

Changing settings

Click the Field List button at the top of this topic for information about
fields on the Options form.
Click here for hints on using forms.
See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure

Options Form — Company Tab
This tab lets you change the contact name, telephone number, and fax
number for the company's Inventory Control administration.

Company name and address
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company Profile in Common Services.

Contact name and telephone and fax numbers
for Inventory Control
To change the contact name, telephone number, and fax number for the
Inventory Control administration, use the Company tab of the Options
form.
Depending on the choice of the Format Phone Numbers option in the
Company Profile in Common Services, parentheses and hyphens may be
inserted.
For information about other Options tabs, click the following links:
Processing

Items

Documents

Costing

For an overview of the Options form, click Options.
See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Options Form — Processing Tab
This tab lets you:
Indicate whether your Inventory Control system uses multicurrency
accounting.
See Using multicurrency accounting in Inventory Control.
Change settings that determine whether you allow fractional
quantities, negative inventory levels, receipt of non-stock items, and
items at all locations.
Set options for deleting transactions after posting, saving transaction
history, and prorating additional costs on receipt returns to items
remaining on receipts.
Specify the default weight unit of measure, the default goods-intransit location, and whether you use only defined units of measure.
Change settings that determine whether to keep statistics for items
and, if so, the type of year and period by which you accumulate the
statistics.
Assign names for up to two alternate cost fields you want to add to
the Location Details form or use as the base for discount pricing.
More information on selecting processing options.

Changing option selections
After setup, you can change your choices for all Processing options, with
the following exceptions and restrictions:
You can select the Multicurrency and Allow Fractional Quantities
options at any time, but cannot turn either option off once you save
changes to the Options form.
You can change the type of year (fiscal or calendar) and period by
which you accumulate item statistics, but you should do so only at
fiscal or calendar year end.
If you change either method partway through a year, the statistics
already accumulated will be incorrect or in the wrong period.

For information about other tabs, click the following links:
Company

Items

Documents

Click here for hints on using forms.

See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Costing

Serials

Lots

Selecting Processing Options
This topic lists the options you can select on the Processing tab in the
Options form.
Using multicurrency accounting
Allow fractional quantities
Allow items at all locations
Allow negative inventory Levels
Allow receipt of non-stock items
Keep transaction history
Prompt to delete during posting
Only use defined UOM
Alternate amount fields
Default weight unit of measure for inventory items
Additional costs for items on receipt returns
Default goods-in-transit location
Keep item statistics
Allow edit of statistics
Options for organizing statistics

(Accumulate By / Period Type)

See also
Selecting G/L Integration Options
Steps for setting up Inventory Control

Options Form — Items Tab
This tab lets you:
Specify the item number segments that will be used in your item
numbers.
In Inventory Control, an item number can consist of up to ten parts,
called segments (up to four segments in Sage ERP Accpac 100).
You use segments to organize items by common attributes such as
item category, style, color, or size. On many reports, you can specify
the segment of an item number by which you want reports sorted.
Assign the default item structure for your Inventory Control ledger.
Choose which characters can be used as segment separators in
item numbers.
Once you add item number segments on this tab, you can define item
number structures in the Item Structures form.
For more information on defining item number segments and structures,
click the field list button at the top of this page, or choose from the
following topics:
Segment—Defined
Structure—Defined
Specifying and Using Item Number Segments and Structures
Selecting Separator and Prefix Characters

For information about other tabs, click the following links:
Company

Processing

Documents

Click here for hints on using forms.

See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control

Costing

Serials

Lots

Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Options Form — Documents Tab
This tab lets you specify the prefix and sequence numbers for all
numbers used to identify documents in your inventory system
(shipments, receipts, returns, transfers, transfer receipts, adjustments,
internal usage transactions, assemblies, and disassemblies).

Document Numbers
Inventory Control assigns a unique number to each document you add.
The number is a combination of a prefix you use to identify the
transaction type, and a number that Inventory Control assigns
sequentially, starting with the number you specify. The default length of
each document number is 22 characters (including the prefix).
Length. If your document numbers (for transfers, shipments, receipts,
etc.) are less than 22 characters long, edit this field. The maximum length
of a document number is 22 characters, including the prefix.
Prefix. Type the prefixes you use in your existing document numbers, or
use the default prefixes you see on this tab. Each prefix can be up to six
alphanumeric characters.
Next Number. If you do not want to start document numbering at "1" (or
if you want to change document numbering at a later time) enter the next
number that you want to use. The program increases the number by 1
each time you post a transaction, but you are not forced to use the
numbers assigned by the program.
For information about other tabs, click the following links:
Company

Processing

Items

Click here for hints on using forms.

See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure

Costing

Serials

Lots

Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Options Form — Costing Tab
This tab lets you:
Specify when the program should cost inventory — either each time
you post an inventory transaction or only when you run Day End
Processing.
Specify when it should create sub-ledger and audit information.
Note: These settings have a large impact on how Sage ERP Accpac
handles inventory transactions. They apply to all inventory
transactions created in Inventory Control, Order Entry, and
Purchase Orders.
If you cost inventory during posting, sales order posting and purchase
order posting will take longer.
If you create sub-ledger batches during posting, you may also create
and post A/R invoice batches with each O/E invoice and A/P invoice
batches with each purchase order invoice.
For information on other processing options, see selecting processing options.

Changing costing options
After setup, you can change your costing options, with the following
exceptions and restrictions:
You can switch from costing during posting to costing during day end
processing at any time.
However, you must run Day End Processing before switching to
costing during posting to make sure that you complete item costing
and to make sure that all G/L transactions have been created
properly.
For information about other tabs, click the following links:
Company

Processing

Items

Click here for hints on using forms.

Documents

Serials

Lots

See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Options Form - Serials Tab
The Serials Tab appears on the I/C Options form if you have the
Serialized Inventory and Lot Tracking license installed. Use the options
on this form to define the default settings that pertain to the assignment
and allocation of serial numbers when working with serialized items.
Use the Item Defaults section to define the default Serial Number Mask
that appears for all serialized items. You can change this on an item by
item basis using the I/C Items form.
To enforce a validity period for your serial numbers, select the Days to
Expiry checkbox and enter the number of days from creation to expiry. If
enforcing an expiry period for serial numbers, you should also make a
selection from the Expired Serial Allocation Message list.
Select the Allow Serial Quantities to be Different from the Quantity in
Entries checkbox to make it optional that all serialized items have a
serial number assigned before a transaction can be saved.
The Separators Used in Serial Mask Structures section lists the different
characters that can be used to separate segments in Serial Masks. If you
want to exclude a character from being used when creating a serial
mask, make sure the Use column is set to No for that character.
When using the Auto-allocation feature to automatically assign serial
numbers, the order in which available numbers appear is determined by
the settings in the Auto-allocation section.
The Use the Qty Ordered field in OE for the Allocation of Serial
Numbers checkbox affects the Sage Accpac Order Entry program. When
selected, the quantity of serial numbers that needs to be allocated to
ordered items will be determined by the Quantity Ordered field in Order
Entry.
See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control

Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Options Form - Lots Tab
The Lots Tab appears on the I/C Options form if you have the Serialized
Inventory and Lot Tracking license installed. Use the options on this form
to define the default settings that pertain to the assignment and allocation
of lot numbers when working with lotted items.
Use the Item Defaults section to define the default Lot Number Mask
that appears for all lotted items. You can change this on an item by item
basis using the I/C Items form.
To enforce a validity period for your lot numbers, select the Days to
Expiry checkbox and enter the number of days from creation to expiry. If
enforcing an expiry period for lot numbers, you should also make a
selection from the Expired Lot Allocation Message list.
If you want all lots to be quarantined for a specific number of days after
receipt, select the Days on Quarantine checkbox and enter the number
of days in the adjacent field. You can release individual lots before the
specified period using the Quarantine Release form.
Select the Allow Lot Quantities to be Different from the Quantity in
Entries checkbox to make it optional that all lotted items have a lot
number assigned before a transaction can be saved.
The Separators Used in Lot Mask Structures section lists the different
characters that can be used to separate segments in Lot Masks. If you
want to exclude a character from being used when creating a serial
mask, make sure the Use column is set to No for that character.
When using the Auto-allocation feature to automatically assign lot
numbers, the order in which available numbers appear is determined by
the settings in the Auto-allocation section.
The Use the Qty Ordered field in OE for the Allocation of Lot
Numbers checkbox affects the Sage ERP Accpac Order Entry program.
When selected, the allocation of lot numbers to ordered items will be
determined by the Quantity Ordered field in Order Entry.
See also
Account Sets
Categories
G/L Integration Options

Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control
Units of Measure
Weight Units of Measure
Mask Structures
Warranty Codes
Contract Codes

Optional Fields
The Optional Fields form lets you assign optional fields to item records, to
reorder quantities, and to inventory transactions and transaction details.
Setting up optional fields is a two-step process in Sage ERP
Accpac:
Step 1: Add optional fields to Sage ERP Accpac using the Optional
Fields form in Common Services (see your System Manager Help).
Step 2: Assign optional fields to item records and to different types of
I/C transaction records using Inventory Control's Optional Fields setup
form (see the following procedure).
Once you have added optional fields, you can enter data in the optional
fields when you add new I/C items and enter inventory transactions.

To assign optional fields to item and transaction
records in I/C:
1.Select I/C Setup > Optional Fields to display the I/C Optional Fields
form.
2.Select one of the following record/transaction types from the Optional
Fields For drop-down list:
Items
Reorder Quantities
These optional fields appear in Purchase Orders on POs that are
generated when you run Create POs from I/C in the Purchase
Orders module.
Receipts
Receipt Details
Shipments
Shipment Details
Adjustments
Adjustment Details
Optional fields also appear on the Physical Inventory Quantities
form if you add optional fields for adjustment and/or adjustment
details. These fields appear with the adjustments that are
generated from posting the inventory reconciliation.
Transfers
Transfer Details
Assemblies
Internal Usage
Internal Usage Details
Item Serials (Appears only if the Serialized Inventory and Lot
Tracking license is installed)

Item Lots (Appears only if the Serialized Inventory and Lot
Tracking license is installed)
3.Click in the optional field entry grid, and then press the Insert key on
your keyboard to start a new line.
4.Click the Finder (or press F5) in the Optional Field column, then
choose an existing optional field from the Finder list. If the field you
want to add does not appear, select Common Services > Optional
Fields and define the new field you want to add and restart this
procedure.
5.If you want a value to automatically appear in forms that will include
the optional field, enter the value in the Default Value column (the
Value Set field changes to Yes). If you don't need a default value to
appear, then ensure No appears in the Value Set field.
6.If the you want to make it mandatory that data be entered in the field,
ensure Yes appears in the Required Column. The Default Value must
be defined before you can do this, and the Auto Insert column should
be set to Yes as well.
7.Set the Auto Insert column to Yes if you want to allow the optional
field (and its default value) to appear in new records and transactions.
Choose No if you do not want the optional field to appear
automatically.
8.Click the Settings button to select the G/L accounts that this optional
field will be included with for G/L transactions and transactions sent to
other subledgers. The G/L accounts include the following:
Receipt Details: Payables Clearing, Inventory Control, and NonStock Clearing.
Shipment Details: Inventory Control, Cost of Goods Sold, Nonstock Clearing, Cost Variance, Work in Progress, and Overhead.
Adjustment Details: Inventory Control, Adjustment Write-Off,
Non-Stock Clearing, Work in Progress, Cost of Sales, and
Overhead.
Transfer Details: Inventory Control - From Location; Inventory
Control - To Location; Inventory Control - GIT Location; and

Transfer Clearing.
Assemblies: Inventory Control - Master Item; Inventory Control Component; Assembly Cost Credit; and Disassembly Expense.
Internal Usage Details: Inventory Control, Usage Expense, Nonstock Clearing, and Cost Variance.
Consider carefully the purpose of each optional field that you add.
For example, only send optional fields to General Ledger that are
used for financial analysis, and only to the accounts where they are
required.
If you routinely send all the optional field information to G/L, your
general ledger may become unwieldy, and you many also slow down
processing considerably.
9.Click Add to save the optional field.
You can now open the form to which you added optional fields and enter
data. For example, if you defined an optional field for Shipments, you
would see the optional field when you clicked the zoom button beside
Optional Fields in the Shipment entry form.
See also
Adding optional fields to records

Price List Codes Form
This form lets you:
Add price list codes to identify your price lists.
Select default options for calculating customer discounts or markups
for the items you later assign to the price lists.
Check price overrides in Order Entry for customers and orders that
use this price list.
Specify default tax authorities and classes for the items you later
assign to the price lists.

Before adding price list codes
Choose a code of up to six characters to identify each price list you
plan to use.
Decide which options you want to select for calculating customer
discounts or markups for each price list code.
Add the tax information you need to Tax Services.
For information about other tabs, click these links:
Discounts

Price Check

Taxes

Click here for hints on using forms.

See also
Account Sets
Categories
G/L Integration Options
Inventory Control icons
Inventory Locations
Item Structures
Options
Segment Codes
Steps for Setting Up Inventory Control

Setting Up Price Lists
This topic describes how you set up and use price lists in Inventory
Control to meet your company’s needs. You can have as many price lists
for your items as you need, to handle different locations, different
countries, and different currencies.
You take the following steps to set up price lists for your items in
Inventory Control:
1.Add one or more price lists using the Price List Codes form.
Each price list lets you select default options for calculating customer
discounts (by customer type or by volume purchased) for the items
you add to price lists. You can override these discount options when
adding item prices to the price lists. You do not have to create price
lists before you add inventory items.
2.Add inventory items using the Items form.
3.Add items to price lists using the Item Pricing form.
To have items appear on a price list, you must assign the items to the
price list code. When you assign items to their first price list code, you
specify pricing information for one item at a time. Afterwards, if you
want to assign items to other price list codes, you can use the Copy
Item Pricing form to copy prices to additional price lists, adjusting
pricing information as needed in the process.
These steps are described in more detail in the following sections.
Adding price lists
Creating other price lists

Using Sage ERP Accpac Order Entry. Inventory Control uses price lists
for information purposes (reports) only. Order Entry uses Inventory
Control price lists to calculate prices on orders and invoices.
See also
Price List Codes form
Steps for setting up Inventory Control

Price List Codes Form — Discount Tab
The Discounts tab lets you:
Specify the number of decimals to use in prices on the price list.
The method of calculating selling prices for items on the price list.
For information about other tabs, click these links:
Price Check

Taxes

Click here for hints on using forms.

See also
Account Sets
Categories
Inventory Control icons
Inventory Locations
Item Structures
Options
Segment Codes
Steps for Setting Up Inventory Control

Price List Codes Form — Taxes Tab
The Taxes tab lets you specify the tax authorities and classes that apply
to items on the price list.
For information about other tabs, click these links:
Discounts

Price Check

Click here for hints on using forms.

See also
Account Sets
Categories
Inventory Control icons
Inventory Locations
Item Structures
Options
Segment Codes
Steps for Setting Up Inventory Control

Segment Codes Form
This form lets you:
Add valid segment codes to a table so Inventory Control will verify
the item number segments when adding new items.
You can add segment codes for any segment you have added to the
Options form.
Adding segment codes is optional, as is using them once you have
entered them. Use the Items tab in the Options form to turn on and off the
option to use segment codes for individual segments.

Before adding segment codes
Add segments to the Options form.
Decide which codes to use for each segment. Segment codes can
be neither longer nor shorter than the length of the segment for
which they will be used.
Click the Field List button at the top of this topic for information about
fields on the form.
See also
Account sets
Categories
G/L Integration Options
Inventory Control icons
Inventory locations
Item structures
Options
Price list codes
Steps for setting up Inventory Control

Units of Measure Form
This form lets you:
Add the units of measure (UOMs) in which buy, sell, price, and stock
your inventory items.
Inventory Control lets you define all of your units of measure in a
single place so you can add them more easily to item records.
Units of measure can be numbers of items, dry measures, liquid
measures, or weights. You can add all of your stocking units and
multiples of stocking units to the Units Of Measure form, and then choose
the group of units you need for each item you add.
Note: You can choose in the I/C Options form whether to allow only the
units of measure that you define here in inventory records. If you do not
choose Only Use Defined UOM, you can use other units of measure with
items.
To add a unit of measure
If units of measure have already been added to the Units Of Measure
form, you will have to press the Insert key to start a new line.
Specify:
The unit of measure.
The default conversion factor between the stocking unit of measure
and this unit of measure.
This is a default conversion factor. You can change it when you add
units of measure to item records.
Stocking unit of measure
One of the units of measure assigned to each inventory item is the
item’s stocking unit of measure. The stocking unit of measure is
important in Inventory Control for the following reasons:
Inventory Control uses it to report stock levels for the item. (Note that
different items can use different stocking units.)
If you did not select the Allow Fractional Quantities option in the I/C

Options form, the stocking unit is the smallest unit of measure that
you can specify for shipping or selling the item. All other units of
measure for an item are based upon the stocking unit of measure.
The conversion factor for a stocking unit of measure is always 1.
Before adding units of measure
Decide on your stocking units for each inventory item.
Remember: If you did not select the Allow Fractional Quantities
option in the I/C Options form, the stocking unit is the smallest unit of
measure that you can specify for shipping or selling the item.
Calculate the conversion factors between the stocking units of
measure and additional units.
Choose what to call each of the units of measure. The names you
use appear on data entry screens.
See also
Account sets
Categories
G/L Integration Options
Inventory Control icons
Inventory locations
Item structures
Options
Price list codes
Steps for setting up Inventory Control
Weight Units of Measure

Warranty Codes Form
If you have the Serialized Inventory and Lot Tracking license installed,
you may sell items with basic and extendable warranties to your
customers. If so you will need to set up a number of different warranty
codes that will be applied to your serialized or lotted items at point of
sale.
Use the Warranty Codes form to enter the terms of your sales
agreements you have with your customers on the serialized or lotted
items that they purchase from you. Each warranty code can have up to
five periods, and you can define the number of days in each period of the
warranty. The number of days in the periods are cumulative. For
example, for a 90-day warranty, you can have three periods set to 30
days.
Click the Field List button at the top of this topic for information about
fields on the Warranty Codes form.
To add warranty codes
1.Select I/C Setup > Warranty Codes to display the Warranty Codes
form. If the Warranty Codes icon does not appear in the I/C Setup
folder, that means you have not installed the Serialized Inventory and
Lot Tracking license.
2.Enter a WarrantyCode of up to six characters and a description of the
warranty code in the adjacent field.
3.Add a line in the grid for each period in the warranty code:
If the period has a Lifetime warranty, double-click this field to
change it to Yes. Otherwise, leave it as No.
Enter the number of warranty days in this period. (not available for
a period where the Lifetime field is set to Yes.)
Enter the number of days after the sold date that the warranty
period becomes effective.
Enter a description of the warranty period, up to 60 characters.
To add the next period, press the Insert key.

To delete a period, highlight the line and press the Delete key on your
keyboard.
4.Click Save to add the warranty code.
After Warranty Codes are defined and applied against sale items, you
may have to periodically update the warranties on items.
Click here for hints on using forms.

Weight Units of Measure Form
This form lets you:
Add the different units that you use for measuring the weight of items
— such as pounds, tons, kilograms, and metric tons.
The default weight unit of measure (specified on the I/C Options form) is
the unit for expressing the weight of orders in the Order Entry module.
The default weight unit of measure has a conversion factor of 1, and all
other weight UOMs are defined in terms of a default weight UOM.
To add a weight unit of measure, you specify
The weight unit of measure.
A description of the weight.
The weight conversion factor between the default weight unit of
measure and the unit you are adding (as a multiple of the default
weight unit of measure).
The conversion factor for a default weight unit of measure is
always 1.
You can use fractions in weight conversion factors even if you do
not use fractional inventory quantities.
Before adding weight units of measure
Decide on the default weight unit of measure that you want to use on
orders.
Calculate the conversion factors between the default weight unit of
measure and all other weight units of measure.
You set the default weight unit of measure on the I/C Options form
after adding it to the Weight Units of Measure form.
Choose what to call each of the weight units of measure. The names
you use appear on data entry screens.
See also
Account sets

Categories
G/L Integration Options
Inventory Control icons
Inventory locations
Item structures
Options
Price list codes
Steps for setting up Inventory Control
Units of Measure

Inventory Control Icons
The following icons appear when you highlight the Inventory Control
folder (unless you use a text-only menu structure). When you doubleclick the icon, more icons for that feature appear in the right-hand pane of
the Sage ERP Accpac desktop.
Click these icons to move to another help topic displaying icons for the
forms associated with each folder.

Inventory Control Menu Commands
The menu bar appears in all Inventory Control forms immediately below
the title bar. The menu bar lists the available menus for the form.
A menu contains a list of commands, or actions, you can carry out in the
form.
For information about Inventory Control menu commands, select one of
the following links:
File menu
Help menu
Settings Menu

Data Entry Tools and Shortcuts
Inventory Control data entry forms contain many aids to data entry which
you can activate by pressing function keys, clicking buttons, or using the
mouse.
For more information, see the following topics:
Browse button
Changing column order in data entry forms
Working with entry grids
Drop-down lists
Using Help

For more information on data entry buttons that appear on forms, click
the button or command listed below:
New

or
Find

or
Go

Drilldown

or
Zoom

Navigation Buttons

Shift +
Detail Zoom

Working with Detail Entry Grids
The first tab of each transaction entry form in Inventory Control contains
a detail entry grid that shows the document details in tabular format.
If there are more columns than can be displayed at one time, you can
use the horizontal scroll bar at the bottom of a list to view the additional
columns. You can also rearrange the order of columns, or change column widths,
consistent with how you enter data.
If you need to view or edit options for a single detail, you can select a
detail and open a separate form that lets you see all the fields for the
selected detail.
To add details using the detail grid, do one of the following
If a blank line is highlighted, tab to the Item Number field, then either
type the item number or select it from the Finder. Enter the remaining
information for the detail.
To start a new line, press Insert or tab through the end of the last line
on the grid. If you want to insert a new line in a particular location,
highlight the line above the location, then press Insert.
A detail line is saved as you enter it on the detail entry grid.
To edit details using the detail grid
Highlight the line you want to edit, then enter your changes on that
line.

To delete details using the detail grid
1.Highlight the line you want to delete.
2.Press the Delete key on your keyboard.
3.If you see a message asking you to confirm the deletion, click Yes.

To open a Detail form (F9)
In most cases, you can enter all the necessary details for a document
right on the grid.
You can also view and edit all the fields for a single detail on a separate
Detail form.
To open the Detail form to edit item information or to change options,
highlight the detail on the grid, then either click the Detail button or press
the F9 key on your keyboard.
See also
Changing column widths in data-entry forms
Changing column order in date-entry forms

Processing Transactions
This topic presents a brief overview of how posting, day-end processing,
and audit trails relate to transaction processing in Inventory Control. The
types of transactions in Inventory Control are receipts, shipments,
adjustments, stock transfers, and item assemblies.

Online posting or batch processing
Inventory Control lets you choose between online transaction processing
or batch processing for posting all kinds of transactions.
You can either:
Post each transaction when you enter it.
or
Save transactions after entering them for later editing or posting
(using the Post Transactions form).
When you post a transaction, the program immediately updates item
quantities so you always know your inventory levels. This is especially
important when you are using Order Entry and need to know whether an
item is in stock.

Costing — during posting or at day end
Depending on your program settings, posting will also update the cost of
goods in stock and the cost of goods that you've sold. Posting, however,
does not update accounting and statistical information—those
procedures are performed by Day End Processing.
Note: With Inventory Control, you can choose in I/C Options whether you
want the program to recost items based on newly posted transactions, or
whether it should wait until you run day-end to cost items.
If you have a large transaction volume, we suggest that you cost items
during Day-end.
You must run Day End Processing to update item and sales statistics,
audit information, and to generate general ledger transactions.

If necessary, you can run Day End Processing several times a day to
keep this information more current.
As well as posting transactions to the current session date and reporting
period, you can post them to past or future dates and reporting periods.

Printing the audit trail
To view your audit trail for transactions, print the posting journal for the
type of transaction you want, after running day-end processing.
If you selected the Keep Transaction History option in the Options form,
the program keeps another copy of the audit trail information that is
printed on the posting journal. You can then print the Transaction History
report to list audit trail information that you may have cleared from the
posting journal.
See also
Processing adjustments
Processing assemblies
Processing internal usage transactions
Processing receipts
Processing shipments
Processing transfers

Entering Current and Historical Transactions
Inventory Control maintains sales and transaction statistics for the current
year and for all the previous years for which you retain the data. You add
the historical information you need during setup. Inventory Control then
automatically updates the statistical information each time you run dayend processing.
Item quantities and costs. To set up your Inventory Control system, you
must add your current item quantities and costs.
Current-year sales and transaction statistics. If you set up partway
through a fiscal year, enter any sales and transaction statistics from
previous periods of the current year that you want to view online or for
which you want to print reports.
Previous-years sales and transaction statistics. You can also enter
any sales and transaction statistics from previous years that you want to
view online or for which you want to print reports.
You can enter current-year and previous-years sales and transaction
statistics either during or after setup.
Entering Current Item Quantities and Costs
Entering Sales Statistics for Current and Previous Years
Entering Transaction Statistics for Current and Previous Years

For step-by-step instructions for entering transaction statistics, see
Adding or Editing Transaction Statistics in the online help.
See also
Setting up item records
Steps for setting up Inventory Control

Post Transactions Form
Use this form to post transactions — receipts, shipments, returns, internal
usage, adjustments, assemblies and disassemblies — that have been
entered and saved.
Inventory Control lets you enter transactions and post them directly or
save transactions after entry and post them later — either using the
transaction entry form or using the Post Transactions form.
Once you post transactions, the program updates inventory quantities
and costing (if you choose the option to update costing data during
posting).

To post transactions
1.Open the Post Transactions form.
2.Choose the types of transactions that you want to post, and specify a
range of transactions (or accept the default entries to post all
unposted transactions).
3.Click the Process button.

After using
Run Day End Processing to update Inventory Control's audit data,
costing data (if you cost data during day end), and item statistics.
Print the transaction posting journals to check the transactions that
you posted.
See also
Processing transactions
Processing adjustments
Processing receipts
Processing internal usage transactions
Receipt adjustments
Receipt returns
Understanding Serialized Inventory and Lot Tracking

Assemblies/Disassemblies Form
Use this form to:
Enter and post assemblies of master items from component items.
Enter and post disassemblies of master items from component
items.
Import assembly transactions from other Sage ERP Accpac
databases or from non-Sage ERP Accpac programs.
if you have the Serialized
Inventory and Lot Tracking license installed.
Assign serial and/or lot numbers to component or master items

Click the Field List button at the top of this topic for information about
fields on the Assemblies/Disassemblies form.
Click here for hints on using forms.

Before you start
You must set up bills of material to define master items before you can enter
assembly transactions.

To enter an assembly transaction
1.Double-click the Assemblies icon in the Transactions folder.
2.Press the Tab key to start a new assembly or disassembly. The
program automatically assigns the assembly number.
3.Choose Assembly as the transaction type.
4.Enter an optional description and reference.
5.If necessary, choose a date from the calendar (click the Calendar
button beside the date field), then choose a fiscal year and period for
the assembly.
6.Enter the (master) item number to be assembled or select it from the
Finder.
7.Enter the BOM (bill of material) number or select it from the Finder.
8.If this is a multi-level bill of material, choose how you want

components assembled.
Note: Multi-level assemblies cannot be created if any part of the
assembly (master or component) is serialized and/or lotted.
9.Enter the location code or select it from the Finder.
10.Enter the quantity to assemble (a multiple of the Build Quantity). You
can click the Verify Quantities button to check that there are enough
items on hand for the quantity you are posting. If required, assign serial
and/or lot numbers for applicable items after entering a quantity.
Note: If working with serialized items, all serialized components
should have a quantity in stocking unit of measure that is a multiple of
the master's build quantity in stocking unit of measure, otherwise you
will not be able to save or post the assembly.
11. Click Save or Post, then click OK at the message that displays the
assembly number.
You cannot modify assembly transactions after you post them.

To enter a disassembly transaction
1.Double-click the Assemblies icon in the Transactions folder.
2.Press the Tab key to start a new assembly or disassembly. The
program automatically assigns the assembly number.
3.Choose Disassembly as the transaction type.
4.Select the assembly that you are disassembling in the From
Assembly field. Leave the field blank if the From Assembly transaction
no longer exists.
Note: If you are disassembling a previous assembly, you can only
specify the quantity being disassembled and a disassembly cost.
5.Enter a description and reference for the disassembly (optional).
The program generates a general ledger transaction which debits the
inventory control account, and credits the items' assembly cost credit
accounts.
6.Enter the item number of the master item being disassembled, if you
did not specify an assembly, or select the number from the Finder.

If you are disassembling a specific assembly, you cannot change the
item number.
Note that the program automatically displays a bill of material number
in the BOM Number field if you select the item number from the
Finder. Any remaining amount in the master item's assembly cost
credit account represents the variable and fixed costs for the
disassembled items.
7.Enter a number or type over the existing BOM number for the bill of
material to use for assembling or disassembling units of the master
item, or select the number from the Finder.
You can view (and edit) the bill of material you specify by clicking the
Zoom button beside the BOM Number field (or press F9) to open the
Bills Of Material form for the selected master item, (then click Close to
return to the Assemblies form).
If you are disassembling a specific assembly, you cannot change the
BOM.
8.If this is a multi-level bill of material (and subassemblies were
assembled in the selected assembly), choose how you want
components disassembled.
9.Specify the location where the master items are being disassembled.
10.Enter a disassembly cost.
11. To change the number displayed in the Quantity field, type over it.
Inventory Control automatically displays the bill of material's build
quantity in the bill of material's unit of measure.
Note: The quantity must be a multiple of the number in the Build
Quantity field. For example, if the build quantity for the bill of material
is 25, then you must specify a multiple of 25 (such as 25, 50, or 75)
for the quantity, or the program will not allow you to save or post the
assembly.
If required, assign serial and/or lot numbers for applicable items after entering a quantity.
12.When you are finished, click the Save or Post button.

After using

If you saved the assembly/disassembly, post the transaction using
the Post Transactions form.
Run Day End Processing to update Inventory Control's audit data,
costing data (unless you update costs during posting), and item
statistics.
Print the Assemblies Posting Journal to check the assembly
transactions you posted.
See also
Processing assemblies and disassemblies
Transaction processing
Adding bills of material

Processing Assemblies and Disassemblies
Use Inventory Control's Assemblies / Disassemblies form to:
Record assemblies of or repackaging of component items from
inventory into master items for resale.
Conceptually, assembling is like shipping component items and
receiving master items.
Disassemble items that you previously assembled.

Bills of material
You must set up bills of material to define master items before you can
enter assembly transactions to build the master items.

Disassembling master items
You can reference particular assemblies to correctly cost component
items returned to inventory. You can also disassemble master items after
clearing the assembly transaction information.

Information entered with assemblies
The information you enter with assemblies is presented in the order in
which it appears in the Assemblies form.
See also
Processing adjustments
Processing receipts
Processing internal usage transactions
Processing shipments
Processing transfers
Processing transactions
Adding bills of material

Receipts Form
Use this form to:
Enter and post new receipts of items.
Enter returns and adjustments to incomplete receipts you posted
previously.
Change the status of incomplete receipts to Complete.
Import receipt transactions from other Sage ERP Accpac databases
or from non-Sage ERP Accpac programs.
if you have the Serialized Inventory and Lot
Tracking license installed.
Assign serial and/or lot numbers

Multicurrency ledgers
If you have a multicurrency system, you specify the receipt currency and
the currency to use for any additional costs when you enter the receipt.
The additional cost currency must be the same as either the receipt
currency or your company's functional (home) currency.

Before you start
Determine the receipt numbers to use for new receipts or have the
program allocate numbers for you automatically.
Decide whether to post each new receipt as you enter it, or save the
receipts to post them later in a batch using the Post Transactions
form.
Find out the numbers of the receipts to which you wish to post
returns and adjustments. Note that you can post returns and
adjustments only to incomplete receipts. Once a receipt is complete,
you can make changes to it only by using the Adjustments form.

Using the Receipts form
To add new receipts

After using
Run Day End Processing to update Inventory Control's audit data,
costing data (unless you cost items during posting), and item
statistics after posting receipts, receipt returns, and receipt
adjustments.
Print the Receipts Posting Journal to check the receipts, receipt
returns, and receipt adjustments you posted.
Click the Field List button at the top of this topic for information about
fields on the Receipts form.
Click here for hints on using forms.

See also
Processing transactions
Processing adjustments
Processing receipts
Receipt adjustments
Receipt returns
Understanding Serialized Inventory and Lot Tracking

Processing Receipts
Use Inventory Control's Receipts form for receiving items into inventory
and for returning items to suppliers.
Using Inventory Control with Purchase Orders. If you use the Sage
ERP Accpac Purchase Orders program, you can process receipts either
in Inventory Control or Purchase Orders.

Entering receipts, receipt returns, and receipt
adjustments
You can enter returns and adjustments on posted receipts that you have
not yet deleted. You cannot adjust or return receipt transactions that have
been deleted (either immediately after posting, or later, using the
Transactions option on the Clear History form).

Information entered with transactions
Click the following links for information about entering receipts, receipt
returns and receipt adjustments.
See also
Processing adjustments
Processing assemblies and disassemblies
Processing internal usage transactions
Processing shipments
Processing transactions
Processing transfers
Receipts form

Adding New Receipts
1.Click the Receipts icon in the Inventory Control folder.
2.Press the Tab key (with *** NEW *** displayed) to let the program
assign the receipt number, or enter a receipt number and press the
Tab key.
3.Enter an optional description and reference for the receipt, then
specify the transaction date and fiscal year and period to which you
will post it.
4.If a vendor number applies to the receipt, enter that number. If you
use Sage Accpac Accounts Payable with Inventory Control, you can
select vendor numbers from the Finder beside the Vendor Number
field.
5.Enter a purchase order number, if any.
6.If you use multicurrency accounting, specify the currency in which you
will enter item costs and specify the exchange rate.
7.Indicate whether you want to print labels for the receipt.
8.If you use multicurrency accounting, specify the currency in which you
will enter any additional costs.
9.Enter the amount of any additional cost.
10.For each item on the receipt, type or use the Finder to enter the item
number and location.
11. Enter the quantity received and unit of measure. If working with a
serialized or lotted item, you will be prompted to assign serial and/or lot numbers
after specifying a quantity.
12.Enter the unit cost or the extended cost if it is different from the cost
displayed by the program.
13.Indicate the number of labels you require, if any, and enter any
comments you want to appear on the Receipts Posting Journal
regarding the detail line (optional).
14.Press the Insert key on your keyboard to start a new line. Repeat
steps 10 through 13 for each additional line you want to add for the

receipt.
15.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the receipt
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction. If you delete the posted transaction, you will not be
able to drill down to the transaction details from General
Ledger. Also, you will not be able to recall the receipt for
returns or adjustments.
16.Note the receipt number, and click Close at the confirmation
message.

Shipments Form
Use this form to:
Record shipments of items out of inventory.
Record returns of items to inventory (sales returns).
Import shipment and sales return transactions from other Sage ERP
Accpac databases or from non-Sage Accpac programs.
Export shipment and sales return transactions.
of serialized/lotted items if you have the
Serialized Inventory and Lot Tracking license installed
Assign serial and/or lot numbers to shipments

If you use the Sage ERP Accpac Order Entry program, you can process
shipments and sales returns in either Inventory Control or Order Entry.

Multicurrency ledgers
If you have a multicurrency system, you specify the currency and
exchange rate for each shipment or return transaction.

Project and Job Costing integration
If you use Project and Job Costing to assign goods to jobs, the shipment
transactions created by Project and Job Costing will appear in Inventory
Control showing that goods have been allocated to particular contracts,
projects, job categories and WIP accounts.
Note, however, that you cannot assign goods to jobs from the Inventory
Control program.

Types of transactions
You use the Shipments form to enter, save, and post shipments of items
out of inventory and returns of items (sales returns) to inventory.
You can display or drill down to shipment and sales return transactions
from General Ledger after posting unless you delete or clear them.
However, you cannot edit the posted transactions.
To enter shipments and returns:

1.Double-click the Shipments icon in the I/C Transactions folder.
2.Click the New button to start a new shipment or sales return.
3.Press the Tab key to accept the program-assigned number or enter a
shipment or sales return number up to 22 characters long.
4.For Entry Type, select Shipment if you are entering a shipment, or
Return if you are entering a sales return.
5.Specify the date, fiscal year, and fiscal period to which you will post
the transaction in the general ledger, and enter an optional description
and reference for the shipment or sales return.
6.Enter a customer number and the name of the customer's contact
person or position (optional).
7.Enter the price list code for the transaction or select one from the
Finder. The program automatically selects the default price list for the
customer.
8.If you have a multicurrency ledger, and you did not select a customer
from your Accounts Receivable data, enter the currency code and
exchange rate.
9.Add the detail lines, specifying the item number, category, location,
quantity shipped or returned, unit of measure, prices, and costs.
10.If applicable, assign serial and/ or lot numbers to the shipment after specifying a quantity.
11. Enter an optional comment.
12.When you are ready, click the Save or Post button.
13.If the program prompts you to delete the transaction, choose No
unless your company always deletes posted transactions. (You
cannot view or drill down to transactions if you delete them.)

After using
Run Day End Processing to update Inventory Control's audit data,
costing data (if you cost during Day End Processing), and item
statistics after posting shipments or sales returns.
Print the Shipments Posting Journal to check the shipment and sales
return transactions you posted.

Click the Field List button at the top of this topic for information about
fields on the Shipments form.
Click here for hints on using forms.

See also
Processing transactions
Processing shipments
Understanding Serialized Inventory and Lot Tracking

Processing Shipments
Use Inventory Control's Shipments form for shipping items out of
inventory, and for returning items to inventory (sales returns).
Using Inventory Control with Order Entry.If you use the Sage ERP
Accpac Order Entry program, you can process shipments and sales
returns in either Inventory Control or Order Entry.
Using Inventory Control with Project and Job Costing.If you use the
Sage ERP Accpac Project and Job Costing program, you can process
job-related shipments out of inventory in Project and Job Costing.
Note that you cannot enter job-related shipments in Inventory Control. I/C
displays Contract, Project, Category and WIP Account information fields
in the detail lines only for shipments created in the Project and Job
Costing module.

Information entered with transactions
For general information about processing shipments, click here.
For information about shipment detail lines, click here.
To calculate the cost of goods shipped and returned, click here.
Note: You cannot modify posted shipments or sales returns.
See also
Processing adjustments
Processing assemblies
Processing internal usage transactions
Processing receipts
Processing transactions
Processing transfers
Shipments form

Transfers Form
Use this form to:
Enter and post stock transfers between physical inventory locations
if you store items at more than one location.
Import transfer transactions from other Sage ERP Accpac databases
or from non-Sage ERP Accpac programs.
Export transfer transactions.
if you have the Serialized Inventory and Lot
Tracking license installed.
Assign serial and/or lot numbers

Types of transfers
Inventory Control provides two main ways to transfer goods between
locations:
Directly (and immediately) to the destination location.
Via a goods-in-transit location to the destination location, specifying
a transfer number to track the shipment.
When you ship via a goods-in-transit location, all goods must be
separately received at the destination location. Goods can travel on
different trucks and be received in separate lots.

Multicurrency ledgers
If you have a multicurrency system, you enter costs in functional
currency.

To enter transfers
1.Double-click the Transfers icon in the Inventory Control folder.
2.Press the Tab key to start a new transfer and accept the programassigned number (or click the New button if you have already entered
or looked up a transaction).
3.Choose the type of transfer transaction you are entering.
Transfer. Lets you move goods directly and instantly between two

locations—without using a goods-in-transit location.
Transit Transfer. Lets you move goods from one location into
transit.
Transit Receipt. Lets you receive goods currently in transit at the
destination location.
4.Enter the transfer number from a previously entered transit transfer if
you are receiving the goods at a destination location or if you are
adding to the goods being moved into transit.
5.Type over the Document Date if you want to change it (or click the
Calendar button to select a new date). Inventory Control automatically
displays the session date.
6.To change the year or period, type over the default entries or select a
new one from the dropdown list. This is the year and fiscal period to
which the general ledger transaction will be posted, no matter what
date you enter.
7.Enter an expected arrival date for the goods you are transferring.
8.If necessary, enter an additional cost amount.
If you have entered an additional cost amount, select a proration
method.
9.Enter a description and reference for the transaction.
10.Add the detail lines, specifying for each the item number, from and to
locations, quantity transferred, and unit of measure. If you have
selected the manual proration option, enter an amount in the manual
proration field. When transferring items that use the user-specified
costing method, type the unit cost and extended cost.
11. If required, assign serial and/or lot numbers for applicable items after entering a
quantity.
12.Enter any comments you want to add.
13.Click Save or Post.

After using
Run Day End Processing to update Inventory Control's audit data,

costing data (if you perform costing during Day End Processing), and
item statistics after posting transfers.
Print the Transfers Posting Journal to check the transfer transactions
you posted.
Click the Field List button at the top of this topic for information about
fields on the Internal Usage form.
Click here for hints on using forms.

See also
Processing transfers
Processing transactions
Transferring stock items that use FIFO or LIFO costing
Understanding Serialized Inventory and Lot Tracking

Processing Transfers
Use Inventory Control's Transfers form to record stock transfers between
physical inventory locations, if you store inventory items at more than one
location.
Inventory Control lets you transfer goods between locations using two
different methods:
Directly (and immediately) to the destination location.
Via a goods-in-transit location to the destination location, and
specifying a transfer number to track the shipment.
Goods in transit are transferred first to a goods-in-transit location (usually
marked as a logical inventory location). When they reach their destination, they
must be received from the goods-in-transit location.
In other words, goods in transit:
Exist between locations—like in the real world.
Can travel on different trucks and be received in separate lots.
Transfers change item quantities at locations without changing the total
number of items in inventory, or the total inventory valuation.
When you post transfers, the program generates journal entries to track
the movement of stock because costing is done by location.

Information entered with transfers
Before you can post transfers, you must allow the items being transferred
to be stocked at the locations to which you are transferring them. For
general information about entering transfers, click here; for more detailed
information, click here.
See also
Processing adjustments
Processing assemblies
Processing internal usage transactions
Processing receipts
Processing shipments
Transferring stock items that use FIFO or LIFO costing
Transfers form

Adjustments Form
Use this form to:
Enter and post adjustments to item quantities and costs.
Import adjustment transactions from other Sage ERP Accpac
databases or from non-Sage ERP Accpac programs.
if you have the Serialized
Inventory and Lot Tracking license installed
Assign serial and/or lot numbers to items in adjustments

Click the Field List button at the top of this topic for information about
fields on the Adjustments form.
Click here for hints on using forms.

To enter adjustments
1.Select I/C Transactions > Adjustments to display the I/C Adjustments
form.
2.Click New to start a new adjustment, then press Tab to let the
program assign an adjustment number, or enter an adjustment
number.
3.If necessary, select an adjustment date (click the Calendar button),
and select a fiscal year/period from the drop-down list at the
Year/Period field.
4.Enter an optional description and reference for the adjustment.
5.Add the detail lines, specifying the item number, adjustment type, and
location for each, then:
If the item uses the FIFO or LIFO costing method, specify the bucket type,
receipt number, and cost date.
If the adjustment type is Quantity Increase, Quantity Decrease,
Both Increase, or Both Decrease, specify the quantity and unit of
measure.
If the adjustment type is Cost Increase, Cost Decrease, Both
Increase, or Both Decrease, specify the cost adjustment and
adjustment/write-off general ledger account.

6.Enter any comments you wish to add.
7.Click the Post or Save button, then click OK at the message that
displays the adjustment number.

Project and Job Costing integration
If you use Project and Job Costing, material adjustment transactions
created by Project and Job Costing will appear in Inventory Control
showing adjustments to particular contracts, projects, job categories and
overhead accounts.
Note, however, that you cannot adjust materials for jobs from the
Inventory Control program.

After using the Adjustments form
Run Day End Processing to update Inventory Control's audit data,
costing data (unless you cost items during posting), and item
statistics after posting adjustments.
Print the Adjustments Posting Journal to check the adjustment
transactions you posted.
See also
Adjustments to items using FIFO or LIFO costing
Entering adjustments
Processing adjustments
Processing transactions
Understanding Serialized Inventory and Lot Tracking

Processing Adjustments
Inventory Control provides several forms for adjusting item costs and
quantities:
Use the Adjustments form to change item costs and quantities as needed.
Some examples of when you would want to use the Adjustments
form are:
To update the quantity on hand at a location to agree with your
physical inventory count.
To return goods to a vendor after you have completed the receipt.
To remove additional cost remaining on a receipt when you return
the total quantity received for an item at a location to the vendor.
Use the Process Adjustments form to automatically create adjustments to:
Write off the cost of items with zero quantities.
Write off the quantities of items with zero cost.
Adjust the total costs of items with non-zero quantities and zero
total cost to a new cost.
Use the Post Inventory Reconciliation form to post the counts and costs that you
entered in the Physical Inventory Quantities form. The program
creates adjustment transactions when you post inventory
reconciliations.
Note that when you post an inventory reconciliation for which an
adjustment number already exists, the Inventory Worksheet will create
separate adjustments for every one hundred items, and append "1", "2",
"3", etc. to the end of the document number.
See also
Adjustments form

(for automatic adjustments)

Process Adjustments form
Entering adjustments
Types of adjustments
Processing assemblies
Processing internal usage transactions
Processing receipts
Processing shipments
Processing transfers

Processing transactions
Posting inventory reconciliations

Entering Adjustments
For full instructions on entering adjustments, see Adjustments form.
See also
Adjustments to items using FIFO or LIFO costing
Adjustments form
Processing assemblies
Processing receipts
Processing shipments
Processing transfers
Processing transactions

Internal Usage Form
Use this form to:
Record transactions that take items from inventory for your own
company's use.
For example, an office supply store could take a desk from inventory
for a new employee. Or it could take paper, pencils, and pens from
inventory for office supplies.
Import internal usage transactions from other Sage ERP Accpac
databases or from non-Sage ERP Accpac programs.
Export internal usage transactions.
Record items as fixed assets in Sage Fixed Assets.
of serialized/lotted items if you have
the Serialized Inventory and Lot Tracking license installed
Assign serial and/or lot numbers for internal usage

If you use Sage Fixed Assets system (FAS) to manage the fixed assets in
your company, you can also mark goods that are taken out of inventory
for internal use as fixed assets. Sage ERP Accpac will transfer the asset
information to FAS. See Using I/C with Sage Fixed Assets (FAS).

To enter internal usage transactions:
1.Double-click the Internal Usage icon in the I/C Transactions folder.
2.Click the New button to start a new transaction.
3.Press the Tab key to accept the program-assigned number or enter
an internal usage number up to 22 characters long.
4.Specify the date, fiscal year, and fiscal period to which you will post
the transaction in the general ledger.
5.Enter an optional description and reference for the internal use
transaction.
6.Enter or select the person in your company who ordered the goods. If
you use the US or Canadian Payroll module, you can choose
employees from the Finder.
7.Click the Zoom button ( ) to add optional fields for this transactions
(appears only if you use optional fields).
8.Add the detail lines, specifying the item number, category, location,
quantity, and unit of measure.
9.If required, assign serial and/or lot numbers for applicable items after entering a
quantity.
10.Enter an optional comment.
11. Enter optional fields.
12.When you are ready, click the Save or Post button.
13.If the program prompts you to delete the transaction, choose No
unless your company always deletes posted transactions. (You
cannot view or drill down to transactions if you delete them.)
Click here for hints on using forms.

After using
Run Day End Processing to update Inventory Control's audit data,
costing data (if you cost during Day End Processing), and item
statistics after posting internal usage transactions.

Print the Transaction Listing Report or Posting Journal for internal
transactions to check the transactions that you saved and posted.
Click the Field List button at the top of this topic for information about
fields on the Internal Usage form.

Drill Down from General Ledger
You can display or drill down to internal usage transactions from General
Ledger after posting unless you delete or clear them. However, you
cannot edit the posted transactions.
See also
Processing transactions
Processing shipments
Understanding Serialized Inventory and Lot Tracking
Using I/C with Sage Fixed Assets (FAS)

Using I/C with Sage Fixed Assets (FAS)
Sage ERP Accpac provides full integration with the Sage Fixed Assets
program, allowing you to enter asset transactions in Inventory Control,
Purchase Orders, Accounts Payable, and Intercompany Transactions.
Sage FAS integration lets you:
In Inventory Control, identify items as financial assets when you
withdraw them from inventory for internal use by your Company.
In Purchase Orders, Accounts Payable, and Intercompany
Transactions, identify items as financial assets when you purchase
them.
Send asset information to Sage FAS to set up program assets that
you have identified in Sage Accpac ERP.
Sage Fixed Assets works with Inventory Control 5.5 and higher.

Recording the Internal Use of Inventory for FAS
You use the Internal Usage form in Sage ERP Accpac Inventory Control
to withdraw items from inventory for use by your company (or
organization) and identify them as fixed assets for Sage FAS.
To record the purchase of an asset for Sage FAS:
1.In Inventory Control, from the I/C Transactions folder, choose Internal
Usage.
2.Create a new internal usage transaction, entering header information
as usual. (See Use Goods Internally for detailed instructions on entering
internal usage transactions.)
3.Click the detail-entry grid, and then click the Detail button or press the
F9 key.
4.Enter information for the item detail, including the item number for the
asset you are withdrawing from inventory, location, quantity, and unit
of measure, as usual.
5.Select the Fixed Assets option, and then click the Zoom button to
open the Fixed Assets form.
6.Enter information for the asset record as follows:
a.

If you want to use a different template than the one displayed on
the Fixed Assets form, use the Finder for the Sage FAS Template
field to select a different one. Otherwise, either accept the default
template code that appears or clear the entry from this field. (You
do not have to use a template to create the asset in Sage FAS.)

b.

Use the Description field to enter the description that you want to
use for the asset in Sage FAS.

c.

If you are using more than one asset item and you want to create
separate asset records for each one in Sage FAS, select the
Separate Assets option.
The program allocates the Sage FAS value entered on the Fixed
Assets form proportionately to each Sage FAS record it creates.
For example, for a quantity of 10 and a value of $25,000, the

program creates 10 asset records with a value of $2,500 each.
d.

In the Sage FAS Quantity field, type the quantity of asset items
you are removing for internal use.

e.

In the Sage FAS UOM field, type the unit of measure for the
quantity you entered.

f.

In the Sage FAS Value field, type the value to book for the asset in
Sage FAS.

7.Click Close to return to the detail entry form.
8.Click Add.
9.When you have finished adding details for the transaction, click Close
to return to the main Internal Usage form.
10.Click Add, and then click Close.
Note: You must run Create Assets in the Sage FAS Integration module to
update Sage FAS with the asset information.

Setting Up Inventory Item Records
Before you can enter inventory transactions, you need to add your
inventory item records to Inventory Control. Item records contain the
information you need to manage your inventory.
This topic tells you what you need to know before adding item records to
Inventory Control, and describes the options you can select so the item
records meet your company’s needs.
Before you can add your item records to Inventory Control, you must set
up item number formats, account sets, categories, and locations. If you
need more information about any of these tasks, see the online help
instructions Setting Up Inventory Control
Prepare to add inventory items

When you are ready to add your item records to Inventory Control, follow
the online help instructions Setting Up Inventory Control.
Adding Inventory Items
Importing item records
Manufacturers' Item Numbers

Sage ERP Accpac Order Entry
If you use Order Entry, you can display and select from an item’s
alternate item list when entering orders, invoices, or credit notes.
See also
Adding bills of material
Adding reorder Information
Assigning items to locations
Defining item number formats
Items form
Planning your item numbers
Steps for setting up Inventory Control
Understanding Serialized Inventory and Lot Tracking

Adding Current Item Quantities and Costs
This topic describes the steps you take to post the current item quantities
and costs for each of your inventory items when you are setting up your
Inventory Control system.

Before adding item quantities and costs:
From your existing system, gather the amounts and costs for your items
at each location.

To add current item quantities and costs:
1.Make your selections in the Options form, if you have not already done
so.
2.Use the Receipts form to add your current item quantities and costs to
Inventory Control. Importing item quantities and costs.
3.Use the Day End Processing icon to update your Inventory Control
records.
4.Double-click the Item Valuation icon in the Stock Control Reports
folder to print the Item Valuation report to check that the item
quantities and costs you added match those on your source
documents. If you need to make adjustments.
5.Doulbe-click the Posting Journals icon in the Price/Sales Analysis
Reports folder, then print the journal of the receipts (and adjustments,
if applicable) you posted.
Compare the posting journal(s) to the Item Valuation report you
printed in step 4, and your source documents.
6.Click the Clear History icon in the Periodic Processing folder, to delete
the printed posting journal(s) for receipts (and adjustments, if
necessary).
Select the Printed Posting Journals option, then select Receipts (and
Adjustments, if you made any).
7.Double-click the G/L Transactions icon in the Price/Sales Analysis
Reports folder, then print the G/L Transactions report using the

displayed posting sequence number.
8.Double-click the Create G/L Batch icon in the Periodic Processing
folder, then create the general ledger transactions for the Inventory
Control transactions you posted (use the displayed day-end number).
Compare the G/L Transactions report you printed in step 7 to your
general ledger listing to be sure the totals balance.
Delete the general ledger batches that you created.
If you do not delete the batches, you risk posting them twice in your
general ledger. To delete the batches
In step 1, you may have had to make one or more changes in the
Options form before entering your item quantities and costs. If you
made changes, you can now change the options back. More
See also
Setting up item records
Steps for setting up Inventory Control

Copying Items and Prices
You can copy items and prices from one price list to another.
1.Double-click the Copy Item Pricing icon in the Items And Price Lists
form.
2.If you use multicurrency accounting, enter the currency from which
you want to copy item pricing information, or use the Finder to select
the currency.
3.Enter a price list code or use the Finder to select the price list from
which you want to copy item pricing information.
4.If you use multicurrency accounting, enter a currency code or use the
Finder to select the currency to which you are copying pricing
information.
5.Enter a price list code or use the Finder to select the price list to which
you want to copy pricing information.
6.Specify the method to use to select the range of items to assign.
7.Select the pricing information you want to copy and how you want to
change it.
8.Click the Copy button to copy the selected range of items to the price
list.

Assigning Items to Locations
If you did not select the Allow Items At All Locations option in the Options
form, you must assign an item to the locations where you want to stock it.
You must allow an item at a location before you can post transactions
involving the item and location.
For example, you must assign an item to a location before you can add
(receive) to Inventory Control the number of units and cost for the item at
the location.
You can assign active items to any number of locations. (You cannot
assign inactive items to locations.)
Inventory Control provides three ways for you to assign items to
locations. You can assign:
All your inventory items to all locations.
A group of items to specific locations.
A single item to specific locations.
Use the following list to decide which of these methods (or combination of
methods) of assigning items to locations is the most efficient for you to
use.

Assign all items to all locations
If your company does not keep inventory at more than one location, or it
does not need to restrict any items from being kept at any of several
locations, you can save time setting up your Inventory Control system by
assigning all your inventory items to all locations. This allows you to start
entering transactions right away involving any item at any location.
To allow every item to be stocked at all storage locations, select the Allow
Items At All Locations option on the Processing tab in the Options form.
You can turn the option on or off at any time.

Assign a single item to a specific location
If your company keeps some inventory items at more than one location,
but restricts others, you can assign items individually to as many

locations as you want.
Use the Location Details form to assign single items to inventory
locations.

Assign multiple items to a specific location
If your company keeps different categories or types of inventory items at
different locations, you can assign ranges of items (by item category, item
number, or a segment of an item number) to any locations.
For example, if you had the three item categories F1, F2, and F3 for
different types of filing cabinets, you could assign all the filing cabinets to
a location by specifying that all items having a category in the range F1 to
F3 be assigned to the location.
Use the Locations form to assign group of items at the same time to a
specific inventory location.
See also
Adding bills of material
Setting Up Inventory Item Records
Steps for setting up Inventory Control

Manufacturers' Items
Inventory Control lets you associate additional item numbers with the
items in your inventory.
The main purpose of adding these "alias" item numbers is to let you
associate bar codes with your inventory items. Manufacturers' item
numbers are automatically translated to your inventory item numbers
when you enter them in item number fields in the Inventory Control,
Order Entry, or Purchase Orders programs.
You add manufacturers' item numbers using the Manufacturers' Items
form in I/C Items and Price Lists folder. The program has no limit to the
number associated with each item number.
Note: Manufacturers' item codes also provide a unit of measure, so you
can assign different codes for single items, a box, and a pallet.
You can create several different item coding systems for the same
inventory items.
Decide what bar coding schemes you want to use. UPC codes are
specific to manufacturers' items.
If creating shortcut aliases, design an easily-remembered, logical
coding scheme.
See also
Account Sets
Categories
Items
Item Pricing
Location Details
Locations
Price List Codes
Segment Codes

Adding Reorder Information
If you add reorder information to Inventory Control, you can print reports
that list understocked and overstocked items in your inventory. You can
use these reports to help you decide when to reorder items.

Adding reorder information
Use the Reorder Quantities form to add reorder information for your
inventory items.
Sage ERP Accpac Purchase Orders. If you use Inventory Control with
Purchase Orders, you can use the Purchase Orders program to generate
purchase orders automatically for items which need to be reordered.
If you stock an item at more than one location, you add reorder
information for the item at each location.

Varying reorder information
You can keep different reorder information for different periods of the
year. More…

Minimum and maximum quantities
Inventory Control calculates the number of units for an item as the
quantity on hand plus the quantity on purchase order, minus the quantity
on sales order. More…
See also
Reorder Quantities form
Steps for Setting up Inventory Control

Bills of Material Form
This form lets you:
Set up bills of material if you plan to assemble or repackage
inventory items to create a supply of "master items" to sell.
Click the following topic headings for more help, and click the Field List
button at the top of this topic for information about fields on the form:
Multilevel BOMs
Bills of Material versus Kits
Rules for Bills of Material
Before Adding Bills of Material
Before Posting Assemblies
Negative Inventory Levels
Alternative BOMS
Build Quantities

See also
Adding bills of material
Steps for setting up Inventory Control

Contract Pricing Form
Use this form to set up contract pricing for specific customers. Sage
Accpac Order Entry uses this information to calculate the default price for
any item affected by the customer’s pricing contract.

Before setting up contract pricing:
Decide on the terms of the pricing contracts, where applicable, with
your customers.
Specifically, decide whether they are to affect individual items or
entire item categories.

To set up contract pricing:
1.Double-click the Contract Pricing icon in the I/C Items and Price Lists
folder to open the I/C Contract Pricing form.
2.Enter the customer number or select one using the Finder for the
customer for whom you want to set up a contract price.
3.Select the pricing method you prefer: by item number or by category
code.
If you are pricing by Item Number:
If you are pricing by Category Code:

Fields in the lower portion of the form are displayed according to the
choices you made in the upper portion.
If you are pricing by Item Number
If you are pricing by Category Code

4.Using the Calendar icons, select the start and expiration dates of the
contract. You can leave these fields blank if you want the contract to
be open-ended. These dates are used in O/E transaction entries
when determining the default item price.
5.Click the Add button to add the contract pricing to your data. You will
later be able to edit this contract or add another for the same
customer by using the Finder or the scroll buttons. You can also clear
expired contract prices by using the Clear History form.

Click the Field List button at the top of this topic for information about
fields on the Contract Pricing form.
Click here for hints on using forms.

See also
Item Pricing form
Price List Codes form
Customer Details
Location Details
Manufacturer's Item Numbers

Copy Bills of Material Form
This form lets you:
Create a new bill of material based on an existing bill of material.
The new BOM can be:
For the same master item or for a different master item.
A single-level or multilevel bill of material.
Accept the existing values of the selected bill of material (such as the
fixed cost, variable cost, build quantity, etc.) or change the values for
the new build.
Choose which items from the original bill of material should be
copied to the new bill of material.
You cannot add components to the new bill of material or change the
item numbers of components.
This form copies bill of material information, adding a new bill of material
to an existing master item.
To update component item numbers or costs for a range of bills of
material, use the Update Bills of Material form instead.

Before you start
Use the Items form to add the new master or component inventory
items for which you are creating bills of material.

After copying bills of material
Print the bills of material using the Bills of Material report in the
Setup Reports folder to check the new record information.
Use the Bills of Material form add or change component items on the
new bills of material.
Click the Field List button at the top of this topic for information about
fields on the Copy Bills of Material form.
Click here for hints on using forms.

See also
Items form
Bills of Material form

Copy Item Pricing Form
This form lets you:
Copy the contents of one price list to create a new price list and, if
you wish, specify a percentage increase or decrease in the base
price, sale price, markup cost and discount pricing (if specified by
amounts).
Copy the prices in one currency to another currency on the same
price list to create a new set of prices — adjusting prices using
current exchange rates.
This form copies pricing information, adding items to a new or existing
price list. To update item prices on an existing price list, use the Update Item
Pricing icon instead.

Multicurrency ledgers
If you have a multicurrency system, you can include prices in different
currencies for an item on the same price list. Use the Item Pricing form to
set up the price list for items in one currency, then use Copy Item Pricing
to create prices in other currencies for the items.

Before you start
Use the Price List Codes form to add the price list codes you need
for new price lists you want to create.
Use the Price Lists form in Price/Sales Analysis Reports folder to
print the price lists from which you are copying information.
Choose how you are going to copy pricing information. For example,
map out item ranges and price changes between the source price list
and the target.
Note: You cannot copy an item or a range of items if any of the items
already appear on the list you are copying to. Use the Update Item
Pricing icon instead to change existing price list information.

After copying price lists

Print the price lists to which you copied information, using the Price
Lists form in Price/Sales Analysis Reports folder.
Compare the new price lists to your original price lists to verify that
you copied pricing information correctly.
Click the Field List button at the top of this topic for information about
fields on the Copy Item Pricing form.
Click here for hints on using forms.

See also
Items form
Price List Codes form

Customer Details Form
Use this form to:
Set up a list of numbers that your customers use for your inventory
items.
Customer item numbers are particular to the customer and also
specify the customer’s unit of measure, so different customers can
use the same number for different items.
Customer item numbers are often required for large customers, where
the customer uses their stock numbers when ordering from you.
You may have a number of customer item numbers associated with a
single item if you supply goods to several large outlets.

To add a customer item number
1.Open the Customer Details form from the Items and Price Lists folder.
2.Choose the item from your inventory.
3.Specify the customer.
4.Enter the customers’ item number and their description of the item.
5.Enter the unit of measure.
6.Enter relevant comments and particular instructions for handling or
shipping. Comments and instructions appear on Orders when the
customer item number is used in Order Entry.
Click the Field List button at the top of this topic for information about
fields on the Customer Details form.
Click here for hints on using forms.

See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Form — Overview
The Items form has four tabs: Items, Units, Taxes, and Optional Fields.
The Serials and Lots tabs appear as well if working with a serialized
and/or lotted item.
You use the Items form to:
Add new items, and change or delete existing item records.
Select the item structure and enter segment information for a new
item number. (Click the Zoom button [ ] to open the Construct Item Number
form.)
Note that you can include blanks in your item numbers. This means,
for example, that you can have two difference item numbers: "12 3"
and "1 23".
Set item attributes, such as whether items are sellable, have serial
numbers, are sold on the Web, are kits (a collection of other items),
are kept in stock, etc.
Enter and revise picking sequences (or bin numbers), item weights,
units of measure and tax information.
Add or change optional field information for items.
You must add items to Inventory Control before you can use them in
transactions.

Allowing items at different locations
If you did not select the Allow Items At All Locations option in the I/C
Options form, you must use the Locations form (in the Setup folder) or
the Location Details form (in the Items and Price Lists folder) to specify
which items you want to stock at each location.
For an overview of Item records, see Setting Up Inventory Item Records.
For information about tabs in the Items form, click these links:
Items

Units

Taxes

Serials

Lots

Optional Fields

For information about fields in the Items form, click the Field List button
beside the title of this help topic.

Click here for hints on using forms.

Choose the Items icon in the Items And Price Lists folder to add item
records to Inventory Control, and to modify or delete existing item
records.
Before adding items
To use the Items form
After changing item records

See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Wizard
The Items Wizard streamlines the process for setting up items by letting
you enter all item set up information within a single item wizard.
For information about fields in the Items Wizard, click the Field List button
in the title bar of this help topic.
The Items Wizard lets you:
Add a new item with all applicable information.
Add information for an item that already exists.
If you have to leave the wizard while adding an item, just click the Cancel
button, and you will have the chance to save your entries. The next time
you start the Items Wizard, you can continue from the last entry by
entering the same Item Number.

Wizard process
The Items Wizard takes you through the process of adding the following
information:
Items
Location Details
Vendor Details
Item Pricing
Contract Pricing
Manufacturers’ Items
Customer Details
Bills of Material
Kitting Items
Reorder Quantities
For more information on adding items to Inventory Control, see:
Account Sets
Bills of Material

Categories
Contract Pricing
Customer Details
Item Pricing
Items
Kitting Items
Location Details
Locations
Manufacturers' Items
Price List Codes
Reorder Quantities
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Item Pricing Form — Overview
This form lets you:
Assign items to price lists.
Specify and edit item pricing information for each price list. If you
have Sage ERP Accpac 500, you can also:
Price volume discounts by quantity or weight.
Enter one or more base prices for multiple units of measure.
Calculate the base price using the cost plus a percentage or
amount.
Edit discount or markup information for calculating item prices.
Assign the tax authorities and customer tax classes for taxes that are
included in the item price.
Set checks for price overrides in Order Entry.
Remove items from a price list.
Inventory Control uses price lists for reporting purposes only.
Order Entry uses price lists to calculate the prices of goods, taxes, and
discounts on customer orders and invoices.
For an overview of item records and item pricing, see:
Setting Up Inventory Item Records
Setting Up Price Lists

For information about tabs in the Item Pricing form, click these links:
Prices

Discounts

Price Check

Taxes

Click here for hints on using forms.

For information about fields in the Item Pricing form, select the Field List
button beside the title of this help topic.

Before assigning items to price lists
Add the price list codes you want to use.
Gather the existing pricing information for each item in your

inventory.

Modifying price lists
You can change most of the information in an item pricing record at any
time, but the Quantity Purchased field cannot be zero if you entered a
discount or markup percentage or amount. (The Quantity Purchased field
appears on the Discounts tab when you select Volume Discounts in the
Prices Determined By field.)
To use the Item Pricing form
After changing price lists

See also
Items
Price List Codes
Update Item Pricing

Kitting Items
Kitting items are collections of items that are priced and sold through
Order Entry as a single item, and are often collected together at sale time
— such as a particular computer, keyboard, and monitor combination, or
a back-to-school binder, pencil case, and felt pen set.
For information about fields in the Kitting Items form, click the Field List
button in the title bar of this help topic.
Difference between kitting items and items assembled using bills of
materials
Kitting items allow you to group items for special promotions and sell
them as a single item. Kits do not have build costs, and the kitting
item is not treated as a stock item (so there are no stocked quantities
of the kit — only of the components).
Bills of material, on the other hand, are designed for manufacturing
items from other items or subassemblies, and for stocking the new
items.
For both kinds of assemblies, you must add the master item record and
all of the component item records before you can define the kit or BOM.
Note the following points regarding kitting items
You must add the kitting item record and all of the component item
records before you can specify the contents of kitting items.
Kitting items must use an account set code that specifies a userspecified costing method.
You must choose the Kitting Item option for kitting item.
Kitting items can include non-stock items — such as shipping or
installation fees.
Kitting items cannot have serial numbers.
You can track kits by using lot numbers or serialized inventory
numbers for kitting item components. However, the actual kitting
master item cannot have a serial number.

The cost of a kit is based on each individual item in the kit. If the price is
based on costs, it will be determined by the cost of all the items together.

Before Defining the Components for the Kitting
Items
Before you can set up the list of component items for a kit, you must add
each component item record and add the inventory record for the kitting
item.
To add the inventory record for the kitting item
1.Open the Items form (located in the Items and Price Lists folder), then
use the Finder to select the Item Number (or type the code in the
field).
2.On the Items tab, in the Account Set Code field, select a code that
uses a user-specified costing method.
3.Uncheck the Stock Item box. Kitting items are non-stock items.
3.Select the Kitting Item option.
4.Continue entering information and choosing options on other tabs of
the Items form and then click Add to save the kitting item.
5.Set up as many other items to be kitting items as you need, following
the above instructions.
You now set up kits.

To Set up Kitting Items
1.Double-click the Kitting Items icon in the I/C Items and Price Lists
folder.
2.Using the Finder, choose the item number for the kitting item. (See
the above instructions for creating the kitting item record.)
3.Enter a kitting number, and then click the Go button ( ) to activate the
rest of the fields on the form.
The kitting number is 6 character code that identifies the list of
components. You can have as many component lists as you need to

accommodate alternative/substitute item components.
4.Enter a description for the kit.
5.To use this kit as a default setup, select the Use as Default option.
(optional)
6.Enter a comment if you wish.
7.In the grid, use the Finder to select component item numbers.
8.Enter the quantities for each component as well as the unit of
measure for each quantity.
9.Enter a Unit Cost, if allowed (for example, if the item has a userspecified cost).
10.Click Add.
You can now use this kit in Order Entry. You can also set up I/C to track the
items.
See the Order Entry online help for instructions about assigning lot
numbers to the components that are being tracked (if you use Sage ERP
Accpac Lot Tracking).
See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Location Details Form
This form lets you:
Enter costing information for items at each location where you allow
the item to be stocked.
Look up information about the locations where you stock individual
items.
Specify the locations at which you allow items to be stocked (if you
do not use the Allow Items At All Locations option).
Specify the locations at which you allow items to be used in
transactions.
View the number of items at each location on purchase order, on
sales order, and committed to orders.
Highlight the location you want, and click the drilldown button to see
purchase order and sales order details. You can drill down again to
specific purchase orders and sales orders.
View and edit the last cost for purchasing an item.
View the serial or lot cost for an item (if working with a serialized
and/or lotted item that uses the serial or lot costing methods)
Before adding location details
Modifying location details
After changing location details

Click the Field List button at the top of this topic for information about
fields on the Location Details form.
Click here for hints on using forms.

See also
Assigning Items to Locations
Items
Item Pricing
Locations

Manufacturers' Items Form
The Manufacturers' Items form lets you associate additional numbers
with the items in your inventory. This feature lets you:
Use manufacturers' bar codes (or UPC and ISBN codes) for entering
transactions in Inventory Control, Order Entry, or Purchase Orders.
Manufacturers' item numbers are automatically translated during data
entry to your inventory item numbers.
Note: Manufacturers' item codes also provide a unit of measure, so
you can assign different codes for single items, a box, or a pallet.
Simplify data entry by creating a set of shortcut item numbers for
your most popular items.
You can add as many manufacturers' item numbers as you need. The
program has no limit to the numbers associated with each item number.
For information about fields in the Manufacturers' Items form, click the
Field List button beside the title of this help topic.

Before adding manufacturers' items
You can create several different item coding systems for the same
inventory items.
Decide what bar coding schemes you want to use. UPC codes are
specific to manufacturers' items.
If creating shortcut aliases, design an easily-remembered, logical
coding scheme.
Click the Field List button at the top of this topic for information about
fields on the Manufacturers' Items form.
Click here for hints on using forms.

See also
Account Sets
Categories
Items
Item Pricing
Location Details
Locations
Price List Codes
Segment Codes

Units of Measure
Weight Units of Measure

Reorder Quantities Form
This form lets you:
Set up reorder information (maximum, minimum, reorder, and
projected sales quantities in item stocking units) for your inventory
items if you want to use the Overstocked Items report or the Reorder
Report to assist you in managing your inventory.
Specify separate reorder criteria for each item at each inventory
location where you stock the item, or for all locations.

Before adding reorder criteria:
Decide on the items (all, some, or none) for which you will add
reorder criteria to Inventory Control.
For each item, decide on the minimum number and maximum
number you want stocked at each location in your inventory, or set
overall maximum and minimum reorder quantities for all locations.
Decide on the number of each item you want to order if the amount
of the item in stock at a location drops below the minimum number
you specify for the time period.
Estimate the quantity of each item you expect to sell during each
time period.

To specify reorder information
1.Double-click the Reorder Quantities icon in the Items And Price Lists
folder.
2.Enter or use the Finder to select the item number for which you want
to add reorder criteria.
3.Select whether you want to set reorder quantities for a specific
location or for all locations.
If you choose to set reorder quantities for a specific location, you
cannot later set quantities for the same item for all locations, unless
you first delete the reorder quantities for each of the specific locations.
Similarly, if you choose to set quantities for all locations, you cannot

later set quantities for a specific location unless you first delete the
quantities for all locations.
4.If you have chosen to set quantities for a specific location, enter the
location code, or use the Finder to select an inventory location. (You
must have previously allowed the item to be stocked at the location.)
5.Click the Go button [ ] (or press F7), then add the starting date and
the quantities for each desired period (press the Tab or Insert keys to
add a new line).
6.You can add optional field information for this item and location if you
assigned optional fields to reorder quantities records.
7.Click Save to save your entries.

After changing reorder quantities
Print the Reorder report to check the new record information and to
update your printed records.
Compare the report you printed before changing or deleting reorder
quantities to those printed after the changes to verify that you made
the required changes correctly.
Click the Field List button at the top of this topic for information about
fields on the Reorder Quantities form.
Click here for hints on using forms.

See also
Adding Reorder Information
Location Details
Overstocked Items report
Reorder Quantities report
Reorder report

Update Bills of Material
This form lets you:
Change the fixed or variable costs for a range of bills of material by a
percent or an amount.
Add, remove, or replace particular components in a range of bills of
material.
This form updates information on existing bills of material. If you want to
create new bills of material, use the Bills Of Material form or the Copy
Bills Of Material form.

Before you start
Determine the bills of material and item or costs that you want to
update.
Determine the method you want to use to update costs (by percent
or by a fixed amount).
Print the Bills Of Material report from the Setup Reports folder for the
bills of material that you want to change.

To update the costs or items in a range of BOMs
1.Double-click the Update Bills Of Material icon in the Items And Price
Lists folder.
2.Use the Finders to specify the range of master item numbers to
include in the update.
3.Use the Finders to specify the range of BOMs to update.
4.Select whether you are updating components or costs.
If components, choose whether you are replacing, adding, or
removing components, and specify the components and BOMs.
If costs, choose fixed or variable cost, whether you are using an
amount or percent, whether this is an increase or decrease, and
the amount or percent change.
5.Click the Update button to update the selected bills of material.

After updating bills of material
Print the bills of material lists that include the information you
changed, using the Bills of Material icon in Setup Reports folder, to check
the new record information.
Compare the bills of material you printed before making changes to
those printed afterwards to verify that you made all changes
correctly.
Click the Field List button at the top of this topic for information about
fields on the Update Bills of Material form.
Click here for hints on using forms.

See also
Copy Bills of Material
Bills of Material

Update Item Pricing Form
This form lets you:
Change prices, costs, or price check type for a range of items on one
or more price lists.
You can change the type of price check performed on items, or you can
update the base price, sale price, or markup cost by using percentage,
amount, markup, or margin. You can also specify the percentage of the
increase or decrease in the base price.
This form updates item information on existing price lists. If you want to
create a new price list, open the Item Pricing form or the Copy Item
Pricing form.

Before you start
Determine the price lists and items you want to update.
Determine the method you want to use to update prices.
Print the Price Lists report from the Price/Sales Analysis Reports
folder for the price lists you want to change.

To update the prices in one price list
1.Double-click the Update Item Pricing icon in the Items And Price Lists
folder.
2.Use the Finders to specify the range of price lists to update.
3.Use the Finders to specify the range of items to include in the update.
4.Select the kind of change and the method of updating, then, for prices
or costs, specify the increase or decrease.
5.Click the Update button to update the selected price lists.

After updating price lists
Print the price lists that include the information you changed, using
the Price Lists icon in Price/Sales Analysis Reports folder, to check the
new record information.

Compare the price lists you printed before making changes to those
printed afterwards, to verify that you made all changes correctly.

Multicurrency ledgers
If you have a multicurrency system, you can update prices by currency
and exchange rate.
For example, if you update US prices first, you can update Canadian
prices on your price list by using exchange rates, and basing the new
prices on the US currency prices.
For example, if the price list code is RETAIL, and you enter the following
in the Update Pricing fields:
Currency: CAD
Price List Code: from RETAIL to RETAIL
Update: Base Price using Exchange Rate
Base on currency: USD
The program will first locate the item pricing with:
Currency: USD
Price list code: RETAIL
Then it will multiply the base price times the exchange rate, and update
the item pricing for:
Currency: CAD and
Price List Code: RETAIL
Click the Field List button at the top of this topic for information about
fields on the Update Item Pricing form.
Click here for hints on using forms.

See also
Copy Item Pricing
Item Pricing
Price List Codes

Vendor Details Form
Use this form to:
Link up to nine vendors to each item in your inventory.
Assign a priority (type) to the vendors who supply you with each
item.
Enter detailed information about each vendor and their costs for the
item.

To use the Vendor Details form
1.Enter an item number or choose the number from the Finder.
2.If vendors are already attached to the item, press the Insert key to
add a new one.
3.Each new vendor will automatically be assigned the next highest type.
However, you may change the vendor type by selecting one from the
list. (Use the down arrow in the Vendor Type field.) You cannot assign
the same type to two vendors of the same item.
4.Enter a number into the Vendor Number field or select one using the
Finder. If the number you enter corresponds to an existing vendor, its
name will appear in the Vendor Name field. If the number does not
appear in the Finder list, it is a new vendor and you will have to
manually enter its name in the appropriate field.
5.Enter the other vendor details: vendor contact, vendor item number,
and vendor cost.
6.Either select the cost unit and vendor currency using the Finders or
manually enter the entries.
Click the Field List button at the top of this topic for information about
fields on the Vendor Details form.
Click here for hints on using forms.

I/C Serial Numbers
The I/C Serial Numbers form appears when you select I/C Items and
Price Lists > Serial Numbers. Use this form to view the status of a
serial number and edit serial number details such as contract codes and
optional fields. Item level information can also be edited as you have the
ability to open the I/C Items form using this form. You can also view the
transaction history of serial numbers and drill-down to source documents
for greater detail.
Note: You cannot create new serial numbers using this form. Use the
Serial/Lot Reconciliation form to do so.
To use the I/C Serial Numbers Form:
1.Open I/C Items and Price Lists > Serial Numbers.
2.Enter a Serial Number or make a selection using the Finder. If you
enter or select an Item Number before using the Serial Number field,
only those serial numbers that were assigned to the item will appear
in the Finder list.
Once a number is selected, read-only information appears in the
Location, Status and Stock Date fields. The Allocated to OE Order
checkbox is selected if this serialized item has been reserved for an
upcoming order processed in the Order Entry application.
3.If required, change the Expiry Date of the selected number.
4.If required, edit or add the Contract Code.
5.Select the Optional Fields tab to view any optional fields already
associated with the number. You can add to or edit this information if
required.
6.If you wish to view or edit Item level information, click Items and the
I/C Items form appears with the selected item's details.
7.Click Transactions and the Serial Number Inquiry form appears with a
list of transactions that pertain to the selected number. Select a
transaction and click Details to drill down to the source document of
the transaction.

8.Click Save on the I/C Serial Numbers form to save any changes you
made.
If you want to see which serial numbers have been reserved for
upcoming orders, create a report for Reserved Stock using the Serial/Lot Stock
Listing Report.

I/C Lot Numbers
The I/C Lot Numbers form appears when you select I/C Items and Price
Lists > Lot Numbers. Use this form to view the status of a lot number
and edit lot number details such as contract codes and optional fields.
You can also place a specific lot on quarantine if required. Item level
information can also be edited as you have the ability to open the I/C Items
form using this form. You can also view the transaction history of lot
numbers and drill-down to source documents for greater detail.
Note: You cannot create new lot numbers using this form. Use the Serial/Lot
Reconciliation form to do so.
To use the I/C Lot Numbers Form:
1.Open I/C Items and Price Lists > Lot Numbers.
2.Enter a Lot Number or make a selection using the Finder. If you enter
or select an Item Number before using the Lot Number field, only
those lot numbers that were assigned to the item will appear in the
Finder list.
Once a number is selected, read-only information appears in the
Location, Status, Stock Date and Quantity fields. The Quantity
Reserved for Order field will display a number if any items in the
selected lot have been reserved for an upcoming order processed in
the Order Entry application.
3.If required, change the Expiry Date of the selected number.
4.If required, edit or add the Contract Code.
5.You can place the lot on Quarantine if required, or if the lot is already
quarantined, change the date it is quarantined until.
6.Select the Optional Fields tab to view any optional fields already
associated with the number. You can add to or edit this information if
required.
7.If you wish to view or edit Item level information, click Items and the
I/C Items form appears with the selected item's details.
8.Click Transactions and the Lot Number Inquiry form appears with a

list of transactions that pertain to the selected number. Select a
transaction and click Details to drill down to the source document of
the transaction.
9.Click Save on the I/C Lot Numbers form to save any changes you
made.
If you want to see which lot numbers have been reserved for upcoming
orders, create a report for Reserved Stock using the Serial/Lot Stock Listing Report.
Note: While you are able to enter fractional quantities into lots, the
database may round the amount up or down to the nearest whole
number, which can result in discrepancies when reporting lot amounts
and costs in the Lot Number Inquiry and I/C Lot Numbers forms.

Periodic Processing
Inventory Control provides you with several tools you can use to process
transactions and keep your inventory system up to date. This section
outlines the periodic tasks you can perform, which include:
Running day end processing.
Creating transaction batches for your general ledger.
Clearing history data.
Deleting inactive records.
The Periodic Processing folder contains the following icons that display
the forms you use for your periodic processing tasks:
Use this form to update statistics, cost inventory (if you
choose the option to cost during day end) and to process Order
Entry and Purchase Orders transactions. Run day end processing
before creating G/L batches, clearing history, or deleting inactive
records.
Day End Processing.

. If you do not use the option to create general ledger
transactions during day end processing, you must double-click this
icon to create a general ledger transaction batch. Process the batch
in Sage ERP Accpac General Ledger, if you use it, or post it
manually to your other general ledger.
Create G/L Batch

. Use this form to clear the transaction and sales data you no
longer need.
Clear History

. Use this form to delete inactive records from your
Inventory Control system.
Delete Inactive Records

If have the Serialized Inventory and Lot tracking license installed, extra
icons will appear that will allow you to recall/release lots, split/combine lots, reconcile serial/lot
numbers, release lots from quarantine, register serial numbers and update warranties on
serialized/lotted items.
Warning! If you want to print the G/L Transactions report, you must print
it before you create the general ledger batch. When you create the
general ledger batch, Inventory Control deletes the information in the G/L

Transactions report.

Results of Day-End Processing
When you post Inventory Control transactions, the program always
updates the affected item quantities in your system, so you always know
what you have in stock.

Costing Inventory During Posting or During Day
End Processing
You can choose whether Inventory Control updates costing and creates
transactions when you post transactions, or later, when you run Day End
Processing.
Note: Costing inventory during posting is time consuming. To speed up
processing (especially from posting orders in Order Entry), choose
Costing During Day End Processing in the I/C Options form.

What Day End Processing Does
If you choose Costing During Day End Processing, you must run day end
processing to update the rest of your Inventory Control data — such as
item costs, general ledger transactions, item statistics, and transaction
history. Each time you run day-end processing, the program processes
all the transactions you have posted since the last time you ran day-end
processing.
Use the Day End Processing form to update your Inventory Control data
and the transaction and audit data for Order Entry and Purchase Orders.
Run day-end processing as part of your daily routine, to keep your
Inventory Control audit trail and reports up to date. You can run day-end
processing as many times a day as you want.
Depending on your selection for the Create G/L Transactions option in
the G/L Integration form, day-end processing either creates a batch of
general ledger transactions (and optionally posts it in General Ledger), or
just updates Inventory Control data so you can create the general ledger
batch when you want, using the Create G/L Batch form.
If you do not use Sage ERP Accpac General Ledger, or if it is at another

location from Inventory Control, then day-end processing creates a batch
you can import into another program, or print, then enter manually into
your general ledger.
Day-end processing also does the following:
Updates audit trail data, which you print using the Posting Journals
form.
Assigns the day-end number that is displayed in the Next Day End
Number field on the Documents tab of the Options form, to all the
Inventory Control transactions being processed, then increases the
day-end number to prepare for the next time you run Day End
Processing.
Updates costing data for all transactions.
Updates statistics and history used by the analysis reports.
If you are showing costs, you must perform day-end processing if
you want an accurate reflection of costs for labels.
Note that the G/L Transactions report is updated by day-end
processing only if you create the general ledger batch manually,
using the Create G/L Batch form. Note also that if you create the
general ledger batch during day-end processing, you cannot print
this report.
Before running day-end processing

Using Sage ERP Accpac Order Entry and
Purchase Orders
If you use Order Entry, Purchase Orders, or both of these programs with
Inventory Control, their data is also updated by running Inventory
Control's day-end processing.
See also
Journal Entries Generated by Day-End Processing

Create G/L Batch
Use this form to:
Create general ledger transactions from posted receipts, shipments,
assemblies, internal usage transactions, adjustments, and transfers,
if you do not create them during Day End Processing.

G/L Integration options and G/L batches
You use the Create G/L Batch form to create general ledger batches only
if you did not choose the option Create G/L Transactions During Day End
Processing on the Integration tab of the G/L Integration form.
G/L Integration options also let you:
Add new transactions to an existing G/L batch or create a new one
(and optionally post it directly to G/L accounts).
Consolidate transactions during batch creation.
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in general
ledger transactions.
When you create the general ledger batch, the last day-end number
processed is entered in the G/L Transactions Generated Through Day
End Number field on the Integration tab of the Options form, as well as
the next day-end number the program will assign.

Locked fiscal periods
Note that if a fiscal period is locked for General Ledger but not for
Inventory Control, you can create batches for General Ledger during Day
End Processing or using the Create G/L Batch icon (depending on
Inventory Control's G/L Integration settings). When you try to post
transactions to a locked period in General Ledger, however, the
transactions will be placed in an error batch. You can avoid this situation
if you create and post General Ledger batches for outstanding Inventory
Control transactions before locking the period for General Ledger.

Before you start
Select G/L batch creation and posting options on the Integration tab
of the G/L Integration form.
Run Day End Processing to update the company's Inventory Control
data.
If you use Sage ERP Accpac General Ledger, print the G/L

Transactions report, then file it with your audit trail reports.
Note: If you do not use Sage ERP Accpac General Ledger, or if your
Sage ERP Accpac General Ledger system is at another location,
Inventory Control appends its general ledger transactions to a file
called icgltran.csv, created in the same directory as your company
database.
The file is in Comma Separated Values (CSV) format, This file can be
imported by a remote site Sage ERP Accpac General Ledger or
transferred to another general ledger that you use.
Note that all general ledger transactions are placed in the same CSV
file, and that each time Inventory Control creates transactions it asks
whether to add to the file, or replace it.
Always add to a CSV file. If you overwrite it, you will destroy all
transactions that are already in the file.

To create the general ledger batch:
1.Double-click the Create G/L Batch icon in the Periodic Processing
folder.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Click Process.

After creating the general ledger batch:
Post the batches in Sage ERP Accpac General Ledger (unless they
are posted automatically).
If you use a different general ledger,
Import the CSV batch file into your general ledger, and then delete
the original CSV file.
Or
Using the G/L Transactions report, transfer the entries to your
general ledger manually, and then delete the CSV batch file.

See also
G/L integration options
Inventory Control icons
Clear history form
Delete inactive records
Periodic processing

Delete Inactive Records Form
Use the Delete Inactive Records dialog box to remove obsolete items,
account sets, categories, and locations from Inventory Control.
You can delete one or more types of inactive records at the same time.

Before you start
Print reports.
Update records.
Assign Inactive status to all records you want to delete.
Make sure that the records are not used anywhere.
For example, you cannot delete account sets, categories or locations
that are used by items, and you cannot delete a bill of material that is
used as a component in a multi-level BOM.
Deleting item records
Deleting a single item record
Deleting account sets
Deleting a single account set
Deleting categories
Deleting a single category
Deleting locations
Deleting a single location
Deleting bills of material
Deleting a single BOM
Deleting inactive records

After deleting inactive records
Print new copies of the lists of the types of records you deleted, to update
your files with current information.
Click the Field List button at the top of this topic for information about
fields on the Delete Inactive Records form.
Click here for hints on using forms.

See also
Create G/L batch
Clear history
Inventory Control icons
Periodic processing

Clear History Form
Use the Clear History form to selectively remove (erase) data you no
longer want to keep in your Inventory Control system, such as the
following:
Transaction history
Transaction statistics
Sales statistics
Printed posting journals
Printed item labels
Expired contract prices
Transactions
Serial numbers
Lot numbers
Serial history
Lot history
You can clear one or more types of data at the same time.
Before clearing history

Click the Field List button at the top of this topic for information about
fields on the Clear History form.
Click here for hints on using forms.

See also
Create G/L batch
Delete inactive records
Inventory Control icons
Periodic processing

Day End Processing
Use this dialog box to:
Update costing data for all transactions (unless you chose the option
to update costing during posting).
Produce general ledger journal entries from the transactions that
were posted during the day (unless you do item costing during
posting or create G/L transactions using the Create G/L Batch icon).
Produce a posting journal for each type of transaction that was
posted.
Update Inventory Control statistics and transaction history.
Day End Processing also performs processing tasks for the Order Entry
and Purchase Orders modules, if you have them:
Processing transactions that were posted during the day in Order
Entry and Purchase Orders.
Activating and posting future sales orders and purchase orders that
have reached their order date, and updating quantities on sales
order and on purchase order.
Removing quotes and purchase requisitions with expiration dates up
to and including the session date for day-end processing.
Updating sales commissions.
Creating batches of Accounts Receivable summary invoices and
credit notes from posted Order Entry transactions.
Deleting completed transaction details if you do not keep transaction
history.
Updating statistics and history in Order Entry and Purchase Orders,

Processing time
The time it takes to complete day-end processing varies according to
your computer and the number of transactions you entered since the last
time you ran Day End Processing. We recommend that you run Day End
Processing when you do not need to use your computer for other tasks.

You might find it best to run it overnight.

Checking data integrity
Run Day End Processing before using the Data Integrity icon in
Administrative Services to check your Inventory Control data.

Locked fiscal periods
Note that if a fiscal period is locked for General Ledger but not for
Inventory Control, you can create batches for General Ledger during Day
End Processing or using the Create G/L Batch icon (depending on
Inventory Control's G/L Integration settings). When you try to post
transactions to a locked period in General Ledger, however, the
transactions will be placed in an error batch. You can avoid this situation
if you create and post General Ledger batches for outstanding Inventory
Control transactions before locking the period for General Ledger.

Before you start
Post all the transactions that you want to be processed by Day End
Processing.
Note: Any transactions you post while Day End Processing is running
will not be processed if processing has already been completed for
the transaction type.
To be sure of processing all the day's transactions, post them before
starting Day End Processing. Inventory Control processes receipts
first, followed in order by adjustments, transfers, assemblies, and
shipments.
Back up your Inventory Control data.

To run Day End Processing
1.Double-click the Day End Processing icon in the Inventory Control
form.
2.Click Process.
3.When the message appears to indicate that processing is complete,

click the OK button or press Enter to close the message and the Day
End Processing form.

After running Day End Processing
Before you post any new transactions after running Day End Processing,
do the following:
Print the posting journals.
Print the G/L Transactions report if you create the general ledger
batch manually (using Create G/L Batch). Note that you cannot print
the G/L Transactions report in Inventory Control if you use the option
to create the general ledger batch during day-end processing.
Print any other reports, such as Item Valuation, Transaction
Statistics, Sales Statistics, or Transaction History, that you want for
updating your records.
Modify Inventory Control account sets, categories, and other records
that could affect costing, as needed.
See also
Results of day-end processing
Journal entries generated by day-end processing
Periodic processing
Posting journals

Process Adjustments
Use this dialog box to automatically:
Write off the cost of items with zero quantities.
Write off the quantities of items with zero cost.
Adjust the total costs of items with non-zero quantities and zero total
cost to a new cost.
Zero costs can arise if user-specified costs are not entered properly on
shipments or receipts, or if adjustments are entered incorrectly.
Zero quantities can appear after physical inventory counts -- or
improperly entered adjustments.

Before you start
Usually, you process adjustments after printing the Item Valuation Report
and finding that your costs are out of balance with inventory amounts. (In
other words, you use this form to automatically fix problems that you
have already found.)
We suggest that you:
Print the Item Valuation Report.
Physically check inventory quantities to make sure that the items will
be adjusted properly.
To process adjustments automatically
1.Double-click the Process Adjustments icon in the Periodic Processing
folder.
2.Enter the range of item numbers for which you want to create
adjustments.
3.Enter the range of locations for which you want to create adjustments.
4.Choose one of the following types of adjustments:
Total cost to zero for items with zero quantities
Total quantity to zero for items with zero total cost

Total cost for items with non-zero quantities and zero total cost.
If you choose "Total cost for items with non-zero quantities", you
must also choose the type of cost to which you want the cost
adjusted:
Standard cost
Most recent cost (includes the tax)
Last Unit cost (does not include the tax)
User defined cost 1
User defined cost 2
5.Click Process.
After processing adjustments
Print the Item Valuation Report and compare it to the report that you
printed earlier.
Print the Adjustment Posting Journal to check the actual posted
adjustments.
See also
Adjustments form
Item Valuation Report
Journal entries generated by day-end processing
Periodic processing
Posting journals

Recalling and Releasing Lotted Inventory Items
Recalls and releases can only be performed on lotted inventory items. As
such, this feature only pertains if you have the Serialized Inventory and
Lot Tracking license installed as part of Sage ERP Accpac Inventory
Control.
You may have to recall inventory items when instructed by the original
vendor, or as a result of consistent negative customer experiences.
Further sales of recalled units need to be restricted, and customers sold
the goods in question need to be notified. Recalled units that are
subsequently tested and found safe or usable can be released for sale.
To Recall Lotted Inventory Items:
1.Select I/C Periodic Processing > Lot Recalls/Releases to display
the I/C Lot Recalls/Releases form.
2.Select Recall from the Entry Type list, then change the default
transaction date if required.
3.Select the Lot Number of the lot you wish to recall. The Item
Number field is completed for you.
4.If you wish to see a list of transactions recorded against the specified
lot number, click Transactions and the Lot Number Transaction
Inquiry appears.
5.Click Post to put the items on recall. A message appears confirming
the recall.
Record the Recall Number, as you will need to use it in the future to
release the items if they are deemed safe and usable for consumption.
You can print the report from this form by selecting File > Print from the
menu to display the I/C Recall Report form.
To Release Previously Recalled Lotted Inventory Items:
1.Select I/C Periodic Processing > Lot Recalls/Releases to display
the I/C Recalls/Releases form.
2.Enter the Recall Number assigned when the goods were recalled, or
use the finder to select it.

3.Click Post and the recalled items become released and available for
use in Inventory Control. The lot is released based on its current
state, so if the lot was transferred to a different location after being
recalled, it will be released from the new location.
Do not confuse the lot release procedure with the quarantine release procedure,
which is typically used to release lots that are quarantined upon receipt.

Splitting and Combining Lots
When working with lotted inventory items, you can split existing lots into
two or more parts, or combine two lots into one. You can only
split/combine lotted items that belong to the same inventory item and
location. As well, lots that are in quarantine, are on recall, and have been
assigned a contract code cannot be split or combined. Expired lots
however, can be combined or split.
To Split a Lot into Two or More Lots:
1.Select I/C Periodic Processing > Lot Splits/Combines to display
the I/C Lot Split/Combine form.
2.Select Split from the Type list, then enter the Item Number of the
lotted inventory item you want to work with.
3.Enter the Location where the lot you want to split is stored.
4.Change the default transaction date if required.
5.In the From section, enter the Lot Number of the lot you want to split,
then specify the quantity you want to split.
6.In the To section, select the existing lot(s) that you want to add
quantities to. You can also enter and create new lot numbers provided
the numbers conform to the lot number mask.
Note: The total value of all quantities in the Qty. Split column must
equal the value entered in the Qty. to Split field in the From section,
or you will not be able to post the transaction.
7.You can change the Stock Date of the destination lot. You can also
enter an Expiry Date if required.
8.Click Post to split the lot.
To Combine Two or More Lots:
1.Select I/C Periodic Processing > Lot Splits/Combines to display
the I/C Lot Split/Combine form.
2.Select Combine from the Type list, then enter the Item Number of
the lotted inventory item you want to work with.

3.Enter the Location where the lots you want to combine are stored.
4.Change the default transaction date if required.
5.In the To section, enter the Lot Number of the destination lot you
want to combine items into, then enter a value in the Qty. to Combine
field. You can also enter and create new lot numbers provided the
numbers conform to the lot number mask.
6.Enter the Stock Date of the lot that will have quantities added to it
from the lot(s) defined in the From section. You can also enter the
Expiry Date of the combined lot if required.
7.In the From section, select the existing lot(s) that you want to take
quantities from.
Note: The total value of all quantities in the Qty. Combine column
must equal the value entered in the Qty. to Combine field in the From
section, or you will not be able to post the transaction.
8.Click Post to combine the lots.

Reconciling Serial and Lot Numbers
Use this feature to reconcile the number of serial numbers and lots you
have assigned to existing inventory on hand. You should reconcile your
serial/lot numbers after upgrading to version 5.6 from a previous version
of Accpac Inventory Control, after deciding to use serials/lots on an item
not previously tracked, or when you think there are more numbers
assigned than there are items actually in inventory (or vice versa).
There are four transaction types you can select when reconciling
numbers with on-hand inventory.
Receipt is used when you need to add serials/lots to match the
number of items you have on hand
Shipment is used when you need to subtract serials/lots to match the
number of items you have on hand
OE Invoice is used when you want to change the serial/lot numbers
assigned when items were sold to a customer or to add the numbers
if they were not originally assigned
PO Invoice is used when you want change the serial/lot numbers
assigned when items were received from a vendor or to add the
numbers if they were not originally assigned
Do not use the I/C Serial/Lot Reconciliation form to enter original receipts
from vendors, shipments to customers or invoices of serialized/lotted
items, as this form is intended to be used to adjust numbers on items
already processed in inventory.
Before you begin, post all transactions that affect inventory and run Day
End Processing.
To Reconcile Serial/Lot numbers:
1.Select I/C Periodic Processing > Serial/Lot Reconciliations to
display the I/C Serial/Lot Reconciliations form.
2.Make a selection from the Transaction Type list.
3.If you selected OE Invoice or PO Invoice as the transaction type,
enter the document number of the original invoice in the Apply to

Document field.
4.Specify what you want to reconcile and where using the Item Number
and Location finders.
5.Enter the Stock Date when the serial/lot number was received into
inventory. This field defaults to the session date.
6.Enter the Quantity that you want to reconcile.
7.If you selected Receipt or PO Invoice as the transaction type, you can
adjust the Unit Cost of the item if desired.
8.Skip this step if you are not working with a serialized item. Depending
on the transaction type selection, you will need to add (Receipt or PO
Invoice) or subtract (Shipment or OE Invoice) serial numbers.
If adding serial numbers,
If subtracting serial numbers,

9.Skip this step if you are not working with a lotted item. Depending on
the transaction type selection, you will need to add (Receipt or PO
Invoice) or subtract (Shipment or OE Invoice) lot numbers.
If adding lot numbers,
If subtracting lot numbers,

Note: When reconciling a shipment, make sure you select lots that
are not recalled or in quarantine, as you will not be able to save the
transaction.
10.Click Post to complete the reconciliation.

Releasing Lots From Quarantine
Lotted Inventory items may occasionally be placed in quarantine if there
are potential quality defects that need to be resolved before the items are
sold. Or in the case of imports that need to pass customs, paperwork
and/or duties may need to be provided to authorities before the items can
be used.
Newly created inventory items that are lotted can be automatically placed
on quarantine at time of receipt if the Days on Quarantine checkbox is
selected on the Lots tab in the I/C Options form. Lots can be quarantined using the Lot
Numbers form in the I/C Items and Price Lists folder. Lots can also be quarantined on an itemby-item basis using the I/C Items form.
Once the issues have been resolved, you can release the lots from
quarantine. Before you begin, you must have either the lot number of the
lot you want to release, or the item number of the item that is included in
the lot. Keep in mind that you must release all quantities of a lot or none
at all.
To Release Lots from Quarantine:
1.Select I/C Periodic Processing > Quarantine Release to display the
I/C Quarantine Release form.
2.Specify one or more lots using the Lot Number From and To fields. If
you don't know the Lot Number, you can use the Item Number From
and To fields instead.
3.Change the As at date if you don't want to use the session date as
the effective date of release.
4.Click Process to release the lot(s) from quarantine.
Related Topics
Printing the Quarantine Report
Recalling and Releasing Lotted Inventory items

Registering Serial Numbers for Customer
Warranties
You can register serial numbers for warranty management purposes
when selling serialized inventory items. Customers would typically fill out
and mail a registration form after purchasing the item and taking it home.
Serialized items can be placed on warranty using the I/C Items form - Serials tab.
Before you can register a serial number, you must first have completed a
shipment from either Inventory Control or Order Entry, or have created an
invoice or debit note in Order Entry, as you will need to provide the
document number of the original transaction during serial registration.
To Register a Serial Number for Warranty Purposes:
1.Select I/C Periodic Processing > Serial Registration to display the
I/C Serial Registration form.
2.Make a selection from the Document Type list, then enter the
Document Number of the original transaction.
3.Use the Item Number field to enter or find the item with the serial
number you want to register. You can only enter an item number that
appeared on the detail lines of the document you defined in the
previous step.
4.Use the Serial Number field to enter or find the serial number you
want to register. You can only enter a serial number that was assigned
to the item in the originating document defined in step 2.
5.Click Register.
For a list of serialized items with warranties that are registered, generate
a Serial/Lot Stock Listing report and select Registered as the Report Type. Note
that, while you can use the I/C Items form - Lots tab to place lotted items on warranty,
only serialized items can have warranties registered.
Related Topics
Updating Warranties
Serial Number Inquiry

Updating Warranties for Serialized and Lotted
Items
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
Warranties can be applied automatically to serialized/lotted items using
the I/C Items form, or you can use Warranty Update form. This form can
also be used to change the terms of a warranty for a serialized/lotted item
after a sale. For instance, a customer may wish to purchase an extended
warranty for an item, or a discounted floor model may be sold without a
warranty during a clearance sale.
Before you begin, make sure there is already a warranty code defined in
I/C setup that has the required terms, as you must select an existing
code when adding or updating a warranty. You must also have the
serial/lot number of the item and the document number of the sale.
To Apply or Update a Warranty for a Serialized/Lotted Item:
1.Select I/C Periodic Processing > Warranty Update to display the I/C
Warranty Update form.
2.Select either Serials or Lots.
3.Use the Item Number field to enter or find the item you want to work
with.
4.Enter the Serial/Lot Number of the item or use the finder.
5.Enter the Document Number of the sale or use the finder.
6.Use the finder to select the Warranty Code with the terms you want
to apply to the item.
7.Click Update to save your changes to the warranty.

Related Topics
Creating Warranty Codes for Serialized/Lotted Items
Printing the Warranty/Contract List Report
Using the I/C Items form - Serials tab
Using the I/C Items form - Lots tab

Physical Inventory — Overview
Inventory Control lets you enter the results of physical counts into your
system and helps you reconcile the differences between the physical
count and the calculated quantities-on-hand in your Inventory Control
system.
You can find the physical inventory forms in the I/C Physical Inventory
folder. They include Generate Inventory Worksheet, Inventory
Worksheet, Physical Inventory Quantities, Inventory Counts, Inventory
Reconciliation, and Post Inventory Reconciliation, as described below.
Use the Generate Inventory Worksheet form to generate inventory worksheets
that specify the locations, account sets, and items for which you
want to count inventory.
You can use the Default Quantity On Hand option to automatically
include the current quantity on hand for each item in the Counted
Quantity column of the Inventory Worksheet.
Use the Inventory Worksheet to print copies of the inventory worksheets you
generate, if you want to write the physical counts on them while
taking stock.
If you used the Default Quantity On Hand choice in the Generate
Inventory Worksheet, you can choose the Quantities option to print
the current quantity on hand in the Counted Quantity column. This
means that you have to enter quantities only when the counted
quantity differs from the quantity on hand stored in Inventory Control.
Use the Physical Inventory Quantities or the Inventory Counts to enter counted item
quantities. You can also assign an adjustment unit cost for items with
the Physical Inventory Quantities form, and view, edit, and delete
inventory worksheets that you created.
Use the Inventory Reconciliation form to print a report of the counts and costs
that will be posted when you reconcile your inventory counts.
Use the Post Inventory Reconciliation form to post the counts and costs that you
entered in the Physical Inventory Quantities form. The program
creates adjustment transactions when you post inventory
reconciliations.

After posting a reconciliation, print the Inventory Reconciliation report
to check for any items that the program could not post.

Generate Inventory Worksheet
Use this form to generate worksheets of item quantities on hand for all
inventory locations for which you are taking inventory.
You can optionally print worksheets to use for recording your physical
inventory counts prior to entering the data in the Physical Inventory
Quantities form and posting it to your Inventory Control system.
You can create inventory worksheets for a range of items sorted by item
number, category, item segment, picking sequence, or any optional field
names defined for Inventory Control. You can choose to include:
Only the items in the specified item range that are assigned to the
location(s) for which you are generating worksheets.
Only the items in the specified item range that are assigned to and
have been used in one or more transactions at the location(s) for
which you are generating worksheets.
All the items in the specified item range, regardless of whether they
are assigned to the location(s) for which you are generating
worksheets.
Note: Items are included regardless of whether they are currently
allowed to be used in Inventory Control transactions.
If you generate an inventory worksheet for a location that already has a
worksheet, the program replaces the old worksheet with a new one. The
program warns you if there are existing worksheets for locations and lets
you choose whether to replace them.
Warning! To ensure quantities and costs on worksheets are current, do
not post transactions (receipts, shipments, transfers, adjustments, or
assemblies) then run Day End Processing between the time you
generate inventory worksheets and the time you the post the inventory
reconciliation.
Before generating an inventory worksheet
Generating an inventory worksheet
After generating an inventory worksheet

Click the following links for more help, and click the Field List button at
the top of this topic for information about fields on the Generate Inventory
Worksheet form.
Click here for hints on using forms.

See also
Inventory reconciliation report
Inventory worksheet - printing
Periodic processing
Physical inventory quantities
Inventory Counts
Post inventory reconciliation

Printing the Inventory Worksheet
The Inventory Worksheet provides an organized form which you can fill
out when taking a physical count of inventory. Use the report to enter
total quantities for each unit of measure into Inventory Control to prepare
for inventory reconciliation.
The report also sets the range and order of item numbers for the
Inventory Reconciliation report.
For more information on the contents of this report, see Inventory Worksheet –
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.
You must first generate a worksheet for each location you want to include
in the report, using the Generate Inventory Worksheet form.

When to print
You can print the worksheet to assist you when doing a physical
inventory count.

To print the Physical Inventory Worksheet
1.Choose the Inventory Worksheet icon from the Physical Inventory
folder.
2.Make your selections as follows:
From Location [ ] to [ ]. Enter location codes or use the Finder to
select the range of locations at which you want to count inventory.
Include. Select the information to include in the report.
Unit Cost. Prints the unit cost for each item on the worksheet.
Quantity on Hand. Prints the quantity on hand for each unit of
measure defined for each selected item.
Comment. Select this option to include a comment line for each

item. Use the comment line to record remarks while doing the
physical count.
4.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and change
the number of copies to print. Click OK if the settings are correct;
otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Physical Inventory Quantities
Use this form to:
Enter inventory counts after taking inventory.
Edit inventory worksheets (if needed) in preparation for posting
reconciliations.
Assign serial and/or lot numbers if applicable.
You can enter counted quantities (which are all zero on newly generated
worksheets) and adjustment unit costs, and change posting status. Press
F9 to enter quantities in different units of measure.
You can delete a worksheet (use the Delete button), but you cannot
delete individual lines.
Optional fields are available for the Physical Inventory Quantities form if
you add optional fields for adjustments and adjustment details in the
Optional Fields form in I/C. The fields appear on the adjustments
generated when you post the inventory reconciliation.
Note: Use the Inventory Counts form for a simpler version on which you enter
only inventory quantities.
Before entering physical inventories
Entering physical inventory quantities
After using the physical inventory quantities form

Click the Field List button at the top of this topic for information about
fields on the Physical Inventory Quantities form.
Click here for hints on using forms.

See also
Generate inventory worksheet
Inventory reconciliation report
Inventory worksheet - Printing
Periodic processing
Post inventory reconciliation
Inventory Counts form

Inventory Counts
The Inventory Counts form is a simpler version of the Physical Inventory
Quantities form, where you enter inventory counts after taking inventory.
You can assign serial and/or lot numbers in the Inventory Counts
form if you have Serialized Inventory and Lot Tracking license
installed.
The inventory counts entered in the Inventory Counts form update the
current physical inventory worksheet.
If you select "Default Quantity On Hand" when you generate the
physical inventory worksheet, the Quantity Counted column will list
the quantity that's calculated by Inventory Control.
If you do not select "Default Quantity On Hand" when you generate
the physical inventory worksheet, the Quantity Counted column will
show zero quantities until you enter a count.
Use the Physical Inventory Quantities form instead of Inventory Counts if
you want to compare calculated quantities to actual counts, or to enter
adjustment unit costs or change the posting status for individual items.

Before you start
Run Day End Processing to update the company's Inventory Control
data if you have posted transactions since the last time you ran Day
End Processing.
Decide on the inventory locations, account sets, and items for which
you want to generate worksheets.
Decide on the sorting order in which to list items on the worksheets.
Make sure no other users are working with the Inventory Control
database and no other Inventory Control forms are open on your
computer.

To enter inventory counts
1.Double-click the Inventory Counts icon in the Physical Inventory
folder.

2.Enter the location code or use the Finder to select the code
3.Enter the starting item number or use the Finder to select the item
number code.
4.If you use optional fields, use the Zoom button ( ) to edit optional
fields that apply to the whole worksheet.
5.Enter the physical count or edit the displayed count in the Quantity
Counted column. Press F9 to enter quantities in different units of
measure.
6.If you use optional fields for item details, use the Zoom button ( ) to
edit detail optional fields.
7.When you are finished, click Close to save your changes and close
the Inventory Counts form.

Using Different Units of Measure
If you have more than one unit of measure defined for an item, you can
enter counted quantities in any unit or combination of units by following
these steps:
1.Press F9 in the detail grid to open the Quantities detail form that
displays the units of measure defined for the item.
2.Enter new counts in the Quantity Counted columns beside each unit
of measure.
3.Click the navigation buttons to move to another item.
4.Click Close to save your changes. This closes the Quantities detail
form and returns you to the Inventory Counts form.

After using
Use the Inventory Reconciliation form to print the Inventory
Reconciliation report, then check the report before posting the
reconciliation (optional).
Use the Post Inventory Reconciliation form to post the inventory
reconciliation.
Click the Field List button at the top of this topic for information about

fields on the Inventory Counts form.
Click here for hints on using forms.

See also
Generate inventory worksheet
Inventory reconciliation report
Inventory worksheet
Periodic processing
Post inventory reconciliation

Inventory Reconciliation Report — Features
The Inventory Reconciliation report lets you compare actual physical
inventory totals with the totals in your Sage ERP Accpac Inventory
Control system.
The report identifies discrepancies between item quantities and costs,
and shows what will be posted by the Post Inventory Reconciliation form.
For instructions on printing the report, see Printing the Inventory Reconciliation Report.

Information printed on the report
The Include All Units Of Measure version of the report includes:
The ranges of account sets and item numbers selected when you
generated the Inventory Worksheet.
The adjusted unit cost, which is the Adjustment Unit Cost you
entered for each item in the Physical Inventory Quantities form after
taking inventory.
The quantities on hand, calculated by Inventory Control from the
transactions posted for each item.
The physical count (quantity counted) you entered in the Physical
Inventory Quantities form for each item's units of measure.
The variance, if any, between quantity on hand as calculated by
Inventory Control and the counted quantity you entered.
The cost variance, which Inventory Control calculates by multiplying
the adjusted unit cost by the quantity variance.
The Serial/Lot Quantity variance (if any) between the quantity
counted and the numbers assigned.
The status code of each item, indicating whether the item information
can be posted by the Post Inventory Reconciliation form.
Comment lines where you can write remarks for your own
information.
Explanations of each status code:

The item is ready to post and will be deleted from the report when
you post the inventory reconciliation.
The item is not ready to post. Information for on-hold items is not
updated when you post an inventory reconciliation, and the item is
not deleted from the report when you post the reconciliation.
The item record was deleted from Inventory Control after you
generated the Physical Inventory Worksheet.
This status identifies non-stock items.
This status identifies items at a location which are not allowed to be
used in transactions.
This status applies only when you do not use the Allow Negative
Inventory option. The status identifies items whose quantity on hand
would fall below zero if you posted the reconciliation.
The item's status has been set to Inactive on the item record.
The Include Stocking Unit Only version of the report includes a single line
for each item, showing information for only the stocking unit of measure,
rather than for all units defined for the item. The report also includes
comment lines if you selected this option.
See also
Inventory Control reports

Post Inventory Reconciliation
Use this form to post inventory counts and costs that you entered in the
Physical Inventory Quantities form or the Inventory Counts form.
When you post an inventory reconciliation, the program creates
adjustment transactions for any discrepancies between your physical
inventory count and the figures calculated by Inventory Control.
Note that when you post an inventory reconciliation for which an
adjustment number already exists, the Inventory Worksheet will create
separate adjustments for every one hundred items, and append "1", "2",
"3", etc. to the end of the document number.

Depending on your settings, posting may only
update quantities
When you post an inventory reconciliation, the program immediately
updates item quantities so you always know your inventory levels.
Posting however will only update costing, accounting, and statistical
information if you chose the option to update costing during posting (in
the I/C Options form).
If you update costing during day end processing, you must run day end to
update costing information, item statistics, and audit information, and to
generate general ledger transactions.
If necessary, you can run day end processing several times a day to keep
costing, accounting, and statistical information current.
As well as posting inventory reconciliations to the current session date
and reporting period, you can post them to past or future dates and
reporting periods.
FIFO/LIFO costed items: For items that use the FIFO or LIFO costing
method, the program adjusts the item's offset bucket for Inventory
reconciliation transactions.
Before posting an inventory reconciliation
Posting an inventory reconciliation
After using the Post Inventory Reconciliation form

Before posting an inventory reconciliation

Click the Field List button at the top of this topic for information about
fields on the Post Inventory Reconciliation form.
Click here for hints on using forms.

See also
Periodic processing

Sales Statistics Form
If you use the Keep Item History option, the Sales Statistics form lets you:
Enter sales and return quantities and amounts for the years and
periods for which you keep data in your Inventory Control system (if
you use the Allow Edit Of Statistics option).
View sales and return statistics kept for each item.
Note: To edit sales data, you need security rights for Day End Processing
and/or Item Maintenance.
If you want to use the Sales Statistics report to assist you in managing
your inventory, use the Sales Statistics form to add sales (and returns)
data for your inventory items during setup.
You can add sales data for reporting periods from the current year and
from previous years. After setup, Inventory Control automatically updates
these statistics when you run day-end processing, but you can edit the
statistics as needed, if you use the Allow Edit Of Statistics option.

Multicurrency ledgers
If you have a multicurrency system, you enter statistical amounts in the
functional currency.

Before adding statistics
Make sure you have the proper security rights for this task.
Select the Keep Item Statistics and Allow Edit Of Statistics options in
the Options form.
Collect current year and previous years sales data that you intend to
add to Inventory Control from your existing system.

Click here for instructions on adding current sales and return statistics

To view sales and return statistics:
1.Double-click the Sales Statistics icon in the Statistics and Inquiries
folder.
2.Enter or use the Finder to select the item number, location, and year
for which you want to see sales statistics.
3.Enter the number of the statistical period for which you want to see
sales statistics.

After changing sales statistics
Print the Sales Statistics report to check the new record information
and to update your printed records.
Compare the report you printed before changing or deleting sales
statistics to those printed after the changes, to verify that you made
the required changes correctly.
Click the Field List button at the top of this topic for information about
fields on the Sales Statistics form.
Click here for hints on using forms.

See also
Transaction Statistics
Clear History

Transaction Statistics Form
If you use the Keep Item History option, this form lets you:
Add transaction data for your inventory items so you can use the
Transaction Statistics report to assist you in managing your inventory
(if you use the Allow Edit Of Statistics option).
View transaction statistics for the years and statistical periods for
which you keep data.
Note: To edit sales data, you need security rights for Day End Processing
and/or Item Maintenance.
You can add transaction data for statistical periods from the current year
and from previous years during setup. You can also add transaction data
after setup.
Select the Allow Edit Of Statistics option on the Processing Tab of the
Options form to enter or change transaction statistics. Once you enter
data for prior periods (during setup), the program will maintain all
transaction data.

Multicurrency ledgers
If you have a multicurrency system, you enter statistical amounts in the
functional currency.

Before adding transaction statistics
Make sure you have the proper security rights for this task.
Select the Keep Item Statistics and Allow Edit Of Statistics options in
the Options form.
Collect current year and previous years transaction data that you
intend to add to Inventory Control.
To add or edit transaction statistics

After changing transaction statistics
Print the Transaction Statistics report to check the new record
information and to update your printed records.

Compare the report you printed before changing or deleting
transactions statistics to those printed after the changes, to verify
that you made the required changes correctly.
Uncheck the Allow Edit Of Statistics option on the Processing Tab of
the Options form.
Click the Field List button at the top of this topic for information about
fields on the form.
See also
Sales Statistics
Clear History

Current Transactions Inquiry Form
This form allows you to view current sales orders originating in Order
Entry and purchase orders originating in Purchase Orders if you have
installed those modules on your system.
Note: You must have the proper security rights to use this form.

To view information about current transactions:
1.Double-click the Current Transactions Inquiry icon in the I/C Statistics
and Inquiries folder.
2.Enter an item number in the Item Number field or select one using the
Finder.
3.Choose whether to inquire about Purchase Orders or Sales Orders by
using the drop-down list beside the .
4.Enter either:
The range of expected shipping dates, for sales orders
OR
The range of expected arrival dates, for purchase orders.
5.Click the Go button when you are satisfied with your selections.
Information about sales orders is presented under the following
column headings:
Order number
Customer
number
Customer name
Expected ship
date
Location

Original quantity
ordered
Unit of measure
Quantity shipped
Quantity
outstanding

Information about purchase orders is presented under the following
column headings:

Purchase order
number
Vendor number

Quantity ordered
Unit of measure

Vendor name

Quantity
received

Expected arrival
date

Quantity
outstanding

Location
6.To view further details about a transaction, highlight it and then click
the Details button.

Transaction History Inquiry Form
Use the Transaction History Inquiry form in the Statistics and Inquiries
folder to view transactions created in Sage ERP Accpac Order Entry,
Purchase Orders or Inventory Control. You can drill down to transactions
as follows:
Order Entry:

Purchase Orders:

Inventory Control:

Invoices

Receipts

Receipts

Shipments

Invoices

Shipments

Credit notes

Returns

Adjustments

Debit notes

Credit notes

Transfers

Debit notes

Assemblies
Internal usage
transactions

To drill down:
1.Open Inventory Control > I/C Statistics and Inquiries > Transaction
History Inquiry.
2.To change the fiscal year and period select a new one from the dropdown list beside the As At Year/Period field.
3.Enter the beginning and ending item numbers, or select them using
the Finders.
4.Enter the beginning and ending account set numbers, or select them
using the Finders.
5.Enter the beginning and ending location numbers, or select them
using the Finders.
6.When you are satisfied with your inquiry criteria, click the Go button.
7.A list of items matching your criteria is displayed. To view a list of
recent transactions involving an item, select the item from the list and
click the Details button.
8.The popup list includes the document number and other information
about the transaction.
9.To drill down to the original document, double-click the appropriate
field, or highlight a transaction and click the drilldown column heading
for Document Number or Invoice Number.
Sage ERP Accpac will display the original transaction unless it has been
cleared from the database.

LIFO/FIFO Inquiry Form
You use the LIFO/FIFO Inquiry form to view information for items that use
the LIFO and FIFO costing methods.
1.Open Inventory Control > I/C Statistics and Inquiries > LIFO/FIFO
Inquiry.
2.Select the account set or sets (LIFO or FIFO) for which you want to
view information.
3.Choose an item number or a range of item numbers.
4.Select a location or locations.
5.Once you have made your selections, click the Go button.
The information you requested appears in the grid.
6.To view additional details about a particular item (including documents
processed and quantities and costs shipped, received, and available),
highlight a line, and then click the Details button.
The program displays the details on a separate form. Information for
items that have not been processed by Day End Processing appears
below the grid.
7.Click the Close button to return to the LIFO/FIFO Inquiry form.

BOM Component Usage Inquiry
This form:
Lists all of the bills of material in which a particular component item
appears.
Provides bills of material details for BOMs that include the selected
component item.
To use the BOM Component Usage Inquiry function in the I/C
Statistics and Inquiries folder:
1.Enter the number of the component item that you want to review, or
select it from the Finder. The following details are displayed for each
BOM in which the component appears:
Master item number
Master BOM number
Description of the BOM
Build quantity
Master unit of measure
Component's quantity in the build
Component's BOM number if the component is also a master item
2.To view complete BOM details, highlight the row with the master item
number and BOM number that you want to review, and click the
Details button.

Item Location Details Quantity Inquiry Form
Use the Item Location Details Quantity Inquiry form to look up sales
orders transactions created in Sage ERP Accpac Order Entry that include
the inquiry item.
To drill down to sales orders in the O/ E module or purchase orders
in the P/O module:
1.Select the item that you are interested in.
2.Choose the specific location for which you want to view sales orders
quantities, or choose All Locations.
3.Select the item status that you want to view — to view the item
quantities on sales orders or quantities that are committed to orders,
or view quantities on purchase orders.
4.Once you have made your selection, click the Go button.
5.The information you requested is displayed in columns.
Expected ship date / Expected arrival date
Order number / PO number
Date
Customer/Vendor number
Customer/Vendor name
6.To display the order details, highlight the order line and click the
Drilldown button in the column heading or click the Details button at
the bottom of the form.
7.Click the Close button when finished.

Stock Transactions Inquiry
This form is used to view transactions that result in inventory movements.
The inquiry can be performed for a specific fiscal period, and can be
done using multiple items, locations or account sets. The initial inquiry
will provide summary results, but you can get further detail by looking at
source documents and using the drill down feature.
Stock Transactions Inquiry replaces the "Stock Card Inquiry" functionality
in Stock Card integration.

To use the Stock Transactions Inquiry form:
1.Select I/C Statistics and Inquiries > Stock Transactions Inquiry to
open the form.
2.Use the calendar to select a year and period for the inquiry.
3.Select one or more items using the From Item Number and to fields.
4.Select one or more account sets.
5.Select one or more locations.
Note: When selecting a range, make sure the starting value is smaller
than the ending value. For example, select From account set AVG to
LIFO or From Location 1 to 2, not the other way around. Otherwise an
error message appears prompting you to change your selections.
6.Click the Go button to perform the inquiry and display summary
results in the details grid.
7.Highlight a row in the grid and click Details to see a list of source
documents and their associated transactions in the Stock Transaction
Inquiry Detail window.
8.If you want further details, double click the document number to drill
down and view the source document.
9.Click Print to open the Stock Transactions Report form.
Click here for hints on using forms.

Serial Number Inquiry
The Serial Number Inquiry form is available if you have a license to use
Serialized Inventory and Lot Tracking.
This form allows you to make inquiries on serial numbers based on
parameters such as item number, location, stock date and status. The
initial inquiry will provide summary results, but you can get further details
by looking at source documents. You can also get a list of transactions
involving specific serial numbers, and print a Serial/Lot List report from
this form.
To use the Serial Number Inquiry form:
1.Open I/C Statistics and Inquiries > Serial Number Inquiry.
2.Use the Serial Number From and To fields to select a range of serial
numbers.
3.Select one or more items using the Item Number From and To fields.
4.Select one or more locations.
5.Select a date range using the Stock Date From and To fields.
Note: When selecting a range, make sure the starting value is smaller
than the ending value. For example, select location 1 to 2, not the
other way around. Otherwise an error message appears prompting
you to change your selections.
6.Make a selection from the Status list. You can inquire on Available
number, Unavailable numbers, or Both.
7.Click the Go button to perform the inquiry and display summary
results in the details grid.
8.Make a selection in the grid and click Transactions to display the
Serial Number Transaction Inquiry form, where a list of transactions
appear involving the selected number. You can drill down to the
source document of a specific transaction by selecting it in the grid
and clicking Details.
9.Make a selection in the grid and click Details to display the I/C Serial
Numbers form, where a list of serial number attributes appear (Item

Number, Location, Total Cost, Status Stock and Expiry Dates). You
can also edit the Contract Code and add Optional Fields where
required. You can also display the I/C Items and Serial Number
Transaction Inquiry forms from the I/C Serial Numbers form by
clicking Items and Transactions, respectively.
10.Click Print from the Serial Number Inquiry form to open the I/C Serial/Lot List
Report form.
Click here for hints on using forms.

Lot Number Inquiry
The I/C Lot Numbers Inquiry form is available if you have a license to use
Serialized Inventory and Lot Tracking.
You use this form to inquire on lot numbers using parameters, such as
item number, location, stock date and status. The initial inquiry provides
summary results, but you can get further details by looking at source
documents. You can also get a list of transactions involving specific lot
numbers, and print a Serial/Lot List report using this form.
To use the Lot Number Inquiry form:
1.Open I/C Statistics and Inquiries > Lot Number Inquiry.
2.Use the Lot Number From and To fields to select a range of lot
numbers.
3.Select one or more items using the Item Number From and To fields.
4.Select one or more locations.
5.Select a date range using the Stock Date From and To fields.
Note: When selecting a range, make sure the starting value is smaller
than the ending value. For example, select location 1 to 2, not the
other way around. Otherwise an error message appears prompting
you to change your selections.
6.Make a selection from the Status list. You can inquire on Available
numbers, Unavailable numbers, or Both.
7.Click the Go button to perform the inquiry and display summary
results in the details grid.
8.Make a selection in the grid and click Transactions to display the Lot
Number Transaction Inquiry form, where a list of transactions appear
involving the selected number. You can drill down to the source
document of a specific transaction by selecting it in the grid and
clicking Details.
9.Make a selection in the grid and click Details to display the I/C Lot
Numbers form, where a list of lot number attributes appear (Item
Number, Location, Total Cost, Status Stock and Expiry Dates). You

can also edit the Contract Code and add Optional Fields where
required. You can display the I/C Items and Lot Number Transaction
Inquiry forms from the I/C Lot Numbers form by clicking Items and
Transactions, respectively.
10.Click Print from the Lot Number Inquiry form to open the I/C Serial/Lot List
Report form.
Note: While you are able to enter fractional quantities into lots, the
database may round the amount up or down to the nearest whole
number, which can result in discrepancies when reporting lot amounts
and costs in the Lot Number Inquiry and I/C Lot Numbers forms.
Click here for hints on using forms.

Print Destination
Print destinations include printing to a file, to a printer, to the screen, to
an e-mail, to Messenger Fax, and printing according to a schedule, as
described when you click on the following links:
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing Inventory Control Data
Inventory Control prints data in a variety of reports to help you manage
your inventory. Printed reports also serve as a source of backup
information in case any of the data gets damaged on your computer.

Printing reports
Sage ERP Accpac offers five options for printing Inventory Control
reports. These include:
Printing directly from the program to a printer, (to laser printers on 8�"
x 11" paper, or to dot matrix printers) to obtain permanent copies of
the information.
Printing the information on your screen, for a quick review.
Printing to a file for printing later, importing into another program, or
for transferring to a diskette.
Printing to an e-mail to send to another user or office.
See also
Setup reports
Stock control reports
Price/sales analysis reports
Physical inventory reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Inventory Worksheet — Features
The Inventory Worksheet provides an organized form which you can fill
out when taking a physical count of inventory. Use the report to enter
total quantities for each unit of measure into Inventory Control to prepare
for inventory reconciliation.
The report also sets the range and order of item numbers for the
Inventory Reconciliation report.
Note that when you post an inventory reconciliation for which an
adjustment number already exists, the Inventory Worksheet will create
separate adjustments for every one hundred items, and append "1", "2",
"3", etc. to the end of the document number.
For instructions on printing the report, see Printing the Inventory Worksheet.

Information printed on the report
The date on which you generated the worksheet, and the comment
you entered for the worksheet in the Inventory Worksheet form.
The unit cost (appears if you selected Unit Cost for the report). If you
use the most recent cost or standard cost costing methods, the unit
cost is the same as that displayed in the Location Details form. For
average and LIFO/FIFO costing, Inventory Control calculates the
average unit cost by dividing the actual cost by the quantity on hand.
The column where you record the inventory count for each item and
corresponding unit of measure. You later enter these figures in the
Physical Inventory Quantities form. If you selected the Default
Quantity On Hand choice in the Generate Inventory Worksheet form,
the current quantity on hand for each item is already printed in the
Counted Quantity column. You then manually enter figures only
when the counted quantity differs from the figure stored as the
quantity on hand in your Inventory Control program.
A column where you can record a temporary status of On Hold or
Not On Hold for items whose status you want to change for
reconciliation purposes. You then use the Physical Inventory
Quantities form to assign the temporary status to affected items. Use

the On Hold status to prevent items from being updated when you
post the inventory reconciliation. Use the Ready To Post status to
allow on-hold items to be updated when you post the reconciliation.
An optional blank line you can include for writing comments or
remarks about each item, for your own information (appears if you
selected Comment for the report). You do not enter these comments
in Inventory Control.
See also
Inventory Control reports

Contract Pricing Report — Features
This report lists the details of the pricing contracts you have established
with one or more customers.
For instructions on printing the report, see Printing the Contract Pricing Report.

Information printed on the report
The range of customer numbers included in the report.
The customer number and name for each customer included in the
report.
Whether the contract is set up by category code or item number.
The category code or item number and its description.
The price list code. Codes appear in this column only if you have
selected "item number" as the basis for the contract.
The expiration date for the contract, if applicable.
The contract price type.
The costing method. This column will have entries only if you have
selected one of the "cost-plus" pricing options.
See also
Inventory Control reports

G/L Transactions Report — Features
The G/L Transactions report is a list of the general ledger journal entries
created from all transactions posted in Inventory Control since the last
time you created the general ledger batch.
For instructions on printing the report, see Printing the G/L Transactions Report.

Information printed on the G/L Transactions
report
The Detail report includes, for each transaction:
The posting sequence number, which is the number of the day-end
processing run during which the transaction was created.
The entry number indicating the order in which the transaction was
processed by Day End Processing. There are no batches in
Inventory Control so the batch number is always 0 (zero).
The source code that identifies the source program (Inventory
Control) and the type of transaction in your general ledger. Inventory
Control source codes are:
IC-AD — adjustments
IC-AS — assemblies
IC-CO — consolidated transactions
IC-DA — disassemblies
IC-RA — adjustments to receipts
IC-RC — receipts
IC-RR — returns posted to receipts
IC-SH — shipments
IC-SR — shipment returns
IC-TF — transfers
The data in the Reference, Description, and Comments columns
depends on your selections for G/L fields in the G/L Integration form.
Totals by sorting option.

The debit and credit totals of the transactions listed on the report.
The Summary report lists a single line for each general ledger account
number, with the total debit and credit amount for the account.
See also
Inventory Control reports

Markup Analysis Report — Features
The Markup Analysis report lists each item whose base price varies from
a desired selling price by more than the percentage you specify for the
report.
For instructions on printing the report, see Printing the Markup Analysis Report.

Information printed on the report
The most recent cost entered for the item in the Location Details
form.
The costing unit assigned to the item in the Location Details form.
The markup factor entered on the Prices tab of the Item Pricing form.
The desired selling price, calculated by multiplying the item's markup
factor by the selected cost.
The pricing unit specified for the item in the Item Pricing form.
The base price entered for the item on the Prices tab of the Item
Pricing form.
The percentage variance between the desired selling price and the
base price, calculated as:

See also
Inventory Control reports

Posting Journals — Features
A posting journal is the printed record of the transactions that were
processed together during day-end processing.
You can print six types of posting journals, one for each transaction type
you can post in Inventory Control: adjustments, assemblies, receipts,
shipments, internal usage, and transfers.
For instructions on printing posting journals, see Printing Posting Journals.

Information printed on the report:
Receipts Posting Journal
Shipments Posting Journal
Adjustments Posting Journal
Assemblies Posting Journal
Transfers Posting Journal
Internal Usage Posting Journal

See also
Inventory Control reports

Price Lists Report — Features
The Price Lists report lists price, markup, discount, and tax information
for items in the range of price lists you select.
There are four versions of the report: Price List, Detail, Price List
Summary, and Item Number Summary.
For instructions on printing the report, see Printing the Price Lists Report.

Information printed on the report
The report contents differ depending on the report type you select to
print.
The Price List version of the report includes:
In multicurrency ledgers, the currency code for each set of pricing
information. A single price list can have more than one currency.
The base price and sale price (if any) assigned for the item, and the
corresponding units.
The markup cost, factor and costing unit for the item.
The discount or markup prices calculated for the item.
The Detail version of the report includes most of the information entered
in the Item Pricing form, and also includes:
In multicurrency ledgers, prices in whatever currency you choose,
regardless of the currency for the price list.
The previous price and previous (markup) cost. If the current base
price and markup cost are the first ones you entered for the item, the
previous price or markup will be zero.
The date of the last change made to the base price and markup cost.
If the current base price and markup cost are the first ones you
entered for the item, the date of the change will be zeroes.
The Price List Summary and Item Number Summary reports include the
current base price and pricing unit for each item.
See also

Inventory Control reports

Sales Statistics Report — Features
The Sales Statistics report lists figures for sales and returns by the
statistical reporting periods you specify in the Options form.
You can print this report only if you use the Keep Item Statistics option.
For instructions on printing the report, see Printing the Sales Statistics Report.

Information printed on the report
The unconsolidated (Show Every Item) report shows sales and returns
information by item, location, and period, including:
The year and period as determined by your selections in the
Accumulate By and Period Type fields on the Processing tab on the
I/C Options form.
Quantities of the item that were sold or returned, by location and
period.
The number of sales and returns transactions for the item, by
location and period.
The total sales and return amounts for the item. In multicurrency
ledgers, these amounts are shown only in the functional currency.
Margin figures for each item, calculated as
Margin percentage, calculated as:
Margin X 100
Sales - Returns
Subtotals by item numbers, which is what you see when you print
the Consolidate Items version of the report.
See also
Inventory Control reports

Selling Price/Margin Analysis Report — Features
The Selling Price and Margin Analysis report lists items whose base
prices or discount or markup prices have a gross profit margin that is less
than the percentage you specify.
Use the report to identify items with unusually low or high profit margins.
For instructions on printing the report, see Printing the Selling Price/Margin Analysis Report.

Information printed on the report
Amounts in the currency and at the exchange rate you specify, if you
use a multicurrency ledger. Note that the markup cost is always in
the functional currency.
The unit cost for each type of costing method selected for the report.
The base price, from the Prices tab of the Item Pricing form.
The margin, calculated as follows:

The discount or markup prices calculated as specified for the item on
the Discounts tab of the Item Pricing form.
The quantity that must be purchased for each discount level to apply,
if the prices vary by the volume purchased.
The margin for each discount or markup price, calculated as follows:

See also
Inventory Control reports

Transaction Statistics Report — Features
The Transaction Statistics report lists statistics from posted transactions
for the current year and all the previous years for which you keep history.
Transaction statistics are accumulated according to the selections you
made for the Accumulate By and Period Type fields in the Options form.
You must use the Keep Item Statistics option if you want to print the
Transaction Statistics report.
For instructions on printing the report, see Printing the Transaction Statistics Report.

Information printed on the report
The report lists statistical information for receipts, shipments, internal
usage transactions, adjustments, and transfers, subtotaled by period.
See also
Inventory Control reports

Transaction History Report — Features
The Transaction History report lists all transactions posted for the items
assigned to the account sets you select within the period you specify. The
report shows the net change to the inventory control account for the
account set and period.
Transaction history is accumulated and reported according to the settings
you chose in the Fiscal Calendar in Common Services. Transactions are
accumulated for this report only if you use the Keep Transaction History
option in the Options form.
Transactions cleared in the Clear History form will not be included in the
report.
For instructions on printing the report, see Printing the Transaction History Report.

Information printed on the report
The date, fiscal year, and fiscal period of each transaction.
The document number entered with the transaction.
Day-end numbers, assigned sequentially each time Day End
Processing is run, and entry numbers indicating the order in which
each transaction was processed by Day End Processing.
If you use multicurrency ledgers, the source currency and exchange
rate for each transaction.
The amount of the transaction in source currency. Amounts that
credit the general ledger inventory control account (such as
shipments) are displayed in parentheses.
Debit or credit amounts for each transaction, to be posted to the
account set's general ledger inventory control account. In
multicurrency ledgers, these amounts are in the functional currency.
The net change posted to the inventory control account from all
transactions posted for the item.
The opening and ending balances for the item's inventory control
account when you sort the report by account set.

The opening and ending balances and the net change for each
location and account set when you sort by account set.
If you sort by item number, the report shows only the net change for each
location and account set.
See also
Inventory Control reports

Account Sets Report — Features
This report lists the account sets defined for your Inventory Control
system. Print the report when you add, change, or delete account sets.
For instructions on printing the report, see Printing the Account Sets Report.

For each account set, the report lists
The costing method assigned to each account set.
The account numbers for the Inventory Control, Payables Clearing,
Adjustment Write-Off, Assembly Cost, Non-Stock Clearing, Transfer
Clearing, Shipment Clearing, Disassembly Expense, Physical
Inventory Adjustment and Credit/Debit Note Clearing accounts.
The date on which each account set was last edited (last
maintained).
If an account set is inactive, the date it became inactive is also listed.
You cannot assign inactive account sets to items or post transactions
for items using an inactive set.
See also
Inventory Control reports

Alternate Items Report — Features
The Alternate Items report lists the numbers of items to which alternate
items are assigned, together with the numbers and descriptions of the
corresponding alternate items. You can print the report by item numbers,
categories, item number segments, optional fields, and vendor numbers.
For instructions on printing the report, see Printing the Alternate Items Report.

Information printed on the report
The range of item numbers selected for the report.
For each item, the alternate item number and corresponding
description.
See also
Inventory Control reports

Bills of Material Report — Features
The Bills Of Material report lists the component items and quantities
required to build the master items in your Inventory Control system.
For instructions on printing the report, see Printing the Bills of Material Report.

Information printed on the Bills Of Material
report
Item numbers and descriptions for master and component items, the
bill of material number, the build quantity, and the unit of measure for
each master and component item.
The item numbers and descriptions of each item in each component
bill of material, if listing component BOMs.
The fixed and variable costs of the master item. If you select the
Include Costs For Each Item option, the report also lists the unit
costs of component items, and the total assembled cost of the
master item.
See also
Inventory Control reports

Categories Report — Features
The Categories report lists the information entered to define the category
codes you use to group inventory items.
For instructions on printing the report, see Printing the Categories Report.

Information printed on the report
The default price list for the category, if one has been assigned. The
code of the default price list appears automatically on item records
you add that use the category, but you can assign other price lists to
items.
The commission rate allowed on sales from the category.
The commission rate appears only if you selected the Allow
Commissions option for the category.
This rate is used by Sage ERP Accpac Order Entry for
commissions unless it is 0.0000.
If this rate is zero, Order Entry will use the salespersons’ rates
specified in the Salesperson Commission Rates form in the Order
Entry program.
The general ledger accounts to which you post transactions for each
category.
The tax authorities and tax classes applicable to each category.
Category tax information appears as the default information in new
item records you assign to the category.
See also
Inventory Control reports

Customer Details Report — Features
The Customer Details report lists customer item numbers and inventory
item numbers that they identify.
For instructions on printing the report, see Printing the Customer Details Report.

Information printed on the report
You can sort the report by item number or by customer number, and
specify ranges of item numbers and customers that you want to appear
on the report.
The report shows the numbers your customers use to identify your
inventory items, along with the item numbers used in your inventory
system.
Note: The report includes only customer details that are assigned to
items in the I/C Customer Details form.
The report also includes the descriptions entered with each
customer's item number, and the unit of measure used by the item
number.
See also
Inventory Control reports

Printing the G/L Integration Report
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Inventory Control system sends transactions to General
Ledger.
For more information on the contents of this report, see G/L Intregration — Features.

When to print
Print the report before and after changing options.

To print the G/L Integration report
1.Double-click the G/L Integration icon in the Setup Reports folder, or
choose File, Print from the G/L Integration form.
2.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Item Structures Report — Features
The Item Structures report lists the information you entered in your
Inventory Control system to format item numbers.
For instructions on printing the report, see Printing the Item Structures Report.

Information printed on the report
The report includes descriptions of each segment composing an item
structure, the characters you use in the structure as prefixes to item
numbers or to separate segments of item numbers, the total length of the
item structure, and a sample item number that uses the corresponding
item structure.
See also
Inventory Control reports

Mask Structures Report
The Mask Structures report is available if you have a license to use
Serialized Inventory and Lot Tracking.
This report lists the different serial and lot number formats that were
created using the Mask Structures form.
To print the Mask Structures report:
1.Open I/C Setup Reports > Mask Structures.
2.In the From Mask Structure and To Mask Structure fields, specify a
range of structures to include on the report, or accept the default
selections to include all mask structures.
3.Click Print.
See also
Inventory Control reports

Kitting Items Report
The Kitting Items report prints all or a range of kits defined in the
Inventory Control system.
To print a list of kitting items:
1.Click the Kitting Items icon in the Setup Reports folder.
2.Choose the field that you want to use to sort the report. The choices
are:
Item Number
Category
Item Segment
An Optional Field that has been assigned to Kitting Items
3.Choose the range of kits that you want to print for the report.
If you selected Item Segment for sorting the report, you must then
choose the item segment that you want to use for sorting and for
defining the print range.
4.Choose whether you want to print costs for each item (optional).
If you selected Costs For Each Item, you must also select a Location
for the item costs.
5.Click Print.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Location Details Report — Features
The Location Details report lists information for items at each location
where you allow the items to be stocked.
For instructions on printing the report, see Printing the Location Details Report.

Information printed on the report
Whether the item is allowed to be used in transactions at a location.
Whether any transactions have been posted involving the item. "Yes"
indicates that transactions have been posted for the item.
An alternate cost for which you can enter amounts in the Location
Details form. You can assign the name for up to two alternate
amounts in the Options form. The amounts can also be used by
Sage ERP Accpac Order Entry and Purchase Orders as the basis of
tax calculations.
See also
Inventory Control reports

Locations Report — Features
The Locations report lists the information entered to define the inventory
locations used in your Inventory Control system.
For instructions on printing the report, see Printing the Locations Report.

Information printed on the report
The report includes the name and address of each location, the
telephone and fax numbers at the location, the date the record was
last maintained (edited), the date the location was set to Inactive
status, if applicable, and the name of a contact person or position at
the location.
The report also includes the segments of your general ledger
account numbers to which you post transactions for locations that
use the Override G/L Account Segments option.
See also
Inventory Control reports

Manufacturers' Items Report — Features
The Manufacturers' Items report lists the information for manufacturers'
item numbers (such as bar codes) that have been added for your
inventory items.
For instructions on printing the report, see Printing the Manufacturers' Item Report.

Information printed on the report
The report includes the manufacturers' item numbers and inventory
item numbers that they identify.
The report also includes the descriptions entered with each
manufacturer's item number, and the unit of measure used by the
item number (so you can have different codes for individual items,
boxes, and pallet loads).
See also
Inventory Control reports

Optional Fields Report
Click the Optional Fields icon in the Setup Reports folder, then click the
Print button.
The report displays the optional field code, description, the default value,
and whether the optional field will be auto-inserted.

How to print
1.Double-click the Optional Fields icon in the Setup Reports folder, or
choose File, Print from the Optional Fields form.
2.Click Print.

Information printed on the report
The Optional Field report displays the optional field code and description,
as well as the default value and whether or not you want the value to be
automatically inserted.
See also
Inventory Control Reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Options Report — Features
The Options report lists the selected options and other information you
entered in the Options form to specify how your Inventory Control system
operates.
For instructions on printing the report, see Printing the Options Report.

Information printed on the report
Company options
Processing options
Item number segment definitions
Document numbering structure (length, prefix and next number)
Aging periods for the Aged Inventory report
Costing options
Serialized Inventory options (if Serialized Inventory and Lot Tracking
license is installed)
Lotted Inventory options (if Serialized Inventory and Lot Tracking
license is installed)
See also
Inventory Control reports

Price List Codes Report — Features
The Price List Codes report lists codes you defined to identify your
company's price lists.
For instructions on printing the report, see Printing the Price List Codes Report.

Information printed on the report
The report includes the code and description for each price list, as well as
the discount or markup type and method of calculation, and the tax
authorities and classes that apply.
See also
Inventory Control reports

Reorder Quantities Report — Features
The Reorder Quantities report lists the maximum and minimum item
quantities permitted at your locations during each period. The report also
shows the number of units you usually order at a time and the number of
units you expect to sell in each period.
The report includes only items for which you have entered reorder
information in the Reorder Quantities form.
For instructions on printing the report, see Printing the Reorder Quantities Report.

Information printed on the report
The report includes the starting and ending dates for the reorder
periods you assigned to an item and location.
The maximum, minimum, and reorder quantities, and the projected
sales figures for each period.
See also
Inventory Control reports

Segment Codes Report — Features
The Segment Codes report lists the segments used in your Inventory
Control system and the segment codes and corresponding descriptions
used with each segment.
For instructions on printing the report, see Printing the Segment Codes Report.

Information printed on the report
Printed with the All Segments option, the report lists each segment name
and its corresponding segment codes and descriptions.
See also
Inventory Control reports

Printing the Units of Measure Report
The Units of Measure report lists the information entered to define the
units of measure used in your Inventory Control system.
For more information on the contents of this report, see Units of Measure Report —
Features.

When to print
Print the report when you add, change, or delete units of measure, or to
provide people setting up items with a list of the units that have already
been added.

To print the Units of Measure report
1.Double-click the Units of Measure icon in the Setup Reports folder, or
choose File, Print from the Units of Measure form.
2.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Vendor Details Report — Features
The Vendor Details report lists vendors from whom you purchase
inventory items and the items each supplies. The report includes only the
vendors you have assigned to Inventory Control items in the I/C Vendor
Details form.
For instructions on printing the report, see Printing the Vendor Details Report.

Information printed on the report
The order in which the information appears on the Vendor Details report
depends on your sorting selections. The other reports print your Inventory
Control item numbers in the first column, followed by any additional
sorting options (such as categories), and include the same types of
information as you see on the sample report.
The number you assign to identify the vendor in Inventory Control. If
you use Sage ERP Accpac Accounts Payable, you can select
vendor numbers from Finders in Inventory Control.
The number you use to identify the item in Inventory Control.
A number you assign to the vendor in the item record, usually to
identify vendors from whom you most frequently order the item.
The code or number used by the vendor to identify the item.
See also
Inventory Control reports

Printing the Weight Units of Measure Report
The Weight Units of Measure report lists the information entered to define
the weight units of measure used in your Inventory Control system.
For more information on the contents of this report, see Weight Units of Measure
Report — Features .

When to print
Print the report when you add, change, or delete weight units of measure,
or to provide people setting up items with a list of the weight UOMs that
have already been added.

To print the Weight Units of Measure report
1.Double-click the Weight Units of Measure icon in the Setup Reports
folder, or choose File, Print from the Weight Units of Measure form.
2.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Warranty/Contract Codes Report
The Warranty/Contract Codes is available if you have a license to use
Serialized Inventory and Lot Tracking.
This report lists the Contract Codes and Warranty Codes in your Inventory Control
system. It is useful when you are setting up new codes, and want to know
which ones are currently used.
If you want a report of specific serialized/lotted items that have warranties
and contracts assigned to them, print the Warranty/Contract List report,
available in the I/C Stock Control Reports folder.
To print the Warranty/Contract Codes report:
1.Open I/C Setup Reports > Warranty/Contract Codes.
2.From the Report Type list, select Contract Codes or Warranty Codes .
3.In the From and To fields, select a range of codes to print, or accept
the default selections to print all codes in the system.
4.Click Print.
See also
Inventory Control reports

Printing the Aged Inventory Report
The report prints the net changes in item quantities and costs for a set of
four aging periods specified by the user at print time.
Depending on the options chosen at print time, the report can be printed
in a detailed or summary version. The detailed version prints all individual
transactions affecting item quantities and costs. The summary version
prints only the totals of the net changes for each period.
For information on the contents of this report, see Aged Inventory Report � Features.
To print the report
1.Choose the Aged Inventory Report icon from the Stock Control
Reports folder.
2.Make your selections in the following fields:
Age Transactions As Of. Specify the date on which to report the
inventory. The program uses this date to assign transactions to aging
periods. For example, if you print the report by due date, the program
assigns each transaction to an aging period by calculating the number
of days between its due date and the Age As Of date.
Cutoff By. The report includes only those transactions that have a
document date or a fiscal period before or on the cutoff date you
specify. There are two methods for selecting a cutoff date.
Document Date. Use this method if you want to include all
transactions up to a specific date that is not the fiscal period end
date. Enter a date in the Cutoff Date field. If you enter zeros for the
month, day, and year, the report includes all transactions,
regardless of date.
Year/Period. Use this method if you want to include all
transactions up to the end of a fiscal period. Make your selections
in the Year and Period fields.
Print Separate or Consolidated Locations. If you select Separate
Locations, the report prints each location on a new page. If you select
Consolidated Locations, the report prints a single total for each item
for all locations (within the range you specify).

Print Transactions In. Indicate whether to print a Summary or
detailed report (one that prints only one line per item, or one that
includes all transactions).
Start Date. Specify the date of the oldest transactions that you want
to have printed on a detail report.
Include. Specify whether you want all net totals to be printed, or print
only positive, negative, zero, or non-zero net changes in costs and in
quantities.
From/To. Indicate the ranges of account sets, locations, and item
numbers that you want to include in the report. You can also select a
range of values for the field that you use to sort the report.
Sort By. You can choose to sort the report by item category, item
segment, or by optional field value. You can also choose a range of
values for the sort field.
Use Aging Periods. The aging periods entered in the I/C Options
form appear here, but you can assign different periods for the report, if
you wish.
3.Click

.

Print

See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Bin/Shelf Labels Report � Features
You can print bin or shelf labels to attach to the bins or shelves where
you store inventory items.
For instructions on printing labels, see Printing Bin/Shelf Labels.

Information printed on the report
Bin and shelf labels can include any of the information in the item record.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
When Print Destination is Schedule

Printing the Inventory Movement Report
The Inventory Movement report shows the quantities and extended costs
of inventory items that were received into stock and shipped out of stock
during the period that you specify.
The report displays the stock activity showing each transaction in and out
of stock for the period. Users can group items in all locations together or
display items in each location separately.
For information on the contents of this report, see Inventory Movement Report �
Features.
To print the report
1.Choose the Inventory Movement Report icon from the Stock Control
Reports folder.
2.Make your selections in the following fields:
Select Transactions By. There are two methods for selecting a cutoff
date.
Document Date. Use this method if you want to specify
transactions for a specific range of dates.
Year/Period. Use this method if you want to include all
transactions up to the end of a fiscal period. Make your selections
in the Year and Period fields.
Print Separate or Consolidated Locations. If you select Separate
Locations, the report prints each location on a new page. If you select
Consolidated Locations, the report prints a single total for each item
for all locations (within the range you specify).
Report Currency. In a multicurrency ledger, choose whether you
want to see amounts in source and functional currency.
From/To. Indicate the ranges of account sets, locations, and item
numbers that you want to include in the report. You can also select a
range of values for the field that you use to sort the report.
Sort By.You can choose to sort the report by item category, item
segment, or by optional field value. You can also choose a range of

values for the sort field.
3.Click

Print.

See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Item Labels Report — Features
Inventory Control allows you to print labels such as price tags that you
can attach to items as you receive them from your suppliers, and to items
already in your inventory.
To print labels for the bins or shelves where you store items at your
inventory locations, use the Bin/Shelf Labels form.
For instructions on printing the report, see Printing Item Labels.

Information printed on the report
The sample item labels include the item number and description, picking
sequence number (Bin/Shelf), and price per pricing unit. You choose
which information to print.
See also
Inventory Control reports

Item Status Report — Features
Use the Item Status report to print the information entered for each item
in the Items form, as well as the quantities on hand at your inventory
locations. If you use the Keep Item Statistics option, the report also
shows shipment and receipt statistics for each item.
For instructions on printing the report, see Printing the Item Status Report.

Information printed on the report
Profile. Lists the information entered on the Items tab of the Items
form.
Units of Measure. Lists all defined units of measure, as entered on
the Items tab of the Items form, including the stocking unit, and the
corresponding conversion factors for each non-stocking unit.
Taxes. Lists the authorities and other tax information entered on the
Taxes tab of the Items form.
Additional Item Information. Lists text entered in the Additional
Item Information fields on the Optional Fields tab of the Items form.
Optional Fields. Lists the title and data for any active optional fields
that appear on the Optional Fields tab of the Items form.
Quantity by Location. Lists quantities on hand, on purchase order,
and on sales order for each location.
Total Quantities. Lists total quantities on hand, on purchase order,
and on sales order for your entire inventory.
Statistics. Lists locations, date of last item shipment, date of last
receipt of the item, average days between shipments, and average
units shipped by location.
FIFO/LIFO Costing. For each location and item, lists the receipt
number and date for each bucket, and the quantity and extended
cost for items received, shipped, and available. Quantities and costs
of items in the offset bucket are also given for each location, as well
as the quantities of items not costed (entered since the last time you
ran Day End Processing, if you do costing during Day End

Processing).
Serials. Lists the serial number mask used, the next number that will
be assigned, the days to expiry and the default warranty/contract
settings for each item.
Lots. Lists the lot number mask used, the next number that will be
assigned, the days to expiry, days on quarantine, and the warranty
and contract default settings for each item.
See also
Inventory Control reports

Item Valuation Report � Features
The Item Valuation report shows the value of inventory quantities on
hand, calculated for the items, locations, costs, or optional amounts you
select for the report.
For instructions on printing the report, see Printing the Item Valuation Report.

Information printed on the report
The Items By Location in Detail version of the report includes:
The costing method that is assigned to the item by its account set.
The average unit value and the cost per costing unit for each costing
method. If you include costs entered in the optional amount field, unit
values in the optional amount column are expressed in stocking
units.
A column in the "Valuation" section for each costing method you
selected for the report, including any optional or alternate costing
methods.
The totals for all items on the report. This line is what is printed when
you choose the Print Items by Location in Summary option.
Quantities and costs are separate options so that you can include
any combination of quantity and cost values, such as positive
quantities and negative costs, or zero quantities and positive or
negative costs.
The Print Consolidated Locations in Detail version of the report prints
the item number, description, and costing method for each item across all
locations. It also prints the quantity on hand and costing information totals
for each item.
The Print Consolidated Locations in Summary version consists of a
single line showing the total costs for all inventory items included in the
range of items and locations you select.
The Separate Locations in Detail version of the report includes:
The location code and location description.

The totals for all items at the location. This line is what is printed
when you choose the Print Separate Locations in Summary option.
The Default Item Price List version lets you print a report that values
your inventory using the base price of the selected price list.
The report starts a new page for each location you select.
The Transaction Costs version of the report includes:
The location code and location description.
The totals for all items at the location. This line is what is printed
when you choose the Print Separate Locations in Summary option.
See also
Inventory Control reports

Overstocked Items Report — Features
The Overstocked Items report lists each item at each location for which
the quantity on hand (plus the quantity on PO minus the quantity on sales
order) exceeds the maximum or projected sales quantity assigned for the
item and location.
You can choose from four basic reports:
Quantity Greater Than Maximum Level. Lists items for which the
quantities on hand are more than a specified percentage higher than
the maximum levels entered for the items in the Reorder Quantities
form.
Quantity Greater Than Projected Sales. Lists items for which the
quantities on hand are greater over the number of days you specify
than the projected sales quantities entered for the period in the
Reorder Quantities form.
Annualized Turn and Earn Ratio. Lists items for which the ratio of
the inventory turnover rate to the profit margin is less than the
percentage you specify.
Average Cost of Excess Quantity. Lists items with an actual cost
that is greater than the amount you specify in the Greater Than field.
Most Recent Cost of Excess Quantity. Lists items whose most
recent cost is greater than the amount you specify in the Greater
Than field.
You can report item quantities for locations that are over the maximum
level or over the projected sales figures entered for the items in the
Reorder Quantities form. You can include cost figures on the report to
see the costs of carrying the extra inventory items.
To print meaningful data on some versions of this report, you must first
enter figures for the items in the Reorder Quantities form.
For instructions on printing the report, see Printing the Overstocked Items Report.

Information printed on the report
The report's features differ according to the criterion you select for

determining whether items are overstocked.
For example, if you select overstocked items by their annualized turn and
earn ratios, the report includes:
The quantities on purchase order and sales order, which are entered
and updated by Sage ERP Accpac Purchase Orders and Order
Entry, respectively.
The quantity sold, total sales, and cost amounts posted for the item
in the year to date, from the Sales Statistics form.
The number of times the company's average inventory has been
sold in the year to date, calculated as:

Inventory Control calculates the number of days gone by in the year
by subtracting the session date from the first day in the current fiscal
year.
The margin percentage, calculated as:

The turn and earn ratio, calculated by multiplying the YTD turnover
by the margin. The ratio may not exactly equal the YTD turnover
multiplied by the margin percentage because the report rounds
figures to two decimal places.
If you select overstocked items by the most recent cost of excess
quantity, the report includes:
The starting and ending dates for the reorder period, as defined in
the Reorder Quantities form.
The date of the last shipment and receipt of the item.
The maximum quantity specified for the item, location, and period
entered in the Reorder Quantities form.
The amount by which the item quantity on hand exceeds the
maximum quantity entered for the item, location, and period in the
Reorder Quantities form.

The excess cost (excess quantity multiplied by the most recent cost
per unit).
You can print this version of the report only if you entered reorder
information in the Reorder Quantities form.
See also
Inventory Control reports

Quarantine Report
The Quarantine report is available if you have a license to use Serialized
Inventory and Lot Tracking.
This report lists the lot numbers that are currently on quarantine, as well
as the expected release date, lot quantity, and lot cost .
To print the Quarantine report:
1.Open I/C Stock Control Reports > Quarantine.
2.In the Lot Number From and To fields, specify a range of lots to
include on the report, or accept the default selections to include all
lots.
3.In the Item Number From and To fields, specify a range of item to print
on the report.
4.In the Location From and To fields, specify a range of locations. Items
and lots that are not at these location do not appear on the report.
5.In the Quarantine Date From and To fields, specify a range of
quarantine dates to include on the report. Lots quarantined before or
after these dates do not appear on the report.
6.Click Print.
See also
Inventory Control reports

Recall Report
The Recall report is available if you have a license to use Serialized
Inventory and Lot Tracking.
This report lists the lots that are currently on recall or have been released
from recall, the original vendor of the items as well as the customers the
items were sold to (if applicable). The recall/release date, recall quantity
and stock and sold dates are also provided on the report .
To print the Recall report:
1.Open I/C Stock Control Reports > Recall.
2.Use the Sort By list to specify whether to sort the report by
Customer/Vendor Number, Item Number, or Recall Number.
3.In the Recall Number From and To fields, specify a range of recall
numbers to include on the report, or accept the default selections to
print the report for all recall numbers.
4.In the Item Number From and To fields, specify a range of items to
include on the report.
5.Use the Customer Number From and To fields to specify a range of
customers to include on the report. Customers who have bought
recalled goods, but are outside the range, will not appear on the
report.
6.In the Vendor Number From and To fields, specify one or more
vendors. The report will list the lots purchased from these vendors
that are or have been on recall.
7.In the Location From and To fields, specify the range of locations to
include on the report.
8.In the Recall Date From and To fields, specify a range of recall dates
for the report.
9.Click Print.
See also
Inventory Control reports

Reorder Report — Features
The Reorder report lists items that are out of stock or have low quantities
on hand at the selected locations. The report also lists the suggested
reorder quantity, estimated cost to replenish, and names of the usual
suppliers you assigned for each item on the report.
For instructions on printing the report, see Printing the Reorder Report.

Information printed on the report
The criteria you selected to determine which item quantity levels to
list.
The number and name of the vendor from whom you usually order
the item. This information and the vendor's item number appear only
if you assigned vendors to the item record in the Items form.
The quantities on hand, on purchase order, and on sales order for
each location you included in the report. (Purchase order and sales
order figures are entered and updated by transactions posted in
Sage ERP Accpac Purchase Orders and Order Entry, respectively.)
The starting and ending dates for the reorder periods. You specify
the starting date for each period in the Reorder Quantities form.
Inventory Control calculates the period ending dates, based on the
starting dates.
The minimum and reorder quantities specified for the item in the
Reorder Quantities form, as well as the most recent cost.
The amount it would cost to purchase the full reorder quantity,
calculated by multiplying the reorder quantity by the item's most
recent cost.
See also
Inventory Control reports

Serial/Lot Number List Report
The Serial/Lot Number List report is available if you have a license to use
Serialized Inventory and Lot Tracking.
This report lists the serial numbers and lot numbers used for each lotted
or serialized inventory item. You can sort reports by serial/lot number,
location, or item number.
To print the Serial/Lot Number List report:
1.Open I/C Stock Control Reports > Serial/Lot Number List.
2.Use the Print list to specify whether to print the report for lot numbers
or serial numbers.
3.Select a Report Type.
Summary reports show the serial/lot numbers assigned to the
selected items, location, status, stock dates, and serial/lot cost.
Detail reports provide additional transaction information, including any
optional fields used.
4.In the first Select By list, specify whether to select records by Item
Number, Serial/Lot Number, or Customer Number. Use the From and
To fields to specify the range of numbers to appear on the report.
5.In the second Select By list, optionally specify whether to select
records also by Vendor Number, Sold Date, Location, or Expiry Date.
Use the From and To fields to specify the range you want to appear
on the report.
6.If required, make a selection from the third Select By list. Use the
From and To fields to specify the range you want to appear on the
report.
7.In the Sort By list, specify whether to sort the information by serial/lot
number, item number, or location.
8.Click Print.
See also
Inventory Control reports

Serial/Lot Number Quantity on Hand Report
The Serial/Lot Number Quantity on Hand report is available if you have a
license to use Serialized Inventory and Lot Tracking.
This report is helpful when reconciling serial/lot quantities with physical
inventory quantities. It lists all serial/lot numbers and their quantities for
each item number at each location. Summary and detailed report types
are available, and you can sort the report by item number or location.
To print the Serial/Lot Number Quantity on Hand report:
1.Open I/C Stock Control Reports > Serial/Lot Number Quantity on
Hand.
2.Use the Print field to specify whether to print the report for Lot
Numbers or Serial Numbers.
3.Select a Report Type.
Summary reports show the serial/lot numbers assigned to items, the
quantities on hand, and any differences.
Detail reports provide also provide the individual serial/lot numbers for
the quantity on hand.
4.In the Location From and To fields, specify one or more locations to
include on the report.
5.In the Item Number From and To fields, specify a range of item to
include on the report.
6.In the Sort By list, specify whether to sort the information on the report
by item number or location.
7.To exclude items if their physical quantity matches the quantity
assigned to serial/lot numbers, select the Show Only Items With IC
Quantity Variance option.
8.Click Print.
See also
Inventory Control reports

Serial/Lot Stock Listing Report
The Serial/Lot Stock Listing report is available if you have a license to
use Serialized Inventory and Lot Tracking.
This report generates a list of either lot or serial numbers that are
categorized as sold, reserved or expired. Serials have an additional
option that lists the serial numbers that have been sold that have
registered warranties. You can sort this report by item number, customer
number or location.
To print the Serial/Lot Stock Listing report:
1.Open I/C Stock Control Reports > Serial/Lot Stock Listing.
2.Use the Print list to specify what you want to base the report on, Lot
Numbers or Serial Numbers.
3.Select a Report Type.
Lot Numbers have three report types: Sold Stock, Reserved Stock, or
Expired Stock.
Serial numbers have an additional type: Registered Stock.
4.Use the Date From and To fields to define the date range for the
report.
5.Use the Location From and To fields to specify a range of locations to
include on the report.
6.Use the Item Number From and To fields to specify a range of items
to include on the report.
7.Use the Number From and To fields to specify a range of serial
numbers or lot numbers, or accept the default selections to include all
the numbers on the report.
8.Use the Customer Number From and To fields to specify a range of
customers to include on the report.
9.In the Sort By list, specify whether to sort the report by item number,
customer number, or location.
10.Click Print.

See also
Inventory Control reports

Serial/Lot Transactions Report
The Serial/Lot Transactions report is available if you have a license to
use Serialized Inventory and Lot Tracking.
This report generates a list of lot numbers or serial numbers, along with
the transactions that include the numbers. You can sort the report by
serial/lot number or item number.
To print the Serial/Lot Transactions report:
1.Open I/C Stock Control Reports > Serial/Lot Transactions.
2.Use the Print list to specify what you want to base the report on, Lot
Number or Serial Number.
3.Use the Number From and To fields to specify a range of serial
numbers or lot numbers to appear on the report, or accept the default
selections to include all the numbers.
To specify a single serial or lot number, enter the number in both
fields.
4.Use the Item Number From and To fields to specify the item(s) you
want to appear on the report.
5.Use the Location From and To fields to specify one or more locations
that you want to appear on the report.
6.Use the Document Date From and To fields to define the date range
for the report. Transactions that occurred outside the defined date
range will not appear in the report.
7.Make a selection from the Status list. You can include available,
unavailable, or both kinds of serial/lot numbers on the report.
8.Make a selection from the Sort By list. You can sort the information on
the report by item or serial/lot number.
9.Click Print.
See also
Inventory Control reports

Slow Moving Items Report — Features
The Slow Moving Items report lists items that are not selling well,
according to the criteria you select when you print the report.
For instructions on printing the report, see Printing the Slow Moving Items Report.

Information printed on the report
The criteria you selected to identify slowly moving items.
The reasons each item was included in the report. The numbers in
this column correspond to the criteria you selected to identify slowly
moving items.
See also
Inventory Control reports

Stock Transactions Report
The Stock Transactions Reports list the inventory changes or status for
one or more items from one or more account sets and locations. You can
print a summary or detailed report, group by items or locations and
include costs, quantity or both.
There are two kinds of reports you can create; Stock Transactions and
Stock Status. Stock Transactions provides a list of inventory changes for
selected items over a range of periods, while Stock Status provides the
valuation of selected items as at a specific period. These two report types
replace the "Stock Card Print" and "Item Valuation" functions in Stock
Card integration.

To print the stock transactions report:
1.Select Inventory Control > I/C Stock Control Reports > Stock
Transactions to open the form.
2.Decide on whether you want a Summary or Detail report and select
one of the two Report Type options. Stock Transactions will provide
you a list of transactions that result in changes to inventory levels for
selected items, while Stock Status will list all the items in the range,
even if no inventory movements were made.
3.Use the Group By field to group report results either by Items or
Locations.
4.By default the report prints both the costs and quantity of the selected
item(s). You can change this to Costs Only or Quantity Only.
5.Select the period(s) for the report. If creating a Stock Transactions
report, you can select a range of periods. If creating a Stock Status
report, select a single period to use as the "As at " period.
6.Select one or more account sets.
7.Select one or more locations.
8.Select one or more items to include in the report.
Note: When selecting a range, make sure the starting value is smaller
than the ending value. For example, select From account set AVG to

LIFO or From Location 1 to 2, not the other way around. Otherwise an
error message appears prompting you to change your selections.
9.Select the Include Inactive Items checkbox if you wish to do so on
the report.
10.Click Print.
Click here for hints on using forms.

Printing Transfer Slips
Inventory Control lets you print transfer slips when you post transfers to
accompany goods to the receiving location (either carried by the driver or
attached to the goods by way of a clear packing envelope or window
envelope).
For more information on the contents of this report, see Transfer Slips � Features.

When to print
Print transfer slips when you are posting stock transfers and want to
attach transfer slips to the transfer shipment.
You can also enter transfer transactions first, and then print transfer slips
at a later time by choosing the Transfer Slips icon in the Stock Control
Reports folder.

To print transfer slips
1.Save or post a new transfer transaction and choose "Yes" when I/C
displays the transfer number and asks if you want to print transfer
slips.
Or, choose the Transfer Slips icon in the Stock Control Reports folder.
2.Select the transfer slip that you want to use.
I/C ships with two transfer slips: one prints the Quantity Received on
the slip, and the other leaves this field blank.
3.If you used the Transfer Slips icon to open the print form, select the
range of inventory transfers for which you want to print transfer slips.
4.Select the Include Serial/Lot Numbers checkbox to print serial/lot
numbers of applicable items on the transfer slips.
5.Select Include Transfer Slips Already Printed checkbox if you want to
reprint a transfer slip.
5.Click the print button.
See also

Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Warranty/Contract List Report
The Warranty/Contract List report is available if you have a license to use
Serialized Inventory and Lot Tracking.
This report provides the lot/serial numbers that have warranty and/or
contract codes assigned to them. You can select a range of warranty
codes, contract codes, item numbers and locations to print on the report.
To print the Warranty/Contract List report:
1.Open I/C Stock Control Reports > Warranty/Contract List.
2.From the Report Type list, select Item Summary, Contract Summary,
or Warranty Summary .
3.In the Print field, select Serial Numbers or Lot Numbers.
4.If you selected Warranty Summary or Contract Summary as the report
type, in the Order By list specify whether to print the report by Item
Numbers or Serial/Lot Numbers.
5.In the Sort By field, choose the sort order for the report details. (The
choices available depend on your selections in the Report Type and
Print fields.)
6.Use the Status field to include or exclude items or numbers by their
status (Available, Not Available or Both).
7.If you selected Warranty Summary as the report type, and you are
printing serial numbers on the report, in the Show list specify whether
to include registered warranties, unregistered warranties, or both on
the report.
8.In the From and To fields, select a range of codes (Warranty and/or
Contract), Item Numbers, Locations and Dates (Expiry, Stock or Sold)
to include on the report.
9.In the Use field, specify the latest or the earliest expiry date for the
warranties and/or contracts to include on the report.
10.Click Print.
See also

Inventory Control reports

Printing Posting Journals
A posting journal is the printed record of the transactions that were
processed together during day-end processing.
You can print six types of posting journals, one for each transaction type
you can post in Inventory Control: adjustments, assemblies, receipts,
shipments, internal usage, and stock transfers.
For more information on the contents of this report, see Posting Journals Features.–

Before printing
Remember to run Day End Processing if you want to print the most
current posting journals.

When to print
You should print posting journals after each day-end processing, then file
them with your other audit trail records. You must print copies of the
journals to a printer or file before you can clear the data for them in the
Clear History form.

To print posting journals
1.Double-click the Posting Journals icon in the Price/Sales Analysis
Reports folder.
2.Make your selections in the following fields:
Select Journal. Select the type of posting journal to print:
Adjustments, Assemblies, Receipts, Shipments, Internal Usage, or
Stock Transfers.
From Day End Number and To Day End Number. Type the lowest
and highest numbers in the range of day-end numbers you want to
include in the journal. A unique day-end number is assigned each
time you run Day End Processing.
These fields display the lowest and highest day-end numbers in your
Inventory Control system for the type of journal you select.
Sort By. Specify the order in which to list transactions on the posting

journal.
Day End Number. Lists transactions in order by the day-end and
entry numbers they were assigned when you processed them.
Transaction Date. Lists transactions in order by the dates you
entered with them.
Adjustment/Assembly/Receipt/Shipment/Internal
Usage/Transfer Number. Lists transactions in order by the
document numbers that you entered with the transactions.
Reprint Previously Printed Journals. Select this option if you want
to print additional copies of journals you printed before and have not
yet cleared.
Include Optional Fields. Select this option to include optional fields
added to transactions and transaction details.
Include Serial/Lot Numbers. Choose whether to show serial and/or
lot numbers of applicable items in the posting journal.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing Transaction Listings
The Transaction Listing lets you print the details of any saved or posted
transactions that have not been cleared from the Inventory Control
system.
For more information on the contents of this report, see Transaction Listing
Features.�

You can print six types of transaction listings, one for each transaction
type you can post in Inventory Control: adjustments, assemblies,
receipts, shipments, stock transfers, and internal usage transactions.

When to print
Depending on how you organize transaction entry, you may:
Enter and save transactions, and then print a report showing all
unposted transactions to review before posting.
Print posted transaction listings at the end of the day to compare to
source documents.

To print transaction listings
1.Double-click the Transaction Listing icon in the I/C Transactions
folder.
2.Make your selections in the following fields:
Select Transaction Type. Select the type of listing to print:
Adjustments, Assemblies, Receipts, Shipments, Stock Transfers, or
Internal Usage.
Reprint Previously Printed Transactions. Choose whether to reprint
previously printed transactions.
Include Comments. Choose whether to show comments entered
with each transaction (doesn't apply to assemblies).
Include Serial/Lot Numbers. Choose whether to show serial and/or
lot numbers of applicable items in the report.
Include Optional Fields. Choose whether to print optional field

information with transactions.
From [Document] Number and To [Document] Number. Type the
lowest and highest document numbers that you want to include in the
listing.
From Transaction Date and To Transaction Date. Type the first and
last dates for which you want to print transactions.
Entered / Posted. Choose the status of transactions that you want to
appear. If you are reviewing saved transactions only, select Entered.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Sage ERP Accpac Training
Become a Sage ERP Accpac expert with online or classroom training
through Sage University.
If you want to get beyond the basics and tap into the full power of your
Sage ERP Accpac system, nothing beats targeted training and
education.
Our training resources include a nationwide network of authorized
classroom training centers, online courses, partners who can conduct onsite training, manuals and guides for your self-study, and an annual
customer conference.
For more information on Sage ERP Accpac training, choose one of the
following links:
Find a Course

Search training courses on the Sage University Web site by product,
type, location, track, schedule—or try our advanced search.
Anytime Interactive

Anytime Interactive training offers a full range of recorded instructor-led
sessions that are easy to use, always accessible, and ready when you
are. All you need is a computer, speakers and a high-speed Internet
connection.
Anytime Interactive sessions are ideal for review material, acquainting
new-hires with basic processing skills, and cross-training staff. Interactive
sessions include product specific instruction and online review quizzes.
Classroom

Instructor-led classroom training provides you with personal interaction in
a professional atmosphere you will enjoy. Classroom training also allows
you the opportunity to become Sage certified.
Classroom training is ideal if you prefer one-on-one assistance,
interaction with other students and a classroom atmosphere.
Lunch & Learn

Lunch & Learns are one-hour Realtime (Online) sessions that cover a

particular topic or process. Each Lunch & Learn is designed to increase
productivity by simply providing you with a stronger understanding of a
specific feature or functionality within the software.
Choose one of our 40+ information packed Lunch & Learn sessions and
become more proficient in just one hour.
Realtime

Realtime training sessions are online, instructor led and scheduled for a
specific date and time. All you need is a computer, phone, and an
Internet connection. Everything happens live, so you can ask questions
and interact with other participants and the instructor.
Realtime combines the interaction of a classroom with the convenience
of staying right where you are.
Realtime sessions include live product specific instruction, electronic or
printed course materials, hands-on exercises, and online review quizzes.

Receive Goods from Vendors
Before you start

To add receipts of inventory in the Inventory Control module:
1.Open Inventory Control > I/C Transactions > Receipts.
Click here for help on receipts fields.

Note: If you ordered goods through the Purchase Orders module, you
should receive shipments in P/O.
2.Press the Tab key — with *** NEW *** displayed — to start a new
receipt. The program will automatically assign a document number
when you save or post the transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Enter an optional description and reference for the receipt, then
specify the transaction date and fiscal year and period to which you
will post it.
4.If a vendor number applies to the receipt, enter that number. If you
use Sage Accpac Accounts Payable with Inventory Control, you can
select vendor numbers from the Finder beside the Vendor Number
field.
5.Enter a purchase order number, if any.
6.If you use multicurrency accounting, specify the currency in which you
will enter item costs and specify the exchange rate.
7.Indicate whether you want to print labels for the receipt.
8.Click the Zoom button ( ) by the Optional Fields checkbox (if one
appears) to add optional field information to this receipt.
9.If you use multicurrency accounting, specify the currency in which you
will enter any additional costs.
10.Enter the amount of any additional cost.
11. For each item on the receipt, type or use the Finder to enter the item

number and location.
12.Enter the quantity received and unit of measure. If working with
serialized and/or lotted items, you will be prompted to assign serial/lot numbers.
13.Enter the unit cost or the extended cost if it is different from the cost
displayed by the program.
14.Indicate the number of labels you require, if any, and enter any
comments or optional fields you want to appear on the Receipts
Posting Journal regarding the detail line (optional).
15.Press the Insert key on your keyboard to start a new line. Repeat
steps 10 through 13 for each additional line you want to add for the
receipt.
16.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the receipt
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger. Also, you will
not be able to recall the receipt for returns or adjustments.
17.Note the receipt number, and click OK at the confirmation message.
After using
Related topics

Return Goods to Vendors
Before you start

Note: If the receipt is marked as Complete, or is no longer available, you
must use the Adjustments form to adjust inventory levels and costs.
To return goods to vendors:
1.Open Inventory Control > I/C Transactions > Receipts.
Click here for help on receipt/return fields.

Note: If you received goods through the Purchase Orders module,
you should return those goods using P/O.
2.Use the Finder or the navigation keys to select the receipt for which
you are returning goods.
3.Enter a description for the return, and then specify the transaction
date and fiscal year and period to which you will post it.
4.You cannot change the vendor information or the exchange rate for a
multicurrency transaction.
5.Choose whether additional costs applied to returned goods on the
original receipt should be prorated to the remaining goods on the
receipt or left assigned to the items to which they were originally
allocated.
Note: If you return all of the items on the receipt, you must use the
Adjustments form to write off the additional cost from the receipt to a
general ledger write-off account, even if you select the Prorate option.
6.Click the Zoom button ( ) to edit optional fields for the return, if you
use optional fields.
7.To fill in the return details:
a.

Select the receipt line for the goods that you are returning.

b.

Tab to the comments field and provide a reason for the return.

c.

Tab to the Quantity Returned field and enter the quantity being
returned. If working with serialized and/or lotted items, you will be
prompted to assign serial/lot numbers.

d.

Click the Zoom button in the Optional Fields column heading to
enter optional field information.

8.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the return immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger. Also, you will
not be able to recall the returns or adjustments.
9.Click OK at the confirmation message.
After using
Related topics

Adjust Vendor Receipts
Before you start

To adjust vendor receipts:
1.Open Inventory Control > I/C Transactions > Receipts.
Click here for help on receipt adjustment fields.

Note: If you received goods through the Purchase Orders module,
you must edit the receipt using P/O.
2.Use the Finder or the navigation keys to select the receipt that you
are adjusting.
3.Enter a description for the adjustment, and then specify the
transaction date and fiscal year and period to which you will post it.
4.You cannot change the vendor information or the exchange rate for a
multicurrency transaction.
5.Change the additional cost for the receipt, if necessary.
6.Click the Zoom button ( ) to edit optional fields for the receipt, if you
use optional fields.
7.To adjust the receipt details:
a.

Select the receipt line that you are adjusting.

b.

Tab to the comments field and provide a reason for the
adjustment.

c.

Tab to the Adjusted Cost or the Total Adjusted Cost to enter or
change the value or the goods received. You cannot change the
quantity on the receipt.

d.

Click the Zoom button in the Optional Fields column heading to
enter optional field information.
You cannot add or remove lines from the receipt.

8.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.

If you choose Post, Inventory Control posts the adjusted receipt
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger. Also, you will
not be able to recall the returns or adjustments.
9.Click OK at the confirmation message.
After using
Related topics

Adjust Item Quantities and Costs
Which form should I use to process adjustments?
Can I adjust material usage for a project?
Before you start

To adjust item quantities and costs:
1.Open Inventory Control > I/C Transactions > Adjustments.
Click here for help on adjustment fields.

2.Press the Tab key — with ***NEW*** displayed in the Adjustment
Number field — to start a new transfer receipt. The program will
automatically assign a document number when you save or post the
transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.If necessary, select an adjustment date (click the Calendar button),
and select a fiscal year/period from the fiscal calendar at the
Year/Period field.
4.Enter an optional description and reference for the adjustment.
5.Click the Zoom button ( ) by the Optional Fields checkbox (if one
appears) to add optional field information to this adjustment.
6.Add the detail lines, specifying the item number, adjustment type, and
location for each, then:
If the item uses the FIFO or LIFO costing method, specify the bucket type,
receipt number, and cost date.
If the adjustment type is Quantity Increase, Quantity Decrease,
Both Increase, or Both Decrease, specify the quantity and unit of
measure. If working with serialized and/or lotted items, you will be
prompted to assign serial/lot numbers.
If the adjustment type is Cost Increase, Cost Decrease, Both
Increase, or Both Decrease, specify the cost adjustment and
adjustment/write-off general ledger account.

7.Enter any comments you wish to add to the detail line.
8.Click the Zoom button ( ) for the Optional Fields column (or
checkbox), if one appears, to add optional field information to this
adjustment detail.
9.When you are finished, click the Post or Save button, and then click
OK at the message that displays the adjustment number.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the adjustment
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger. Also, you will
not be able to recall the returns or adjustments.
10.Click OK at the confirmation message.
After using
Related topics

Ship Goods to Customers
Before you start

To add shipments of inventory in the Inventory Control module:
1.Open Inventory Control > I/C Transactions > Shipments.
Click here for help on shipment fields.

Note: If you are shipping an order that was entered in the Order Entry
module, you should process the shipment in O/E.
2.Press the Tab key — with *** NEW *** displayed — to start a new
shipment. The program will automatically assign a document number
when you save or post the transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Shipment as the Entry Type.
4.Enter the Ship Date and Year/Period of the transaction.
Inventory Control automatically displays the logon date, and the fiscal
year and period that are associated with the date in Accpac's fiscal
calendar.
5.Enter an optional description and reference for the shipment.
6.If the shipment is to an existing A/R customer, enter the customer
number. If you use Sage ERP Accpac Accounts Receivable with
Inventory Control, you can select customer numbers from the Finder
beside the Customer Number field.
7.If you didn't specify an existing customer, enter a contact name (and
other relevant information, such as a phone number).
8.Choose a default price list for this shipment. (You can change the
price list on individual detail lines.) The program automatically selects
the default price list for the customer.
9.Click the Zoom button ( ) by the Optional Fields checkbox to add
optional field information to this shipment.

10.If you use multicurrency accounting, specify the currency in which you
will enter item prices, and specify the exchange rate. Click the Zoom
button ( ) to change exchange rate information.
11. For each item on the shipment, type or use the Finder to enter the
item number, location, quantity, and unit of measure for each item that
you are shipping. If working with serialized and/or lotted items, you
will be prompted to assign serial/lot numbers to items after specifying a quantity.
Click the Detail button to view all detail fields on a single entry form.
12.Enter the unit price or the extended price if it is different from the price
displayed by the program.
13.If necessary, enter comments, optional fields, and WIP account
information for job-related shipments.
14.Press the Insert key on your keyboard to start a new line. Repeat
steps 11 through 13 for each additional line you want to add to the
shipment.
15.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the shipment
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
16.Note the shipment number, and click OK at the confirmation message.
After using
Related topics

Receive Returned Goods from Customers
Before you start

To add returns from shipments of inventory in the I/C module:
1.Open Inventory Control > I/C Transactions > Shipments.
Click here for help on shipment fields.

Note: If you are entering returns from an order that was filled using
the Order Entry module, you should process the return in O/E.
2.Press the Tab key — with *** NEW *** displayed — to start a new
return. The program will automatically assign a document number
when you save or post the transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Return as the Entry Type.
4.Enter the Date of the return and the Year and Period of the
transaction.
Inventory Control automatically displays the logon date, and the fiscal
year and period that are associated with the date in Accpac's fiscal
calendar.
5.Enter an optional description and reference for the return.
6.If the shipment was to an existing A/R customer, enter the customer
number. (You can select customer numbers from the Finder beside
the Customer Number field.)
7.If you didn't specify an existing A/R customer, enter a contact name
(and other relevant information, such as a phone number).
8.Choose the price list that was in effect for the shipment. (You can
override any prices on the individual detail lines.) The program
automatically selects the default price list for the customer.
9.Click the Zoom button ( ) by the Optional Fields checkbox to add
optional field information to this return.

10.If you use multicurrency accounting, specify the currency for all
prices, and specify the exchange rate. Click the Zoom button ( ) to
change exchange rate information.
11. For each item being returned, type or use the Finder to enter the item
number, location, quantity, and unit of measure for each item. If
working with serialized and/or lotted items, you will be prompted to
assign serial/lot numbers to items after specifying a quantity.
Click the Detail button to view all detail fields on a single entry form.
12.Enter the unit price or the extended price if it is different from the price
displayed by the program.
13.If necessary, enter comments, optional fields, and WIP account
information for job-related returns.
14.Press the Insert key on your keyboard to start a new line. Repeat
steps 11 through 13 for each additional item being returned.
15.When you are ready, click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the return immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
16.Note the shipment number, and click OK at the confirmation message.
After using
Related topics

Use Goods Internally
Before you start

To take goods from inventory for your company's use:
1.Open Inventory Control > I/C Transactions > Internal Usage.
Click here for help on internal usage fields.

2.Press the Tab key — with *** NEW *** displayed — to start a new
transaction. The program will automatically assign a document
number when you click the Save or Post button.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Specify the date, fiscal year, and fiscal period to which you will post
the transaction in the general ledger.
4.Enter an optional description and reference for the internal use
transaction.
5.Enter or select the person in your company who ordered the goods. If
you use the US or Canadian Payroll module, you can choose
employees from the Finder.
6.Click the Zoom button ( ) to add optional fields for this transactions
(appears only if you use optional fields).
7.Add the detail lines, specifying the item number, category, location,
quantity, and unit of measure. If working with serialized and/or lotted
items, you will be prompted to assign serial/lot numbers to items after specifying
a quantity.
8.If you are entering an asset and use Sage FAS, see Record Internal Usage as a
Fixed Asset for Sage FAS for instructions on entering fixed asset information.
9.Enter an optional comment.
10.Enter optional fields, if you use them.
11. When you are ready, click the Save or Post button.
If you choose Save, Inventory Control saves the transaction so

you can edit and post it later.
If you choose Post, Inventory Control posts the transaction
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
13.If the program prompts you to delete the transaction, choose No
unless your company always deletes posted transactions. (You
cannot view or drill down to transactions if you delete them.)
14.Note the transaction number, and click OK at the confirmation
message.
After using
Related topics

Record Internal Usage as a Fixed Asset for Sage
FAS
Overview
Before you start

To record the internal use of inventory in Sage Fixed Assets:
1.Open Inventory Control > I/C Transactions > Internal Usage.
Click here for help on internal usage fields.

2.Create a new internal usage transaction, entering header information
as usual. (See Use Goods Internally for detailed instructions on entering
internal usage transactions.)
3.Click the detail-entry grid (if necessary, use the Insert key to start a
new line), and then click the Detail button or press the F9 key to use
the zoomed entry form.
4.Enter information for the item detail, including the item number for the
asset you are withdrawing from inventory, location, quantity, and unit
of measure, as usual.
5.Select the Fixed Assets option, and then click the Zoom button ( ) to
open the Fixed Assets form.
6.Enter information for the asset record as follows:
a.

If you want to use a different template than the one displayed on
the Fixed Assets form, use the Finder for the Sage FAS Template
field to select a different one. Otherwise, either accept the default
template code that appears or clear the entry from this field. (You
do not have to use a template to create the asset in Sage FAS.)

b.

Use the Description field to enter the description that you want to
use for the asset in Sage FAS.

c.

If you are using more than one asset item and you want to create
separate asset records for each one in Sage FAS, select the
Separate Assets option.
The program allocates the Sage FAS value entered on the Fixed
Assets form proportionately to each Sage FAS record it creates.

For example, for a quantity of 10 and a value of $25,000, the
program creates 10 asset records with a value of $2,500 each.
d.

In the Sage FAS Quantity field, type the quantity of asset items
you are removing for internal use. If working with serialized and/or
lotted items, you will be prompted to assign serial/lot numbers to items after
specifying a quantity.

e.

In the Sage FAS UOM field, type the unit of measure for the
quantity you entered.

f.

In the Sage FAS Value field, type the value to book for the asset in
Sage FAS.

7.Click Close to return to the detail entry form.
8.Click Add.
9.When you have finished adding details for the transaction, click Close
to return to the main Internal Usage form.
10.Click Add, and then click Close.
After using
Related topics

Transfer Goods between Two Inventory
Locations
verview

O

Before you start

To transfer goods directly to another inventory location:
1.Open Inventory Control > I/C Transactions > Transfers.
Click here for help on transfer fields.

2.Press the Tab key — with ***NEW*** displayed in the Document
Number field — to start a new transfer. The program will automatically
assign a document number when you save or post the transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Transfer as the type of transfer transaction you are entering.
This lets you move goods directly and instantly between two locations
—without using a goods-in-transit location or receiving goods at the
destination location.
4.Enter the transfer number from a previously entered transit transfer if
you are adding to the number of items being transferred.
For example, if the original transfer request included 10 pallets of
fertilizer, but you could only fit 5 in the truck, you can select the
previous transfer, and transfer the remaining 5 pallets.
Entering a Transfer Number field to complete a previously entered transfer.

5.Type over the Document Date if you want to change it (or click the
Calendar button to select a new date). Inventory Control automatically
displays the session date.
6.To change the year or period, type over the default entries or select a
new one from the fiscal calendar. This is the year and fiscal period to
which the general ledger transaction will be posted, no matter what
date you enter.
7.Enter an expected arrival date for the goods you are transferring.

8.If necessary, enter an additional cost amount. (For example, this may
be the shipping charges.)
9.If you entered an additional cost amount, select a proration method.
You can prorate by quantity, by weight, by cost, equally, or manually.
Selecting "Manually" allows you to enter each item’s share of the
additional cost in the Manual Proration field. All other options cause
the program to automatically calculate amounts (and you cannot use
the Manual Proration field).
10.Enter a description and reference for the transaction.
11. If you use optional fields, click the Zoom button ( ) beside the
Optional Fields checkbox to display the Optional Fields form.
12.Add the detail lines, specifying for each the item number, from and to
locations, requested quantity and unit of measure, and transfer
quantity.
If the transfer quantity is less than the requested quantity, the program
will fill in the Outstanding Quantity when you save or post the
transaction. You can create a new transfer transaction at a later time,
specifying this transaction number, to complete the transfer.
If working with serialized and/or lotted items, you will be prompted to
assign serial/lot numbers to items after specifying a quantity.
13.If you selected the manual proration option for an additional cost
amount, enter an amount in the manual proration field. When
transferring items that use the user-specified costing method, type the
unit cost and extended cost.
14.Enter any comments you want to add.
15.If you use optional fields, click the Zoom button ( ) to add optional
field information to individual detail lines.
16.Click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the transfer
immediately.

If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
17.Note the transfer number, and click OK at the confirmation message.
After using
Related topics

Transfer Goods Using a Goods-In-Transit
Location
verview

O

Before you start

To transfer goods to a goods-in-transit location to be received later
at another inventory location:
1.Open Inventory Control > I/C Transactions > Transfers.
Click here for help on transfer fields.

2.Press the Tab key — with ***NEW*** displayed in the Document
Number field — to start a new transfer. The program will automatically
assign a document number when you save or post the transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Transit Transfer as the Document Type (to move goods to a
goods-in-transit location while they are between physical inventory
locations).
4.Enter the transfer number from a previously entered transit transfer if
you are adding to the goods being moved into transit.
For example, if the original transfer request included 10 pallets of
fertilizer, but you could only fit 5 in the truck, you can select the
previous transfer, and transfer the remaining 5 pallets.
Entering a Transfer Number field to complete a previously entered transfer.

5.Type over the Document Date if you want to change it (or click the
Calendar button to select a new date). Inventory Control automatically
displays the session date.
6.To change the year or period, type over the default entries or select a
new one from the fiscal calendar. This is the year and fiscal period to
which the general ledger transaction will be posted, no matter what
date you enter.
7.Enter an expected arrival date for the goods you are transferring.

8.If necessary, enter an additional cost amount.
9.If you entered an additional cost amount, select a proration method.
You can prorate by quantity, by weight, by cost, equally, or manually.
Selecting "Manually" allows you to enter each item’s share of the
additional cost in the Manual Proration field. All other options cause
the program to automatically calculate amounts (and you cannot use
the Manual Proration field).
10.Enter a description and reference for the transaction.
11. If you use optional fields, click the Zoom button ( ) beside the
Optional Fields checkbox to display the Optional Fields form.
12.Add the detail lines, specifying for each the item number, the from
location, goods-in-transit location and to location, the requested
quantity and unit of measure, and the transferred quantity.
If working with serialized and/or lotted items, you will be prompted to
assign serial/lot numbers to items after specifying a quantity.
If you selected the manual proration option, enter an amount in the
manual proration field. When transferring items that use the userspecified costing method, type the unit cost and extended cost.
13.Enter any comments you want to add.
14.Add detail optional fields if you use them.
15.Click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the transfer
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.
If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
16.Note the transfer number, and click OK at the confirmation message.

After using
Related topics

Receive Goods from a Goods-In-Transit
Location
All goods that are transferred between locations using a goods-in-transit
location must be separately received at the destination location.
Before you start

To receive goods being transferred from another location:
1.Open Inventory Control > I/C Transactions > Transfers.
Click here for help on transfer & receipt fields.

2.Press the Tab key — with ***NEW*** displayed in the Document
Number field — to start a new transfer receipt. The program will
automatically assign a document number when you save or post the
transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Transit Receipt as the Document Type (to receive goods
that are in transit between physical inventory locations).
4.Enter the transfer number. This is the number assigned to the transfer
that you are receiving. The transfer details will appear on the form.
5.Type over the Document Date if you need to change it (or click the
Calendar button to select a new date). Inventory Control automatically
displays the session date.
6.To change the year or period, select a new one from the fiscal
calendar. This is the year and fiscal period to which the general ledger
transaction will be posted, no matter what date you enter.
7.Enter arrival date for the goods you are receiving.
8.If necessary, enter an additional cost amount.
9.If you entered an additional cost amount, select a proration method.
You can prorate by quantity, by weight, by cost, equally, or manually.
Selecting "Manually" allows you to enter each item’s share of the

additional cost in the Manual Proration field. All other options cause
the program to automatically calculate amounts (and you cannot use
the Manual Proration field).
10.Enter a description and reference for the transaction.
11. If you use optional fields, click the Zoom button ( ) beside the
Optional Fields checkbox to display the Optional Fields form.
12.For each item detail line on the receipt:
a.

Tab to the Transfer Quantity field and accept or enter the number
of items that you are receiving. If working with serialized and/or
lotted items, you will be prompted to assign serial/lot numbers to items after
specifying a quantity.

b.

If you selected the manual proration option, enter an amount in the
Manual Proration field.
When transferring items that use the user-specified costing
method, type the unit cost and extended cost.

c.

Tab to the Completed field. If you received all items, you can mark
the line as Completed. (If you received the full requested quantity,
the program will automatically mark the line as Completed when
you post the transaction.)
If you mark a line Complete before all goods are received, the
unreceived items will remain in the GIT location, and you will have
to create a new transfer to move them to the destination location.

d.

Enter any comments you want to add.

e.

Add detail optional fields if you use them.

13.Click Save or Post.
If you choose Save, Inventory Control saves the transaction so
you can edit and post it later.
If you choose Post, Inventory Control posts the transfer
immediately.
If you use the option to allow you to delete transactions after
posting, Inventory Control asks if you want to delete the
transaction.

If you delete the posted transaction, you will not be able to drill
down to the transaction details from General Ledger.
14.Note the transfer number, and click OK at the confirmation message.
After using
Related topics

Assemble Items from Bills of Material
Before you start

To assemble master items from bills of material:
1.Open Inventory Control > I/C Transactions > Assemblies.
Click here for help on item assembly fields.

2.Press the Tab key — with ***NEW*** displayed in the Assembly
Number field — to start a new assembly. The program will
automatically assign a document number when you save or post the
transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Assembly as the transaction type.
4.Enter an optional description and reference.
5.If necessary, choose a date from the calendar (click the Calendar
button beside the date field), and then choose a fiscal year and period
for the assembly.
6.Enter the (master) item number to be assembled or select it from the
Finder.
7.Enter the BOM (bill of material) number or select it from the Finder.
8.If this is a multi-level bill of material, choose how you want
components assembled.
9.Enter the location code or select it from the Finder.
10.Enter the quantity to assemble (a multiple of the Build Quantity). You
can click the Verify Quantities button to check that there are enough
items on hand for the quantity you are posting. If working with
serialized and/or lotted items, you will be prompted to assign serial/lot numbers
to items after specifying a quantity.
11. Click Save or Post, and then click OK at the message that displays
the assembly number.

Note that you cannot modify assembly transactions after you post
them.
After assembling items
Related topics

Disassemble Items
Before you start

To assemble master items from bills of material:
1.Open Inventory Control > I/C Transactions > Assemblies.
Click here for help on item assembly fields.

2.Press the Tab key — with ***NEW*** displayed in the Assembly
Number field — to start a new disassembly. The program will
automatically assign a document number when you save or post the
transaction.
Click the New button if ***NEW*** doesn't appear.
You can also enter a new transaction number yourself, and press
Tab.
3.Choose Disassembly as the transaction type.
4.Select the assembly that you are disassembling in the From
Assembly field. Leave the field blank if the From Assembly transaction
no longer exists.
Note: If you are disassembling a previous assembly, you can only
specify the quantity being disassembled and a disassembly cost.
5.Enter a description and reference for the disassembly (optional).
The program generates a general ledger transaction which debits the
inventory control account, and credits the items' assembly cost credit
accounts.
6.Enter the item number of the master item being disassembled, if you
did not specify an assembly, or select the number from the Finder.
Note that the program automatically displays a bill of material
number in the BOM Number field if you select the item number
from the Finder.
Any remaining amount in the master item's assembly cost credit
account represents the variable and fixed costs for the
disassembled items.

If you are disassembling a specific assembly, you cannot change the
item number.
7.Enter a number or type over the existing BOM number for the bill of
material to use for assembling or disassembling units of the master
item, or select the number from the Finder.
You can view (and edit) the bill of material you specify by clicking the
Zoom button beside the BOM Number field (or press F9) to open the
Bills Of Material form for the selected master item, (then click Close to
return to the Assemblies form).
If you are disassembling a specific assembly, you cannot change the
BOM.
8.If this is a multi-level bill of material (and subassemblies were
assembled in the selected assembly), choose how you want
components disassembled.
9.Specify the location where the master items are being disassembled.
10.Enter a disassembly cost.
11. To change the number displayed in the Quantity field, type over it.
Inventory Control automatically displays the bill of material's build
quantity in the bill of material's unit of measure. You may be prompted
to assign serial/ lot numbers if working with serialized and/or lotted items.
Note: The quantity must be a multiple of the number in the Build
Quantity field. For example, if the build quantity for the bill of material
is 25, then you must specify a multiple of 25 (such as 25, 50, or 75)
for the quantity, or the program will not allow you to save or post the
assembly.
10.When you are finished, click the Save or Post button.
After disassembling built items
Related topics

Post Inventory Transactions
verview

O

Before you start

To post inventory receipts, shipments, adjustments, transfer,
assemblies, and internal usage transactions:
1.Open Inventory Control > I/C Transactions > Post Transactions.
2.Choose the types of transactions that you want to post, and specify a
range of transactions (or accept the default ranges to post all
unposted transactions).
3.Click the Process button.
4.Click OK when posting is finished, and then close the Post
Transactions form.
Note: If the program displays a message that no transactions were
posted, this may mean that all transactions were posted immediately
when they were entered (using the Post button).
After posting
Related topics

Look Up Sales Statistics
If you use the Keep Item History option, you can View sales and return
statistics kept for each item.
To look up item sales statistics:
1.Open Inventory Control > I/C Statistics and Inquiries > Sales
Statistics.
Click here for help on Sales Statistics fields.

2.Enter or use the Finder to select the item number, location, and year
for which you want to see sales statistics.
3.Enter the number of the statistical period for which you want to see
sales statistics.
Related topics

Look Up Transaction Statistics
verview

O

To look up item transaction statistics:
1.Open Inventory Control > I/C Statistics and Inquiries > Transaction
Statistics.
Click here for help on Transaction Statistics fields.

2.Enter or use the Finder to select the item number, location, and year
for which you want to see transaction statistics.
3.Enter the number of the statistical period for which you want to see
transaction statistics.
Related topics

Look Up Sales Orders or Purchase Orders by
Item
verview

O

To look up sales orders or purchase orders that include a particular
inventory item:
1.Open Inventory Control > I/C Statistics and Inquiries > Item Location
Details Quantity Inquiry.
Click here for help on Item Location Details Quanity Inquiry fields.

2.Enter the number of the component item that you want to review, or
select it from the Finder. The following details are displayed for each
BOM in which the component appears:
Master item number
Master BOM number
Description of the BOM
Build quantity
Master unit of measure
Component's quantity in the build
Component's BOM number if the component is also a master item.
3.To view complete BOM details, highlight the row with the master item
number and BOM number that you want to review, and click the
Details button.
Related topics

Look Up Current Order Entry and Purchase
Order Transactions
verview

O

To look up Order Entry and Purchase Orders transactions:
1.Open Inventory Control > I/C Statistics and Inquiries > Current
Transactions Inquiry.
Click here for help on Current Transactions Inquiry fields.

2.Enter an item number in the Item Number field or select one using the
Finder.
3.Choose whether to inquire about Purchase Orders or Sales Orders by
using the drop-down list beside the .
4.Enter either:
The range of expected shipping dates, for sales orders
OR
The range of expected arrival dates, for purchase orders.
5.Click the Go button when you are satisfied with your selections.
Information about sales orders is presented under the following
column headings:
Order number
Customer
number
Customer name
Expected ship
date
Location

Original quantity
ordered
Unit of measure
Quantity shipped
Quantity
outstanding

Information about purchase orders is presented under the following
column headings:
Purchase order

Quantity ordered

number

Unit of measure

Vendor number

Quantity
received

Vendor name
Expected arrival
date

Quantity
outstanding

Location
6.To view further details about a transaction, highlight it and then click
the Details button.
Related topics

Look Up Transaction History
verview

O

To look up transactions:
1.Open Inventory Control > I/C Statistics and Inquiries > Transaction
History Inquiry.
Click here for help on Transaction History Inquiry fields.

2.To change the fiscal year and period, select a new one from the dropdown list beside the As At Year/Period field.
3.Enter the beginning and ending item numbers, or select them using
the Finders.
4.Enter the beginning and ending account set numbers, or select them
using the Finders.
5.Enter the beginning and ending location numbers, or select them
using the Finders.
6.When you are satisfied with your inquiry criteria, click the Go button.
7.A list of items matching your criteria is displayed. To view a list of
recent transactions involving an item, select the item from the list and
click the Details button.
8.The list includes the document number and other information about
the transaction.
9.To drill down to the original document, highlight a transaction and click
the Details button.
Sage ERP Accpac will display the original transaction unless it has been
cleared from the database.
Related topics

Look Up BOMs by Component
BOM Component Usage Inquiry lists all bills of material in which a
particular component item appears.
To look up BOMs that include a particular component item:
1.Open Inventory Control > I/C Statistics and Inquiries > BOM
Component Usage Inquiry.
2.Enter the number of the component item that you want to review, or
select it from the Finder. The following details are displayed for each
BOM in which the component appears:
Master item number
Master BOM number
Description of the BOM
Build quantity
Master unit of measure
Component's quantity in the build
Component's BOM number if the component is also a master item.
3.To view complete BOM details, highlight the row with the master item
number and BOM number that you want to review, and click the
Details button.
Related topics

Look Up Costs of LIFO and FIFO Items
verview

O

To look up the costs of LIFO and FIFO items on particular
transactions:
1.Open Inventory Control > I/C Statistics and Inquiries > LIFO/FIFO
Inquiry.
Click here for help on LIFO/FIFO Inquiry fields.

2.Select the account set or sets (LIFO or FIFO) for which you want to
view information.
3.Choose an item number or range of item numbers.
4.Select a location or locations.
5.Once you have made your selections, click the Go button ( ).
6.The information you requested is displayed in columns.
7.For further information concerning each item, highlight a line and click
the Details button. The following details are displayed in columns:
Document number
Date
Quantity received and cost
Quantity shipped and cost
Quantity available and cost
Information on items that have not yet been through day-end
processing is displayed beneath the columns.
8.Click the Close button to return to the LIFO/FIFO Inquiry form.
Related topics

Add Inventory Items Using the Items Wizard
Before you start

To add inventory items:
1.Open Inventory Control > I/C Items and Price Lists > Items Wizard.
Click here for help on Items Wizard fields.

Note: The Items Wizard leads you through the complete process for
adding inventory items. You can also use the Items form to add the
basic item record, and then add other information later.
Click here for a list of the individual inventory item information forms.

2.Click the Next button to move to the first item information page.
The Wizard lets you add new items or change information for existing
inventory items.
3.Click the New button next to the Item Number field, and then enter a
code for the item record that you want to add.
You can enter an item number directly, or click the Zoom button ( ) to
use the Construct Item Number form.
Note: You must make sure that the item structure that you select in
the Structure Code field matches your item number and will format the item
number as you want.
4.Continue filling in the fields on the first page of the Items Wizard. Use
the Finder button ( ) where available to see a list of the choices for
each field beside a field.
5.When you complete the first item information page, click the Next
button to move on.
6.Once you finish entering the required information for the item record,
you can click the Done button whenever you wish to save your item
and leave the Wizard.
Done. The Done button appears on the 4th Wizard page (if the
Serialized Inventory and Lot Tracking license is not installed). If you
are just adding basic item information, you can click the Done button
to add the inventory item.

You can add more item information later by selecting the item number
in the Item Wizard, or by using the other forms in the Items And Price
Lists folder.
Finish. The Finish button appears after you complete the last wizard
page for the item.
If you have to leave the wizard while adding an item, just click the
Done button.
The next time you start the Items Wizard, you can continue from the
last entry by entering the same Item Number, and then clicking the
Next button until you come to the point where you saved your work.
If you click the Cancel button, the Wizard will ask you if you want to
save your entries.
After adding inventory items
Related topics

Add Items to Locations
Overview
Before you start

To add items to locations:
1.Open Inventory Control > I/C Items and Price Lists > Location Details.
Click here for help on Location Details fields.

2.Enter an item number or select an item number from the Finder.
3.Tab to the entry grid and, if necessary, click the insert key to start a
new line, and then click the Finder button in the Location column
heading to choose the first location where you want to add the item.
4.Fill in the rest of the fields in the grid as follows:
a.

Enter a picking sequence number (often a bin number).

b.

Double-click the Allowed field to change it to Yes.
The "In Use" field will contain "No" until you post transactions for
the item the new location.

c.

Enter or select a cost unit of measure for the program to use when
costing transactions for the item at this location.

d.

Enter costing information for the item in the UOM selected in the
Cost Unit Of Measure column.
The program updates each time you process a receipt, transfer, or
assembly for the item and run day-end processing.
See Location Details fields for more information on costing fields.
Quantities are updated and displayed by the program when you
when you post inventory transactions for this location.

5.Click Save to save new information or changes.
Related topics

Add Bills of Material
Before you start

To add bills of material for manufacturing inventory items:
1.Open Inventory Control > I/C Items and Price Lists > Bills of Material.
Click here for help on Bills of Material fields.

2.Use the Finder to select the inventory item for which you are adding a
bill of material.
The item must already exist before you can add a BOM. (See Add
Inventory Items.)
3.Specify a BOM number or code. The number lets you define more
than 1 bill of materials for manufacturing a master item. You must
enter a BOM number (for example, "1").
4.Click the Go button ( ) to open the rest of the fields, and then add a
description for the BOM.
5.Enter the fixed cost for setting up a manufacturing run.
6.Specify the number of master items that 1 assembly of the BOM
produces.
7.Enter the variable cost for producing the build quantity of master
items.
8.Enter or choose the unit of measure for the build quantity.
9.If necessary, specify a period of time during which master items can
be assembled.
10.Add the components to the bill of material.
Components can also be master items. You can change or add
components to component BOMs.
11. Click the Add button when you are finished adding components.
Additional information — using BOMs instead if kits
Related topics

Add Kitting Items
Before you start

To add Kitting Items in Inventory Control:
1.Open Inventory Control > I/C Price Lists > Kitting Items.
Click here for help on kitting item fields.

2.Use the Finder to select the master Item Number.
3.Enter a Kitting Number, and then add a description.
4.Click the Go button ( ) to open the rest of the fields.
5.Use the Finder in the Component Item Number field to select
components for this kit.
6.Change the quantity or the unit of measure, if needed.
7.Enter a Unit Cost.
8.Click Add. (Or click Save if you are adding another item to a kit or
deleting an item from a kit.)
See the Order Entry online help for instructions about assigning lot
numbers to the components that are being tracked (if you use Sage ERP
Accpac Lot Tracking).
Additional information
Related topics

Add Bar Codes / Manufacturers' Numbers to
Items
Overview
Before you start

To add bar codes to items:
1.Open Inventory Control > I/C Items and Price Lists > Manufacturers'
Items.
Click here for help on Manufacturers' Items fields.

2.Enter or select the item number for which you want to add a code.
3.If necessary, press the Insert key to start a new line, double-click in
the first column, and type the new code for the inventory item.
You can use a scanner to enter bar codes.
4.Tab to the description field and enter a description.
5.Press Tab again, and use the Finder to select the unit of measure for
this code. You can use different codes for single items, cases, etc.
6.Tab to the last field to enter a comment for the code.
7.Click the Save button.
Related topics

Add Vendor Information to Items
Overview

To add vendor information to items:
1.Open Inventory Control > I/C Items and Price Lists > Vendor Details.
Click here for help on Vendor Information fields.

2.Enter or select the item number for which you want to add vendor
information.
3.Tab to the entry grid and, if necessary, press the Insert key to start a
new line.
If you have Sage ERP Accpac Accounts Payable, click the Finder
button in the Vendor Number column heading and select the vendor
that you are adding.
You can also add a new vendor here and manually enter the Vendor
name.
If you do not have Accounts Payable, double-click the Vendor
Number field to enter the code for your vendor.
Note on the Vendor Type...

4.Enter the other vendor details: vendor contact, vendor item number,
cost unit, vendor cost, and vendor currency (if you use multicurrency
accounting).
Either select the cost unit and vendor currency using the Finders or
manually enter the entries.
5.Click the Save button to save the vendor information.
Related topics

Add Customer Item Numbers
Overview

To add customer item numbers:
1.Open Inventory Control > I/C Items and Price Lists > Customer
Details.
Click here for help on Customer Details fields.

2.Enter or select the item number for which you want to add a customer
item numbers.
3.If necessary, press the Insert key to start a new line, and click the
Finder button in the first column heading to select the customer.
4.Tab to the Customer's Item Number field and enter the item number.
5.Enter the customer's description of the item.
6.Enter the unit of measure.
7.Enter relevant comments and particular instructions for handling or
shipping.
Comments and instructions appear on Orders when you use the
customer item number in Order Entry.
8.Click the Save button.
Related topics

Add Contract Prices for Customers
The Contract Pricing form lets you set up contract pricing for specific
customers.
Before you start

To add contract prices for customers:
1.Open Inventory Control > I/C Items and Price Lists > Contract Pricing.
Click here for help on Contract Pricing fields.

2.Enter the customer number or select one using the Finder for the
customer for whom you want to set up a contract price.
3.Select the pricing method you prefer: by item number or by category
code.
If you are pricing by Item Number:
If you are pricing by Category Code:

Fields in the lower portion of the form are displayed according to the
choices you made in the upper portion.
If you are pricing by Item Number
If you are pricing by Category Code

4.Using the Calendar icons, select the start and expiration dates of the
contract. You can leave these fields blank if you want the contract to
be open-ended.
These dates are used in Order Entry transaction entries when
determining the default item price.
5.Click the Add button to add the contract pricing to your data. You will
later be able to edit this contract or add another for the same
customer by using the Finder or the scroll buttons. You can also clear
expired contract prices by using the Clear History form.
Related topics

Add Picking Sequences / Bin Numbers to Items
Overview
Before you start

To add picking sequences / bin numbers to items:
1.Open Inventory Control > I/C Items and Price Lists > Location Details.
Click here for help on Location Details fields.

2.Enter an item number or select an item number from the Finder.
3.Highlight the location where you want to add the picking sequence,
and double-click the Picking Sequence column.
If you have not yet added the location:
a.

Tab to the entry grid,

b.

Click the insert key to start a new line.

c.

Click the Finder button in the Location column heading to choose
the location where you want to add the item, and where you want
to add the picking sequence.

4.Fill in the rest of the fields in the grid as follows:
a.

Enter a picking sequence number (often a bin number).

b.

Double-click the Allowed field to change it to Yes.
The "In Use" field will contain "No" until you post transactions for
the item the new location.

c.

Enter or select a cost unit of measure for the program to use when
costing transactions for the item at this location.

d.

Enter costing information for the item in the UOM selected in the
Cost Unit Of Measure column.
The program updates each time you process a receipt, transfer, or
assembly for the item and run day-end processing.
See Location Details fields for more information on costing fields.
Quantities are updated and displayed by the program when you
when you post inventory transactions for this location.

5.Click Save to save new information or changes.
Related topics

Add Item Reorder Quantities
Before you start

To item reorder quantities:
1.Open Inventory Control > I/C Items and Price Lists > Reorder
Quantities.
Click here for help on Reorder Quantities fields.

2.Enter or use the Finder to select the item number for which you want
to add reorder criteria.
3.Select whether you want to set reorder quantities for a specific
location or for all locations.
If you choose to set reorder quantities for a specific location, you
cannot later set quantities for the same item for all locations, unless
you first delete the reorder quantities for each of the specific locations.
Similarly, if you choose to set quantities for all locations, you cannot
later set quantities for a specific location unless you first delete the
quantities for all locations.
4.If you have chosen to set quantities for a specific location, enter the
location code, or use the Finder to select an inventory location. (You
must have previously allowed the item to be stocked at the location.)
5.Click the Go button [ ] (or press F7), then add the starting date and
the quantities for each desired period (press the Tab or Insert keys to
add a new line).
6.You can add optional field information for this item and location if you
assigned optional fields to reorder quantities records.
7.Click Save to save your entries.
After adding reorder quantities
Related topics

Assign Inventory Valuation Methods to Items
The account set that an item uses determines its item valuation method.
This means that assigning or changing the item valuation method really
involves two steps:
Step 1: If necessary, create a new account set for the item valuation
method.
Step 2: Use the Items form or the Items Wizard to assign the account set
to inventory items.
Before you start

To assign the inventory valuation method to an account set:
1.Open Inventory Control > I/C Setup > Account Sets.
Click here for help on Account Sets fields.

2.Fill in the fields on the Account Sets form as follows:
Account Set Code. Type a code of up to six characters to identify the
account set.
Description. Type a description for the account set.
Costing Method. Select the costing method that you want the
account set to use for valuing your inventory and determining the cost
of goods sold.
For more information, see Costing Methods.
General Ledger Accounts. Enter general ledger account numbers
for the inventory control, payables clearing, adjustment write off,
assembly cost credit, non stock clearing, transfer clearing, shipment
clearing, disassembly expense, and physical inventory adjustment
accounts that make up the set.
Click the Finder or press F5 to display a list of general ledger account
numbers. Highlight the account you want, and then press Enter to
select it.
3.Click the Add button.
To assign or change the inventory costing methods for an item:

Note: Inventory Control will display an error message if you attempt to
change account sets for an item while there are posted transactions for
the item for which Day End Processing has not been run.
1.Open Inventory Control > I/C Items and Price Lists > Items.
Click here for help on Items fields.

Or
Open Inventory Control > I/C Items and Price Lists > Items Wizard.
Click here for help on Items Wizard fields.

2.If adding a new item, see Add Inventory Items.
If changing the costing method for an existing item:
a.

If using the Items Wizard, click the Next button to move to the data
first entry Wizard page.

b.

Enter the item number or select the item number from the Finder.

c.

Click the Finder button beside the Account Set Code field.
The Finder displays the account set codes, along with their
description, status, and costing method.

d.

Select the new costing method, and then click the Save button at
the bottom of the form.
If using the Items Wizard, you will have to click the Next button
until the Done button appears, and then click Done to save the
changes.

Warning!
After changing inventory costing methods
Related topics

Assign Units of Measure to Items
Overview
Before you start

To add units of measure to Inventory Control:
1.Open Inventory Control > I/C Setup > Units of Measure.
Click here for help on Units of Measure fields.

2.Press the Insert key to start a new line, and then fill in the fields as
follows:
Unit of Measure. Use up to ten characters to identify the unit of
measure. (For example, "each," "crate," "pallet," etc.
Default Conversion Factor. Enter the factor for converting this unit to
the item stocking unit.
For example, if “each” is a stocking unit of measure (with a conversion
factor of 1), the conversion factor for “dozen” would be 12.
Note: Your inventory system can have more than 1 stocking unit with
a conversion factor of "1." See the Units of Measure form for more information.
3.Click the Close button.
To add units of measure to an item record:
1.Open Inventory Control > I/C Items and Price Lists > Items.
Click here for help on Items fields.

Or
Open Inventory Control > I/C Items and Price Lists > Items Wizard.
Click here for help on Items Wizard fields.

2.If adding a new item, see Add Inventory Items.
If adding a unit of measure for an existing item:
a.

If using the Items Wizard:
Click the Next button to move to the data first entry Wizard
page.
Enter the item number or select the item number from the

Finder.
Click the Next button again to move to the page containing
units of measure.
If using the I/C Items form:
Enter the item number or select the item number from the
Finder.
Click Units tab to move to the page containing units of
measure.
b.

Click a line in the Units of Measure grid, and press the Insert key
to start a new line.
Unit of Measure. Click the Finder in the column heading to select
from the list of all units of measure defined for Inventory Control.
If you allow undefined units of measure, you can enter the UOM
and tab directly to the conversion factor column.
Conversion Factor. If necessary, change the default factor for
converting this unit to the item stocking unit.
Stocking Unit of Measure. If you are adding the stocking unit of
measure, note the following points:
The conversion unit must be "1."
If another item is currently selected as the stocking unit of
measure, you must double-click that item in the Stocking UOM
column to set it to "No" before you can set the new UOM to
"Yes."

c.

Click the Save button at the bottom of the form.
If using the Items Wizard, you will have to click the Next button
until the Done button appears, and then click Done to save the
changes.

After adding or changing units of measure
Related topics

Assign Weight Units of Measure to Items
Overview
Before you start

To add weight units of measure to Inventory Control:
1.Open Inventory Control > I/C Setup > Weight Units of Measure.
Click here for help on Weight Units of Measure fields.

2.Press the Insert key to start a new line, and then fill in the fields as
follows:
Weight Unit of Measure. Type the weight unit of measure as you
want it to appear on data entry screens. For example, “lb” or “kg.”
Description. Enter a description for the unit of measure, such as
pound or kilogram.
Weight Conversion Factor. Enter the factor for converting this
weight unit to the default weight unit of measure. For example, if
“pound” is the default weight unit of measure (with a conversion factor
of 1), the conversion factor for “ton” would be 2,000.
You can use fractions in weight conversion factors even if you do not
use fractional inventory quantities. For example, the factor to convert
kilograms to pounds would be 2.2.
Default Weight UOM. You select the default weight unit of measure
in the I/C Options form. This is the unit in which the total order weight
is expressed in Order Entry.
1.0000 In Default Weight. The reciprocal of the conversion factor is
automatically calculated by Inventory Control. It provides a visual
check on the conversion factor.
See the Weight Units of Measure form for more information.
3.Click the Close button.
To add a weight unit of measure to an item record:
1.Open Inventory Control > I/C Items and Price Lists > Items.
Click here for help on Items fields.

Or
Open Inventory Control > I/C Items and Price Lists > Items Wizard.
Click here for help on Items Wizard fields.

2.If adding a new item, see Add Inventory Items.
If adding a weight unit of measure for an existing item:
a.

If using the Items Wizard:
Click the Next button to move to the data first entry Wizard
page.
Enter the item number or select the item number from the
Finder.
Click the Next button again to move to the page containing Unit
Weight field and Weight Unit of Measure field (beside the unit
weight).
If using the I/C Items form:
Enter the item number or select the item number from the
Finder.

b.

Use the Finder beside the Weight Unit of Measure field to select
the unit of measure that matches the unit weight for the item.
The program will display the conversion factor between the weight
unit of measure and the default weight unit of measure used for
orders in Order Entry and Purchase Orders.

c.

Click the Save button at the bottom of the form.
If using the Items Wizard, you will have to click the Next button
until the Done button appears, and then click Done to save the
changes.

After adding or changing weight units of measure
Related topics

Change Inventory Item Descriptions Using the
Items Wizard
Overview

To change inventory item descriptions:
1.Open Inventory Control > I/C Items and Price Lists > Items Wizard.
Click here for help on Items Wizard fields.

Note: The Items Wizard leads you through all of the information in the
Inventory Control module that is related to items.
Click here for a list of the individual inventory item information forms.

2.Click the Next button to move to the first item information page.
3.Click the Finder button ( ) next to the Item Number field, and then
select the code for the item record that you want to change.
4.Change the Item Description immediately below the Item Number
field.
This new description will appear when you look up item numbers
using the Finder in Inventory Control, Order Entry, Purchase Orders,
and Project and Job Costing forms.
However, you should also change the item descriptions for price lists,
and you can add comments regarding the changes to Customer
Details and Manufacturers' Item Numbers.
5.Click the Next button to move to the second information page.
Change the Additional Item Information, if necessary, to match the
description change.
6.Click the Next button until you reach the Item Pricing page. Doubleclick the description field to edit the item description for each of your
price lists.
This is the description that will appear by default on new detail lines in
the Order Entry module.
7.Click the Next button until you reach the Manufacturers' Item
Numbers page. You may want to note the name change in the
Comments field.

8.Click the Next button to reach the Customer Details page. Again, you
may want to note the name change to prevent possible confusion.
9.Click the Done button whenever you wish to save your changes and
leave the Wizard.
After changing item descriptions
Related topics

Copy Bills of Material
Before you start

To copy bills of material to new master items:
1.Open Inventory Control > I/C Items and Price Lists > Copy Bills of
Material.
Click here for help on Copy Bills of Material fields.

2.Specify the source and destination master item numbers and BOM
numbers by entering the From and To price list codes, and then click
the Go button ( ).
The destination item number must already exist. (See Add Inventory Items.)
3.Fill in the following information for the BOM that you are creating.
BOM Description. Enter a description to identify the bill of material
you are creating. The description is important if you use several
alternative BOMs to create the same master item.
Fixed Cost. Enter the setup cost for assembling the new bill of
material. The cost from the original BOM appears by default.
Build Quantity. Enter the number of master items that one assembly
of the bill of material produces. The build quantity from the original
BOM appears by default.
Variable Cost. Enter the cost for one assembly of the bill of material.
(In other words, one assembly produces the “build quantity” of master
items.)
Unit of Measure. Enter the unit of measure or use the Finder to
select the unit of measure that you want to assign to the master items
you create when you assemble the bill of material. The UOM from the
original BOM appears by default.
Start Date / End Date. This is the period of time during which the new
master item can be assembled.
Comments. Enter comments that you want to save with the new
BOM.
Copy Detail. By default, all component items from the old bill of

material will be copied to the new BOM. If you do not want to copy a
particular component, double-click the Copy column to change the
entry to No.
If you want to add items, you must edit the new BOM using the Bill Of
Materials form.
4.Click the Create button to copy the selected BOM.
After copying bills of material
Related topics

Update Bills of Material
Before you start

To update bills of material:
1.Open Inventory Control > I/C Items and Price Lists > Update Bills of
Material.
Click here for help on Update Bills of Material fields.

2.Enter the range of bills of material and BOM numbers that you want to
update or specify the range using the Finder.
3.Specify whether you are updating a cost or adding, removing, or
replacing a bill of material component, and then fill in the appropriate
fields:
For a component update
For a cost update

4.Click the Update button.
After updating bills of material
Related topics

Create a New Price List
Item pricing forms
Before you start

To create a new price list:
1.Add a new price list code using the Price List Codes form.
You select default options for customer discounts, price checks,
and taxes for the items you add to price lists.
Note: Each price list code can support one set of prices (including
discount, tax, and price check information) in each of the currencies
that you use in your business.
You do not need to add price list codes for each currency.
See Add Price List Codes for details.
2.Add items to the new price list using the Item Pricing form.
Or
Copy items to the new price list from an existing price list.
You can adjust prices while copying and select the information that
you want to copy.
You can copy prices from one currency to another, adjusting prices
for the different exchange rate.
After adding or changing prices
Related topics

Add Price List Codes
Overview
Other item pricing forms
Before you start

To add a new price list code:
1.Open Inventory Control > I/C Setup > Price List Codes.
Click here for help on Price List Codes fields

.

2.Fill in the Discounts tab, as described below:
Price List Code. Up to six characters to identify the price list.
Description. For example, "US mail order prices."
Price By. Whether the price of the item is based on weight or on
quantity. More information...
Price Decimals. The number of decimal places (up to 6) for
displaying and printing prices and costs.
Selling Price Based on. The default method for calculating discount
prices on this price list. More information...
If you are pricing by weight, you can choose Discount and Markup On
Markup Cost only.
Discount on Price by/Markup on Cost by. Select from this list the
method to be used to discount or mark up customer discounts. More
information...

Pricing Determined by. Select from this list the method you want to
use to determine price discounts for items. More information...
The selections you made for the previous three fields (Selling Price
Based On, Discount On Price By/Markup On Cost By, and Pricing
Determined By) determine which fields now appear in the lower part
of the Discounts tab.
Note: "A, B, C, D, E" denote the five possible types of customers to
which the discounts or markups you enter apply.
Customer types are assigned to customers in Accounts Receivable

and looked up when you add orders in Sage Order Entry.
See the Price List Codes field list for more information on each field.
3.Click the Price Check tab (in Sage ERP Accpac 500 only). This tab
lets you check price overrides when entering orders in Order Entry
that use this price list. Fill out this tab as follows:
Price Check Type. Choose how you want Order Entry to respond to
price overrides. More information...
Check. Choose whether the check should be done on the unit price
or on the sales margin.
Check Base. If you are checking the unit price, you can check that
the price falls within a percentage range of the cost, an amount range
on the cost, or within a fixed range.
Cost/Margin Base. Choose the cost on which you are calculating the
acceptable range of unit price or sales margin. (This field will not
appear if you choose a fixed unit price.)
User ID / Greater Than… / Less Than…. Enter the range of prices
available to each user ID. If you want, you can create several price
approval levels for sales clerks and supervisors.
The "Default" price check range applies to all users who are not
specifically listed in the grid. If you delete the price check for the
Default user, the program will only do price checks for the listed user
IDs.
4.Click the Taxes tab, and fill in the tax information as follows:
Authority. Enter a tax authority (such as state or province) or use the
Finder to select the tax authority that taxes sales of the item.
Cust. (Customer) Tax Class. Enter the customer tax class or use the
Finder to select a customer tax class for the tax authority.
For more information about tax authorities and tax classes, see the
help for Tax and Bank Services (in the Sage ERP Accpac System
Manager help).
5.Click the Add button, and then repeat these steps for each price list
code that you want to add.

After adding price list codes
Related topics

Add Items to Price Lists
Overview
Other item pricing forms
Typical steps for adding item prices to several price lists
Before you start

To add items to price lists:
1.Open Inventory Control > I/C Items and Price Lists > Item Pricing.
.

Click here for help on Item Pricing fields

2.Enter or use the Finder to select the number of the item for which you
want to add prices.
3.Click the New button to enter new prices.
If you are updating existing prices, double-click the line for the
currency and price list code that you want to change.
4.If you have a multicurrency system, choose the currency in which you
want to add pricing information.
5.Choose the price list code.
6.
Description. For example, "US mail order prices."
Price By. Whether the price of the item is based on weight or on
quantity. More information...
Price Decimals. The number of decimal places (up to 6) for
displaying and printing prices and costs.
Base Price Type. You can enter a base price for a single unit of
measure or for multiple units of measure, or you can calculate the
base price from a cost. More information...
Sale Price Type. You can set the sale price in exactly the same ways
that you set the base price: You can enter a sale price for a single unit
of measure or for multiple units of measure, or you can calculate the
sale price from a cost. More information...
See the discussion above on Base Price Type for more information.

Sale Starts. If you entered a sale price, enter the first date (in the
date format you use) for which the sale price applies.
Sale Ends. If you entered a sale price, enter the last date (in the date
format you use) for which the sale price applies.
Markup Cost. Enter a markup cost if you are setting up the price list
to calculate selling prices by marking up your cost.
Markup Unit. Enter item units or use the Finder to select the item
units in which the markup cost is expressed.
Markup Factor. Type the factor (number) by which you want to
multiply the markup cost to calculate the desired selling price for the
item. Note that this is a reference field (used on reports) and is not
used to calculate the selling price. The actual markup is entered on
the Discounts tab.
You can also see the Item Pricing field list for more information on each field.
7.Fill in the Discounts tab.
Selling Price Based on. The default method for calculating discount
prices on this price list. More information...
If you are pricing by weight, you can choose Discount and Markup On
Markup Cost only.
Discount on Price by/Markup on Cost by. Select from this list the
method to be used to discount or mark up customer discounts. More
information...

Pricing Determined by. Select from this list the method you want to
use to determine price discounts for items. More information...
The selections you made for the previous three fields (Selling Price
Based On, Discount On Price By/Markup On Cost By, and Pricing
Determined By) determine which fields now appear in the lower part
of the Discounts tab.
Note: "A, B, C, D, E" denote the five possible types of customers to
which the discounts or markups you enter apply.
Customer types are assigned to customers in Accounts Receivable
and looked up when you add orders in Sage Order Entry.

See the Price List Codes field list for more information on each field.
8.Click the Price Check tab (in Sage ERP Accpac 500 only).
This tab lets you check price overrides for this item in Order Entry.

9.Click the Taxes tab, and fill in the tax information as follows:
Authority. Enter a tax authority (such as state or province) or use the
Finder to select the tax authority that taxes sales of the item.
Cust. (Customer) Tax Class. Enter the customer tax class or use the
Finder to select a customer tax class for the tax authority.
For more information about tax authorities and tax classes, see the
help for Tax and Bank Services (in the Sage ERP Accpac System
Manager help).
10.Click the Add button, and then repeat these steps for each price list
code that you want to add.
After adding pricing information
Related topics

Change Pricing Information for Single Items
Overview
Other item pricing forms
Before you start

To change item pricing:
1.Open Inventory Control > I/C Items and Price Lists > Item Pricing.
.

Click here for help on Item Pricing fields

2.Enter or select the number of the item that you want to change.
3.Select the price list that you want to edit by double-clicking the line or
by highlighting the line and clicking the Open button.
4.On the detailed Item Pricing form, select the tab where you want to
make changes.
Choose the Prices tab to change base prices and sale prices.
Choose the Discounts tab to change discount or markup
information for calculating item prices for volume sales or preferred
customers.
Use the Price Check tab to set checks for price overrides in Order
Entry.
Use the Taxes tab to change tax authorities and customer tax
classes for taxes that are included in the item price.
See the Item Pricing field list for information on Item Pricing fields.
5.Click the Save button when you are finished.
After changing pricing information
Related topics

Update Pricing Information for Groups of Items
The Update Item Pricing form copies pricing information from one price
list or currency to another, adding items to the new or existing price list.
Other item pricing forms
Before you start

To update item pricing:
1.Open Inventory Control > I/C Items and Price Lists > Update Item
Pricing.
.

Click here for help on Update Item Pricing fields

2.Use the Finder to specify the range of price lists that you want to
update.
3.Choose how you want to select items for updating.
4.Use the Finder to specify the range of items to include in the update
(using the selection criteria).
5.Select the kind of change and the method of updating, then, for prices
or costs, specify the increase or decrease.
If you have a multicurrency system, you can update prices by
currency and exchange rate.
6.Click the Update button to update the selected price lists.
After updating pricing information
Related topics

Copy Pricing Information to Other Price Lists or
Currencies
Overview
Additional features
Other item pricing forms
Before you start

To copy item pricing:
1.Open Inventory Control > I/C Items and Price Lists > Copy Item
Pricing.
.

Click here for help on Copy Item Pricing fields

2.If you have a multicurrency system, enter the currency from which you
want to copy item pricing information, or use the Finder to select the
currency.
3.Enter a price list code or use the Finder to select the price list from
which you want to copy item pricing information.
4.If you have a multicurrency system, enter a currency code or use the
Finder to select the currency to which you are copying pricing
information.
5.Enter a price list code or use the Finder to select the price list to which
you want to copy pricing information.
6.Specify the method for selecting the range of item pricing that you
want to copy.
7.Select the pricing information that you want to copy.
8.Specify how you want to change pricing information. You can specify
a percentage increase or decrease, or apply an exchange rate in a
multicurrency system.
9.Click the Copy button to copy pricing information for the selected
range of items.
After copying pricing information
Related topics

Perform Day-End Processing
verview

O

Before you start

To perform day-end processing:
1.Open Inventory Control > I/C Periodic Processing > Day End
Processing.
2.Click Process.
3.When the message appears to indicate that processing is complete,
click the OK button or press Enter to close the message and the Day
End Processing form.
After using
Related topics

Process Adjustments Automatically
Which form should I use to process adjustments?
Can I adjust material usage for a project?
Before you start

To process adjustments automatically:
1.Open Inventory Control > I/C Periodic Processing > Process
Adjustments.
Click here for help on Process Adjustments fields.

2.Enter the range of item numbers for which you want to create
adjustments.
3.Enter the range of locations for which you want to create adjustments.
4.Choose one of the following types of adjustments:
Total cost to zero for items with zero quantities
Total quantity to zero for items with zero total cost
Total cost for items with non-zero quantities and zero total cost.
If you choose "Total cost for items with non-zero quantities", you
must also choose the type of cost to which you want the cost
adjusted:
Standard cost
Most recent cost (includes the tax)
Last Unit cost (does not include the tax)
User defined cost 1
User defined cost 2
5.Click Process.
After using
Related topics

Delete Inactive Records
Before you start

To delete inactive records:
1.Open Inventory Control > I/C Periodic Processing > Delete Inactive
Records.
Click here for help on Delete Inactive Records fields.

2.Select the types of inactive records to delete.
3.Enter the range of codes or numbers to delete for each record type
that you selected.
4.Type the range of dates for which to delete records.
Inventory Control selects records that have a status of Inactive and a
corresponding "Inactive" date within the range of dates you specify.
By default, the To date is the current session date.
If you do not want to delete all the records for the same range of
inactive dates, process each set of records separately.
5.Click Process.
After using
Related topics

Clear History
Before you start

To clear history:
1.Open Inventory Control > I/C Periodic Processing > Clear History.
Click here for help on Clear History fields.

2.To clear transaction history, select the Transaction History option, then
select the year and period up to which to clear history.
3.To clear transaction statistics, select the Transaction Statistics option,
then select the year and period up to which to clear statistics.
4.To clear sales statistics, select the Sales Statistics option, then select
the year and period up to which to clear statistics, and the range and
type of records to clear.
5.To clear printed posting journals, select the Printed Posting Journals
option, then select the type of posting journal to clear and the day-end
number up to which to clear.
6.To clear item labels that you printed from receipts, select the Printed
Labels option, then specify the range of receipt numbers to clear.
7.To clear contract prices that are no longer valid, select the Expired
Contract Prices option, and then specify the expiry date that you want
to include.
8.To clear transactions, select the Transactions option, then specify the
most recent transaction date that you want to clear. Note that you
cannot drill down to deleted transactions, or do returns for deleted
receipts.
9.To clear serial numbers, select the Serial Numbers option and specify
the date up to which you want to clear the numbers. You can also
choose to clear numbers that have expired contract information.
10.To clear lot numbers, select the Lot Numbers option and specify the
date up to which you want to clear the numbers. You can also choose
to clear numbers that have expired contract information.
11. To clear serial number history, select the Serial History option and

specify the date up to which you want to clear. You can also choose to
clear history with expired warranty information.
12.To clear lot number history, select the Lot History option and specify
the date up to which you want to clear. You can also choose to clear
history with expired warranty information.
13.Click Process to clear the specified data.
After using
Related topics

Create G/L Batch
verview

O

Before you start

To create a batch of G/L transactions:
1.Open Inventory Control > I/C Periodic Processing > Create G/L Batch.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Click Process.
After using
Related topics

Count and Reconcile Inventory Quantities
verview

O

Detailed procedures
Before you start

To count and reconcile inventory quantities:
1.Open Inventory Control > I/C Physical Inventory > Generate Inventory
Worksheet.
Follow these instructions to generate inventory worksheets.

The
2.Open Inventory Control > I/C Physical Inventory > Inventory
Worksheet.
Follow these instructions to print the inventory worksheets that you generated.

3.Count the items in stock.
4.Enter counted item quantities using one of the following forms:
Inventory Control > I/C Physical Inventory > Physical Inventory
Quantities.
The Physical Inventory Quantities form also lets you view, edit,
and delete inventory worksheets that you created.
Follow these instructions to use the Physical Inventory Quantities form.

Or
Inventory Control > I/C Physical Inventory > Inventory Counts.
The Inventory Counts form is a simpler version of the Physical
Inventory Quantities form, which only lets you enter inventory
counts after taking inventory.
Follow these instructions to use the Inventory Counts form.

5.Open Inventory Control > I/C Physical Inventory > Inventory
Reconciliation.
Follow these instructions to print the Inventory Reconciliation report.

The Reconciliation report shows the counts and costs that will be
posted when you post the inventory reconciliation.

6.Open Inventory Control > I/C Physical Inventory > Post Inventory
Reconciliation.
Follow these instructions to post the inventory reconciliation.

The program creates adjustment transactions when you post
inventory reconciliations.
7.Print the Inventory Reconciliation report again to check for any items
that the program could not post.
After completing a physical inventory
Troubleshooting unposted transactions
Related topics

Generate Inventory Worksheets for Stocktaking
verview

O

Warning!
Before you start

To generate inventory worksheets:
1.Open Inventory Control > I/C Physical Inventory > Generate Inventory
Worksheet.
Click here for help on Generate Inventory Worksheet fields.

2.Specify the range of locations and account sets for which you require
the worksheet.
3.Specify the order in which you want to list items on the worksheet.
This is also the method by which you will select the items that you
want to list. For example, you can choose a range of item categories
or item numbers, or you can select a warehouse area by choosing a
range of picking sequences (bin numbers).
4.Type an optional comment to be printed on the worksheet.
5.Specify which items you want to include on the worksheet.
Items from Location Only, to select only the items in the Sort By
range that are assigned to the locations for which you are
generating worksheets.
In Use Items Only, to select only the items in the Sort By range
that are assigned to and have been used in one or more
transactions at the locations for which you are generating
worksheets.
All Items from Inventory List, to select all the items in your
inventory that are in the Sort By range.
Note: Items are included regardless of whether they are currently
allowed to be used in Inventory Control transactions.
6.Select the Default Quantity On Hand choice if you want Inventory
Control to automatically display the current quantity on hand in the
Counted Quantity column in the Physical Inventory Quantities form or

the Inventory Counts form when you enter counts in Inventory
Control.
You can later print the current quantity on hand on Inventory
Worksheets whether or not you chose the Default Quantity On Hand
choice when you generate the inventory worksheet.
7.Click Generate, and then click OK from the message that appears.
After generating physical inventory worksheets
Related topics

Print Inventory Worksheets for Stocktaking
verview

O

Before you start

To print inventory worksheets:
1.Open Inventory Control > I/C Physical Inventory > Inventory
Worksheet.
2.Make your selections as follows:
From Location [ ] to [ ]. Enter location codes or use the Finder to
select the range of locations at which you want to count inventory.
Include. Select the information to include in the report.
Unit Cost. Prints the unit cost for each item on the worksheet.
Quantity. Prints the quantity on hand for each unit of measure
defined for each selected item.
You can print the current quantity on hand in the Counted Quantity
column — whether or not you chose the Default Quantity On Hand
choice when you generated the inventory worksheet.
Comment. Includes space for a comment for each item. Use the
comment line to record remarks while doing the physical count.
3.To begin printing, click the Print button.
After printing physical inventory worksheets
Related topics

Enter Stocktaking Quantities Using the
Inventory Counts Form
verview

O

Before you start

To enter physical inventory quantities using the Inventory Counts
form:
1.Open Inventory Control > I/C Physical Inventory > Inventory Counts.
.

Click here for help on Inventory Counts fields

2.Enter the location code or use the Finder to select the code
3.Enter the starting item number or use the Finder to select the item
number code.
4.If you use Optional Fields, use the Zoom button ( ) to edit optional
fields that apply to the whole worksheet.
5.Enter the physical count or edit the displayed count in the Quantity
Counted column.
If you are working with serialized and/or lotted items, a form will
appear after you specify a quantity counted, prompting you to assign
numbers to the items. You can also display this form by pressing the
Zoom button or pressing the F9 key with your cursor in the Quantity
Counted column.
If you have more than one unit of measure defined for an item, you
can enter counted quantities in any unit, or combination of units, by
following these steps:
a.

Press F9 in the detail grid to open the Quantities detail form that
displays the units of measure defined for the item.

b.

Enter new counts in the Quantity Counted columns beside each
unit of measure.

c.

Click the navigation buttons to move to another item.

d.

Click Close to save your changes. This closes the Quantities detail
form and returns you to the Inventory Counts form.

6.If you use optional fields with item details, use the Zoom button ( ) to
edit optional fields information.
7.When you are finished, click Close to save your changes and close
the Inventory Counts form.
After entering inventory counts
Related topics

Enter Stocktaking Quantities Using the Physical
Inventory Quantities Form
verview

O

Before you start

To enter physical inventory quantities using the Physical Inventory
Quantities form:
1.Open Inventory Control > I/C Physical Inventory > Physical Inventory
Quantities.
Click here for help on Physical Inventory Quantities fields

.

2.Enter the location code or use the Finder to select the code
3.Enter the starting item number or use the Finder to select the starting
item number for the worksheet.
4.If you use Optional Fields, use the Zoom button ( ) to edit optional
fields that apply to the whole worksheet.
5.Enter or edit the physical count, adjustment cost, and status for each
item on the worksheet. (If you selected the Default Quantity On Hand
option in the Generate Inventory Worksheet form, the current
quantities on hand are inserted for each item in the Quantity Counted
column, but you can change the figures.)
If you are working with serialized and/or lotted items, a form will
appear after you specify a quantity counted, prompting you to assign
numbers to the items. You can also display this form by pressing the
Zoom button or pressing the F9 key with your cursor in the Quantity
Counted column.
If you have more than one unit of measure defined for an item, you
can enter quantities in any unit, or combination of units, by following
these steps:
a.

Press F9 in the detail grid to open the Quantities detail form that
displays the units of measure defined for the item.

b.

Enter new counts in the Quantity Counted columns beside each
unit of measure.

c.

Click the navigation buttons to move to another item.

d.

Click Close to save your changes. This closes the Quantities detail
form and returns you to the Physical Inventory Quantities form.

6.If you use optional fields with item details, use the Zoom button ( ) to
edit optional fields information.
7.When you are finished, click Close to save your changes and close
the Physical Inventory Quantities form.

Importing and Exporting from the Physical
Inventory Quantities Form
You can use the Import and Export commands under the File menu of the
Physical Inventory Quantities form to import and export data from/to your
inventory control system. The procedure is slightly different from the way
most Sage ERP Accpac forms import and export data. Instead of one file,
the import/export process involves two files. The first file contains the
worksheet and optional fields data, while the second file contains all other
data.
When exporting, make sure you use two different file names when
prompted to do so. When importing, make sure you select the file with
the worksheet and optional fields data first, then the second file.
After entering inventory counts
Related topics

Print the Inventory Reconciliation Report
verview

O

Before you start

To print the Inventory Reconciliation report:
1.Open Inventory Control > I/C Physical Inventory > Inventory
Reconciliation.
2.Make your selections as follows:
Location [ ] to [ ]. Specify the range of locations to include in the
report.
Show Only Items with Quantity Variance. Select this option to list
only those items that show a variation between the quantity on hand
recorded in Inventory Control and the physical count you entered in
the Physical Inventory Quantities form. The report then excludes
items for which the totals are the same in Inventory Control as in your
physical count.
Include Comment for Each Item. Select this option to print a blank
comment line for each item listed in the report.
Include [ ]. Select from two types of report.
All Units of Measure. The report lists quantities counted for each
unit of measure.
Stocking Unit Only. The report lists total quantities counted in the
stocking unit of measure only.
3.To begin printing, click the Print button.
After printing the Inventory Reconciliation report
Related topics

Post Inventory Reconciliation
verview

O

Before you start

To post inventory reconciliations:
1.Open Inventory Control > I/C Physical Inventory > Post Inventory
Reconciliation.
Click here for help on Post Inventory Reconciliation fields.

2.Enter or use the Finder to select the range of locations for which you
want to post reconciliation adjustments.
3.Enter the transaction date, fiscal year, and period to which you will
post the transaction.
4.Enter a reconciliation number and an optional description or
reference.
5.When you are finished, click Post, then click OK for the message that
appears.
6.Click Close to close the Post Inventory Reconciliation form.
After posting inventory reconciliations
Related topics

Change Inventory Control Processing Options
Overview
Changing settings
Before you start

To change I/C processing options:
1.Open Inventory Control > I/C Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
These are the options you can select or change on the Processing tab
in the I/C Options form.
Accumulate (item statistics) By
Additional Cost For Items On Receipt Returns
Allow Edit Of Statistics
Allow Fractional Quantities
Allow Items At All Locations
Allow Negative Inventory Levels
Allow Receipt of Non-Stock Items
Alternate Amount (1 or 2) Name
Cost Items During (Posting / Day End Processing)
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing)
Default Goods In Transit Location
Default Posting Date
Default Rate Type
Default Weight Unit of Measure
Functional Currency
Keep Item Statistics
Keep Transaction History
Multicurrency option
Only Use Defined UOM
Period Type
Prompt To Delete During Posting
Weight Unit Of Measure

Note:
Costing items and creating subledger transactions and audit
information during posting will increase the time it takes to post
transactions in Inventory Control, Order Entry, and Purchase
Orders.
If you change from updating costs during day end processing to
updating costs during posting, you must first run day end to cost all
outstanding posted transactions.

3.Click the Save button to save any changes to processing options.
After changing I/C Options
Related topics

Change Posting and Day End Processing
Options
Overview
Before you start

Note: You cannot change Posting or Day End Processing options if any
other Inventory Control forms are open, or other users are working with
the Inventory Control database.
To change day end processing options:
1.Open Inventory Control > I/C Setup > Options.
.

Click here for help on all Options fields

2.Click the Costing tab.
3.Change the appropriate option.
Cost items during posting or Day End Processing
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing)

4.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
To change G/L batch creation and posting options:
1.Open Inventory Control > I/C Setup > G/L Integration.
Click here for help on all G/L Integration fields

.

2.Change the appropriate option.
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by

3.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
After changing Day End Procesing and posting options
Related topics

Change General Ledger Integration Options
Overview
Before you start

To change General Ledger integration options:
1.Open Inventory Control > I/C Setup > G/L Integration.
Click here for help on all G/L Integration fields

.

2.The Integration tab lets you change:
When I/C creates transactions for posting to the General Ledger.
You can choose to create transactions when I/C costs inventory
items (this is set in the I/C Options form) or using the Create G/L
Batch form.
Note: This choice can have a large impact on the speed of
processing inventory transactions and transactions in Order Entry.
If you are costing inventory during posting, you may want to create
transactions at a later date.
Whether I/C adds new transactions to existing G/L batches or
creates new batches (and, optionally, automatically posts the new
batches).
Whether I/C consolidates G/L transactions to send less detail to
the general ledger. (This choice can also limit drilldown from the
general ledger.)
The codes attached to each transaction sent from Inventory
Control.
New source codes are automatically added to G/L, but you will
have to update G/L source journal profiles to include transactions
on source journals.
Any changes you make will apply only to general ledger transactions
created after the change, and will not affect existing general ledger
batches.
3.Click the Transaction tab to change the information that appears with
G/L transactions for the Entry Description, Detail Description, Detail

Reference, and Comment fields.
The Entry grid lists each of the transactions produced by Inventory
Control, and displays the information that is currently included in G/L
transactions produced from these I/C transactions.
a.

Double-click the transaction description or transaction detail
information that you want to change.

b.

On the form that appears, highlight the information that you want
to add to the transaction field, and use the Include and Exclude
buttons to add or remove field information.
You can assign one or more pieces of information (segments) to
each G/L transaction field, provided that the combined length of
the segments and separators does not exceed 60 characters.
Fields exceeding this limit will be truncated when you post the
general ledger transactions.

c.

Click Save to save the contents of the G/L transaction field.

d.

Choose a different field to edit, or click Close to return to the
Transaction tab.

4.Click Save to save changes to the G/L Integration form.
After changing G/L Integration Options
Related topics

Add Optional Fields to Item Records and
Transactions
Overview
Before you start

To add optional fields to items, reorder records, transactions, and
transaction details:
1.Open Inventory Control > I/C Setup > Optional Fields.
Click here for help on all Optional Fields setup fields

.

2.Select a record/transaction type from the Optional Fields For list.
.

Click here for more information

3.Click in the optional field entry grid, and then press the Insert key on
your keyboard to start a new line.
4.Click the Finder (or press F5) in the Optional Field column, then
choose an existing optional field from the Finder list. (The description
will appear automatically.)
5.Click the Finder in the Default Value column, then choose the value
for the optional field selected in step 3.
6.Toggle in the Auto Insert column to:
Choose Yes if you want to allow the optional field (and its default
value) to appear in new records and transactions.
Choose No if you do not want the optional field to appear
automatically.
7.Click the Settings button to select the G/L accounts that this optional
field will be included with for G/L transactions and transactions sent to
other subledgers.
Click here for a list of G/L accounts for items and transaction details.

Consider carefully the purpose of each optional field that you add.
For example, only send optional fields to General Ledger that are
used for financial analysis, and only to the accounts where they are
required.

8.Click the Close button to close the Settings form. Click the add button
on the I/C Optional Fields form, and then click Close.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
After adding optional fields to I/C
Related topics

Allow Editing of Sales or Transaction Statistics
Overview
Before you start

To change I/C processing options:
1.Open Inventory Control > I/C Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
3.Change the Allow Edit Of Statistics option.
4.Click the Save button to save any changes to processing options.
After changing statistics
Related topics

Select a Printer for Reports
Sage ERP Accpac lets you choose a default printer for all reports that
you print, and assign different printers to specific reports (such as
invoices or labels).
To change the default printer for all reports:
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
To assign a specific report to a specific printer:
1.Open the report form which you want to assign to a printer.
2.From the menu on the report form, Select File > Print Setup.
3.Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.
Note: By default, the specific printer is the one chosen as the printer
on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop.

The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Choose a paper source if you want to select a particular paper tray or
paper stock for this report.
5.Click OK to close the Print Setup page.
To clear the assigned printer for this report
Prompt for printer each time you print
Related topics

Print Reports to a Printer
verview

O

If your printer is already set up, follow these instructions to change
the print destination back to Printer:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Printer as the print destination.
3.Click OK.
If you have not yet selected a printer for Sage ERP Accpac, follow
these instructions to choose a default printer for printing all reports
from Sage ERP Accpac.
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Microsoft Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
Related topics

Print Reports to the Screen
verview

O

To change the default print destination to Preview:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Preview to view a report on the screen.
You can also print from the Preview window by clicking the Printer
button.
3.Click OK.
Additional information regarding print destinations
Related topics

Print Reports to a File
verview

O

To change the default print destination to File:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select File to save your report as a file in your usual print file folder.
3.Click OK.
When you print to a file, the report is assigned a unique name, for
example, CS1000.TXT.
Related topics

Print Reports as an E-mail Attachment
verview

O

To change the default print destination to E-mail:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select E-mail to create a file that can be attached to an e-mail.
3.Select either Adobe Acrobat (PDF) or Rich Text Format (RTF) as the
file format for the e-mail attachment.
You can open PDF files with Adobe Acrobat Reader (available as a
free download from the Adobe Software website).
You can open RTF files with most Windows and Linux word
processing programs.
4.Click OK.
When you print with an e-mail destination
Related topics

Print Inventory Item Labels
verview

O

Before you start

To print item labels:
1.Open Inventory Control > I/C Stock Control Reports > Item Labels.
2.Make your selections in the following fields:
For Each Item [ ]. Use this field to select the items for which you want to
print labels.
Use Label.Enter the name of the file (including the file extension) that
contains the format for the labels you want to print, or choose the
default filename. If you do not know the file name or the location of
the file you want to use, click the Browse button to select from the list
of directories and files.
If you choose to print labels for each item Received, make your
selections.
If you choose to print labels for each item On File or In Stock, specify
the label format in the Use Label field as described earlier, then make
your selections.
From [ ]To [ ]. Specify the range of item numbers, categories,
segments, picking sequences, or optional field entries to include in the
label run.
3.You can either print the labels or print a sheet of dummy labels to test
your format and the alignment of label forms in your printer.
4.To print a test sheet of labels to check the alignment of the forms in
your printer, click the Align button. This button can only be clicked if
the printing destination is Printer.
5.To begin printing labels, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.

If you are printing to a file, Inventory Control displays the name of the
file so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
Related topics

Print Bin/Shelf Labels
verview

O

Before you start

To print bin/shelf labels:
1.Open Inventory Control > I/C Stock Control Reports > Bin/Shelf
Labels.
2.Make your selections for the following fields:
Location. Select the location.
Currency. If you use multicurrency accounting, select the currency of
the price list for which you want to print labels.
Use Label. Enter the name of the file, including the RPT file extension,
that contains the format for the labels you want to print, or choose the
default filename.
If you do not know the file name or the location of the file you want to
use, click the Browse button to select from the list of your directories
and files.
Price List. Select a price list for the labels.
Sort by. Specify the order in which to generate labels.
From [ ] to [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the label run.
You can either print the labels or print a sheet of dummy labels to test
your format and the alignment of label forms in your printer.
3.To begin printing labels, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file so you can change it or cancel printing.

If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
Related topics

Print Setup Reports
verview

O

To print setup reports:
1.Open Inventory Control > I/C Setup Reports.
2.Choose the report that you want to print.
3.Press F1 when the print form appears for detailed information on
report options.
4.To begin printing, click the Print button.
Related topics

Assigning Serial/Lot Numbers During Receipt
of Goods
When receiving serialized and/or lotted items from suppliers, you can
assign serial and/or lot numbers in the I/C Receipts form to retain a full
transaction history.
1.Select I/C Transactions > Receipts to display the I/C Receipts form if you
haven't already done so.
2.Process the receipt as per usual. After selecting a serialized and/or
lotted item and entering a quantity, an allocation form appears for you
to assign serial/lot numbers to the items.
3.If receiving a serialized item, select the Serials tab. You can accept or
change the default number that appears in the Next Serial Number
field, then click Add to individually add one serial at a time. Or click
Auto-Gen to automatically assign the required number of serials. As
well, you can press the Insert key and manually enter the number or
use the Finder in the Serial Number column to manually select the
serials from the list of available numbers for the specified location.
4.If receiving a lotted item, select the Lots tab. Use the Make X Lots
OR Each Lot has X fields to define the number and quantity of lots
you want to work with. Accept or change the default number that
appears in the Next Lot Number field, then click Add to individually
add lots or click Auto-Gen to automatically assign the required
number of lots. As well, you can press the Insert key and manually
enter the number.
Tip: Make sure the numbers conform to the mask defined in setup
when manually entering serial and/or lot numbers.
5.Click Close to return to the underlying transaction in the I/C Receipts
form. Continue processing, then post the transaction. Be sure to
assign the required number of serials/lots, as an error message will
appear when you try to exit the form if you don't. Refer to the count
section at the bottom of the form to see what remains to be assigned.
You may wish to update the status of the serial or lot numbers you
assigned during receipt. For instance, you can add an expiry date to a

serial or to put a lot on quarantine. Use the Serial Numbers or Lot Numbers form in
I/C Items and Price Lists to do so.
See also:
Understanding Serialized Inventory and Lot Tracking
Receiving Goods From Vendors

Assigning Serial/Lot Numbers to Adjustments
When making inventory adjustments that deal with serialized and/or
lotted items, you can assign serial and/or lot numbers in the I/C
Adjustments form to retain a full transaction history. There are eight kinds
of adjustments you can make, each which may require the assignment of
serial and/or lot numbers.
1.Select I/C Transactions > Adjustments to display the I/C Adjustments form if
you haven't already done so.
2.Process the adjustment as per usual. The respective number
generation/allocation form appears when specifying quantities for
serialized and/or lotted items and performing one of the following
adjustment types: Quantity Increase, Quantity Decrease, Cost
Increase, Cost Decrease, Both Increase, Both Decrease.
3.If increasing quantity for a serialized item, select the Serials tab. You
can accept or change the default number that appears in the Next
Serial Number field, then click Add to individually add one serial at a
time. Or click Auto-Gen to automatically assign the required number
of serials. As well, you can press the Insert key and manually enter
the number or use the Finder in the Serial Number column to
manually select the serials from the list of available numbers for the
specified location.
If decreasing quantity for a serialized item,
If adjusting cost only, or both cost and quantity,

4.If increasing quantity for a lotted item, select the Lots tab. Use the
Make X Lots OR Each Lot has X fields to define the number and
quantity of lots you want to work with. Accept or change the default
number that appears in the Next Lot Number field, then click Add to
individually add lots or click Auto-Gen to automatically assign the
required number of lots. As well, you can press the Insert key and
manually enter the number or use the Finder in the Lot Number
column to manually select the lots from the list of available numbers
for the specified location.
If decreasing quantity for a lotted item,
If adjusting cost only, or both cost and quantity,

5.Click Close to return to the underlying transaction in the I/C
Adjustments form. Continue processing the adjustment, and post. Be
sure to assign the required number of serials/lots, as an error
message will appear when you try to exit the form if you don't. Refer
to the count section at the bottom of the form to see what remains to
be assigned.
For help about fields and buttons on the generation/allocation forms, click
the Field List button at the top of this help page.
See also:
Understanding Serialized Inventory and Lot Tracking
I/C Adjustments

Assigning Serial/Lot Numbers to
Assemblies/Disassemblies
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
When creating assemblies in Inventory Control, you can use serialized/
lotted items as component or master items. You will be prompted to
assign numbers when saving or posting an assembly or disassembly that
contains a serialized and/or lotted item.

To assign serial/lot numbers to
Assemblies/Disassemblies:
1.Select I/C Transactions > Assemblies to display the I/C
Assemblies/Disassemblies form if you haven't already done so.
2.Process the transaction and save it as usual. A form appears for you
to generate or allocate numbers to items when you post or save a
new assembly. If working with an existing assembly, you can also click
the Serials/Lots button to display the Generation/Allocation form.
3.If working with a serialized item, select the Serials tab. You will either
be allocating or generating serials numbers, depending on whether
you are assembling or disassembling an item.
If creating an assembly with a serialized item,
If creating a disassembly with a serialized item,

4.If working with a lotted item, select the Lots tab. You will either be
allocating or generating lot numbers, depending on whether you are
assembling or disassembling an item.
If creating an assembly with a lotted item,
If creating a disassembly with a lotted item,

5.Click Save to return to the underlying transaction in the
Assemblies/Disassemblies form. Continue processing, then post the
transaction.
For help about fields and buttons on the generation/allocation forms, click

the Field List button at the top of this help page.
See also:
Understanding Serialized Inventory and Lot Tracking
Entering Quantities Using the Physical Inventory Quantities form

Assigning Serial/Lot Numbers for Internal
Usage Transactions
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
When using serialized and/or lotted items for internal usage, you can
assign serial and/or lot numbers in the I/C Internal Usage form to retain a
full transaction history.
1.Select I/C Transactions > Internal Usage to display the I/C Internal Usage
form if you haven't already done so.
2.Process the internal usage transaction as per usual. After selecting a
serialized and/or lotted item and entering a quantity, an allocation form
appears for you to assign serial/lot numbers to the items.
3.If using a serialized item, select the Serials tab. Press the Insert key
and manually enter the number or use the Finder in the Serial
Number column to manually select the number from the list of
available numbers for the specified location. Or select the AutoAllocate from checkbox, specify a starting value in the field, then
click Auto-Alloc to automatically assign the required number of
serials.
4.If using a lotted item, select the Lots tab. Press the Insert key and
manually enter the number or use the Finder in the Lot Number
column to manually select the number from the list of available
numbers for the specified location. Or select the Auto-Allocate from
checkbox, specify a starting value in the field, then click Auto-Alloc to
automatically assign the required number of Lots.
Tip: Make sure the numbers conform to the mask defined in setup
when manually entering serial and/or lot numbers.
5.Click Close to return to the underlying transaction in the I/C Internal
Usage form. Continue processing the transaction, then post. Be sure
to assign the required number of serials/lots, as an error message will
appear when you try to exit the form if you don't. Refer to the count
section at the bottom of the form to see what remains to be assigned.

For help about fields and buttons on the generation/allocation forms, click
the Field List button at the top of this help page.
See also:
Understanding Serialized Inventory and Lot Tracking
Using Goods Internally

Assigning Serial/Lot Numbers to Physical
Inventory Quantities
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
When performing inventory quantities for serialized and/or lotted items,
you can assign serial and/or lot numbers in the I/C Physical Inventory
Quantities form to retain a full transaction history. Depending on whether
there is an increase or decrease in quantity for serialized/lotted items,
you may be prompted to generate (add) or allocate (minus) serial and/or
lot numbers.
1.Select I/C Physical Inventory > Physical Inventory Quantities to
display the I/C Physical Inventory Quantities form if you haven't already done so.
2.Process the physical inventory count as usual. The respective number
generation/allocation form appears when increasing or decreasing
physical inventory quantities for serialized and/or lotted items.
3.If increasing quantity for a serialized item, select the Serials tab. You
can accept or change the default number that appears in the Next
Serial Number field, then click Add to individually add one serial at a
time. Or click Auto-Gen to automatically assign the required number
of serials. As well, you can press the Insert key and manually enter
the number or use the Finder in the Serial Number column to
manually select the serials from the list of available numbers for the
specified location.
If decreasing physical inventory quantity for a serialized item,

4.If increasing quantity for a lotted item, select the Lots tab. Use the
Make X Lots OR Each Lot has X fields to define the number and
quantity of lots you want to work with. Accept or change the default
number that appears in the Next Lot Number field, then click Add to
individually add lots or click Auto-Gen to automatically assign the
required number of lots. As well, you can press the Insert key and
manually enter the number or use the Finder in the Lot Number
column to manually select the lots from the list of available numbers

for the specified location.
If decreasing physical inventory quantity for a lotted item,

5.Click Close to return to the underlying transaction in the I/C Physical
Inventory Quantities form. Continue processing, then post the
transaction. Be sure to assign the required number of serials/lots, as
an error message will appear when you try to exit the form if you
don't. Refer to the count section at the bottom of the form to see what
remains to be assigned.
For help about fields and buttons on the generation/allocation forms, click
the Field List button at the top of this help page.
See also:
Understanding Serialized Inventory and Lot Tracking
Entering Quantities Using the Physical Inventory Quantities form

Assigning Serial/Lot Numbers for Shipments
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
When shipping serialized and/or lotted items to customers, you can
assign serial and/or lot numbers in the I/C Shipments form to retain a full
transaction history.
1.Select I/C Transactions > Shipments to display the I/C Shipments form if
you haven't already done so.
2.Process the shipment as per usual. After selecting a serialized and/or
lotted item and entering a quantity, an allocation form appears for you
to assign serial/lot numbers to the item.
3.If using a serialized item, select the Serials tab. Press the Insert key
with your cursor in the detail grid and manually enter the number, or
use the Finder in the Serial Number column to manually select the
number from the list of available numbers for the specified location.
Or select the Auto-Allocate from checkbox, specify a starting value
in the field, then click Auto-Alloc to automatically assign the required
number of serials.
4.If using a lotted item, select the Lots tab. Press the Insert key with
your cursor in the detail grid and manually enter the number, or use
the Finder in the Lot Number column to manually select the number
from the list of available numbers for the specified location. Or select
the Auto-Allocate from checkbox, specify a starting value in the field,
then click Auto-Alloc to automatically assign the required number of
Lots.
Tip: When manually entering serial and/or lot numbers, make sure the
numbers already exist and conform to the mask defined in I/C Setup.
5.Click Close to return to the underlying transaction in the I/C
Shipments form. Continue processing the transaction, then post.
Tip: Refer to the count section at the bottom of the form to see what

remains to be assigned. An error message will appear when you try to
exit the form without assigning the required number of serials/lots,
unless the Allow Serial/Lot Quantity to be Different from the Quantity
in the entries checkbox is selected in I/C Setup.
For help about fields and buttons on the generation/allocation forms, click
the Field List button at the top of this help page.
See also:
Shipping Goods to Customers
Understanding Serialized Inventory and Lot Tracking

Assigning Serial/Lot Numbers to Transfers
This topic applies to you only if you are working with serialized or lotted
inventory items,which requires installation of the Serialized Inventory and
Lot Tracking license.
When transferring serialized and/or lotted items to another location, you
can assign serial and/or lot numbers in the I/C Transfers form to retain a
full transaction history.
1.Select I/C Transactions > Transfers to display the I/C Transfers form if you
haven't already done so.
2.Process the inventory transfer as per usual. After selecting a
serialized and/or lotted item and entering a quantity, an allocation form
appears for you to assign serial/lot numbers to the item.
3.If using a serialized item, select the Serials tab. Press the Insert key
and manually enter the number or use the Finder in the Serial
Number column to manually select the number from the list of
available numbers for the specified location. Or select the AutoAllocate from checkbox, specify a starting value in the field, then
click Auto-Alloc to automatically assign the required number of
serials.
4.If using a lotted item, select the Lots tab. Press the Insert key and
manually enter the number or use the Finder in the Lot Number
column to manually select the number from the list of available
numbers for the specified location. Or select the Auto-Allocate from
checkbox, specify a starting value in the field, then click Auto-Alloc to
automatically assign the required number of Lots.
Tip: Make sure the numbers conform to the mask defined in setup
when manually entering serial and/or lot numbers.
5.Click Close to return to the underlying transaction in the I/C Transfers
form. Continue processing the transaction, then post. Be sure to
assign the required number of serials/lots, as an error message will
appear when you try to exit the form if you don't. Refer to the count
section at the bottom of the form to see what remains to be assigned.
For help about fields and buttons on the generation/allocation forms, click

the Field List button at the top of this help page.
See also:
Transferring Goods between Two Locations
Understanding Serialized Inventory and Lot Tracking

Items Form — Units Tab
Use this tab to:
Enter the units of measure by which you purchase or sell the item.
Identify the stocking unit of measure for the item.
For information about other tabs in the Items form, click the following
links:
Items

Taxes

Serials

Lots

Optional Fields

For information about fields in the Items form, click the Field List button
beside the title of this help topic.
See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Form — Taxes Tab
This tab appears only if you have activated Tax Services. Use the tab to
specify the tax authorities and sales and purchase tax classes that apply
to the item.
If the category you selected on the Items tab contains tax information, the
information appears in fields on this tab. You can make changes to this
information without affecting the tax information in the category record.
For information about other tabs in the Items form, click the following
links:
Items

Units

Serials

Lots

Optional Fields

For information about fields in the Items form, click the Field List button
beside the title of this help topic.
See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Form — Optional Fields Tab
Use the Optional Fields tab to:
Enter data into automatically inserted fields on this tab.
If a field is required, you cannot save the item record until to fill in the
value.
Add optional item fields that were not automatically inserted.
Use the Insert key to add a new line to the grid, and then use the
Finder to add the optional field.
Note: Optional fields must be assigned to the Items form in the I/C
Optional Fields form before you can add them.
For information about other tabs the Items form click the following links:
Items

Units

Taxes

Serials

Lots

For information about fields in the Items form, click the Field List button
beside the title of this help topic.
See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Item Pricing Form — Prices Tab
Use this tab to:
Enter a new description for the item on the price list.
Specify the number of decimals to use in item prices.
Choose the base price type (single unit of measure, multiple units of
measure, or calculated on cost).
Enter the base price, prices, or price calculation method.
Enter the pricing unit for a single base price.
If entering prices for multiple UOMs, specify the default price and
UOM for shipments. (The default price is in effect only if you do not
specify a price for the stocking unit. If you specify a price for the
stocking unit, I/C Shipments will automatically use it as the
default.)
Choose the sale price type (single unit of measure, multiple units of
measure, or calculated on cost).
Enter a sale price, prices, or price calculation method.
Enter the pricing unit for a single base price.
If entering prices for multiple UOMs, specify the default price and
UOM for shipments. (The default price is in effect only if you do not
specify a price for the stocking unit. If you specify a price for the
stocking unit, I/C Shipments will automatically use it as the
default.)
Enter the sale dates for the item.
Specify the item's markup cost, markup unit, and markup factor.
For information about other tabs in the Item Pricing form, click the
following links:
Discounts

Price Check

Taxes

For information about fields in the Item Pricing form, select the Field List
button beside the title of this help topic.

See also
Items
Price List Codes
Update Item Pricing

Item Pricing Form — Discounts Tab
This tab lets you:
Specify whether to calculate additional prices for the item based on
the selling (base) price or a markup of the markup cost, standard
cost, most recent cost, average cost, last cost, or alternate costs 1 or
2 (if you added them).
Select the method for calculating discount or markup prices and
enter the discount/markup percentages or amounts to use.
For information about other tabs in the Item Pricing form, click the
following links:
Prices

Price Check

Taxes

For information about fields in the Item Pricing form, select the Field List
button beside the title of this help topic.
See also
Items
Price List Codes
Update Item Pricing

Item Pricing Form— Taxes Tab
This tab appears only if you have activated Tax Services in Common
Services.
Use the tab to assign the tax authorities and customer tax classes for
taxes that are included by default in the item price.
Note: The Finder will only list tax authorities that have the Allow Tax In
Price option selected in Tax Services.
For information about other tabs in the Item Pricing form, click the
following links:
Prices

Discounts

Price Check

For information about fields in the Item Pricing form, select the Field List
button beside the title of this help topic.
See also
Items
Price List Codes
Update Item Pricing

Printing the Inventory Reconciliation Report
The Inventory Reconciliation report lets you compare actual physical
inventory totals with the totals in your Sage Accpac Inventory Control
system. The report identifies discrepancies between item quantities and
costs, and shows what will be posted by the Post Inventory
Reconciliation form.
For more information on the contents of this report, see Inventory Reconciliation �
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report after generating an Inventory Worksheet, counting
inventory, and entering the counted totals in the Physical Inventory
Quantities form. You can also print the report after posting an inventory
reconciliation to list transactions that had errors and were not posted.

To print the Inventory Reconciliation report
1.Choose the Inventory Reconciliation icon from the Physical Inventory
folder.
2.Make your selections in the following fields:
Location [ ] to [ ]. Specify the range of locations to include in the
report.
Show Only Items with Quantity Variance. Select this option to list
only those items that show a variation between the quantity on hand
recorded in Inventory Control and the physical count you entered in
the Physical Inventory Quantities form. The report then excludes
items for which the totals are the same in Inventory Control as in your
physical count.
Show Only Items with Serial/Lot Quantity Variance. Select this

option to show only those items that have a variance between the
quantity counted and the serial/lot numbers assigned. The report will
exclude items for which the quantity counted equals the numbers
assigned.
Include Comment for Each Item. Select this option to print a blank
comment line for each item listed in the report.
Include [ ]. Select from two types of report.
All Units of Measure. The report lists quantities counted for each
unit of measure.
Stocking Unit Only. The report lists total quantities counted in the
stocking unit of measure only.
3.To begin printing, choose the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination form to let you confirm your printer selection and change
the number of copies to print. Choose OK if the settings are correct;
otherwise, choose Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See Also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
When Print Destination is Schedule

Printing the G/L Transactions Report
The G/L Transactions report is a list of the general ledger journal entries
created from all transactions posted in Inventory Control since the last
time you created the general ledger batch.
You can print detailed or summary versions of the report. If you use
multicurrency accounting, you can print amounts either in the functional
currency or in the source currencies in which you posted the transactions
in Inventory Control.
For more information on the contents of this report, see G/L Transactions �
Features.

Before printing
To print this report, you must select On Request Using G/L Batch Icon for
the Create G/L Transactions option in the Options form.
If you use the option to create transactions during day-end processing,
you cannot print the G/L Transactions report.
Run Day End Processing before you create the general ledger batch, if
you want to include the latest costing information in the report.

When to print
Print the report before you use the Create G/L Batch form to produce
general ledger transactions. When you create the general ledger batch,
the program erases the data for the G/L Transactions report.

To print the G/L Transactions report
1.Double-click the G/L Transactions icon in the Price/Sales Analysis
Reports folder.
2.Make your selections for the following fields:
.

Through Posting Sequence
Report Format.
Sort by.

Report Currency. If you have a multicurrency ledger, select either

functional or source currency.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Markup Analysis Report
The Markup Analysis report lists each item whose base price varies from
a desired selling price by more than the percentage you specify for the
report.
For more information on the contents of this report, see Markup Analysis —
Features.

When to print
Use the report to help you identify products that do not meet the desired
markup.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

To print the Markup Analysis report
1.Double-click the Markup Analysis icon in the Price/Sales Analysis
Reports folder.
2.Make your selections in the following fields:
Price List [ ] to [ ]. Enter a range or use the Finder to select a range
of price lists for the report.
Sort by. Specify the order in which to list item records.
From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Location [ ] to [ ]. Enter a range or use the Finder to select a range of
locations for the report.
Calculate Markup Based on. Select a costing method for calculating the
desired selling price and variance from the base price
Print Items with Absolute Variance over [ ] %. Enter the amount
you want to use as the cut-off point for your analysis. The report then
lists only those items whose base and desired selling prices vary by

the specified percentage or more.
Currency. If you use multicurrency accounting, enter a currency or
use the Finder to select a currency in which to report figures.
Rate Type. If you use multicurrency accounting, enter a rate type or
use the Finder to select a rate type to use to calculate currency
amounts for the report.
Exchange Rate. If you use multicurrency accounting, enter a rate or
use the Finder to select an exchange rate for the report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Price Lists Report
The Price Lists report lists price, markup, discount, and tax information
for items in the range of price lists you select.
There are four versions of the report: Price List, Detail, Price List
Summary, and Item Number Summary.
For more information on the contents of this report, see Price Lists — Features.

When to print
Print the Price List version of the report when you need a list of item base
prices and markup or discount prices on one or more price lists. Print the
Detail version of the report when you want to check price decimals,
previous prices and costs, and the tax authorities and classes assigned
to each item on a price list. Print the Price List Summary or Item Number
Summary when you need a list of current base prices.

To print the Price Lists report
1.Double-click the Price Lists icon in the Price/Sales Analysis Reports
folder, or choose File, Print in the Item Pricing form.
2.Make your selections in the following fields:
Print. Select the type of report you want to print.
From Price List [ ] to [ ]. Select a range of price list codes to include
in the report.
From Currency [ ] to [ ]. Select a range of currencies used in price
lists, if you have a multicurrency system.
Display Price Calculated Using a Cost. This choice applies only to
Inventory Control items that have the Base or Sale Price specified as
Base/Sale Price Calculated Using a Cost in the price list.
Select this option if you want to calculate item prices based on costs
as the report is being printed. (This option does not appear for a
Detail report.)
Use Cost Base for Specific Location or All Locations. If you

choose All Locations, the report will calculate the price based on the
Base/Sale Cost of an item for each location where the item exists.
Otherwise, choose the location for which you want to calculate prices.
Sort by. Specify the order in which to list item records.
From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Include. When printing the Detail version of the report, you can also
select additional information.
From Currency [ ] to [ ]. If you use multicurrency accounting, select
the currency for the report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Sales Statistics Report
The Sales Statistics report lists figures for sales and returns by the
statistical reporting periods you specify in the Options form.
The report includes current statistics only if you use the Keep Item
Statistics option in the Options form.
For more information on the contents of this report, see Sales Statistics � Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report when you need to review the sales figures for items, or to
help you identify trends and determine profit margins.

To print the Sales Statistics report
1.Double-click the Sales Statistics icon in the Price/Sales Analysis
folder.
2.Make your selections in the following fields:
Sort by. Specify the order in which to list item records.
From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Location [ ] to [ ]. Select a range of locations to include in the report.
From Year [ ] and Period [ ], To Year [ ] and Period []. Specify the
range of reporting periods for the report.
[ ] for Each Period Selected. Specify what item information will appear on
the report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and

change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Selling Price/Margin Analysis Report
The Selling Price and Margin Analysis report lists items whose base
prices or discount or markup prices have a gross profit margin that is less
than the percentage you specify.
Use the report to identify items with unusually low or high profit margins.
For more information on the contents of this report, see Selling Price/Margin Analysis
– Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report when you want to analyze item profit margins or compare
base price margins with the margins on discounted or marked-up prices.

To print the Selling Price/Margin Analysis report
1.Double-click the Selling Price/Margin Analysis icon in the Price/Sales
Analysis Reports folder.
2.Make your selections in the following fields:
Price List [ ] to [ ]. Select a range of price lists to include in the
report.
Location [ ] to [ ]. Select a range of locations to include in the report.
Sort by. Specify the order in which to list item records.
From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Print Items with Margin Less than [ ] Percent. Specify the largest
margin percentage for the report. Items whose margins fall below this
amount will be included.
Calculate Margin by. Select a method for calculating the margin.

Currency-related fields appear only if you use multicurrency accounting:
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Transaction History Report
The Transaction History report lists all transactions posted for the items
assigned to the account sets you select within the period you specify. The
report shows the net change to the inventory control account for the
account set and period.
Transaction history is accumulated and reported according to the settings
you chose in the Fiscal Calendar in Common Services. Transactions are
accumulated for this report only if you use the Keep Transaction History
option in the Options form.
Transactions cleared in the Clear History form will not be included in the
report.
For more information on the contents of this report, see Transaction History
Features.�

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report when you want to review transaction history by item or list
transactions from all posting journals.
The report can also be used at the end of an accounting period to check
the balance of your general ledger control account, since the total for the
account sets on the report should match the total for the general ledger
control account.

To print the Transaction History report
1.Choose the Transaction History icon in the Price/Sales Analysis
Reports folder.
2.Make a selection form the Report Type list. You can print a summary
report or a detail report with serial and lot numbers included for
applicable transactions.

3.Make your selections in the following fields:
As at Year [ ] and Period [ ]. Select the ending period for the range of
transactions you want to print. Inventory Control will list all
transactions occurring before and during the specified period,
excluding those you cleared in the Clear History form.
By. Specify the method of sorting transactions. Choose either Account
Set Code or Item Number.
From Account Set [ ], To Account Set [ ]. Select a range of
accounts sets to include in the report.
From Item Number [ ], To Item Number [ ]. If you chose to sort by
item number, select a range of item numbers to include in the report.
4.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Transaction Statistics Report
The Transaction Statistics report lists statistics from posted transactions
for the current year and all the previous years for which you keep history.
Transaction statistics are accumulated according to the selections you
made for the Accumulate By and Period Type fields in the Options form.
You must use the Keep Item Statistics option if you want to print the
Transaction Statistics report.
For more information on the contents of this report, see Transaction Statistics �
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

To print the Transaction Statistics report
1.Double-click the Transaction Statistics icon in the Price/Sales Analysis
Reports folder.
2.Specify the range of years and periods for which to report statistics.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Account Sets Report
The Account Sets report lists descriptions and numbers of the general
ledger accounts in your Inventory Control account sets, and the costing
method used by each account set.
For more information on the contents of this report, see Account Sets Report �
Features.

When to print
Print the report when you add, change, or delete account sets.

To print the Account Sets report
1.Choose File, Print from the Account Sets form, or double-click the
Account Sets icon in the Setup Reports folder.
2.Select the range of account sets you want to print. The default range
includes all account sets.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Alternate Items Report
The Alternate Items report lists the numbers of items to which alternate
items are assigned, together with the numbers and descriptions of the
corresponding alternate items.
For more information on the contents of this report, see Alternate Items – Features.

When to print
Print the report when you add, change, or delete the alternate items you
assigned to your item numbers in the Items form, or when you want to
review the alternate items you use.

To print the Alternate Items report
1.Double-click the Alternate Items icon in the Setup Reports folder, then
make your selections in the following fields:
Sort by. Specify the order in which to list item numbers that include
alternate items. You can choose:
Item Number. Lists items that have alternates in order by the
primary item numbers.
Category. Groups all items that have alternates by the item
categories specified for the report.
Item Segment. Lists only items that contain the specified segment
in their item numbers and that have alternate items, grouped by
each of the segment codes in the specified range.
Optional Field Entries. Lists all items that have alternates by the
contents of the selected optional field. These choices appear only
if you have added optional fields to the I/C Items form.
From [ ] to [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
2.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the

printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Bills of Material Report
The Bills Of Material report lists the component items and quantities
required to build the master items in your Inventory Control system.
For more information on the contents of this report, see Bills Of Material &emdash;
Features.

Before printing
Run Day End Processing before printing the report, if you want to include
the latest costing information.

When to print
Print the Bills Of Material report after you add, delete, or edit bills of
material records, or when you need to review the records.

To print the Bills Of Material report
1.Choose Print from the File menu of the Bills Of Material form, or
double-click the Bills Of Material icon in the Setup Reports form to
print the report.
2.Make your selections in the following fields:
Sort by. Specify the order in which to list bills of material records. You
can choose:
Item Number. Lists bills of material in order by the master item
numbers.
Category. Groups all bills of material by the item categories
specified for the report.
Item Segment. Lists all bills of material by item numbers that
contain the specified segment, grouped by the specified range of
segment codes.
Optional Field Entries. Lists bills of material by the contents of
the selected optional field. These choices appear only if you have
added optional fields to the Bills of Material form using the
Optional Fields Setup form.

From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Include Costs for Each Item. Select this option to show the unit cost
and assembly cost for each of the component items and the total
assembled cost (based on the average actual cost).
Location. If you chose the Include Costs for Each Item option, enter a
location code or use the Finder to select the location for the report.
Include Component BOMs. Select this option to list all of the
components for items that are themselves built from subassemblies.
Components of subassemblies are listed immediately below the
master component item.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Categories Report
The Categories report lists the information entered to define the category
codes you use to group inventory items.
For more information on the contents of this report, see Categories � Features.

When to print
Print the report after adding, changing, or deleting category records, or
when you need to check on commission rates, general ledger account
numbers, or tax information for a category.

To print the Categories report
1.Double-click the Categories icon in the Setup Reports folder or
choose File, Print from the Categories form.
2.Select a range of category codes to print.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Item Structures Report
The Item Structures report lists the information you entered in your
Inventory Control system to format item numbers.
For more information on the contents of this report, see Item Structures � Features.

When to print
Print the report when you add, change, or delete item structures.

To print the Item Structures report
1.Double-click the Item Structures icon in the Setup Reports folder, or
choose File, Print from the Item Structures form
2.Select a range of item structures.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Location Details Report
The Location Details report lists information for items at each location
where you allow the items to be stocked.
For more information on the contents of this report, see Location Details — Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report (if you cost items during Day End Processing).

When to print
Print the report before and after using the Location Details form to add or
remove items from locations, or to change location detail records.

To print the Location Details report
1.Choose File, Print from the Location Details form, or double-click the
Location Details report icon in the Setup Reports folder.
2.Make your selections in the following fields:
Sort by. Specify the order in which to list location detail records.
From [ ] to [ ]. Specify the range of item numbers or locations to
include in the report.
Item Number/Location From [ ] To [ ]. Select a range of items or
locations to include in the report.
Print. Set your record selection criterion.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.

If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Locations Report
The Locations report lists the information entered to define the inventory
locations used in your Inventory Control system.
For more information on the contents of this report, see Locations — Features.

When to print
Print the report when you add, change, or delete locations, or when you
want to refer to the address, phone numbers, and contacts for each
location.

To print the Locations report
1.Double-clickthe Locations icon in the Setup Reports folder, or choose
File, Print from the Locations form.
2.Select a range of locations.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Manufacturers' Items Report
The Manufacturers' Items report lists the manufacturers' item numbers
(such as bar codes) that have been added to identify the inventory items
in your Inventory Control system.
For more information on the contents of this report, see Manufacturers' Items —
Features.

When to print
Print the report when you add, change, or delete locations, or when you
want to refer to the address, phone numbers, and contacts for each
location.

To print the Manufacturers' Items report
1.Double-click the Manufacturers' Items icon in the Setup Reports
folder, or choose File, Print from the Manufacturers' Items form.
2.Choose whether to sort the report by item numbers or by
manufacturers' item numbers.
3.Select a range of item numbers and a range of manufacturers' item
numbers.
4.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer

When Print Destination is Preview
When Print Destination is E-mail

Printing the Options Report
The Options report lists the selected options and other information you
entered in the Options form to specify how your Inventory Control system
operates.
For more information on the contents of this report, see Options — Features.

When to print
Print the report before and after changing options.

To print the Options report
1.Double-click the Options icon in the Setup Reports folder, or choose
File, Print from the Options form.
2.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Price List Codes Report
The Price List Codes report lists codes you defined to identify your
company's price lists.
For more information on the contents of this report, see Price List Codes —
Features.

When to print
Print the report after adding, changing, or deleting price list codes in
Inventory Control.

To print the Price List Codes report
1.Click the Price List Codes icon in the Setup Reports folder, or choose
File, Print in the Price Lists Codes form.
2.Enter a range or use the Finder to select a range of price list codes.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Reorder Quantities Report
The Reorder Quantities report lists the maximum and minimum item
quantities permitted at your locations during each period. The report also
shows the number of units you usually order at a time and the number of
units you expect to sell in each period.
The report includes only items for which you have entered reorder
information in the Reorder Quantities form.
For more information on the contents of this report, see Reorder Quantities —
Features.

When to print
Print the report when you are ready to reorder inventory items and want
to determine the quantities to order. You can also use the report to review
inventory and projected sales levels by period, to see whether you need
to adjust figures in the Reorder Quantities form. When you add, change,
or delete information in Reorder Quantities, print a new copy of the report
for your permanent Inventory Control files.

To print the Reorder Quantities report
1.Double-click the Reorder Quantities icon in the Setup Reports folder,
or choose File, Print in the Reorder Quantities form.
2.Select a range of item numbers and locations to include in the report.
3.Choose whether to print optional fields assigned in the Optional Fields
form to the reorder quantity records for each item.
4.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays

the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Segment Codes Report
The Segment Codes report lists the segments used in your Inventory
Control system and the segment codes and corresponding descriptions
used with each segment.
For more information on the contents of this report, see Segment Codes �
Features.

When to print
Print the report when you add, change, or delete segments or segment
codes.

To print the Segment Codes report
1.Double-click the Segment Codes icon in the Setup Reports folder, or
choose File, Print from the Segment Codes form.
2.Specify whether to list all your Inventory Control segments and
segment codes, or a specific segment and range of the codes
assigned to the segment.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Vendor Details Report
The Vendor Details report lists vendors from whom you purchase
inventory items and the items each supplies. The report includes only the
vendors you have assigned to Inventory Control items in the I/C Vendor
Details form.
The report will be blank if no vendors are assigned to items.
For more information on the contents of this report, see Vendor Details Report �
Features.

When to print
Print the report when you need to review the vendors from whom you buy
inventory, or when you change the vendor information for items.

To print the Vendor Details report
1.Double-click the Vendor Details icon in the Setup Reports folder.
2.Make selections in the following fields:
Sort by. Specify the order in which to list vendor information for item
records. You can print by the vendor numbers, or you can print vendor
information by item category codes, Inventory Control item numbers,
segment codes, or the entries in any of the optional fields you
assigned to items in the I/C Optional Fields form.
From [ ] To [ ]. Specify the range of vendor numbers, categories, item
numbers, segments, or optional field entries to include in the report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays

the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing Bin/Shelf Labels
You can print bin or shelf labels to attach to the bins or shelves where
you store inventory items.
To print labels for your individual items, use the Item Labels icon in the Stock
Control reports folder.
For more information on the contents of this report, see Bin/Shelf Labels �
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information on the labels.

To print bin or shelf labels
1.Double-click the Bin/Shelf Labels icon in the Stock Control Reports
folder.
2.Make your selections for the following fields:
Location. Select the location.
Currency. If you use multicurrency accounting, select the currency of
the price list for which you want to print labels.
Use Label. Enter the name of the file, including the RPT file extension,
that contains the format for the labels you want to print, or choose the
default filename.
If you do not know the file name or the location of the file you want to
use, click the Browse button to select from the list of your directories
and files.
Price List. Select a price list for the labels.
Sort by. Specify the order in which to generate labels.
From [ ] to [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the label run.
You can either print the labels or print a sheet of dummy labels to test
your format and the alignment of label forms in your printer.

3.To begin printing labels, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
Note: To print a test sheet of labels to test the alignment of the forms
in your printer, click the Align button. This button is available only if
the printing destination is Printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing Item Labels
Inventory Control allows you to print labels such as price tags that you
can attach to items as you receive them from your suppliers, and to items
already in your inventory.
To print labels for the bins or shelves where you store items at your
inventory locations, use the Bin/Shelf Labels form. The sample label that
comes with your Inventory Control package includes the item number
and description, as well as the price per pricing unit.
For more information on the contents of this report, see Item Labels � Features.

When to print
Print labels when you are receiving new items into stock and want to
attach price tags or other labels to the items. You specify the number of
labels to print for each item when you post the receipts.
At any time, you can print labels for items already in your inventory - for
example, to replace damaged labels or to update item descriptions and
pricing information.

To print item labels
1.Double-click the Item Labels icon in the Stock Control Reports folder.
2.Make your selections in the following fields:
For Each Item [ ]. Use this field to select the items for which you want to
print labels.
Use Label. Enter the name of the file (including the file extension)
that contains the format for the labels you want to print, or choose the
default filename. If you do not know the file name or the location of
the file you want to use, click the Browse button to select from the list
of directories and files.
If you choose to print labels for each item Received, make your
selections.
If you choose to print labels for each item On File or In Stock, specify
the label format in the Use Label field as described earlier, then make

your selections.
From [ ]To [ ]. Specify the range of item numbers, categories,
segments, picking sequences, or optional field entries to include in the
label run.
3.You can either print the labels or print a sheet of dummy labels to test
your format and the alignment of label forms in your printer.
4.To begin printing labels, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
To print a test sheet of labels to check the alignment of the forms in
your printer, click the Align button. This button can only be clicked if
the printing destination is Printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Item Status Report
Use the Item Status report to print the information entered for each item
in the Items form, as well as the quantities on hand at your inventory
locations. If you use the Keep Item Statistics option, the report also
shows shipment and receipt statistics for each item.
For more information on the contents of this report, see Item Status � Features.

When to print
Print the Item Status Report when you need a quick-reference list of item
information such as quantities on hand or the names of suppliers. You
should also print a new copy for your files after adding, deleting, or
changing item records.

To print the Item Status report
1.Double-click the Item Status icon in the Stock Control Reports folder,
or choose Print from the File menu of the Items form.
2.Make your selections in the following fields:
From Account Set [ ] to [ ]. Enter a range use the Finder to select a
range of account sets for the report.
Sort by. Specify the order in which to list item records. You can
choose:
Item Number. Lists items in order by item numbers.
Category. Groups all items by the item categories specified for the
report.
Item Segment. Lists all items that contain the specified segment
in their item numbers, grouped by the specified range of segment
codes.
Optional Field Entries. Lists all items by the contents of the
selected optional field. These choices appear only if you have
added optional fields to the I/C Items form.
From [ ] To [ ]. Specify the range of item numbers, categories,

segments, or optional field entries to include in the report.
Print. Specify the type of items to include on the report. You can
choose all items, only active items, or only inactive items.
Include. For each item included in the report, print all or a
combination of the information entered in the item record (Profile, Unit
of Measure, Taxes, Additional Item Information, Optional Fields,
Vendors), as well as the quantities on hand at each location, total
quantities on hand, item statistics (if you use the option to keep
statistics) and FIFO or LIFO costing information. If you have serialized
or lotted items in inventory you can choose to include them in the
report as well.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Item Valuation Report
The Item Valuation report shows the value of inventory quantities on
hand, calculated for the items, locations, costs, or optional fields you
select for the report.
For more information on the contents of this report, see Item Valuation – Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report when you want to calculate inventory values.

To print the Item Valuation report
1.Double-click the Item Valuation icon in the Stock Control Reports
folder.
2.Choose the type of valuation report that you want to print.
Location Detail Costs
Transaction Costs

3.Select Transactions by Cutoff Date or Fiscal Year/Period.
If you select Transaction Costs, you also select the date range or
period range for printing transaction information.
3.Make your selections in the following fields:
Print [ ] in [ ]. Select the method of presenting the information on the report.
Print Transaction Details (if using transaction costs). If you selected
Transaction Costs instead of Location Details Costs in the first field,
you can print the details for all of the transactions in the range that
you specified.
Include [ ] Quantities and Costs. Select which quantities and costs to print.
From Account Set [ ] to [ ]. Enter a range or use the Finder to select
a range of account sets by which to select items for the report.

From Location [ ] to [ ]. Enter a range or use the Finder to select a
range of locations from which to include items on the report.
Sort by. Specify how you want item records sorted.
From [ ] to [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Select up to 4 Costing Methods for Valuation. Each costing method you
select adds a column to the report.
4.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Reorder Report
The Reorder report lists items that are out of stock or have low quantities
on hand at the selected locations. The report also lists the suggested
reorder quantity, estimated cost to replenish, and names of the usual
suppliers you assigned for each item on the report.
You may want to compare the report to the Reorder Quantities report to
check maximum quantities and projected sales for each period, to
determine whether you need to order exactly the reorder quantity shown
for each item.
For more information on the contents of this report, see Reorder � Features.

When to print
Print the report when you are ready to place orders for inventory items,
and want to identify the items and quantities you need to order.

To print the Reorder report
1.Double-click the Reorder Report icon in the Stock Control Reports
folder.
2.Make your selections in the following fields:
Report Type. Choose whether you want to list reorder information for
specific locations or for all locations.
Show Location Quantities. If you select All Locations, you have
the option to print quantities at each location.
From Location [ ] to [ ]. If you choose Specific Locations, select a
range of locations to include in the report.
From [ ] to [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
For Quantities [ ]. Specify the record selection criterion.
Sort by.Specify the order in which to list item records, and then choose
a range of records in the From and To fields.
3.To begin printing, click the Print button.

If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview

Printing the Overstocked Items Report
The Overstocked Items report lists each item at each location for which
the quantity on hand (plus the quantity on PO minus the quantity on sales
order) exceeds the maximum or projected sales quantity assigned for the
item and location.
You can report item quantities for locations that are over the maximum
level or over the projected sales figures entered for the items in the
Reorder Quantities form. You can include cost figures on the report to
see the costs of carrying the extra inventory items.
Use the Annualized Turn And Earn Ratio version of this report to find out
how many times your company's average inventory was sold during the
year to date. The report also shows the profit margin, total sales, and
total cost for each item in the year to date.
For more information on the contents of this report, see Overstocked Items —
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.
To print meaningful data on some versions of this report, you must first
enter figures for the items in the Reorder Quantities form.

When to print
Print the Overstocked Items report when you want to estimate the cost of
excess stock, or when you want to determine whether to redistribute
overstocked items to other locations.

To print the Overstocked Items report
1.Double-click the Overstocked Items icon in the Stock Control Reports
folder.
2.Make your selections as follows:
Sort by. Specify the order in which to list item records.

From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
From Location [ ] to [ ]. Enter a range or use the Finder to select a
range of locations.
Print Items with. Select the criterion you want to use to determine
whether items are overstocked.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Slow Moving Items Report
The Slow Moving Items report lists items that are not selling well,
according to the criteria you select when you print the report.
The Slow Moving Items report uses data from the Sales Statistics form to
make its calculations. You must use the Keep Item Statistics option in
order to use the report. The settings you choose in the Accumulate By
and Period Type options will determine the dates the report uses to make
its calculations.
For more information on the contents of this report, see Slow Moving Items �
Features.

Before printing
Run Day End Processing if you want to include the latest costing
information in the report.

When to print
Print the report to identify problem items.

To print the Slow Moving Items report
1.Double-click the Slow Moving Items icon in the Stock Control Reports
folder.
2.Make your selections in the following fields:
Sort by. Specify the order in which to list item records.
From [ ] To [ ]. Specify the range of item numbers, categories,
segments, or optional field entries to include in the report.
Include Items with. Specify a criterion for items to include in your report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination form to let you confirm your printer selection and change
the number of copies to print. Click OK if the settings are correct;
otherwise, click Cancel or Setup.

If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. You can then export it to a file or send it to the printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Using Help
Welcome to Sage ERP Accpac online Help! Context-sensitive Help is
available when you use Sage ERP Accpac on your desktop or from a
Web browser.

Obtaining Online Help
For help on using Sage ERP Accpac:
Click Help Topics on the Help menu on the Sage ERP Accpac
desktop, or
Press F1 in your browser from an open form.
To view the Help contents for a specific module, open a form for the
module, then click Contents on the Help menu.
For form-specific help, display the form, and then press F1.
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Changes in Inventory Control 5.6
Inventory Control version 5.6 integrated serialized inventory and lot
tracking features, and included a number of enhancements to reports.

Serialized Inventory and Lot Tracking Features
Since version 5.6, serialized inventory and lot tracking features are
installed and fully integrated with Sage ERP Accpac Inventory Control.
You require a license for Serialized Inventory and Lot Tracking to turn on
these features in Sage ERP Accpac programs, but you no longer need to
purchase and install Sage ERP Accpac Serialized Inventory and Lot
Tracking programs separately.
Create and Reconcile Serial/Lot numbers
Receive Serialized/Lotted items from Vendors
Make Adjustments involving Serialized/Lotted items
Use Serialized/Lotted items in Assemblies
Use Serialized/Lotted items for Internal Usage
Take Physical Inventory counts of Serialized/Lotted items
Ship Serialized/Lotted items to Customers
Transfer Serialized/Lotted items to other Locations
Register Serial Numbers for Customer Warranties
Update Warranties on Serialized/Lotted items
Recall and Release Lotted items
Release Lots from Quarantine
Split and Combine Lots

Before you can perform these tasks, you must define items as serialized
and/or lotted, define serial and lot number formats, and set global
defaults for serialized and lotted items. For more information on setup
and maintenance tasks, refer to Understanding Serialized Inventory and Lot Tracking.
Converting Serialized Inventory and Lot Tracking Data from a
Previous Version
If you are upgrading to version 5.6 from earlier versions of Inventory
Control, and had serialized and lotted items in your system, you must
convert your data before you can use the Inventory Control system.

Report Changes
In addition to new reports for serialized and lotted items, existing reports
now have additional options to include serial and lot numbers.
The following reports and forms now let you print serial and lot numbers:
Transaction History Detail Report
Posting Journals
Transfer Slips
Transaction Listing Report

The following reports have been enhanced in version 5.6:
Transaction Statistics Inquiry Report
Sales Statistics Inquiry Report
Transaction History Inquiry Report
Item Valuation Report

Upgrading from an Earlier Version?
If you are upgrading from version 5.5, see Changes in Inventory Control 5.6.
If you are upgrading from version 5.4, also see Changes in Inventory Control 5.5.
If you are upgrading from version 5.3, also see Changes in Inventory Control 5.4.

Changes in Inventory Control 5.4
The most important additions made to Inventory Control 5.4 were the
following:
Multiple-level bills of material.
New inventory pricing features, including pricing by weight.
Weight units of measure for inventory items.
Customer item numbers.
An items wizard to simplify the process of adding new items to
inventory.
Physical and logical inventory locations.
Several new inventory reports.
The ability to choose the information that you want to transfer to
General Ledger in the description, reference, and comment fields of
General Ledger transactions arising from Order Entry transactions.
For more information on Inventory Control features, see:
Multiple Level Bills of Material
New Inventory Pricing Features, Including Pricing by Weight
Units of Measure Usage in Inventory Control
Weight Units of Measure in Inventory Control
Customer Item Numbers
Wizard for Adding New Inventory Items
Process Adjustments Automatically
Physical and Logical Inventory Locations
New and Enhanced Inventory Reports
Other Changes in Inventory Control 5.4

Upgrading from an Earlier Version?
If you are upgrading from a version earlier than 5.3A, also see Changes in
Inventory Control 5.3 to read about the features introduced with version 5.3.

Adding Item Records
Use the Items form to add records for your inventory items to Inventory
Control. You must add item records before you can enter and process
transactions in Inventory Control.

Before adding item records
Add item segments in the I/C Options form.
Add the item structures needed to format your item numbers the way
you want.
Add any segment codes you require to control the item numbers the
program allows to be entered.
Add the inventory locations you require to stock items.
Add the categories you require to group your item numbers.
Add the account sets you require for posting transactions to general
ledger accounts.
Add the price list codes you require to vary your basic item prices.
Add the stocking units of measure and pricing units of measure used
with your inventory (required only if you selected the Only Use
Defined UOM option in the I/C Options form).
Add weight units of measure (required if you want to show order
weights in Order Entry).
If you want to include additional information in your item records, add
optional fields for inventory items in Common Services, and then
assign them to Inventory items in the I/C Optional Fields form. (You
can also add optional fields to item records at a later time.)
Add the taxing authorities and tax classes you require (using the Tax
Services icon in Common Services).
Double-click the Items icon in the Items And Price Lists folder, then
either:
Click the New icon next to the Item Number field, then enter a code for

the item record you want to add. Or click the Zoom button beside the
Item Number field (or press F9) to open the Construct Item Number form and select
the structure and segments for the new item number.

Copying an existing record
To define a new item record that uses some of the information entered in
the record for another item, you can copy the information into the new
record, as follows:
1.Double-click the Items icon in the Items And Price Lists form.
2.In the Item Number field, enter the number of the item record you
want to copy, or select it from the Finder.
3.When the item record is displayed, enter the new item number in the
Item Number field (typing over the previous number).
4.Press the Tab key on your keyboard to leave the Item Number field.
5.Edit any of the fields requiring changes for the new record.
6.Click the Units tab, then fill in the fields as follows:
a.

Enter a unit of measure.

b.

Set the conversion factor to 1.

c.

Set the Stocking Unit Of Measure to Yes.

7.Click Add to add the new item record.

Adding Items to Price Lists
You add items to price lists after adding your inventory items to Inventory
Control. After you add prices to one price list, you can use the price list
as the basis for adding prices to other price lists.
For example, you can create a price list of your regular prices first, then
create a sale price list by basing it on the regular price list. Basing the
sale price list on the regular price list allows you to create the sale price
list more quickly than if you enter item prices one at a time, as you must
do for the first price list to which you add each item.

Adding Locations
Use the Locations form to add location records to your Inventory Control
system.
When you add a location, you record the following information:
A unique name of up to six characters to identify the location.
Location names can contain upper-case letters and numbers.
(Optional) The location’s name, address, and phone numbers.
(Optional) The name of a contact person at the location.
Whether this is a physical or logical location (used for goods in
transit).
Whether the location is active (available for use in transactions).
Which items you want to store at the location if you turned off the
Allow Items At All Locations option in the Options form.
You can select groups of items for stocking by item number, category,
item segment, or picking sequence.

Adding Bills of Material
Many non-manufacturing companies repackage items or assemble items
before selling them. Inventory Control contains an assembly function
designed for these situations. You can use the assembly function to
assemble bills of material that you create.
You create a bill of material to define the component items and quantities,
and the fixed and variable costs, required to assemble a specific number
of units (build quantity) of a master item.
Inventory Control lets you create multilevel BOMs so each component
item can be a subassembly with its own component items.
An assembly of a bill of material takes component items out of inventory
and creates a supply of master items. If you allow negative inventory
levels, you can assemble a master item even if its component items are
not in stock. The costs of the components are transferred to the master
item.
If you assemble the same master item from different components (for
example, using alternate items), you must set up a separate bill of
material for each version of the master item.

Build quantity
The build quantity is the number of master items that one assembly of a
bill of material produces.
Fractional build quantities are allowed if you select the Allow
Fractional Quantities option in the I/C Options form.
For the build-quantity unit of measure, you can use any of the units
of measure specified in the master item record. Example

Assigning numbers to identify bills of material
You assign each bill of material (BOM) a BOM number, up to six
characters long, which uniquely identifies it. If you want to assemble the
same master item with different components, you specify a different BOM
number for the second bill of material. BOM numbers can contain

uppercase letters and numbers.

Fixed and variable costs
When you add a bill of material, you can specify fixed and variable costs
associated with assembling the master item.
More (with example)

Adding bills of material
Use the Bills Of Material form to add bills of material to Inventory Control.

Rules for bills of material
Click this link for the rules to follow when defining and using bills of
material: rules
See also
Adding reorder Information
Assigning items to locations
Bills of Material form
Setting Up Inventory Item Records
Steps for setting up Inventory Control

Tips for Item Number Formats
While you design your item numbering format, consider the following
suggestions:
Use numbers (rather than letters or combinations of numbers and
letters) for all segments to make the order in which item numbers
appear on reports and in lists more predictable.
Define item numbers so you have room to add items in the future.
For example, assign large numbers such as 1100, 1200, and 1300 to
a segment for consecutive items, rather than 1100, 1101, and 1102.
Using large numbers leaves you room to assign a new item number,
such as 1150, between two existing numbers (1100 and 1200).
Assign item numbers according to the order in which you want items
to appear on reports and lists. For example, identify the style of an
item as men’s or women’s by assigning a style segment 1100, 1200,
and 1300 for men’s styles, and 2100, 2200, and 2300 for women’s
styles.
Use segments of different lengths in an item number format so you
can easily tell what each part of an item number represents.

Defining Item Number Formats
The steps in setting up item number formats are:
1.Define the segments you require for your item numbers.
2.Add segment codes (optional) to control what the program allows you
to enter in segments of the item number.
For example, if you define a two-digit segment for color, you might
then set up the following segment codes: 01 for red, 02 for white, and
03 for blue.
3.Set up one or more item number formats (called item structures) in
Inventory Control.
Item structures control which segments are included in item numbers and
the order in which the segments appear. You select the item structure
you want to use when you add items to Inventory Control.
The following sections provide more information and examples of
segments, segment codes, and item structures.
Setting up segments. An item number can consist of up to ten parts
called segments. Use the segments in item numbers to organize items by
common attributes. Also, you can sort reports by any segment of an item
number.
Where to define segments. Use the Items tab of the Options form to
add the segments you want to use in your Inventory Control system. More…
Adding segment codes. After you defined the segments you plan to use
for your inventory item numbers, you can store valid segment codes for
each segment. In other words, you can list all the valid codes that you
can enter into a segment of an item number. More…
Where to define segment codes. Use the Segment Codes form to
define segment codes for your segments. More…
Setting up item structures. When you add items to your inventory, the
item structure ensures that you enter item numbers in the format you
want. Item structures control which segments are included in item
numbers and the order in which the segments appear.

Using more than one item structure. If you create more than one item
structure, you can select an item structure code as the default for
formatting item numbers. The item structure code you select will appear
as the default item structure code when you add item records to
Inventory Control. You should choose the item structure code that you
will use most often. More…
Where to define item structures. Use the Item Structures form in the
Setup folder to define item structures for your Inventory Control system.
You create item structures by combining up to ten segments (which you
must set up first), in any order, and you can create as many item
structures as you require for your item numbers. You must create at least
one item structure.
Using separator characters. When you define an item structure, you
can select a separator character to appear between segments so item
numbers are easier to read. For example, for a three-segment item
number it is easier to distinguish the segments in 5046-010-92 than in
504601092. More…
For a list of the separator characters that Inventory Control allows you to
select, see the next section.
Sorting Order for Item Numbers

See also
Planning your item numbers
Setting up inventory item records
Steps for setting up Inventory Control

What you can import or export
Inventory Control records you can both import and export include:
Account sets
Adjustments
Assemblies/disassemblies
Bills of material
Categories
Contract pricing
Customer details
Item pricing
Item structures
Item records
Location details
Locations
Manufacturers' Items
Physical inventory quantities
Price list codes
Receipts
Reorder quantities
Sales statistics
Segment codes
Shipments
Transaction statistics
Transfers
Units of measure
Vendor details

Weight units of measure
Mask Structures
Warranty codes
Contract Codes
Internal Usage
You can, for example, export sales statistics to a spreadsheet for further
analysis. You can also export price lists to a spreadsheet, change some
pricing information, then import them back into Inventory Control.

Import or Export
Inventory Control also lets you import or export transactions.
Adjustments
Shipments
Assemblies
Transfers
Receipts
Internal Usage
Note, however, that you cannot export transactions if you delete them
after posting.

Export formats
Inventory Control can create export files in several formats, including:
Excel 2000
Single CSV File
CSV File (Comma Separated Values)
Access
Excel 5.0
dBase 5.0
ODBC
You select the format to use when you export the data.

Account Sets Field List
Account Set Code
Description
Last Maintained
Inactive
Costing Method
General Ledger Account Numbers

Before Using the Account Sets Form
Print the Account Sets report for the records you want to edit or
delete. Double-click the Account Sets icon in the Setup Reports
folder to open the report.
Print the Item Status report, including the Profile information for the
account sets you want to change so you know which items will be
affected.
If changing account numbers, check that your general ledger
contains the accounts you want to assign for these general ledger
accounts:
Inventory Control account
Payables Clearing account
Adjustment Write-Off account
Assembly Cost Credit account
Non-stock Clearing account
Transfer Clearing account
Shipment Clearing account
Disassembly Expense account
Physical Inventory Adjustment account
Credit/Debit Note Clearing account
If your database does not include Sage ERP Accpac General Ledger,
Inventory Control will not verify any general ledger account numbers.
You will have to check the numbers you specify against the general
ledger that you use.

Specifying different account segments for locations
Inventory Control lets you replace (override) segments in general ledger
accounts when you generate Inventory Control transactions involving
items stocked at the location.
The accounts affected are those defined by an item's category and
account set. You can replace any account segment except the account
segment, which identifies the general ledger account as an asset, liability,
income or expense account.
For example, if you have a location segment in your general ledger
inventory control account, you can value your stock by physical location
— as well as by account set — if you replace the location segment with
segment codes which identify physical locations.

FIFO and LIFO Costing Methods
Although these two costing methods differ in the way they calculate
costs, they are similar enough to be discussed together.
First-In, First-Out (FIFO) costing method. Under this method of
cost calculation, Inventory Control assumes that the first units to
arrive at a location are the first units shipped. Consequently, the
units on hand in the closing inventory are assumed to be from the
most recent purchases. As a result, current revenues are matched to
oldest costs.
Last-In, First-Out (LIFO) costing method. Under this method of
cost calculation, the program assumes that the last units to arrive at
a location are the first ones shipped. Consequently, the units on
hand in the closing inventory are assumed to be from the oldest
purchases.
Inventory balance. The inventory balance is calculated the same way
for both FIFO and LIFO, by summing the costs from all buckets.
Item Status report. The Item Status report includes the information
contained in each bucket, including the offset bucket.
See also
Most recent cost costing method
Standard costing method
User-specified costing method
Weighted moving average costing method
Serial and Lot costing
FIFO/LIFO buckets

Most Recent Cost Costing Method
Most Recent Cost. When you ship units from a location using this
costing method, Inventory Control assigns the cost of the most recently
acquired unit at the location to all units shipped. Consequently, the units
on hand in the closing inventory are assumed to be from the oldest
acquisitions.
The program uses weighted moving average to value inventory when the
costing method is most recent cost.
To determine the total cost of a shipment, the program multiplies the
number of shipped units by their most recent cost at the location.
The program records the difference between the most recent cost and
the average cost in the cost variance account of the category being used
for the shipment. (The average cost is the total cost of units on hand
divided by the total number of units on hand.)
Warning! If you ship units of an item for which you have not yet received
any stock or entered a most recent cost, Inventory Control calculates the
cost of goods sold using a most recent cost of zero.
You can change the most recent cost of an item at a location at any time.
See also
First-in, first-out (FIFO) costing method
Last-in, first-out (LIFO) costing method
Standard costing method
User-specified costing method
Weighted moving average costing method
Serial and Lot costing

Setting Up Account Sets
Account sets are groups of general ledger accounts to which you post
Inventory Control transactions. Each account set also has its own costing
method.
By defining more than one account set, you can group items by the
accounts to which you post item transactions in your general ledger, or by
the inventory costing method you use for valuing inventory and
determining the cost of goods sold. (For information on costing methods,
see "Costing Methods.")
You can use as many account sets as you need for your inventory items.
For example, you may wish to use separate account sets for different
item categories, for items assembled in different areas, or for items
obtained from different suppliers.
Adding account sets. You use the Account Sets form in the Setup folder
to add account sets.
Contents of account sets
Selecting a costing method

See also
Account Sets form
Steps for setting up Inventory Control

Standard Costing Method
Standard costs are carefully predetermined target or attainable costs that
are useful in building budgets and gauging performance. You might use
this method if your item costs do not vary much, or if stock turnover is
rapid.
When you use the standard costing method, Inventory Control records
the difference between the weighted moving average cost and the
standard cost in the cost variance general ledger account, and uses
weighted moving average to value your inventory.
Under the standard costing method, actual costs are posted to inventory
upon receipt. The inventory is then valued and reported on the basis of
the weighted moving average cost for each item at a location. When you
ship goods, the cost of goods sold is calculated using each shipped
item’s standard cost.
You can change the standard cost of an item at any time using the
Location Details form.
Warning! If you ship units of an item for which you have not yet entered
a standard cost, Inventory Control calculates the cost of goods sold using
a standard cost of zero.

See also
First-in, first-out (FIFO) costing method
Last-in, first-out (LIFO) costing method
Most recent cost costing method
User-specified costing
Weighted moving average costing
Serial and Lot costing

User-Specified Costing Method
User-specified costing allows you to enter costs for items as they are
shipped. Inventory Control uses this costing method for all non-stock
items. You can also use it for stock items.
Under this costing method, stock items are received and inventory valued
at moving average cost. When you ship an item, you enter the unit cost
or extended cost.
You can specify items as bills of material components (for example, nonstock items). You can specify the cost for the item when setting up a bill
of material or during assembly of the master item.
See also
First-in, first-out (FIFO) costing method
Last-in, first-out (LIFO) costing method
Most recent cost costing method
Standard costing method
Weighted moving average costing method
Serial and Lot costing

Weighted Moving Average Costing Method
Under this method, Inventory Control pools the costs of all acquired units
at a location, so that the costs of one unit cannot be distinguished from
the costs of another. The program assigns a unit cost to items that are
withdrawn from a location’s inventory for sale or use. This unit cost is an
average of all units in the location’s pool at that time.
When you receive new items into inventory, the program adds the total
cost of the units received to the total cost of the items already in inventory
at that location. When a unit cost is required, Inventory Control divides
the total cost by the units on hand at the location, and rounds the result to
the nearest currency unit (for example, the nearest cent).
To determine the total cost of a shipped item, Inventory Control multiplies
the number of units shipped by the calculated average unit cost at the
location (or the most recent cost if the inventory is less than zero).
The weighted moving average method tends to yield an item cost that is
between those resulting from the FIFO and LIFO methods.
See also
First-in, first-out (FIFO) costing method
Last-in, first-out (LIFO) costing method
Most recent cost costing method
Standard costing method
User-specified costing
Serial and Lot costing

Serial and Lot Costing Methods
The Serial and Lot costing methods are available to use in the I/C
Account Sets form only if you are licensed to use Serialized Inventory
and Lot Tracking.
These methods calculate the cost of serialized/lotted items as follows.
Serial number costs are determined by taking the total detail line
cost (including any additional costs) and dividing by the number of
serial numbers to get the cost per serial number.
Lot costs are determined by taking the total detail line cost (including
any additional costs) and dividing by the number of lots generated to
get the cost per lot.
So for each transaction, all costs per line in the detail grid are added
individually and divided by the total items per line to get the respective
costs. Any cost adjustments processed subsequent to the receipt can
also increase or decrease the cost of the serial numbers/lots being
adjusted.
Inventory Control will use the cost for each serial number or lot in
shipment transactions. For serial numbers, the total cost for the serial
number in the shipment transaction will be used. For lots, if the total lot
quantity is being shipped, the total cost for the lot in the shipment
transaction will be used. If however, the quantity shipped is less than the
total lot quantity, the cost used will be the average unit cost for the lot,
multiplied by the number of units shipped.
Example:
Lot 1: Lot Quantity = 100, total lot cost = $1,000, average unit cost =
$10
If only 15 units from Lot 1 are shipped, the cost used for the shipment
is 15 x $10 = $150
Note: For items that use the serial costing method or lot costing method,
the settings Allow Serial Quantity To Be Different From The Quantity
In The Entries and Allow Lot Quantity To Be Different From The
Quantity In The Entries are not available in the Serials/Lots tabs on the

. The serial quantity and lot quantity must always be the same as
the entry quantity for these costing methods.
I/C Items form

See also
First-in, first-out (FIFO) costing method
Last-in, first-out (LIFO) costing method
Most recent cost costing method
User-specified costing
Weighted moving average costing

Categories Field List
Category Code and Description

Options tab
Allow Commissions
Default Price List
General Ledger Accounts
Inactive
Last Maintained
Commission Rate

Taxes tab
Tax Authority
Purchase Tax Class and Description
Sales Tax Class and Description

Adding Categories
Use the Categories form to create categories for your Inventory Control
system.
You must add categories before you can add items to Inventory Control.
You assign a unique name of up to six characters, called a category
code, to each category you create. If you do not group your inventory
items, you can set up one category code and assign it to all items.
Category codes can contain upper-case letters and numbers.
You can override the category when you ship an item, and you can
change the category assigned to an item record at any time. For
example, on a shipment you could specify the category as "sample" to
deal separately with costs and revenues for goods shipped out as
samples.
You cannot delete a category if it is assigned to any items.
Integration with general ledger. For each category, you must enter
general ledger account numbers for the four following accounts (Sage
ERP Accpac Order Entry uses the Sales account and Returns account —
Inventory Control does not use them):
Sales. A revenue account which Order Entry credits with the
revenue from goods sold.
Returns. A revenue contra account which Order Entry debits to
record the reduction of revenue caused when previously sold goods
are returned or credit notes are issued.
Cost of Goods Sold. An expense account which Inventory Control
automatically debits with the cost of goods sold, and credits with the
cost of goods returned.
Cost Variance. An expense account in which Inventory Control
records the cost variance between the actual cost and either the
standard cost (for items using the standard costing method) or the
most recent cost (for items using the most recent costing method) of
inventory items sold.

Using Sage ERP Accpac Order Entry
If you use Order Entry, the Inventory Control categories:
Specify whether commissions can be paid on the sale of items in a
category and, if so, the maximum commission rate.
Assign a taxing authority, and tax classes for sales and purchases.
Tax information from categories appears automatically in item records to
which you assign the category. You can override the category tax
information in item records.
Order Entry uses the commission rate and tax information — Inventory
Control does not use them.

Contract Codes Field List
Contract Code and description
Period
Lifetime
Contract Days
Effective Days
Description

G/L Integration Form Field List
Integration tab
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by
G/L Transactions Generated Through Day End Number
Transaction Type
Source Ledger
Source Type

Transactions tab
G/L Detail Comment
G/L Detail Description
G/L Detail Reference
G/L Entry Description

G/L Integration — Transactions Tab
Use this form to:
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment columns on the
Inventory Control G/L Transactions report and in the corresponding
fields in the general ledger batch.
Look up the last Day End Number for which you have created
general ledger batches.
Click the field list button or on of the links shown below for more
information on selecting G/L integration options.
Integration tab

Changing Settings
You can change any of your choices in the G/L Integration form at any
time. However, you should be aware that any changes you make will
apply only to general ledger transactions created after the change, and
will not affect existing general ledger batches.

Before using the G/L Integration form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact the options have
on processing within Inventory Control.
See also
Account Sets
Categories
Inventory Control icons
Inventory Locations
Item Structures
Price List Codes
Segment Codes
Steps for Setting Up Inventory Control

Integration Options — Creating G/L Transactions
Inventory Control produces general ledger transactions from the
inventory transactions you post. Each general ledger transaction includes
all the information you need to update inventory control accounts in your
general ledger.
If you use Sage ERP Accpac General Ledger and Inventory Control with
the same database, Inventory Control creates General Ledger batches or
appends to existing batches either when you post the transaction, or
when you run day-end processing, or at a later time that you choose.
If your General Ledger is at another location or in a separate database,
Inventory Control appends general ledger transactions to a file you can
import into another general ledger, or print, then enter manually into your
general ledger. Inventory Control appends to the transaction file either
when you run day-end processing or at a later time that you choose.
See also
Create G/L Transactions
Reporting general ledger data

G/L Integration Options — Consolidation Options
for G/L Transactions
If you selected the On Request Using Create G/L Batch Icon option to
create general ledger transactions, you can create consolidated batches
of general ledger transactions that combine several details into a single
detail, or you can create unconsolidated batches that include all the
details posted to each general ledger account. Select the consolidation
method you want from the Consolidate G/L Batches option.
If you selected the During Day End Processing option to create general
ledger transactions then you cannot create consolidated batches of
general ledger transactions.
Consolidation reduces the amount of information in the general ledger
batch and results in a shorter G/L Transactions Listing. Consolidation
also "consolidates" the information in the Reference and Description
fields for each transaction.
Consolidate transaction details if you do not need a record of all details
posted to each general ledger account from Inventory Control
transactions.
The options available include the following:
Do not consolidate.
All the details posted in Inventory Control will be included in the
General Ledger transaction batch.
Choose this option if you use optional fields and pass optional field
information from I/C transaction details to G/L transaction details.
Consolidate transaction details by account.
All the details within a transaction with the same general ledger
account number are combined into one detail.
Choose this option if you do not use optional fields, but still want to
associate general ledger transactions with originating documents (for
drill down or to maintain a manual audit trail).
Consolidate by account and fiscal period.

All the details with the same general ledger account number and fiscal
period are combined into one detail.
Note that this choice only consolidates details from different
transactions if you create transaction batches using the G/L Batch
form.
Consolidate by account, fiscal period, and source.
All the details with the same general ledger account number, fiscal
period, and source code are combined into one detail.
This choice only consolidates details from different transactions if you
create transaction batches using the G/L Batch form.

Integration Options — Detailed G/L Transactions
Use the Do Not Consolidate option if:
You require detailed general ledger transaction information for your
Inventory Control records.
You want to drill down from transactions in General Ledger to the
source transactions in Inventory Control.
The Do Not Consolidate option provides complete information in your
general ledger transaction batch, but can result in a long G/L
Transactions report and a large general ledger batch. However, if you
use Sage ERP Accpac General Ledger, you can consolidate the
transaction details when you post the batch in General Ledger.

Integration Options — Descriptions, References,
and Comments for G/L Transactions
You can specify the type of information to use in the Description,
Reference, and Comment fields for each unconsolidated general ledger
transaction and transaction detail. The information appears in Inventory
Control’s G/L Transactions report, and on reports in General Ledger.
Select the information you need for your audit trail of unconsolidated
Inventory Control transactions using the Transactions tab of the G/L
Integration form.
When you consolidate general ledger transactions by account number
and fiscal period, the source code after consolidation is IC-CO.
When you consolidate general ledger transactions, the reference for each
transaction becomes blank, and the description for each transaction is
changed to "Consol. by I/C on date." (Note that when there is only one of
a particular transaction type, the reference and description for the
transaction are whatever you selected on the Transactions tab of the G/L
Integration form.)

Item Structures Field List
Item Structure
Prefix
Segment Description
Segment Length
Segment Separator
Structure Code and Description
Total Length
Use As Default Item Structure

Locations Field List
Location

Address tab
Address
City
Contact
Country
E-mail
Inactive
Last Maintained
Location Type
State/Province
Telephone and Fax Numbers
Zip/Postal Code

Contact tab
Name
Telephone
Fax
E-Mail

Items tab (appears if you do not select the option to Allow Items At
All Locations)
Allow Items at This Location
Allowed
Description (item number)
From/To
Item Number
Select by

Integration tab
G/L Segment Code
G/L Segment
Override G/L Account Segments

Locations Form — Contact
On this tab, you specify the name, telephone number, fax and e-mail
address of the main contact person at this location.
Click the following links for information about other tabs in the Locations
form:
Address

Items

See also
Inventory Control icons
Setting up locations

Integration

If you use Sage ERP Accpac General Ledger
You must decide whether you want to turn on the Override G/L Account
Segments option to replace (override) segments in General Ledger
accounts when you generate Inventory Control transactions involving
items stocked at the location.
The accounts affected are those in an item’s category and account set.
You can replace any segment except the account segment, which
identifies the General Ledger account as an asset, liability, income or
expense account.
For example, if you have a location segment in your General Ledger
inventory control account, you can value your stock by physical location if
you replace the location segment with segment codes which identify
physical locations.

Assign Items to Locations
Before you can post transactions involving an item at a location, such as
receive the item at the location, you must do one of the following:
Select the Allow Items At All Locations option in the Options form.
Or,
Assign the item to a location (an item can be assigned to more than
one location).
You must assign an item to a location before you can add (receive)
the current quantity and cost for the item at the location.

Mask Structures Field List
Structure Code
Mask Type
Description
Prefix
Mask Structure
Total Length
Segment Number
Segment Type
Segment Length
Segment Separator
Increment

Options Form Field List
Company tab
Enter company information in the fields provided.

Processing tab
Accumulate (item statistics) By
Additional Cost For Items On Receipt Returns
Allow Edit Of Statistics
Allow Fractional Quantities
Allow Items At All Locations
Allow Negative Inventory Levels
Allow Receipt of Non-Stock Items
Alternate Amount (1 or 2) Name
Default Goods In Transit Location
Default Posting Date
Default Rate Type
Default Weight Unit of Measure
Functional Currency
Keep Item Statistics
Keep Transaction History
Multicurrency option
Only Use Defined UOM
Period Type
Prompt To Delete During Posting
Weight Unit Of Measure

Items tab
Default Item Structure
Segment Name
Length (of segment)
Segment No. (Number)
Segment separators
Validate

Documents tab
Document Type
Length
Prefix
Next Number

Costing tab
Cost Items During (Posting / Day End Processing)
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing)

Serials tab
Serial Number Mask
Days to Expiry
Allow Serial Quantity to be Different from the Quantity in the Entries
Use the Qty Ordered field in OE for the Allocation of Serial Numbers

Expired Serial Allocation Message
Auto-Allocation Sort By
With Earliest/Latest First
Separators Used in Serial Mask Structures

Lots tab
Lot Number Mask
Days to Expiry
Days on Quarantine
Allow Lot Quantity to be Different from the Quantity in the Entries
Use the Qty Ordered field in OE for the Allocation of Lot Numbers
Expired Lot Allocation Message
Auto-Allocation Sort By
With Earliest/Latest First
Separators Used in Lot Mask Structures

Changing Settings
After setup, you can change any of the selections and information you
entered in the Options form, with the following exceptions and
restrictions:
You can select the Multicurrency and Allow Fractional Quantities
options at any time, but you cannot turn either option off after saving
changes to the Options form.
You can change the type of year (fiscal or calendar) and period by
which you accumulate item statistics, but you should do so only at
fiscal or calendar year end.
If you change either method partway through a year, the statistics
already accumulated will be incorrect or in the wrong period.
If you change from updating costs during day end processing to
updating costs during posting, you must first run day end to cost all
outstanding posted transactions.

Using Multicurrency Accounting in Inventory
Control
You use multicurrency accounting if you want to process receipt
transactions and shipment transactions, maintain price lists, and fill
orders (using Sage ERP Accpac Order Entry) in more than one currency.
To create a multicurrency Inventory Control system, you:
1.Turn on the Multicurrency option for the company and select a default
rate type in the Company Profile of Common Services.
2.Use the Common Services Currency forms to add any currency codes
you need for Inventory Control, and enter exchange rates for the
currencies you use.
When you install Sage ERP Accpac, you also install a large set of
currency codes that use standard international abbreviations and the
format and number of decimal places that are normally used with
each currency. You probably will not need to define new codes unless
you do not use the international codes.
3.Select the Multicurrency option in the Options form in Inventory
Control to turn on multicurrency accounting for your Inventory Control
system.
You can select the Multicurrency option at any time; but once you
save the Options form with the option selected, you cannot change
back to single-currency accounting.
4.Use the Item Pricing form and Copy Item Pricing form to add item
prices for every currency in which you sell each item.
You do not need to enter multicurrency totals for Inventory Control sales
statistics, because the program keeps these statistics in the functional
currency.
See also
Steps for setting up Inventory Control

Optional Fields Setup Field List
Click the following links for information about the fields in the I/C Optional
Fields setup form.
Optional Fields For
Optional Field and Description
Value Set
Default Value and Description
Required
Auto Insert

Adding Optional Fields to Records
You can add an unlimited number of optional fields to records and
transactions.
1.Open the form you are adding an optional field to (for example,
Transfers).
2.Click the Zoom button beside the Optional Field label to open the
Optional Fields selection form. (The label remains dimmed, but you
can still click the Zoom button.)
3.In the selection form, click the Finder in the Optional Field column,
then choose an optional field from those that were defined in the I/C
Optional Fields setup form.
If the Finder list is empty, no optional fields have been assigned for
this particular task. You will have to open the Optional Fields form in
I/C Setup to assign one.
4.Click the Finder in the Values field to select a value. The description
appears automatically.
5.Click Close. You return to the form. Note that once an optional field
has been added, a check appears in the box beside the Optional Field
label.
6.Continue with the transaction, and either post it or save it for later
posting.

Price List Codes Field List
Price List Code and Description

Discounts tab
Customer types
Discount on Price by
Discount Percent/Amount
Markup on Cost By
Markup Percent/Amount
Pricing Determined by
Price By Quantity or Weight
Price Decimals
Pricing Determined by
Quantity Purchased
Round to a Multiple of
Rounding Method
Selling Price Based on

Price Check tab
Check
Check Base
Cost/Margin Base
Price Check Type
User ID / Greater Than / Less Than

Taxes tab
Tax Authority and Description
Customer Tax Class and Description

Price List Codes Form — Price Check Tab
The Price Check tab in the I/C Price List Codes form lets you check price
overrides in Order Entry for orders that use this price list.
If you choose None for the Price Check Type, this screen remains blank.
Note: Price checks are available only in Sage ERP Accpac 500

To set price checks
1.Choose how you want Order Entry to respond to price overrides.
Order Entry can:
Do nothing (if you choose None).
Display a warning message and let you continue.
Display an error message and reject the price override.
Force you to get a supervisor’s approval on price overrides.
2.Choose whether the check should be done on the unit price or on the
sales margin.
3.Enter the range of prices available to each user ID. If you want, you
can create several price approval levels for sales clerks and
supervisors.
For information about other tabs, click these links:
Discounts

Taxes

Click here for hints on using forms.

See also
Account Sets
Categories
Inventory Control icons
Inventory Locations
Item Structures
Options
Segment Codes
Steps for Setting Up Inventory Control

Defining Price Lists
You use price lists to store pricing information for all of your inventory
items.
Price lists are used mainly by the Order Entry program to calculate
invoice amounts, but you can also see item prices when you ship goods
from Inventory Control, and you can print item prices on Inventory Control
print on reports and on item labels and bin/shelf labels.
You can use different price lists to store:
Regular prices.
Sale prices.
Wholesale prices.
Regional prices.
Prices for volume discounts to customers who make large
purchases.
Prices in each currency with which your company deals (if you use
multicurrency accounting).
To add an item to a price list, you specify:
The currency code, for multicurrency ledgers ( a price list can
contain items that use different currencies).
The price list code.
The item number.
A description you want to appear with the item on price list reports.
This is also the description that appears in Order Entry detail lines
and on orders and invoices. You can translate this description if the
price list is for other countries.
The number of decimal places you want the program to use for
displaying and printing the prices and costs of the item.
A base price, which is the expected selling price. If you have Sage
ERP Accpac 500, you can also:

Price volume discounts by quantity or weight.
Enter one or more base prices for multiple units of measure.
Calculate the base price using the cost plus a percentage or
amount.
A sale price with start and end dates for the sale (optional). Again, If
you have Sage ERP Accpac 500, you can also:
Enter one or more base prices for multiple units of measure.
Calculate the base price using the cost plus a percentage or
amount.
A markup cost, and a factor by which to mark up this cost to
calculate a selling price for the item.
A start and end date for the price list. This means that you can easily
cut over from an old price list to a new one on a particular date.
Whether to calculate selling prices by discounting your selling (base)
price, or by marking up your cost. You can also choose to mark up
your standard cost. In multicurrency ledgers, you can mark up on
standard cost only on functional-currency price lists.
Whether to calculate customer discounts on selling prices by a
percentage or by a specific amount, and whether customer discounts
are calculated based on volume purchased or on customer type.
If you are using Sage Accpac 500, whether to check for price
overrides in Order Entry for orders that use this price list, and display
warnings, error messages, or require supervisors' approval for prices
that exceed a particular range.
Tax authorities (such as state or province) and customer tax classes
if you want the program to include taxes in the prices of items for
Order Entry.

Adding Price Lists
Use the Price List Codes form to add the price lists you need.
To add a price list, you:
Assign a unique code, up to six characters, to identify the price list.
Price list codes can contain upper-case letters and numbers.
Select default options and settings which will appear when you add
items to price lists. Specify:
Whether to calculate customer discounts by discounting your
selling price, by marking up your markup cost, or by marking up
your standard cost.
Whether to calculate customer discounts by discounting or
marking up by a percentage or a specific amount, and the
percentage or specific amount to discount or mark up.
Whether to base customer discounts on customer type, or on the
number of items purchased (volume discount).
The rounding method (up, down, or none) that you want the
program to use when calculating discount or markup prices. If you
discount or mark up prices by a percentage, you can also specify a
number to which you want all prices rounded, such as the nearest
five cents.
Tax authorities (such as state or province) and customer tax
classes that apply to the sale of items on the price list.
When you define price lists, they contain no prices — you add item prices
later.

Creating Other Price Lists
After adding items to their first price list, use the Copy Item Pricing form if
you want to copy a single item or group of items to subsequent price lists.
To copy items already on a price list to another price list, you specify:
The price list code of the price list to which the items already belong.
The pricing currency you are copying from.
The price list code of the price list to which you are copying the
items.
The pricing currency you are copying to.
Which items to add.
Which pricing information to copy exactly and which to adjust.

Segment Codes Field List
Description (segment code)
Segment Code
Segment Name

Units of Measure Field List
Default Conversion Factor
Units of Measure

Warranty Field List
Warranty Code and description
Period
Lifetime
Warranty Days
Effective Days
Description

Weight Units of Measure Field List
1 (default unit) Equals
Default Weight Unit of Measure
Description
Weight Conversion Factor
Weight Unit of Measure

Inventory Control Icons —
Transactions Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons —
Statistics and Inquiries Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons —
Periodic Processing Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons -Physical Inventory Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons —
Items and Price Lists Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons —
Setup Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

If you have a license to use Serialized Inventory and Lot Tracking, you
see additional icons that allow you to set options and defaults for
serialized and lotted items. Mask StructuresWarranty CodesContract Codes

Inventory Control Icons —
Setup Reports Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

Inventory Control Icons —
Stock Control Reports Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

If you have a license for Serialized Inventory and Lot Tracking, additional
icons appear allowing you to generate the following reports.
Serial/Lot Transactions
Serial/Lot Number Qty on Hand
Recall
Serial/Lot Number List
Serial/Lot Stock Listing
Warranty/Code List
Quarantine

Inventory Control Icons —
Price/Sales Analysis Reports Folder
Click an icon for the Help topic describing the associated Inventory
Control form.

File Menu
The File menu appears in most Inventory Control forms and contains
some or all of the following commands:
Close

Closes the current form.

Use this command to hide fields and/or buttons in forms and
dialog boxes for specific users or for all users.
Customize

Exports the data records you specify from Inventory Control to nonSage ERP Accpac programs.
Export

Imports the data records you specify from non-Sage ERP Accpac
programs to Inventory Control.
Import

Print

Prints the current report, list, or form.

Help Menu
The Help menu contains the following commands:
Contents
Starts Help and displays the topics in Inventory Control Help.
Using Help
Describes how to use Help.
About...
Displays version, mode, and copyright information about the Inventory
Control form you have open.

Settings menu
A Settings menu appears on all transaction entry forms and on several
report forms.

Transaction Entry Settings
The Settings menu provides the following option on transaction entry
forms:
Auto Clear
The Auto Clear option helps you to streamline data entry in transaction
entry forms.
Select the Auto Clear option to start a new entry automatically when you
add a transaction.
If this option is turned on, the program automatically clears all fields
each time you post a transaction, and returns the cursor to the NEW
field to let you start a new transaction.
If this option is turned off, the program leaves the transaction
information on the screen after posting. Click the New button to start
a new transaction.

I/C Report Settings
Save Settings As Defaults / Clear Saved Settings
This setting lets you save the current report settings as personal defaults
or restore the program's original settings. It appears in the menu for the
Item Valuation and Item Status reports.
To save the current settings as your personal defaults for the form, select
the Save Settings As Defaults option.
To revert to the program's original settings, select the Clear Saved
Settings option.

Changing Column Order in Data Entry Forms
You can permanently or temporarily change the order in which columns
appear on many Sage ERP Accpac forms.
For example, you can change the order of the Sales Tax Class and
Description columns to match the field order of a document from which
you are entering data.

To move a column
Point at the column heading.
Hold down the left mouse button.
Drag the column to its new location.
Release the button.

To get back the original column order
Select the All Other Settings option in Restore Defaults (right-click
your mouse on the highlighted icon, then select Restore Defaults
from the popup menu that appears, or select Restore Defaults from
the Sage ERP Accpac desktop's Object menu).
The columns will then display in the order they were in when Sage
ERP Accpac Inventory Control was first installed.
See also
Data Entry Tools and Shortcuts
Using Help

Changing Column Widths in Data Entry Forms
Double clicking on the division between columns resizes the column on
the left to its minimum size based on the data it contains.

To change the width of columns
1.Position the mouse pointer on the vertical line separating a column
heading from the next heading to the right.
2.Drag the column to the right (to make the column wider) or to the left
(to make it narrower).
3.When you reach the width you want, release the mouse button.
To restore your original settings
From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
The columns will be in the original order the next time you open the form.
See also
Changing column order in data entry forms
Data entry tools and shortcuts
Using Help

Processing Internal Usage Transactions
You enter an internal usage transaction when you want to use inventory
items within your own business.
For example,
You might remove items from inventory to stock the store's
bathroom.
An office supply company may use a desk from inventory for its own
office.
If you also have Sage Fixed Assets (FAS), you can identify equipment
such as office furniture, computers, etc. as fixed assets during
transaction entry, and Sage ERP Accpac will transfer the asset
information to FAS.

Internal Usage Transactions
Typically, when you sell inventory items, you credit the inventory account
by the cost of the items sold, and you debit the cost of goods sold
account.
When you record an internal usage transaction, you still credit the
inventory account by the cost of the items, and you either debit an
expense account or an asset account, depending on the type — or value
— of the item ).
For instructions on entering Internal Usage transactions, see Use Goods
Internally.
See also
Processing adjustments
Processing assemblies
Processing receipts
Processing shipments
Processing transfers

Entering Current Item Quantities and Costs
When you set up your Inventory Control system, you must add the
current quantities and costs for your inventory items.
You add your current item quantities and costs by receiving them using
the Receipts form. You can also import receipts from a spreadsheet or
other non-Sage ERP Accpac program.
For step-by-step instructions on adding your current item quantities and
costs, see Adding current item quantities and costs.

Entering Sales Statistics for Current and Previous
Years
If you want prior-period sales statistics, you can enter the sales data
(units sold, number of transactions, sales amount, and actual cost) from
current and previous years that you want to view online or for which you
want to print reports either during or after setup.
Before you can add sales data, you must select the Allow Edit Of
Statistics option on the Processing tab of the Options form.
Use the Sales Statistics form to add sales data from current and previous
years to your Inventory Control system.
Step-by-step instructions for entering sales statistics are included in
"Step 12: Add Sales Statistics," in Chapter 3 of the Getting Started guide.

Entering Transaction Statistics for Current and
Previous Years
Either during or after setup, you can enter transaction data from current
and previous years that you want to view online or for which you want to
print reports.
Before you can add transaction data, you must select the Allow Edit Of
Statistics option on the Processing tab of the Options form.
Use the Transaction Statistics form to add transaction data from current
and previous years to your Inventory Control system.

Receipt Adjustments
You can change the following fields in save receipts:
Description
Date, Year, and Period
Additional Cost
Comments for each detail
Adjusted Unit Cost for each detail
Adjusted Cost (adjusted extended cost for each detail)
This feature lets you receive goods into inventory before you get the
invoice. You can either:
Save an incomplete receipt that does not contain the cost of the
goods, and then edit the receipt and post it later.
Or
Post the receipt, and when you know the cost of the goods, you
enter it as an adjustment to the receipt.
For instructions about using the Receipts form to record receipt
adjustments, see Processing Receipts in the online help.
Chapter5 "Receipts and Shipments" in the Inventory ControlUser Guide.
Note: Do not confuse the Adjustment option in the Receipts form with the
Adjustments form in Inventory Control. You use the Adjustments form to
change (adjust) item quantities and costs for the items in your inventory,
whereas you use the Adjustment option in the Receipts form to make
changes to incomplete receipts.
For example, if a receipt has been deleted and you want to adjust the
quantities and costs of items received, you must enter an adjustment
transaction using the Adjustments form.
See also
Processing receipts
Receipt returns
Receipts form

Receipt Returns
If you return items to a supplier from an incomplete receipt, you can use
the Receipts form to record the transaction. If the receipt has been
deleted, you must enter an adjustment using the Adjustments form to
record the return.
When entering receipt returns, you can change the following fields in the
Receipts form:
Description
Date, Year, and Period
Prorate/Leave Additional Cost
Comments
Quantity Returned
See also
Processing receipts
Receipt adjustments
Receipts form

Understanding Serialized Inventory and Lot
Tracking
If you have a license to use Serialized Inventory and Lot Tracking, you
can assign serial numbers and/or lot numbers to items when you process
transaction in Inventory Control.
You use the serial numbers and lot numbers to track items from their
receipt in inventory to their sale to customers and beyond.

Upgrading from a Previous Version
Users from previous version of Serialized Inventory and Lot Tracking
were able to generate serial and lot numbers as needed while performing
various different transactions. This functionality is not available in version
5.6, as you need to use the Serial/Lot Reconciliations form to create new serial and
lot numbers.

Using Bar Code Readers
When using bar code readers to enter serial numbers, program the
scanner to add a carriage return at the end. When entering multiple serial
numbers during transactions, you will have to place your cursor on a
blank line in the detail grid of the respective form. For instance, if you
leave the cursor in the Next Serial Number field and scan a bar code, you
will be required to click Add before the number appears in the detail grid.

Settings and Options for Serialized and Lotted
Inventory Items
An item is considered "serialized" if the Serial Number checkbox is
selected in the I/C Items form, and "lotted" if the Lot Number checkbox is
selected. Once an item is defined as serialized or lotted (or both),
numbers will need to be assigned when processing transactions involving
the item. But before this happens, the format of lot and serial numbers
must be defined by adding mask structures.
While the Items form is used to manage options on an item-by-item
basis, the Options form is used to define global settings which apply to all
serialized and lotted items.
The Serials tab on the Options form has the Allow Serial Quantity To Be Different
From The Quantity In The Entries setting, which determines whether it
is mandatory or optional that all serialized items in a transaction be
assigned a serial number before the transaction can be saved. A similar
option exists for lot quantities as well on the Lots tab. There are other
settings you can define on the Options form, some which will affect other
Sage applications that process transactions involving serialized or lotted
inventory items.
High value items will often have warranties available to customers and
quality guarantees from vendors. As such you should also set up warranty
and contract codes that can be applied to serialized/lotted item.
Note: If you upgraded to version 5.6 from a previous Sage Inventory
Control version, most of your settings should have been imported during
conversion of serialized/lotted inventory data. Use the Serials tab and Lots tab
on the Items form to ensure the data has been converted properly for
your serialized and lotted items.

Transactions that Require the Assignment of
Serial and/or Lot Numbers
You will be prompted to assign numbers to serialized and/or lotted items
when processing transactions in Inventory Control.
Receive Serialized/Lotted items from Vendors
Make Adjustments involving Serialized/Lotted items
Use Serialized/Lotted items in Assemblies
Use Serialized/Lotted items for Internal Usage
Take Physical Inventory counts of Serialized/Lotted items
Ship Serialized/Lotted items to Customers
Transfer Serialized/Lotted items to other Locations

Serial/Lot Number Maintenance and Reporting
Once you begin processing basic transactions involving serialized/lotted
items, you may need to perform the following maintenance tasks.
Create and Reconcile Serial/Lot numbers
Register Serial Numbers for Customer Warranties
Update Warranties on Serialized/Lotted items
Recall and Release Lotted items
Release Lots from Quarantine
Split and Combine Lots

Use the following reports and Inquiries to determine the status of the
serial and lot numbers in your system.
Serial/Lot Number List Report
Serial/Lot Number Quantity on Hand Report
Serial/Lot Stock Listing Report
Serial/Lot Transactions Report
Mask Structures Report
Quarantine Report
Recall Report
Warranty/Contract Codes Report
Warranty Contract List Report
Lot Number Inquiry
Serial Number Inquiry

Assemblies/Disassemblies Field List
Assembly Number
BOM Number
Build Quantity (display only)
Component Assembly Method
Component Disassembly Method
Date
Description (optional)
Disassembly Cost
From Assembly Number
Location
Master Assembly Number (disassemblies)
Master Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
Posting Date
Quantity
Reference (optional)
Status
Transaction Type
Year/Period (display only)

Buttons
Delete
Details
Post
Save
Serials/Lots
Verify Quantities

Processing Assemblies — General information
For each transaction, you enter the following:
Assembly Number (a number to distinguish the transaction from
other assemblies for audit control purposes).
Press the Tab key to accept a program-generated number.
Description (add any information you want about the assembly;
optional).
Reference (for example, the reason you are assembling the master
items; optional).
Date (of the transaction).
Year and Period (to which you want to post the transaction in the
general ledger).
Master Item Number (of the master stock item for which you are
assembling units).
You cannot enter assemblies for non-stock items.
BOM Number (the number of the bill of material to use for
assembling units of the master item).
You can view and edit the bill of material you specify, by clicking the
Zoom button beside this field to display the Bills Of Material form.
Component Assembly Method (you can choose to assemble no
subassemblies, all component subassemblies in the master build
quantity, or assemble only those subassemblies with insufficient
quantities to complete the master item build quantities)
Location (the inventory location of the component items and the
location where the assembled master items will be stocked).
If you did not select the Allow Items At All Locations option in the
Options form, you can post the transaction only if you previously
allowed the master item and its component items to be stocked at the
specified inventory location.
Build Quantity (the number of master items that is produced from

one assembly of the bill of material; supplied by the program from
the bill of material record).
Quantity (the number of master items to assemble, which must be a
multiple of the build quantity).
The quantity must be a multiple of the number in the Build Quantity
field. For example, if the build quantity for the bill of material is 25,
then you must specify some multiple of 25 (such as 25, 50, or 75) for
the quantity, or the program will not allow you post the assembly.
Note: If you selected the Allow Negative Inventory Levels option in the
Options form, you can post assemblies for which there are insufficient
item quantities in stock.

Assembling Master Items that Use FIFO or LIFO
Costing
Inventory Control processes assemblies for items using FIFO and LIFO
costing methods, as described below:

FIFO / LIFO buckets
The program keeps track of the order in which units arrive at a location
by storing their receipt date, receipt number, quantity, and extended cost
in individual "buckets."
When you assemble units of a master item the program removes each of
the components from inventory, at the location you specified, and costs
them according to their item costing methods. The component costs are
added to the fixed cost and variable cost of the master item. Inventory
Control then creates a bucket at the same location and stores the
assembly number in the bucket. If some time later you want to adjust the
item quantity or cost in a specific bucket created by an assembly, you can
identify the bucket by the assembly number, which you will find on the
Assemblies Posting Journal.
Check component item quantities and locations. Before posting
assemblies, you can use the Verify Quantities button in the Assemblies
form to display a list of component items having insufficient quantity in
stock to assemble the quantity of master items you specified in the
Quantity field.
If you did not select the Allow Items At All Locations option in the Options
form, the Verify Quantities button also displays a list of component items
not stocked at the location specified in the Location field.
See also
FIFO and LIFO Costing Method

Receipts Field List
Additional Cost
Additional Cost Currency (multicurrency ledgers)
Adjusted Unit Cost
Adjusted Cost
Comments (optional)
Description (optional)
Exchange Rate (multicurrency ledgers)
Extended Cost
Item Description (display only)
Item Number
Labels
Line Number (display only)
Location
Manufacturer's Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
PO Number
Posting Date
Prorate/Leave Additional Cost
Quantity Received
Quantity Returned
Receipt Currency (multicurrency ledgers)
Receipt Date
Receipt Number
Reference (optional)
Require Labels
Return Cost (display only)
Total Cost (display only)
Total Extended Cost (display only)
Total Return Cost (display only)
Type
Unit Cost
Unit of Measure
Vendor Number (optional)
Year/Period (display only)

To post saved receipts
1.Enter the number of the receipt or select it from the Finder.
2.Click Post.
3.Click Close at the "Posting completed" message.
You can also use the Post Transactions form to post saved receipts.

To enter returns to existing receipts
1.Enter the number of the receipt or select it from the Finder.
2.Select Return from the Type list.
3.Make any changes you need in the description, date, fiscal year, and
fiscal period.
4.Specify whether to leave the additional cost assigned to the items
being returned or to prorate it over the remaining items on the receipt.
5.Enter comments to be included on the Receipts Posting Journal for
the items being returned.
6.Enter the quantity being returned. If required, assign serial and/or lot
numbers for serialized/loted items after entering a quantity.
7.Click Post or Save.
8.Click Close at the "Posting completed" message.

To enter adjustments to existing receipts
1.Enter the number of the receipt or select it from the Finder.
2.Select Adjustment from the Type list.
3.Make any changes you need in the description, date, fiscal year, and
fiscal period.
4.Enter comments to be included on the Receipts Posting Journal for
the items being adjusted.
5.Enter the adjusted unit cost or extended adjusted cost for each detail
line you wish to adjust.
6.Click Post (or Save to post the receipt later).
7.Click Close in the "Posting completed" message.

Processing Receipts — General information
For receipt transactions, you enter information in the Receipts form as
follows:
Receipt Number (a unique number, up to 24 characters in length, to
distinguish the transaction from other receipts for audit control
purposes)
Press the Tab key to accept a program-generated number.
Description (add any information you want about the receipt;
optional).
Reference (for example, an invoice number; optional).
Date (the transaction date).
Year and Period (to which you want to post the general ledger
transaction).
Vendor Number (the number you use to identify the supplier;
optional).
If you use Accounts Payable, you can select the vendor number from
the Finder.
PO Number (the number of the purchase order being filled by the
receipt; optional).
Receipt currency and exchange rate (multicurrency ledgers)
Prorate/Leave Additional Cost
Additional Cost Currency
Additional Cost

(on returns)

(appears only with multicurrency ledgers)

(the total of all additional receipt costs).

Require Labels.
Optional Fields
Total Cost

(receipts)

Total Extended Cost
Total Return Cost

(receipts)

(returns)

Item Detail information
Item number and description
Location
Quantity received
Unit of measure
Extended cost
Number of labels
Quantity returned
Return cost (if a return)
Manufacturers' item number
Optional fields

Processing Receipts — Detail information
For each detail line on a receipt transaction, you enter the following
information (note that you can enter the Quantity Returned only on a
return, and you can enter an Adjusted Unit Cost or Adjusted Cost only on
an adjustment):
Item Number (of the item being received).
Item Description (supplied by the program from the item record).
Location

(the inventory location at which you are receiving the units).

Quantity Received (the number of units being received).
Unit of Measure (the unit of measure for the quantity being
received).
Unit Cost; Extended Cost

(the unit cost and the extended cost of the units

being received).
(supplied by the program if you selected the Require Labels
option for the receipt, the number of item labels to print; optional).
Labels

Comments (add any comments you want to appear on the Receipts
Posting Journal regarding the detail line; you can change comments
if you enter a return or an adjustment; optional).
Quantity Returned

(the number of units to return to the supplier).

(supplied by the program, the extended cost of the units
being returned to the supplier).
Return Cost

(for modifying costs on receipt adjustments,
the adjusted unit cost and the adjusted extended cost, respectively,
of the units that were received).
Adjusted Unit Cost; Adjusted Cost

Optional Fields (add optional fields to receipt details using the
Optional Fields form in the Setup Folder; optional).
There are no restrictions on the number of detail lines you can enter on
receipt transactions.

Shipments Field List
Category
Comments
Contact (optional)
Contract / Project / Category / WIP Account
Currency (multicurrency ledgers)
Customer Number (optional)
Description (optional)
Entry Type
Exchange Rate (multicurrency ledgers)
Extended Cost
Extended Price
Item Description (display only)
Item Number
Line Number (display only)
Location
Manufacturer's Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
Posting Date
Price List (detail line)
Price List (header — optional)
Quantity
Reference (optional)
Ship Date
Shipment Number
Unit Cost
Unit of Measure
Unit Price
Year/Period (display only)

(if viewing job-related transactions from PJC)

Transfers Field List
Additional Cost
Comments (optional)
Completed
Description (optional)
Document Number
Extended Cost
Extended Weight
From Location
GIT Location
Item Description (display only)
Item Number
Line Number (display only)
Location Descriptions (display only)
Manual Proration
Manufacturer's Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
Outstanding Quantity
Posting Date
Proration Method
Receipt Unit
Received to Date
Reference (optional)
Requested Quantity
To Location
Transfer Date
Transfer Number
Transfer Quantity
Transfer Unit
Transferred to Date
Unit Cost
Unit Weight
Weight Conversion Factor
Weight Unit of Measure
Year/Period (display only)

Transferring Stock Items that Use FIFO or LIFO
Costing
This topic describes how Inventory Control processes transfers for items
using the FIFO and LIFO costing methods.
FIFO/LIFO buckets. The program keeps track of the order in which units
arrive at a location by storing their receipt date, receipt number, quantity,
and extended cost in individual "buckets."
When you transfer units between locations, Inventory Control creates a
bucket at the receiving location and stores the transfer number in the
bucket. If some time later you want to adjust the item quantity or cost in a
specific bucket created by a transfer, you can identify the bucket by the
transfer number, which you will find on the Transfers Posting Journal.
See also
Processing transfers

Adjustments Field List
Adjustment Date
Adjustment Number
Adjustment/Write-Off Account
Average Cost
Bucket Type (FIFO or LIFO costing)
Comments

(if viewing job-related transactions from PJC)

Contract / Project / Category / Overhead
Cost Adjustment
Cost Date (FIFO or LIFO costing)
Cost UOM
Description (optional)
Document Number (FIFO or LIFO costing)
Item Description (display only)
Item Number
Line Number (display only)
Location
Manufacturer's Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
Posting Date
Quantity
Reference (optional)
Transaction Type
Unit of Measure
Year/Period (display only)

Adjustments to Items Using FIFO or LIFO Costing
For items using the FIFO or LIFO costing method, the program keeps
track of the order in which units arrive at a location by storing each item's
receipt date, receipt number, quantity, and extended cost in individual
"buckets."
You can select from three options in the Bucket Type field on detail lines
for how to make adjustments to items that use the FIFO or LIFO costing
method: Offset Bucket, Specific Receipt, or Prorate.
Offset bucket. If you select Offset Bucket, then adjustments affect only
the offset bucket.
For each item at each location, there is an "offset" bucket the program
uses for special cases, such as when you ship more items than there are
in stock from a location (you must have set up Inventory Control to allow
negative inventory levels in order to do this). Offset buckets contain a
quantity and a cost, but do not contain a date or receipt number, like
other buckets.
Specific Receipt. You can specify a receipt number to select the cost
and quantity information for a particular receipt. The number of the
receipt from which a bucket is created is contained in the bucket.
Prorate. Select Prorate to have the program prorate the adjustment
across all buckets (including the offset bucket) for the item at the location.
The number of units and the amount of cost prorated to each bucket is
based on the quantity in each bucket.
The program determines which buckets to adjust by whether the costing
method is FIFO or LIFO.
See also
Adjustments form
Processing adjustments

Types of Adjustments
You specify the type of adjustment you want for each item on a
transaction. You can enter six types of adjustments using the
Adjustments form:
Quantity increase. Increases the item quantity on hand at the
location by the number you specify.
Quantity increase adjustments affect the item's unit cost, but the
extended cost does not change.
The program does not create general ledger transactions for this type
of adjustment because the value of the inventory does not change.
Quantity decrease. Decreases the item quantity on hand at the
location by the number you specify.
Quantity decrease adjustments affect the item's unit cost, but the
extended cost does not change.
The program does not create general ledger transactions for this type
of adjustment.
Cost increase. Increases the extended item cost at the location by
the amount you specify. Inventory Control recalculates the unit cost
based on the increased extended cost.
Cost decrease. Decreases the extended item cost at the location by
the amount you specify. Inventory Control recalculates the unit cost
based on the decreased extended cost.
Both Increase. Increases both the item quantity on hand and the
extended item cost at the location by the increases you specify.
Inventory Control recalculates the unit cost based on the increases.
Both decrease. Reduces both the item quantity on hand and the
extended item cost at the location by the decreases you specify.
Inventory Control recalculates the unit cost based on the decreases.

Internal Usage Field List
Category
Comments
Date
Description (optional)
Extended Cost
Fixed Assets
Asset Description
Sage FAS Template
Sage FAS Quantity
Sage FAS UOM
Sage FAS Value
Separate Assets
Item Description (display only)
Item Number
Internal Usage Number
Line Number (display only)
Location
Manufacturer's Item Number
Optional Fields (transaction)
Optional Fields (transaction detail)
Posting Date
Quantity
Reference (optional)
Unit Cost
Unit of Measure
Usage Account
Usage Account Description (display only)
Used By
Year/Period (display only)

Prepare To Add Inventory Items
You take the following steps to set up item records in Inventory
Control:
1.Add the item information from your existing inventory system to
Inventory Control, selecting the options you want to use.
2.(Optional) Add minimum and maximum desired stock quantities for
items so you can print reports to identify understocked and
overstocked items in your inventory.
Purchase Orders uses reorder information to automatically generate
purchase orders for understocked items.
3.(Optional) If you have already set up your inventory locations, assign
items to the locations where you want to stock them (or you can do
this later).
Note: If you turned on the Allow Items At All Locations option in the
Options form, the program assigns all items to all locations.
4.(Optional) If you repackage or assemble items before selling them as
merchandise, add bills of material to define master items that you
make from component items.

Adding Inventory Items
Adding item records to Inventory Control involves transferring your
existing item information to Sage ERP Accpac and selecting options that
help you process inventory data effectively.
When you add an item, you record the following information in the Items
form:
The item number you use to identify the item.
A description of the item.
The item number structure (the code you use to identify the item
number format).
The category to which the item belongs.
The account set the item uses. (You assign an account set to define
the costing method and general ledger balance-sheet accounts for
the item.)
The default price list from which you want the Shipments form to
display the item’s price. (You can override this price list when you
enter shipments.)
The picking sequence / bin number so items can easily be found in
the warehouse.
Whether the item is active, sellable, allowed in a Web store, a stock
item, has serial/lot numbers, and/or is a kitting item.
(Optional) A commodity number, if your company reports a valueadded tax (VAT).
The unit weight and the weight unit of measure.
An alternative item that can be used if this item is out of stock.
Comments.
The units of measure used for stocking, shipping, and receiving the
item.
Tax authorities used when selling the item through Order Entry.

Entries for optional fields that have been added to the item records.
Adding Bar Codes
Use the Manufacturers' Items form to associate bar codes with your item
numbers.
See also
Sage Accpac Order Entry
Sage ERP Accpac Order Entry and Purchase Orders

Alternate Items
For each item in your inventory, you can specify another inventory item
as its alternate item. Items can have more than one alternate item,
although you specify only one alternate item on each item’s record. An
item’s list of alternate items grows as you assign alternate items to items
which are themselves alternate items. The following example illustrates
how this works:
1.Add items A, B, and C to Inventory Control.
2.On A’s item record, select item B as its alternate item.
The program links the two items so that item A is also an alternate for
item B.
3.On B’s item record, select item C as its alternate item.
Item C is linked to the alternate item list that already contains A and B.
The result is that each of items A, B, and C has two alternates. The
following table shows this result:
Item

Alternate
Items

A
B
C

B,C
A,C
A,B

4.Remove item B from Inventory Control by deleting its item record.
By deleting item B, you remove it from the alternate item list, and the
link between items A and C is broken. Items A and C now have no
alternate items.

Quantities and Costs Selections
On the Integration tab, do the following:
Select On Request Using Create G/L Batch for the Create G/L
Transactions option.
Clear (do not select) the Append G/L Transactions To Existing Batch
option.
On the Processing tab, clear (do not select) the following options:
Keep Transaction History
Keep Item Statistics
After you add your quantities for items and costs, you can change any of
these options.

To delete G/L batches after importing
If you use another general ledger, or if your Sage ERP Accpac
General Ledger uses a different database than Inventory Control,
open your General Ledger and import G/L batches. You can then delete
the batches from the directory in which you keep your company’s
Inventory Control data. (Delete the files that begin with the letters glic,
and have the filename extension .csv.)
If you have just set up your inventory control balances and need to delete
General Ledger batches, follow the instructions in the online help for
Deleting a Batch.
The batches from I/C will appear as open General Ledger batches, and
you must set General Ledger to Allow Edit Of Imported Entries, on the
Posting page of the G/L Options form.

Undoing Option Changes
The options you might have changed are:
Keep Item Statistics option on the Processing tab of the Options
form.
Keep Transaction History option on the Processing tab of the
Options form.
Create G/L Transactions option in the G/L Integration form.
Clear (do not select) the Add G/L Transactions To Existing Batch
option in the G/L Integration form.

Varying Reorder Information (continued)
You can specify quantities for as many periods as you want within the
calendar year.
You can record the following reorder information for each period:
The minimum and maximum number of units you want in inventory.
The projected sales.
The number of units to order when the item’s quantity falls either
below the minimum, or below the projected sales.
You record all quantities in terms of the stocking unit of measure (which
is the unit Inventory Control uses to report stock levels for the item).

Minimum and Maximum Quantities (continued)
For example, if the quantity of an item on hand is 100, on purchase order
is 50, and on sales order is 80, then the quantity of stock for that item is
70 (that is, 100+50-80).
If you want to specify different reorder information for each calendar
quarter, enter the four period-start dates: January 1, April 1, July 1, and
October 1. For bi-monthly coverage enter the six period start-dates:
January 1, March 1, May 1, July 1, September 1, and November 1.
Note that you enter period-start dates numerically in the order month,
day. For example, you would enter the period-start date June 30 as 6/30.
In the preceding two examples, the first period starts on January 1 and all
periods are of equal duration, but these are not requirements. For
example, here is another set of valid period-start dates: May 2,
September 10, January 20, and March 25.
You may want to add reorder information only for part of your inventory,
such as expensive or high-volume items.

Bills of Material Field List
BOM Description
BOM Number
Build Quantity
Comments
Component Description
Component Item Number
Component Quantity
Component Unit of Measure
Component's BOM Number
Components (Yes/No)
End Date
Fixed Cost
Inactive
Master Item Number
Start Date
Unit Cost
Unit of Measure
Variable Cost (per Build Qty.)

Contract Pricing Field List
Customer Number
Price By
Item Number
Category Code
Price List
Contract Price Type
Use Lowest Price
Customer Type
Discount Percentage
Discount Amount
Cost Base
Fixed Amount
Fixed Price
Percentage
Calculated Unit Price
Start Date
Expiration Date

Copy Bills of Material Field List
From / To Master Item Number
From / To BOM Number
BOM Description
Build Quantity
Comments
Component Description
Component Item Number
Component Quantity
Component Unit of Measure
Component's BOM Number
Components (Yes/No)
Copy Detail
End Date
Fixed Cost
Inactive
Start Date
Unit Cost
Unit of Measure
Variable Cost (per Build Qty.)

Copy Item Pricing Field List
Create the Selected Fields Using Percentage / Exchange Rate
Exchange Rate for Default Price/Calculate Price Using Cost
From Price List
To Price List
From Currency Code
To Currency Code
From (Item number, Category, Item segment, or Vendor number)
To (Item number, Category, Item segment, or Vendor number)
Increase / Decrease by Percent
Rate Type and Multiply By Exchange Rate
Select by
Select Fields

Customer Details Field List
Item Number
Customer Number and Name
Customer's Item Number
Customer's Item Description
Unit of Measure
Comments and Instructions

Items Form Field List
Item Number and Description

Construct Item Number form
Structure Code
Item Number (display only)
Segment Number
Segment
Length
Value
Description (display only)

Items tab
Account Set Code
Additional Item Information
Allow Item in Web Store
Alternate Item
Category Code
Commodity Number
Costing Method
Default Picking Sequence
Default Price List
Inactive
Kitting Item
Last Maintained
Lot Number
Serial Number
Sellable
Stock Item
Structure Code
Unit Weight
Weight Unit of Measure and Conversion Factor

Units tab
Conversion Factor
Stocking Unit of Measure
Unit of Measure

Taxes tab
Tax Authority and Description
Purchase Tax Class and Description
Sales Tax Class and Description

Optional Fields tab
Optional Field and Description
Value Set
Value and Description

Items Form — Construct Item Number Popup
Use this popup to add new item numbers, selecting the desired item
structure and entering values for the segments in the number.
Using this popup to enter new item numbers saves you from having to
remember the format of an item structure, and lets you choose the
correct segment codes from the Finder for segments for which the
Validate option is selected on the Segments tab of the Options form.
To open or close the Construct Item Number popup, click the Zoom
button next to the Item Number field, or press F9 in the field.
To add item numbers
1.Type the structure code you want to use or select it from the Finder.
2.Enter a value for each segment of the item number. You can use the
Finder to select segment codes if the segment has been set up in the
Options form to use the Validate option.
3.Check the Item Number field to be sure the entry in the field is correct,
then click Select to move the new item number to the Items tab.
(When you click the Select button, the new number is automatically
formatted and inserted into the Item Number field, and the Construct
Item Number popup is closed.)
4.To cancel the item number you were defining and return to the Items
form, click Close.
See also
Items Form — Overview

Items Form — Items tab
Use this form to:
Specify the structure code, category code, and account set code for
new items.
Assign a default picking sequence and price list for the item.
Indicate whether the item is sellable, and whether it is an inventory
item, a non-stock item, or a kitting item.
Specify whether you assign serial or lot numbers to the item.
Specify the weight of a single stocking unit of the item and the weight
unit of measure.
Enter an alternate item number for the item.
Enter a commodity number (if you report VAT).
For information about other tabs in the Items form, click these links:
Units

Taxes

Serials

Lots

Optional Fields

For information about fields in the Items form, click the Field List button
beside the title of this help topic.
See also
Account Sets
Categories
Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Form -- Serials Tab
This tab appears only if you have a license to use Serialized Inventory
and Lot Tracking and the selected item is serialized.
Use this tab to:
View the serial number mask used for the item.
View or change the next serial number that will be assigned for this
item.
Set an expiration period for the serial, or view the days to expiry.
Make it optional to assign serial numbers before saving transactions
by selecting the option Allow Serial Quantity To Be Different From The
Quantity In The Entries. This option is not available for items that use
serial costing.
This setting allows serialized items that use a costing method other
than serial costing to have different quantities in entries than the
number serials allocated in transactions using Sage ERP Accpac
Inventory Control, Purchase Orders, and Order Entry.
Note that when entering orders, you can enter an order quantity and
choose to not allocate serial numbers. However, you must allocate
serial numbers when shipping the order.
assign or view a warranty code, and automatically place the serial on
warranty when sold and/or registered
assign or view a contract code, and automatically place the serial on
contract when received
add or view any optional fields for this item
For information about other tabs in the Items form, click the following
links:
Items

Units

See also
Account Sets
Categories
Contract Pricing
Customer Details

Lots

Optional Fields

Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Items Form -- Lots Tab
This tab appears only if you have a license to use Serialized Inventory
and Lot Tracking and the selected item is lotted.
Use this tab to:
See the lot number mask used for the item.
View or change the next lot number that will be assigned for this
item.
Set an expiration period for the lot, or view the days to expiry.
Put the lot on quarantine, or view the days left on quarantine.
Make it optional to assign lot numbers before saving transactions by
selecting the Allow Lot Quantity To Be Different From The Quantity In
The Entries option. (You cannot select this option for items that use lot
costing.)
This setting allows lotted items that use a costing method other than
lot costing to use different quantities than the lot numbers that are
allocated in transactions in Sage ERP Accpac Inventory Control,
Purchase Orders, and Order Entry.
Note that when entering orders, you can enter an order quantity and
choose to not allocate lot numbers. However, you must allocate lot
numbers when shipping the order.
Assign or view a warranty code, and automatically place the lot on
warranty when sold
Assign or view a contract code, and automatically place the lot on
contract when received
Add or view any optional fields for this item
For information about other tabs in the Items form, click the following
links:
Items

Units

See also
Account Sets
Categories

Serials

Optional Fields

Contract Pricing
Customer Details
Item Pricing
Location Details
Locations
Manufacturer's Item Numbers
Price List Codes
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure

Before Adding Items
Add the item structures needed to format your item numbers.
Add any segment codes you require to control the item numbers the
program allows to be entered.
Add the inventory locations you require to stock items.
Add the categories you require to group your item numbers.
Add the account sets you require for posting transactions to general
ledger accounts.
Add the units of measure for your items.
Add weight units of measure.
Add the price list codes you require to vary your basic item prices.
Add the taxing authorities and tax classes you require (using Tax
Services in Common Services).
Add any optional fields you want so you can include additional
information in your item records.

Using the Items Form
1.To select an existing record, enter its item number or select it from the
Finder (click the Finder icon beside the Item Number field or press F5
with the cursor in the Item Number field).
To start a new item record, click the "New" icon next to the Item
Number field or choose New from the Item menu.
To delete an item record, enter its item number, then choose the
Delete button. If a message appears asking you to confirm the
deletion, choose Yes.
2.Click another tab to enter more information.
3.Click Add or Save to keep any changes you make, or choose Close to
leave the form without saving changes.
For information about specific tasks, click these topics:
Adding item records
Editing item records
Deleting items records

Items Wizard Field List
Select the Wizard page for which you want field information:

Page 1 - Basic item information

Page 2 - Basic item information (cont.)

Page 3 - Item tax and optional fields information

Page 3 B - for Serialized Items only

Page 3 C - for Lotted Items only

Page 4 - Item location details

Page 5 - Item vendor details

Page 6 - Item pricing

Page 7 - Contract pricing

Page 8 - Manufacturers' item numbers

Page 9 - Customer details

Page 10 - Reorder quantities

Item Pricing Field List
Currency Code
Price List Code
Item Number

Prices tab
Description
Price By
Price Decimals
Base Price Type
Base Price

Base Price Using a Cost
Calculate Base Price Using
Default Base Price Using
Location
Cost Base
Percentage / Amount (added to cost)
Rate Type, Rate Date, and Exchange Rate
Pricing Unit
Sale Price Type
Sale Price

Sale Price Using a Cost
Calculate Sale Price Using
Default Sale Price Using
Location
Cost Base
Percentage / Amount (added to cost)
Rate Type, Rate Date, and Exchange Rate
Sale Unit
Sale Starts
Sale Ends
Markup Cost
Markup Unit
Markup Factor
Price List Starts / Ends

Discounts tab
Selling Price Based on
Discount on Price by
Rounding Method
Price Determined by
Round to a Multiple of
Discount Percentage/Amount
Markup on Cost by
Markup Percentage/Amount
Quantity Purchased
Customer Types

Price Check tab
Price Check Type
Check
Check Base
Cost / Margin Base
User ID / Greater Than / Less Than

Taxes tab
Authority and Description
Customer Tax Class and Description

Item Pricing Form— Price Check Tab
This tab lets you check price overrides in Order Entry for orders that use
this price list. Order Entry can:
Do nothing (if you choose None).
If you choose None for the Price Check Type, the rest of this tab
remains blank.
Display a warning message when prices exceed the boundaries you
define, and let you continue.
Display an error message and reject the price override.
Force you to get a supervisor’s approval on price overrides.
The "Default" price check range applies to all users who are not
specifically listed in the grid.
This tab appears only if you are using Sage ERP Accpac 500.
For information about other tabs in the Item Pricing form, click the
following links:
Prices

Discounts

Taxes

For information about fields in the Item Pricing form, select the Field List
button in the top-right corner of this help topic.
See also
Items
Price List Codes
Update Item Pricing

Using the Item Pricing Form
1.Double-click the Item Pricing icon in the Items And Price Lists folder.
2.Select the item that you want to add to a price list, and click the New
button at the bottom of the form.
3.If you use multicurrency accounting, enter a currency code for the
prices that you are adding, or use the Finder next to the Currency
Code field to select the currency code you need.
4.Enter the price list code or use the Finder next to the field to select the
price list code for the price list you want.
5.If you want to specify a different item number, enter it next , or use the
Finder next to the Item Number field to select the item number of the
item you want to assign to the price list.
To delete an item from the price list, select it, and then click the Delete
button. If a message appears asking you to confirm the deletion, click
Yes.
6.Fill in the fields on all tabs of the Item Pricing form.
7.Click Add or Save to keep any changes you made, or click Close to
leave the form without saving changes.
8.Once you add pricing information, you can change the price list code
to add this item to another price list, or you can change the item
number to edit the prices of another item on the same price list.
All the items you assign to the same price list appear on the same price
list on the Price Lists report.

After changing price lists
Print the price lists that include the information you changed, using
the Price Lists icon in Price/Sales Analysis Reports folder, to check
the new record information.
Compare the price lists you printed before making changes to those
printed afterwards to verify that you made all changes correctly.
After assigning items to their first price list, you can use this form to
assign them to other price lists, depending on your needs. You can also
use the Copy Item Pricing form to assign items on one price list to another price
list.

Kitting Items Field List
Item Number
Kitting Number
Description
Unit of Measure
Use as Default
Comments
Component Item Number/Description
Quantity
Unit of Measure
Unit Cost

Tracking Kitting Item Components
Not all items that are in a kit need to be given lot numbers; only those
that require tracking.
1.In the I/C Items form, use the Finder to display each item to be
included in the kit. (For example, if you had created a master item
called Desk Accessories, you would now choose pens, highlighters,
paper clips, stapler, and so on, to make up the set.)
2.On the Items form, select the Serial Number option for each item that
will become a component of the kit, then save before selecting the
next item.
3.After selecting the Serial Number option for your final component and
saving the change, close I/C Items.
4.Open Kitting Items. (The icon is located in the I/C Items folder.)
5.Use the Finder to select the master item number you created for the
kit.
6.Assign a number in the Kitting Number field, enter a description, then
click the Go button.
7.Enter a Comment if necessary, and, if this kit number will be the usual
version of the kits you create, select the Use as Default option.
8.In the grid, use the Finder in the Component Item Number column to
select components for this kit, then enter quantities and the unit cost
for each. Components can be the items you selected the Serial
Number option in step 2, or other items.
9.Click Add to add this Kitting Item, then click Close.
10.Perform Day End Processing.
After creating kits, you open Order Entry to assign serial numbers to the
components that are being tracked. See Order Entry online help for
instructions.

Location Details Field List
Allowed
Alternate Amount (Costing Unit)
Average Cost (Costing Unit) (display only)
Cost Unit of Measure
In Use (display only)
Item Number
Last Unit Cost / Costing Unit
Location
Name (display only)
Most Recent Cost (Costing Unit)
Picking Sequence
Quantity Available to Ship (display only)
Quantity Committed (display only)
Quantity on Hand (display only)
Quantity on P/O (display only)
Quantity on S/O (display only)
Standard Cost (Costing Unit)
Serial Cost/Lot Cost buttons

Before Adding Location Details
Choose a code of up to ten characters to identify each picking
sequence code you plan to add.
Add your item records to Inventory Control and decide on the
locations at which you want to stock individual items.
Determine the most recent cost for each item in your inventory.
Determine the standard cost of items that use the standard costing
method.
You can assign an item to as many locations as you want, but you must
assign it to at least one location before you can post transactions for that
item.

Using the Location Details Form
1.Enter an item number or select an item number from the Finder
beside the Item Number field.
2.As needed, assign the item to locations (if you do not use the Allow
Items At All Locations option), or add, edit, delete, or view location
details for the item at locations to which the item is already assigned.
To assign the item to a location, enter a location code or use the
Finder beside the Location field to select the location code. Repeat
this for each desired location.
To add or edit details for a location, select (highlight) the line for the
location, then add or edit the details. Repeat this for each desired
location.
To delete a location detail, select (highlight) the line for the detail, then
press the Delete key. If you see a message asking you to confirm the
deletion, click Yes.
3.Click Save to save new information or changes.

Modifying Location Details
You can change location detail records at any time.
To change a record, select the item number for the record you want to
modify, enter new information in the fields you want to change.
You can change the information in the following fields in a location details
record:
Picking Sequence
Cost Unit of Measure
Standard Cost (Costing Unit)
Most Recent Cost (Costing Unit)
Allowed
Last Unit Cost (Costing Unit)
If you added field names to the Alternate Amount 1 Name and Alternate
Amount 2 Name fields on the Processing tab of the Options form, you
can modify the contents of those fields as well.
When you are finished modifying a record, click Save to confirm your
changes.

After Changing Location Details
Print the Location Details report from the Setup Reports folder to
check the new record information, and to update your printed
records.
Compare the report you printed before changing or deleting location
details to those printed after the changes to verify that you made the
required changes correctly.

Manufacturers' Items Field List
Item Number
Manufacturers' Item Number
Manufacturers' Item Description
Unit of Measure
Comment

Reorder Quantities Field List
Item Number
Maximum Quantity
Minimum Quantity
Optional Fields
Period Start
Projected Sales
Reorder for (Location)
Reorder Quantity
Unit of Measure (display only)

Update Bills of Material Field List
From / To Master Item Number
From / To BOM Number
Update (type)
Type (component update)
Component Item Number
BOM Number (component)
Replace by Item Number
BOM Number (replacement)
Unit of Measure
Quantity
Unit Cost
Type (cost update)
Using
Base
Amount/Percent

Update Item Pricing Field List
The fields displayed on the form depend on the update method you
choose (Base Price, Sale Price, Markup Cost, or price check).
Amount
Base on Currency
Currency
Multiply by Exchange Rate
From / To Select by
Increase / Decrease
Margin
Markup Factor
Percentage
Price Check Type
Price List Code From / To
Rate Type
Sale Starts / Ends
Segment
Select by Item Number, Category, Item Segment, Vendor Number, or an Optional Field
Update Base Price / Sale Price / Markup Cost / Price Check
Using Percentage / Amount / Markup / Margin / Exchange Rate

Vendor Details Field List
Cost unit
Item number
Vendor contact
Vendor cost
Vendor currency
Vendor item number
Vendor name
Vendor number
Vendor type

Before Running Day-End Processing
Take the following steps before running day-end processing:
Post all the transactions that you want to be processed by day-end.
Note: Any transactions you post while Day End Processing is running
will not be processed if processing has been completed for the
transaction type. To be sure of processing all the day's transactions,
post them all before you start Day End Processing. Inventory Control
processes receipts first, followed in order by adjustments, transfers,
assemblies, and shipments.
Back up your Inventory Control data.

After Running Day-End Processing
Before you post any transactions after running day-end, do the following:
Print the posting journals.
Print the G/L Transactions report if you create the general ledger
batch manually (using the Create G/L Batch form). Note that you
cannot print the G/L Transactions report in Inventory Control if you
use the option to create the general ledger batch during posting or
day-end processing.
Print any other reports, such as Item Valuation, Transaction
Statistics, Sales Statistics, or Transaction History, that you want for
updating your records.
Modify Inventory Control account sets, categories, and other records
that could affect costing, as needed.

Journal Entries Generated by Posting or Day-End
Processing
This topic describes the journal entries that are created for your general
ledger when you post transactions or run day-end processing (depending
on when you do item costing).
If your Inventory Control ledger is not set to generate general ledger
batches during posting or day-end processing, make sure you create
General Ledger batches as part of your period-end procedures.
If you do not use Sage ERP Accpac General Ledger, Inventory Control
creates its general ledger transactions in a file called ICGLTRAN.CSV,
which can be imported by a Sage ERP Accpac General Ledger at
another site or transferred to another general ledger that you use. The file
is in a Comma Separated Values (CSV) format.
Note that Inventory Control does not create invoices for Accounts
Payable and Accounts Receivable. If you want to generate invoices with
your Inventory Control receipts and shipments, you must use the
Purchase Orders and Order Entry programs.

Receipt returns
Returns posted to incomplete receipts debit the payables clearing
account and credit the inventory control account.

Sales returns
Sales returns debit the inventory control account and credit the cost of
goods sold account.

Non-stock shipments
Non-stock shipments debit the cost of goods sold account and credit the
non-stock clearing account.
Transfers

Assemblies

Assigned source code IC-AS on the G/L Transactions report.
Assembly transactions debit the master item's inventory control account,
and credit the inventory control account of each component item on the
bill of material being assembled. If a fixed or variable cost is specified on
the bill of material, then the master item's assembly cost credit account is
credited.
See also
Results of Day-End Processing

Delete Inactive Records Field List
For help about the options and fields in the Delete Inactive Records
form, select from the links below:
Delete These Records
From/To Inactive Dates
From/To (records)

Deleting Item Records
Before you can delete an item record, make sure that:
The quantity of the item in stock at each location, on sales order, and
on purchase order is zero.
The total cost of the item at each location is zero.
The item is not a master item or a component item on any bills of
material.
You have run day-end processing if you have posted any
transactions for the item since the last day-end processing.
If you want to delete an item that does not meet these conditions, enter
shipments, transfers or adjustments (as you require) until the specified
conditions are met, then make the item inactive.
Use the Items form to make items inactive.
Print the Item Status report to identify inactive item records and their
quantities on hand, on purchase order, and on sales order. Select the
Inactive Items option from the list beside the Print field. Select also the
Profile option and the Quantity By Location option.
Print the Item Valuation report to determine the total cost of each inactive item
on the Item Status report.

Deleting Account Sets
To delete an account set, first assign its item records to another account
set or delete them.
Use the Account Sets form to make account sets inactive. Print the Account
Sets report to identify inactive account sets. If an account set is inactive,
the date it was made inactive appears on this report in the Inactive On
field.

Deleting Categories
To delete a category, first assign its item records to another category or
delete them.
Use the Categories form to make categories inactive. Print the Categories
report to identify inactive categories. If a category is inactive, the date it
was made inactive appears on this report in the Inactive On field.

Deleting Locations
To delete a location, first assign its item records to another location or
delete the items. If an inventory worksheet exists for the location, delete it
also.
Use the Locations form to make locations inactive. Print the Locations report to
identify inactive locations. If a location is inactive, the date it was made
inactive appears on this report below the Last Maintained date in the
Telephone/Fax column.

Deleting Bills of Material
Before deleting bills of material, make sure that inactive BOMs are not
used as component items in multilevel bills of material. You cannot delete
BOMs which are also subassemblies.
Print the Bills of Material report or browse bills of material to view inactive
records. You can also use the BOM Component Usage Inquiry form to see where
component assemblies are used.

Deleting Inactive Records
1.Double-click the Delete Inactive Records icon in the Periodic
Processing folder.
2.Select the types of inactive records to delete.
3.Enter the range of codes or numbers to delete for each record type
you selected.
4.Type the range of dates for which to delete records.
5.Click Process.
If you do not want to delete all the types of records you select for the
same range of dates, use the form more than once, as needed, to delete
each type of record for the applicable dates.

Clear History Field List
Transaction History
Transaction Statistics
Through Year, Period
Sales Statistics
Select By
Segment
From/To
Printed Posting Journals
Through Day End Number
Printed Labels
From Receipt Number/to
Expired Contract Prices
Transactions
Serial Numbers
Lot Numbers
Serial History
Lot History

Before Clearing History
Run Day End Processing to update Inventory Control transactions
and statistics that could affect records you want to clear. (You should
run Day End Processing even if you cost items during posting.)
Determine the fiscal year and period through which to clear
transaction statistics, sales statistics, and transaction history.
Determine the day-end number through which to clear printed
posting journals, the date through which to clear serial numbers, and
the receipts for which to clear printed item labels.
For transactions:
Make sure that you no longer want transactions for drilldown
purposes. You cannot drill down to transactions if you delete them.
Make sure that you want to delete the receipts. You cannot enter
returns for receipts after you delete the receipt transactions.
Print reports of the data you want to clear. For example:
Before clearing transaction history, print the Transaction History report for
the transaction history you plan to clear.
Before clearing transaction statistics, print the Transaction Statistics report
for the statistics you plan to clear.
Before clearing sales statistics, print the Sales Statistics report for the
statistics you plan to clear.
Before clearing expired contract prices, print the Contract Pricing report.
Before clearing posting journals, print a copy of each posting
journal you want to clear to a printer or file. If you use the Create G/L
Batch icon to create the general ledger batch, print the G/L Transactions report
for the journals. Note that you must print the G/L Transactions report
before you use the Create G/L Batch icon.
You must have Printer or File set as the printer destination when you
print posting journals that you want to clear.
Before clearing serial/lot numbers assigned to shipped and
returned items, print the Serial/Lot Transactions report for the numbers you plan

to clear.
See also
Using the Clear History form

Using the Clear History Form
1.Double-click the Clear History icon in the Periodic Processing folder.
2.To clear transaction history, select the Transaction History option, then
select the year and period up to which to clear history.
3.To clear transaction statistics, select the Transaction Statistics option,
then select the year and period up to which to clear statistics.
4.To clear sales statistics, select the Sales Statistics option, then select
the year and period up to which to clear statistics, and the range and
type of records to clear.
5.To clear printed posting journals, select the Printed Posting Journals
option, then select the type of posting journal to clear and the day-end
number up to which to clear.
6.To clear item labels that you printed from receipts, select the Printed
Labels option, then specify the range of receipt numbers to clear.
7.To clear contract prices that are no longer valid, select the Expired
Contract Prices option, and then specify the expiry date that you want
to include.
8.To clear transactions, select the Transactions option, then specify the
most recent transaction date that you want to clear.
Note that you cannot drill down to deleted transactions, or do returns
for deleted receipts.
9.To clear serial numbers, select the Serial Numbers option and specify
the date up to which you want to clear the numbers. You can also
choose to clear numbers that have expired contract information.
10.To clear lot numbers, select the Lot Numbers option and specify the
date up to which you want to clear the numbers. You can also choose
to clear numbers that have expired contract information.
11. To clear serial number history, select the Serial History option and
specify the date up to which you want to clear. You can also choose to
clear history with expired warranty information.
12.To clear lot number history, select the Lot History option and specify

the date up to which you want to clear. You can also choose to clear
history with expired warranty information.
13.Select process to clear the specified data.

Process Adjustments Field List
For help about the options and fields in the Process Adjustments form,
select from the links below:
From/To Item Number
From/To Location
Adjustment (type)
Cost to Use

Lot Numbers Mask
Select the code for Lot Numbers Mask that will be applied to all lots
numbers that are added to the database. The description of the mask is
displayed.

Generate Inventory Worksheet Field List
Comment (optional)
Default Quantity on Hand
From Account Set/to
From Location/to
From/To
Include
Sort by

Before Generating an Inventory Worksheet
Run Day End Processing to update the company's Inventory Control
data if you have posted transactions since the last time you ran Day
End Processing. (You should run Day End Processing even if you
cost items during posting.)
Decide on the inventory locations, account sets, and items for which
you want to generate worksheets.
Decide on the sorting order in which to list items on the worksheets.
Make sure no other users are working with the Inventory Control
database and no other Inventory Control forms are open on your
computer.

Generating an Inventory Worksheet
1.Double-click the Generate Inventory Worksheet icon in the Physical
Inventory form.
2.Specify the range of locations and account sets for which you require
the worksheet.
3.Specify the method by which to select the items to be listed on the
worksheet.
4.Type an optional comment to be printed on the worksheet.
5.Specify which items you want to include on the worksheet.
6.Select the Default Quantity On Hand choice if you want Inventory
Control to automatically display the current quantity on hand in the
Counted Quantity column in the Physical Inventory Quantities form.
7.Click Generate, then click OK from the message that appears.

After Generating an Inventory Worksheet
If desired, use the Inventory Worksheet form to print inventory
worksheets on which to record physical inventory counts.
Use the Physical Inventory Quantities form to enter physical
inventory counts for inventory worksheets.

Inventory Control Reports
Inventory Control Reports are divided into the following categories:
Setup reports: list the information entered to define your Inventory
Control system.
Account Sets
Alternate Items
Bills of Material
Categories
Customer Details
G/L Integration
Item Structures
Mask Structures
Kitting Items
Location Details
Locations
Manufacturers' Items
Optional Fields
Options
Price List Codes
Reorder Quantities
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure
Warranty/Contract Codes

Stock Control reports: provide you with status information, and also

provide item labels and bin/shelf labels.
Aged Inventory Report
Bin/Shelf Labels
Inventory Movement
Item Labels
Item Status
Item Valuation
Overstocked Items
Reorder Report
Stock Transactions
Slow Moving Items
Transfer Slips
Serial/Lot Transactions
Serial/Lot Number Quantity on Hand
Recall
Serial/Lot Number List
Serial/Lot Stock Listing
Warranty/Contract List
Quarantine

Price/Sales Analysis reports: interpret, analyze, and summarize
your data.
G/L Transactions
Contract Pricing
Markup Analysis
Posting Journals
Price Lists
Sales Statistics

Selling Price/Margin Analysis
Transaction History
Transaction Statistics

Transaction reports:print the details of saved or posted transactions.
Transaction Listing

Physical Inventory reports: enter the results of an inventory count
and reconcile the inventory totals.
Inventory Reconciliation
Inventory Worksheet

If you have a multicurrency ledger, some of these reports can also
include source and functional-currency (home-currency) information.

When File is the Print Destination
To print to a file, choose Print Destination from the File menu on the
company desktop. Select the File option, then click OK.
After selecting the File option as your print destination and then choosing
to print an Inventory Control form, a dialog box appears where you enter
a drive, a directory, and the filename of the file you want to use as the
destination. You can enter the name of a non-existent file or directory to
be created by the system when you print.
After printing to a file, you can clear the data for some reports such as
posting journals and the Batch Status report.
See also
Inventory Control reports
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

When Printer is the Print Destination
To print to a printer, choose Print Destination from the File menu on the
company desktop. Select the Printer option, then click OK.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Preview
When Print Destination is E-mail

When Preview is the Print Destination
To print to the screen (that is, display the report on your monitor), choose
Print Destination from the File menu on the company desktop, then select
the Preview option.
Printing audit reports to the screen does not clear the data for them.
Similarly, if you print batch listings and posting journals only to the
screen, the status for them is not updated.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is E-mail

When E-mail is the Print Destination
To print to an e-mail, choose Print Destination from the File menu on the
company desktop. Select the E mail option, then click OK.
After printing to an e-mail, you can clear the data for some reports, such
as posting journals and the Batch Status report, using the Clear History
form.
See also
Inventory Control reports,
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview

Physical Inventory Quantities Field List
For information about fields in the Physical Inventory Quantities form,
click the following links:
Adjustment Unit Cost
Comment (display only)
Cost Variance (display only)
Estimated Unit Cost (display only)
Item Number and Description (display only)
Location
Optional Fields
Picking Sequence (display only)
Quantity Counted (F9)
Quantity on Hand (display only)
Quantity Variance (display only)
Starting Item Number
Status (display only)
Status
Stocking Unit of Measure (display only)

Before Entering Physical Inventories
Use the Generate Inventory Worksheet form to create inventory
worksheets.
Count inventory quantities, check unit costs, and determine whether
you want to place any items "on hold." (Use the Inventory Worksheet
form if you want to print worksheets on which to record counted
quantities, unit costs, and posting status.)

Entering Physical Inventory Quantities
Double-click the Physical Inventory Quantities icon or the Inventory
Counts icon in the Physical Inventory folder.
1.Enter a location code or use the Finder to select the location code and
starting item number for the worksheet.
2.If you use optional fields, use the Zoom button ( ) to edit optional
fields that apply to the whole worksheet.
3.Enter or edit the physical count, adjustment cost, and status for each
item on the worksheet. (If you selected the Default Quantity On Hand
option in the Generate Inventory Worksheet form, the current
quantities on hand are inserted for each item in the Quantity Counted
column, but you can change the figures.)
Press F9 to enter quantities in different units of measure.
Use the Quantities form to enter counts by the various units of measure
you have assigned to an item.
4.If you use optional fields for item details, use the Zoom button ( ) to
edit detail optional fields.
5.When you are finished, click Close to save your changes and close
the form.

Importing and Exporting from the Physical
Inventory Quantities Form
You can use the Import and Export commands under the File menu of the
Physical Inventory Quantities form to import and export data from/to your
inventory control system. The procedure is slightly different from the way
most Sage ERP Accpac forms import and export data. Instead of one file,
the import/export process involves two files. The first file contains the
worksheet and optional fields data, while the second file contains all other
data.
When exporting, make sure you use two different file names when
prompted to do so. When importing, make sure you select the file with
the worksheet and optional fields data first, then the second file.

After Using the Physical Inventory Quantities Form
Use the Inventory Reconciliation form to print the Inventory
Reconciliation report, then check the report before posting the
reconciliation (optional).
Use the Post Inventory Reconciliation form to post the inventory
reconciliation.

Inventory Counts Field List
For information about fields in the Inventory Counts form, click the
following links:
Item Number and Description (display only)
Location
Picking Sequence (display only)
Quantity Counted (F9)
Starting Item Number
Stocking Unit of Measure (display only)

Post Inventory Reconciliation Field List
Date
Description (optional)
From Location/to
Posting Date
Reconciliation No.
Reference (optional)
Year/Period

Posting an Inventory Reconciliation
1.Double-click the Post Inventory Reconciliation icon in the Physical
Inventory folder.
2.Enter or use the Finder to select the range of locations for which you
want to post reconciliation adjustments.
3.Enter the transaction date, fiscal year, and period to which you will
post the transaction.
4.Enter a reconciliation number and an optional reference and
description.
5.When you are finished, click Post, then click OK for the message that
appears.
6.Click Close to close the Post Inventory Reconciliation form.

After Using the Post Inventory Reconciliation Form
Print the Inventory Reconciliation report to check for any items that
the program could not post (optional).
Note: If all the items were posted, the Inventory Reconciliation report
is blank.
Items that the program could not post appear on the report, as do any
items that had the posting status "On hold" prior to posting. Items that
were posted successfully do not appear on the report.
When you post reconciliations, the program changes the "Ready to
post" status of any items it cannot post to a status that indicates the
problem. Check each item's status to decide whether you want to
make the changes needed to post the item.
To enable you to post items (if desired) that the program assigns a
status from the following list, make the changes described, then use
the Physical Inventory Quantities form to set the item's status to
"Ready to post":
Item does not exist
Non-stock item
Item not allowed at location
Insufficient quantity
Item not active

Run Day End Processing to update the company's costing and statistical
data (unnecessary if you cost items during posting).
Print the Adjustments Posting Journal to check the adjustment transactions
posted by the program for the reconciliation.
Note that when you post an inventory reconciliation for which an
adjustment number already exists, the Inventory Worksheet will create
separate adjustments for every one hundred items, and append "1",
"2", "3", etc. to the end of the document number.
Delete inventory worksheets that you do not need. For example,
delete worksheets that contain only items that you do not want to
post.

Before Posting an Inventory Reconciliation
Print the Inventory Reconciliation report (optional) before posting to
check that the information you entered in the Physical Inventory
Quantities form is accurate for each location.
The Inventory Reconciliation report lists the quantities and costs that the
program will post the next time you use the Post Inventory Reconciliation
form. The only items that will be posted are those that have the status
"Ready to post."
You can also check item statuses by displaying the worksheet in the
Physical Inventory Quantities form.

Deleting Inventory Reconciliations
Use the Physical Inventory Quantities form to delete inventory
worksheets that you do not need, such as worksheets you accidentally
generated for the wrong location or worksheets with leftover items you do
not want to post.
To delete an inventory reconciliation (or worksheet):
1.Double-click the Physical Inventory Quantities icon in the Physical
Inventory folder.
2.Type or use the Finder to select the location code for the inventory
worksheet you want to delete.
3.Click the Delete button.
4.Click Close to close the Physical Inventory Quantities form.

Sales Statistics Field List
Amount — Sales and Returns
Cost — Sales and Returns
Count — Sales and Returns
Item Number
Location
Margin — Sales (display only)
Quantity — Sales and Returns
Year and Period

Adding Current Sales and Return Statistics
1.Double-click the Sales Statistics icon in the Statistics and Inquiries
folder.
2.Enter an item number or use the Finder to select the item number,
then select the location and year for which you want to add or edit
sales statistics.
3.Select the statistical period for which you want to add or edit sales
statistics.
You specify the desired type of statistical period using the Period Type
option on the Processing tab of the Options form.
4.Click the Go button (or press F7). This prepares the remaining fields
for the sales data.
5.Enter the number of items sold and returned (in stocking units), the
number of sales and return transactions posted, the amount of sales
and returns (in functional currency if you use multicurrency
accounting), and the cost of goods sold and returned (in functional
currency if you use multicurrency accounting).
6.To delete statistics for a period, choose Delete. If a message appears
asking you to confirm the deletion, click Yes.
7.Click Save or Add.
8.Repeat steps 2 through 6 for each item and period for which you want
to add sales and returns statistics.
9.Click Close to close the form.

Transaction Statistics Field List
Adjustments — Count and Actual Cost
Internal Usage — Count and Actual Cost
Receipt Adjustments — Count and Actual Cost
Receipt Returns — Count and Actual Cost
Receipts — Count and Actual Cost
Shipments — Count, Actual Cost, and Sales/Return Amount
Shipment Returns — Count, Actual Cost, and Sales/Return Amount
Transfers — Count
Year and Period

Viewing transaction statistics
1.Double-click the Transaction Statistics icon in the Statistics and
Inquiries folder.
2.Enter the year or use the Finder to select the year for which you want
to see statistics.
3.Enter the number of the statistical period for which you want to see
statistics, or select it from the drop-down list.

Adding or Editing Transaction Statistics
1.Double-click the Transaction Statistics icon in the Items And Price
Lists folder.
2.Enter the year (or use the Finder) for which you want to add or edit
statistics.
3.Enter the number of the statistical period for which you want to add or
edit statistics.
You specify the desired type of statistical period using the Period Type
option on the Processing tab of the Options form.
4.Click the Go button (or press F7). This prepares the remaining fields
for the sales data.
5.Enter the information or changes.
To delete statistics for a period, click Delete. If a message appears
asking you to confirm the deletion, click Yes.
6.Click Save or Add.
7.Repeat steps 2 through 6 for each set of transaction data you want to
add.
8.Click Close to close the form and save the information.

Current Transactions Inquiry Field List
Item Number
Inquire About
From / To Expected Ship/Arrival Date

Transaction History Inquiry Field List
As At Year/Period
From / To Item No.
From / To Account Set
From / to Location

LIFO/FIFO Inquiry Field List
From / To Account Set
From / To Item Number
From / to Location

Item Location Details Quantity Inquiry Field List
Item Number
Inquire for (Specific Location / All Locations)
Document Type
Expected Ship Date / Expected Arrival Date
Order Number / PO Number
Date
Customer/Vendor Number
Customer/Vendor Name

Setup Reports
You can print reports showing the information entered to define each of
the records you create when setting up or updating your Inventory
Control system. The reports you can print include:
Account Sets
Alternate Items
Bills of Material
Categories
Customer Details
G/L Integration
Item Structures
Mask Structures
Kitting Items
Locations
Location Details
Manufacturers' Items
Optional Fields
Options
Price List Codes
Reorder Quantities
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure
Warranty/Contract Codes

Any time you add, delete, or change any of these records, you should
print and file the corresponding reports, to keep your printed records up

to date.
Choose from the icons in the Setup Reports form to print these reports.

Stock control reports
Inventory Control provides reports that give you detailed information
about your inventory items. These reports also provide you with stock
prices, costs, quantities, labels, and stock movement information that will
help you manage your inventory.
Stock reports that you can print include:
Aged Inventory
Bin/Shelf Labels
Inventory Movement
Item Labels
Item Status
Item Valuation
Overstocked Items
Reorder
Slow Moving Items
Stock Transactions
Transfer Slips

Choose from the icons in the Stock Control Reports form to print these
reports. If you have the Serialized Inventory and Lot Tracking license
installed, you can also generate the following reports.
Serial/Lot Transactions
Serial/Lot Number Qty on Hand
Recall
Serial/Lot Number List
Serial/Lot Stock Listing
Warranty/Contract List
Quarantine

Price/Sales Analysis Reports
Inventory Control provides reports you can use to analyze item sales and
prices. There are also reports about the Inventory Control transactions
you post (transactions include: receipts, shipments, transfers,
adjustments, and assemblies), and the general ledger transactions
created by the program.
You can print reports showing the following information:
Contract Pricing
G/L Transactions
Markup Analysis
Posting Journals
Price Lists
Sales Statistics
Selling Price/Margin Analysis
Transaction History
Transaction Statistics

Choose from the icons in the Price/Sales Analysis Reports folder to print
these reports.

Physical Inventory Reports
Inventory Control provides two reports to use in reconciling your actual
inventory quantities to your computerized records:
Print Inventory Reconciliation reports to reconcile your actual inventory
quantities to your computerized records.
You print the Inventory Reconciliation report before posting
reconciliations to check the data that will be posted, and after posting
reconciliations to check for any items that the program could not post.
Print Inventory Worksheets to use for recording the actual physical inventory
on hand as it is counted.
See also
Inventory Control reports
Reporting Inventory Control data
Setup reports
Stock Control reports
Price/Sales Analysis reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Contract Pricing Report
The Contract Pricing report lists the contract pricing arrangements you
have established for a customer or for a range of customers.
For more information on the contents of this report, see Contract Pricing � Features.

When to print
Print the report after adding, changing, or deleting pricing contracts, or
when you need to check on existing arrangements for particular
customers.

How to print
1.Double-click the Contract Pricing icon in the Price/Sales Analysis
Reports folder or choose File, Print from the Contract Pricing form.
2.Select a range of customer numbers to include in the report, and click
Print.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing the Customer Details Report
The Customer Details report lists customer item numbers and inventory
item numbers that they identify.
For more information on the contents of this report, see Customer Details Report �
Features.

When to print
Print the report to see the item numbers customers use for your inventory
items.
Note: The report includes details only for customers that are assigned to
items in the I/C Customer Details form. The report will be blank if you
have not entered customer item numbers.

To print the Customer Details report
1.Double-click the Customer Details icon in the Setup Reports folder.
2.Make selections in the following fields:
Sort by. Specify the order in which to list customer item numbers. You
can print them by customer or by item number.
From [ ] To [ ]. Specify the range of customer numbers and item
numbers to include in the report.
3.To begin printing, click the Print button.
If you are printing to a printer, Inventory Control displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Inventory Control displays the name of the
file, so you can change it or cancel printing.
If you are printing to the screen (preview), Inventory Control displays
the report. If you want, you can then export it to a file or send it to the
printer.
See also

Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

G/L Integration Report — Features
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Inventory Control system sends transactions to General
Ledger.
For instructions on printing the report, see Printing the G/L Integration Report.

Information printed on the report
General ledger integration options.
Information transferred from source transactions to G/L transaction
fields.
See also
Inventory Control reports

Units of Measure Report — Features
The Units of Measure report lists the information entered to define the
inventory units of measure used in your Inventory Control system.
For instructions on printing the report, see Printing the Units of Measure Report.

Information printed on the report
The report lists the units of measure along with their default
conversion factors.
See also
Inventory Control reports

Weight Units of Measure Report — Features
The Weight Units of Measure report lists the information entered to define
the inventory weight units of measure used in your Inventory Control
system.
For instructions on printing the report, see Printing the Weight Units of Measure Report.

Information printed on the report
The report lists the weight units of measure along with their
descriptions and weight conversion factors. It also identifies the
default weight unit of measure.
See also
Inventory Control reports

Aged Inventory Report � Features
The report prints the net changes in item quantities and costs for a set of
four aging periods specified by the user at print time.
Depending on the options chosen at print time, the report can be printed
in a detailed or summary version. The detailed version prints all individual
transactions affecting item quantities and costs. The summary version
prints only the totals of the net changes for each period.
Note: The cost of the items received in the inventory is the actual cost of
the item. The cost of the items shipped form inventory is calculated
depending on the costing methods used.
For instructions on printing the report, see Aged Inventory Report � Printing.

Information printed on the report
Lists the quantities and costs for four aging periods. Period 1 uses
the "As of" date as the starting point.
Shows opening balances, net changes, and closing balances for
quantities and costs in each of the aging periods.
Prints subtotals by the sorting order field (category, item segment, or
optional field).
Prints the report for separate locations, consolidated locations, or
items by location.
The summary version of the report includes one line for each item
number, listing the net change in item quantities and costs in each of
four periods.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
When Print Destination is Schedule

When Schedule is the Print Destination
You can schedule a report to be printed from a computer running Crystal
Reports software.

To schedule a report for printing:
1.Choose Print Destination from the File menu on the company
desktop.
2.Select Schedule as the option, then click OK.
3.Open a report form, choose the options that you want to appear on
the report, then click Print in the report form. The Schedule Report
dialog box appears.
4.Enter your Crystal Info user name and password.
5.Select a server from the APS field (Automated Process Server).
6.Indicate the publishing format and enter the name of the file you are
scheduling for printing.
7.Select the destination (either to a hard disk on another workstation or
to a computer running Crystal Info server).
8.Enter the date and time you would like the report printed.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Inventory Movement Report � Features
The Inventory Movement report shows the quantities and extended costs
of inventory items that were received into stock and shipped out of stock
during the period that you specify.
The report displays the stock activity showing each transaction in and out
of stock for the period. Users can group items in all locations together or
display items in each location separately.
Note: The cost of the items received in the inventory is the actual cost of
the item. The cost of the items shipped form inventory is calculated
depending on the costing methods used.
For instructions on printing the report, see Inventory Movement Report � Printing.

Information printed on the report
Reports transactions for a particular period of time � specified using
transaction dates or fiscal periods.
Prints item opening and closing balances, as well as inventory-in and
inventory out item totals in functional currency.
For each transaction, prints the document number, source ledger
(e.g. Order Entry, Purchase Orders, Project and Job Costing),
inventory location, unit of measure, inventory-in or inventory-out
quantity and cost (optionally, in source and functional currencies),
and running balances.
Prints subtotals by the sorting order field (category, item segment, or
optional field).
Prints the report for separate locations, consolidated locations, or
items by location.
See also
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
When Print Destination is Schedule

Transfer Slips Report — Features
Inventory Control lets you print transfer slips when you post transfers to
accompany goods to the receiving location (either carried by the driver or
attached to the goods by way of a clear packing envelope or window
envelope).
Transfer slips provide a column where the receiver can check whether
the goods received (items and quantities) match the goods shipped.
For instructions on printing the report, see Printing Transfer Slips.

Information printed on the report
The transfer slip includes:
Shipping and receiving plant information, including contact names
and phone numbers.
Item number, item description, quantity transferred, and the unit of
measure.
Space to write the quantity received and comments concerning the
receipt.
Note: Inventory Control provides two transfer slips — ICTRNS01.RPT
and ICTRNS02.RPT.
Report ICTRNS01.RPT always prints blanks in the “Quantity Received”
column.
For report ICTRNS02.RPT, the contents of the “Quantity Received”
column depends on the type of transaction that you have just posted.
For a Transfer transaction, it prints blanks in the “Quantity Received”
column.
For a Transit Transfer, it prints the total quantities of all the transit
receipts that originated from the transit transfer.
For a Transit Receipt, it prints the receipt quantity.
See also
Inventory Control reports

Transaction Listing — Features
A transaction listing prints the details of saved and/or posted transactions
that have not been cleared from the Inventory Control system.
You can print six types of transactions listings, one for each transaction
type you can post in Inventory Control: adjustments, assemblies,
receipts, shipments, transfers, and internal usage transactions.
For instructions on printing transaction listings, see Transaction Listing.

Information printed on the report:
Adjustments Transaction Listing
Assemblies Transaction Listing
Receipts Transaction Listing
Shipments Transaction Listing
Transfers Transaction Listing
Internal Usage Transaction Listing

See also
Inventory Control reports

Quantities Detail Form
This detail form lets you enter inventory counts for the units of measure
assigned to the item.
Inventory Control then converts these quantities into a single total
expressed in stocking units, and inserts the total in the Quantity Counted
column for the item.

To use the Quantities form:
1.Highlight a line in the Physical Inventory Quantities data entry grid,
then press F9 to open the Quantities detail form.
2.Enter the quantity counted for each unit of measure. Do not enter the
same count twice for different units of measure, because this would
count some items twice.
3.When you are finished, click Close (or press F9) to return to Physical
Inventory Quantities.

Adjustments Posting Journal
The adjustments posting journal report includes all adjustments created
using:
Adjustment entry in the Transactions folder.
Process Adjustments in the Periodic Processing folder.
Post Inventory Reconciliation in the Physical Inventory folder.
For information on creating adjustments, see Processing Adjustments.
The report includes:
The type of adjustment (Cost Increase, Cost Decrease, Quantity
Increase, Quantity Decrease, Both Increase, Both Decrease).
If you make an adjustment to a LIFO or FIFO item, this column also
specifies the bucket type (Offset Bucket, Specific Bucket, or
Prorate).
The Debit and Credit columns show changes in functional currency
to your adjustment/write-off accounts when you adjust costs. A
change in quantity only does not affect these accounts.

Insufficient Quantity
Reconciling the on-hand and counted quantities entered in the Physical
Inventory Quantities form will reduce the item's on-hand quantity to below
zero in the Inventory Control system. (If the Allow Negative Inventory
Levels option is turned on, the program does not assign this status.)
Before you can post the item:
Either turn on the Allow Negative Inventory Levels option on the
Processing tab of the Options form, or replace the number in the
Quantity Counted column in the Physical Inventory Quantities form so
that the sum of the quantity counted and the quantity on hand is zero
or greater.

Non-stock Items
You can create non-stock item records to use when shipping specially
ordered items which you do not normally stock in your inventory, or to
handle service charges or other non-inventory charges.
Non-stock items must use the user-specified costing method.
Note also that kitting items are non-stock items.

Allowing Items at all Locations: How it Works
The program shows an item to be stocked at a location only after you
enter the first transaction (such as a receipt) involving the item at the
location. If you stock the item at more than one location, the item appears
on reports and in forms only at the locations for which a transaction has
been entered (even though the item is allowed to be stocked at any
location).
For example, only after you enter the first transaction for an item at a
location does the item appear in the Location Details form or report at
that location.

Changing the Method of Reporting Statistics
You can change the type of year and period by which Inventory Control
reports statistics, but you will not be able to compare new period figures
directly to figures in past periods.
If you need to change the type of year or period by which Inventory
Control reports statistics, you should either do so after year-end, or edit
the statistics for the earlier periods in the year to correct distortions.

Require Labels
If you want to print exactly one item label for each item being received,
turn on the Require Labels option (click it with your mouse, or tab to it
then press the Spacebar).
When you turn on the Require Labels option, the program automatically
displays the same number in the Labels column on each item's detail line
as the number you enter in the item's Quantity Received column. If you
want to print more or fewer labels, type over the number in the Labels
column.
Turn off the Require Labels option if you do not want to print item labels,
or if you want to print more or fewer labels than the number of items
being received on any detail line.
When you turn off the Require Labels option, the program automatically
displays zero in the Labels column on each item's detail line. If you want
to print labels for items, type over the zero displayed in the Labels
column.

For Each Item
Received. Select this option to print labels for the items included on
receipts you have posted, after having specified the number of labels
in the Receipts form.
On File. Select this option to print labels for all or any of the items
that are included in your inventory, whether or not you currently have
them in stock.
In Stock. Select this option to print labels for items that are currently
in stock.
Non-Stock. Select this option to print labels for non-stock items.

Received
Receipt Number [ ] to [ ]. Specify the range of receipt numbers for
which to print labels. This option prints the number of labels for each
item that was specified on the receipt.
Price List. Enter a code or use the Finder to select the price list
code assigned to the items for which you want to print labels.
Currency. If you use multicurrency accounting, enter a code or use
the Finder to select the currency code used with the price list from
which you are printing labels.
Reprint Previously Printed Items. Select this option if you want to
print a new set of labels that you printed previously, for example
because the first set was damaged. This option also prints labels you
have not previously printed, if you included any in the range of item
numbers you selected.

On File or In Stock
Print [ ] Labels. Enter the number of copies to print of each label.
Location. Enter the location or use the Finder to select the location
for which to print labels.
Price List. Enter the price list code or use the Finder to select the
code for the price list that contains the items for which you want to
print labels.
Currency. If you use multicurrency accounting, enter the price list
code or use the Finder to select the code for the currency of the
price list to use.
Sort by. Specify the order in which to generate labels. You can
choose:
Item Number. Generates labels in order by item numbers.
Category. Generates labels sorted by item categories specified for
the report.
Item Segment. Generates labels sorted by items that contain the
specified segment in their item numbers, grouped by the specified
range of segment codes.
Picking Sequence. Generates labels in order of item picking
sequence codes (used, for example, to specify the bin or shelf
where the item is stored at your locations).
Optional Field Entries. Generates labels sorted by the contents
of the selected optional field. These choices appear only if you
have added optional text fields using the Optional Fields form.

Price/Sales Analysis Reports
Use the icons in the Price/Sales Analysis Reports folder to print reports
of:
Item sales and prices for analysis.
The Inventory Control transactions you post (receipts, shipments,
transfers, adjustments, and assemblies).
The general ledger transactions created by the program.
Analysis reports include:
Contract Pricing
G/L Transactions
Markup Analysis
Posting Journals
Price Lists
Sales Statistics
Selling Price/Margin Analysis
Transaction History
Transaction Statistics

See also
Inventory Control reports
Reporting Inventory Control data
Setup reports
Stock Control reports
Physical Inventory reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Setup Reports
Use the icons in the Setup Reports form to print reports of:
The options you selected, data you entered, and records you added
to set up your Inventory Control system.
Records you revised.
Setup reports include:
Account Sets
Alternate Items
Bills of Material
Categories
Customer Details
G/L Integration
Item Structures
Mask Structures
Kitting Items
Location Details
Locations
Manufacturers' Items
Optional Fields
Options
Price List Codes
Reorder Quantities
Segment Codes
Units of Measure
Vendor Details
Weight Units of Measure
Warranty/Contract Codes

See also
Reporting Inventory Control data
Physical Inventory reports
Stock Control reports
Price/Sales Analysis reports
Inventory Control reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Stock Control Reports
Use the icons in the Stock Control Reports folder to print:
Detailed information about your inventory items, including prices,
costs, quantities, labels, and stock movement information that will
help you manage your inventory.
Bin/shelf and item labels.
Stock Control reports include:
Aged Inventory
Bin/Shelf Labels
Inventory Movement
Item Labels
Item Status
Item Valuation
Overstocked Items
Reorder
Slow Moving Items
Stock Transactions
Transfer Slips

These reports appear only if the Serialized Inventory and Lot
Tracking License is installed:
Serial/Lot Transactions
Serial/Lot Number Qty on Hand
Recall
Serial/Lot Number List
Serial/Lot Stock Listing
Warranty/Contract List
Quarantine

See also
Inventory Control reports
Setup reports
Price/Sales Analysis reports
Physical Inventory reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
Reporting Inventory Control data

Sort By (Bin/Shelf Labels Report)
Item Number. Generates labels in order by item numbers.
Category. Generates labels sorted by the item categories specified
for the report.
Item Segment. Generates labels sorted by items that contain the
specified segment in their item numbers, grouped by the specified
range of segment codes.
Picking Sequence. Generates labels in order of item bin locations.
Optional Field Entries. Generates labels sorted by the contents of
the selected optional field. These choices appear only if you added
one or more optional fields in the Optional Fields form.

Serial/Lot Number Assignment Forms — Field List
The following buttons and fields are used in Inventory Control forms that
appear when serial and/or lot numbers need to be assigned to inventory
items. Click on a link for a brief description.
Auto Allocate From
Auto Alloc.
Make_ Lots OR Each Lot Has _
Next Lot Number
Next Serial Number
Auto Gen
Clear All
Return All
Receive All
Close
Assign Master

Fields in forms that are not listed above are display-only.

Through Posting Sequence
Type the latest day-end processing number for which you want to report
general ledger transactions. The report then lists all transactions
produced in Inventory Control since the last time you created the general
ledger batch, up to and including the day-end number you specify.

Report Format
Select the kind of report you want.
Detail. Lists details of all general ledger transactions for each
general ledger account or for each reporting period.
Summary. Lists one total for each account number.

Sort by (G/L Transactions Report)
Specify the order in which to list general ledger transactions. You can sort
by:
Account. Lists general ledger transactions in order by the general
ledger account numbers.
Year and Period. Lists general ledger transactions in order by the
year and period in which they occurred.

Sort By (Markup Analysis Report)
Item Number. Lists items in order of item numbers.
Category. Groups items by item categories.
Item Segment. Lists items that contain the specified segment in
their item numbers, grouped by the specified range of segment
codes.
Optional Field Entries. Lists items by the contents of the selected
optional field. These choices appear only if you added one or more
optional fields in the Optional Fields form.

Costing Method
Most Recent Cost. Select this option to use the cost of the most
recently acquired units of the item.
Standard Cost. Select this option to use the standard cost.
Markup Cost. Select this option to use the markup cost you entered
in the Item Pricing form.
Alternate Costing Methods. Select this option to use any alternate
amounts entered for the item in the two optional alternate amount
fields you can activate in the Options form. (The names you assign
to these fields appear in the list displayed for the Calculate Markup
Based On field.)
User-Specified Costing Method. You can specify items with a userspecified costing method as bills of material components (for
example, non-stock items). You can specify the cost for the item
when setting up a bill of material or during assembly of the master
item.

Sort By (Selling Price/Margin Analysis Report)
Item Number. Lists items in order by item numbers.
Category. Groups all items by the categories specified for the report.
Item Segment. Lists all items that contain the specified segment in
their item numbers, grouped by the specified range of segment
codes.
Optional Field Entries. These choices appear only if you added one
or more optional fields in the Optional Fields form. Lists all items by
the entries in the selected optional field.

Calculate Margin By
Average Cost. Use the item's total actual cost, divided by the
number of units on hand.
Most Recent Cost. Use the cost of the most recently acquired units
of the item (from the Location Details form) to calculate the margin.
Standard Cost. Use the item's standard cost (from the Location
Details form) to calculate the margin.
Markup Cost. Use the markup cost entered for the item in the Item
Pricing form to calculate the margin.
Alternate Costing Methods. Use the costs you entered in the
optional Alternate Amount 1 and Alternate Amount 2 fields, if you
use them, in the Location Details form.

Multicurrency Fields
Currency. If you use multicurrency accounting, type the currency for
the report, or select it from the Finder. If you select the functional
currency, skip the Rate Type, Rate Date, and Exchange Rate fields.
Rate Type. If you use multicurrency accounting, type or use the
Finder to select the rate type to use when converting sourcecurrency amounts to the functional currency.
Rate Date. If you use multicurrency accounting, the date for the
exchange rate is displayed.
Exchange Rate. If you did not select the functional currency, type an
exchange rate for the currency on the report.

Sort By (Location Details report)
Item Number. Lists records in order by item number.
Location. Lists records in order by location code.

Print Location Details Report
Location Details with Items Not Allowed. Lists only items that are
in stock but which cannot be used in transactions at one or more of
the selected locations.
Location Details with Items Allowed. Lists only items that are in
stock and which can be used in transactions at one or more of the
selected locations.
All Location Details. Lists all items at the selected locations.
See also
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Sort By (Slow Moving Items Report)
Item Number. Lists items in order by item numbers.
Category. Groups all items by the categories specified for the report.
Item Segment. Lists all items that contain the specified segment in
their item numbers, grouped by the specified range of segment
codes.
Optional Field Entries. These choices appear only if you added one
or more optional fields in the Optional Fields form. Lists all items by
the entries in the selected optional field.

Include Items With
No Sales for More than [ ] Days. Include items for which no
shipments were posted in Inventory Control or Sage Accpac Order
Entry (if you use it) during the number of days you specify. Inventory
Control subtracts the last shipment date from the session date and
compares the results to the number of days you enter.
Year-To-Date (YTD) Turnover Less than [ ] Times. Include items
with sales that were less than the year-to-date turnover multiplied by
the number of times you specify. The year-to-date turnover is
calculated as:

Period-To-Date (PTD) Turnover Less than [ ] Times. Include items
with sales that were less than the period-to-date turnover multiplied
by the number of times you specify. The period-to-date turnover is
calculated as:

PTD Units Sold Less than YTD Average by More than [ ] Percent.
Include items with fewer sales in the current period than the year-todate average, by the percent you specify. The percentage is
calculated as:

The daily average sales up to last period is calculated as:

The daily average sales for the current period is calculated as:

YTD Units Sold Less than Last Year's Average by More than [ ]
Percent. Include items with lower average sales in the current year
than the last year's average amount, by the percent you specify. The

percentage is calculated as:

with A and B derived as follows:

Average Days between Shipments Greater than [ ] Days. Include
items for which no quantities were shipped in the average number of
days you specify.

Converting Serialized/Lotted Data from Previous
Versions
If you were using version 5.5 or 5.3B of Serialized Inventory or Lot
Tracking with your previous version of Sage ERP Accpac, you must run
the Accpac SN/LT conversion program to convert the Serialized Inventory
and Lot Tracking data before you can use version 5.6 programs.
Before you begin, make sure you run a Data Integrity Check the to clean
up your data in the previous version. Do so in the program you are
upgrading from, not in version 5.6.
Note: Any data used by third party products to access SN/LT history
tables or record other information will be ignored during conversion.
To run the conversion program:
1.Activate your Inventory Control data if you haven't already done so.
2.Double-click the Accpac SN/LT Data Conversion icon in the
Inventory Control folder. This should be the only icon that appears in
the folder.
3.A window appears with default mask serial and lot mask codes
(assuming you have both kinds of items in your inventory data). You
can change the default codes.
4.Click Process.
A message appears confirming the conversion, icons appear in the
Inventory Control folder and the system is available for you to use.

Changes in Inventory Control 5.5
The most important additions made to Inventory Control 5.5 were the
following:
A new Internal Usage form for recording internally consumed
inventory.
Integration to Sage Fixed Assets (FAS) when taking items out of
inventory for internal use.
More options that let you cost items during posting, but create
subledger transactions and audit information when you run Day End
Processing.
In version 5.5, these two processes have been separated to give you
better control over posting performance.
Item inquiries on the quantity on sales order, quantity on purchase
order, and committed quantity in the Location Details form.
Drilldown to Project and Job Costing from job-related shipment and
adjustment transactions.
Start and end dates for price lists.
Ability to prevent already-printed transfer slips from being reprinted.
User-definable source types for G/L transactions.
Different document dates and posting dates for transactions.
Multi-level bills of material added to Sage ERP Accpac 100 and
Sage ERP Accpac 200. (Multi-level bills of material were added to
Sage ERP Accpac 500 in version 5.4.)
Faster processing, especially when posting and running Day End
Processing.
For more information on these features, see:
Internal Usage Form
Integration with Sage Fixed Assets (FAS)
Additional Costing and Transaction Creation Options
Item Inquiry and Drilldown from Location Details
Drilldown to Project and Job Costing Transactions
Start and End Dates for Price Lists
Prevent Transfer Slips from Being Reprinted
Different Document and Posting Dates

User-Defined Source Types

Upgrading from an Earlier Version?
If you are upgrading from version 5.3, see Changes in Inventory Control 5.4.
If you are upgrading from a version earlier than 5.3A, also see Changes
in Inventory Control 5.3 to read about the features introduced with version 5.3.

Multiple Level Bills of Material
Inventory Control’s bills of material feature supports unlimited levels of
assemblies and sub-assemblies in a single bill of materials, providing a
sophisticated tool for manufacturing or assembling items for sale.
Each bill of material level includes a list of component parts and
quantities, as well as the fixed and variable costs for manufacturing, such
as labor cost, materials, and overhead.
To make it easier to handle large BOMs, Inventory Control’s Bills of
Material entry screen provides a tree view that displays, and lets you
navigate through, all components and subassemblies.

New Inventory Pricing Features, Including Pricing
by Weight, for Version 5.4
Inventory Control’s item pricing features have been expanded to make
pricing more flexible.
In version 5.4, you can now:
Specify whether the discount price of the item is based on weight or
on quantity.
If you specify weight, I/C lets you set volume discount amounts or
percentages that are determined by item weight. The weights are
calculated in Order Entry by multiplying the unit weight of an item
times the quantity ordered, and converting the weight to default units.
Note: Pricing by weight is available only in Sage ERP Accpac 500.
Price items by a single or multiple units of measure.
You can enter a base price for a single unit of measure or for multiple
units of measure. You can also enter sale prices for single or multiple
units of measure.
Default the unit price using a cost plus a percentage or a fixed
amount.
Choose how you want Order Entry to respond to price overrides.
Order Entry can:
Do nothing.
Display a warning message and let you continue.
Display an error message and reject the price override.
Force you to get a supervisor’s approval on price overrides.
For more information on pricing features, see Inventory Control online
help.

Units of Measure Usage in Inventory Control
Units of measure are the quantities in which you buy, sell, price, and
stock your goods. Inventory Control now lets you set up a centralized list
of the units of measure that you use for your inventory items, along with
conversion factors for converting between different units, so you can add
them more easily to item records.
Note the following points concerning units of measure:
The conversion factor for a stocking unit of measure is always 1.
You must choose the Allow Fractional Quantities option in the I/C
Options form to enter conversion factors that involve fractions.
You must also choose the Allow Fractional Quantities option if you
want to ship fractions of the stocking unit.

Using Only Defined Units of Measure
This option only affects new inventory items or new units of measure that
you add to existing items. If you turn on this option, it will have no effect
on existing items unless you add new units of measure to item records.
If you choose the Use Only … setting, you can only use inventory
units of measure that you have already defined in new inventory item
records.
If you do not choose this setting, you can specify any units of
measure for new inventory items — whether or not they have been
added to Inventory Control.
You may want to leave this option unselected if you use a basic list of
units for most of your items, but have some records that use a
completely different set of units of measure.

Weight Units of Measure in Inventory Control
Inventory Control also lets you set up as many weight units of measure
as you need for your inventory items — such as tons, kilograms, pounds,
ounces, and grams. With each unit weight that you add, you also specify
the conversion factor to the default weight unit of measure, so Order
Entry and Purchase orders can calculate the total weights of orders
comprising goods using various weight units of measure.

Default Weight Unit of Measure
You now specify the basic or standard unit of measure that you use for
measuring the weight of your inventory items — such as pounds or
kilograms.
You can change the unit of measure for individual items in Inventory
Control, but this setting is also used by Order Entry and Purchase Orders
as the weight unit of measure for orders.
You can use the estimated total order weights to calculate the costs of
shipping orders.

Customer Item Numbers
Inventory Control 5.4 lets you associate customer item numbers with your
inventory item records. Customer item numbers are often required for
large customers, where the customer uses their stock numbers when
ordering from you. You may have any number of customer item numbers
associated with a single item in your inventory.
Customer item numbers are particular to the customer and also specify
the customer’s unit of measure, so different customers can use the same
number for different items.
When you add a customer item number, you:
Choose the item from your inventory.
Specify the customer.
Enter the customers’ item number and their description of the item.
Enter the unit of measure.
Enter relevant comments and particular instructions for handling or
shipping.
Note: Customer item numbers are available in Sage ERP Accpac 500
only.

Wizard for Adding New Inventory Items
The new Items Wizard helps you add inventory items quickly and easily
by taking you through all of the set up windows for required and optional
setup information.
This wizard lets you add new item records, specify item locations and
costs, assign items to vendors, set up item pricing, add customer’s and
manufacturer’s item numbers, and set up reorder information.

Process Adjustments Automatically
Inventory Control now automatically processes adjustments to:
Adjust the actual costs of items to a new standard cost.
Write off the cost of items with a zero quantity.
Write off quantities of items with a zero cost.

Physical and Logical Inventory Locations
This version of Inventory Control lets you designate inventory locations
as physical locations or logical locations.
Logical locations cannot receive or ship goods, so you would generally
designate goods-in-transit locations as logical locations.

New and Enhanced Inventory Reports for Version
5.4
New Transfer Slip
The new transfer slip can be printed when transfers are posted at a
shipping location, and is designed to accompany goods to the receiving
location (either carried by the driver or attached to the goods by way of a
clear packing envelope or window envelope).
The transfer slip includes a column where receivers can check whether
the goods received (quantities and item numbers) match the goods as
stated on the transfer slip. The slip also includes shipping and receiving
location information, including contact names and phone numbers, so
shippers, receivers and carriers can easily see who they should contact if
problems arise at any point during the transfer.
You can also print the transfer slip using the Transfer Slip form in the I/C
Stock Control Reports folder.
New Inventory Movement Report
The Inventory Movement report is a new report that displays the
Inventory Control items that were received into stock and shipped out of
stock for the period specified by users.
New Aged Inventory Report
The Aged Inventory report is a new report that displays the Inventory
Control items into three aging periods specified by users. The report
shows items� quantities and costs for each period. The costs of the
items are calculated depending on items� costing methods. The
following is an example of the report for three different costing methods:
The aging periods on the I/C Options form are used by default on the
Aged Inventory report, but you can change them at print time.
Enhanced Markup Analysis Report
In version 5.4, the Item Pricing form changed to let users enter the Base
Price for multiple units of measure, and the Markup Analysis report has
changed to display the Base Price for each unit of measure specified for

the item.
Enhanced Selling Price and Margin Analysis Report
The Selling Price and Margin Analysis report has been changed to:
Handle base prices for multiple units of measure.
Be more logically arranged.
For example, the Cost Unit of Measure now appears between the Unit
Cost and Margin Type fields instead of under the Unit Cost field, and the
Pricing Unit (Base Weigh Unit) now appears between the Base Price and
Margin % fields instead of under the Base Price field.
Enhanced Item Pricing Report
The 5.4 version of the Item Pricing report supports:
Pricing by quantity or weight.
Pricing by a single or multiple units of measure.
If there are several base costs for multiple units of measure, discounts
or markups are calculated for each unit of measure that has a base
price.
Pricing by a cost plus a percentage or a fixed amount (variable price,
calculated for every new order).
The report also identifies the price check method for each item, if any has
been selected for items on the Price List form (such as comparing the
price with the cost of an item or with a sales margin, and assigning the
price check to particular Sage ERP Accpac users).
Enhanced Performance for the Transaction History Report
This report is significantly faster in version 5.4.

Other Changes in Inventory Control 5.4
Sellable Items
A new check box on the item record lets you specify whether an item is
sellable or not through Order Entry. This let you separate items used in
BOMs or items used by consultants or construction crews from your retail
inventory.
Optional Fields in Finders
Optional fields now appear in Finders for I/C records, so you can search
for and select records using the entries in optional fields.
Required Optional Fields without Default Values
In version 5.3 of Sage ERP Accpac, you had to specify a default value for
any optional fields that were required in transaction forms or records.
This is no longer the case. Note, however, that you must make an entry
for all required fields before you can save records or post transactions.
Lowest Price for Contract Prices
Inventory Control now provides an option in contract pricing to let you use
the lowest price for your customer, regardless of the contract price. If
chosen, Order Entry will use the lowest of the contract price, discounted
base price, or sale price.
Physical Inventory Adjustment Account
Version 5.4 includes a Physical Inventory Adjustment account with
inventory account sets. This account is the expense account that
balances the change in inventory value when you adjust inventory
quantities after making a physical inventory count.
G/L Integration Options
Like other Sage ERP Accpac 5.4 products, Inventory Control lets you
choose the information that appears in description, reference and
comment fields for General Ledger transactions generated from I/C
transactions. You specify this information on the G/L Integration form,
where you can also choose to automatically post all General Ledger
batches that are created by Inventory Control.

When you upgrade to Inventory Control 5.4, the program maintains the
same description and reference information that you chose previously.
You should review the choices you made previously to see if you now
want to change them.
See G/L Integration in the Inventory Control help online for more
information on General Ledger entries created by Inventory Control.

Changes in Inventory Control 5.3
This most important features added to Inventory Control in version5.3A
were:
Unlimited optional fields attached to transactions and transaction
details.
Kitting items.
Fractional Quantities on BOM masters.
Changes to G/L transaction consolidation.
Note: General Ledger integration changed significantly in Inventory
Control 5.4. If you are upgrading from version 5.2, you should see Consolidate
G/L Batches, for a discussion of G/L transaction consolidation.

Build Quantity - Example
Consider the following bill of material:
Master item = Mixture A
Build quantity = 10 bottles
Components: X1= 3 boxes, Y1 = 4 cans, Z1 = 7 lb.
One assembly of the above bill of material requires 3 boxes of X1, 4 cans
of Y1, and 7 pounds of Z1 to make 10 bottles of Mixture A.

Fixed and Variable Costs
Fixed cost is the setup cost for preparing to assemble a bill of material
one or more times. The fixed cost is a one-time cost which is the same
regardless of the number of times you assemble the build quantity of the
master item.
Variable cost is the cost of assembling the build quantity of a bill of
material exactly once.
When you assemble a bill of material, the program multiplies the variable
cost by the number of assemblies (not the number of master items
produced). The cost of labor for an assembly is an example of a variable
cost.
For example, consider the following bill of material:
Master item = Mixture A
Build quantity = 10 bottles
Components: X1 = 3 boxes, Y1 = 4 cans, Z1 = 7 lb.
Fixed cost = $16.00 (for setup)
Variable cost = $15.00 (for labor)
Assembling the preceding bill of material five times:
Produces fifty bottles (5 times 10 bottles) of the master item
(mixture A).
Requires 15 boxes of X1, 20 cans of Y1, and 35 pounds of Z1.
Incurs a fixed cost of $16.00 (this is the setup cost).
Incurs a variable cost of $75.00 (5 times $15.00).

Rules for Bills Of Material
Before you can set up a bill of material, you must add item records
for the items you intend to use for the master item and component
items in the bill of material.
Before you can post an assembly transaction, the master item and
all its component items must be stocked at the same Inventory
Control location.
Master items and component items can use any costing method
except the user-specified costing method.
You cannot delete an item from inventory if it is a master or
component item in a bill of material.
The component items in a bill of material are fixed (you cannot use
alternative components). To build a master item using an alternative
component item, you must create, and use, a separate bill of
material.
You can create multilevel bills of material that include master items
of subassemblies as component items.

Where To Define Segment Codes
You can define up to ten segments, any number of which you can then
combine to define item structures, which are used to format item
numbers. Each segment can be up to 24 characters long. An item
structure can be up to 24 characters long (including all segments,
separator characters, and a prefix character).
For example, item number #01-RED-L3401 has the following item
number segments:
Segment Length Description
XX
XXX
XXXXX

2
3
5

Style
Color
Size

You can change the name of a segment after it is set up, but you cannot
change or delete the segment itself.
Note: Sage Accpac 100 allows a maximum of 4 item segments.

Adding Segment Codes
Segment codes are optional. Adding segment codes is optional, as is
using them once you have entered them. Use the Items tab in the
Options form to turn on the Validate option to restrict entries to the list of
segment codes for individual segments at any time.
The following table shows two examples of how you can set up segment
codes (consecutive Xs denote a segment in an item structure):

Segment Length Description
XX

2

Style

XXX

3

Color

See also
Segment Codes Form

Segment Code
andDescription
R1 -- Regular
M1 -- Modern
RED -- Red
WHI -- White
BLU -- Blue

Where to Define Segment Codes (continued)
A segment code can contain upper-case letters and numbers. Segment
codes can be neither longer nor shorter than the length of the segment
for which they will be used.
Used to verify item numbers. You can turn the Validate option for
segment codes on or off for individual segments at any time. When you
add a new inventory item number, Inventory Control verifies what you
enter in each segment (for which the segment code Validate option is on)
of the item structure, against the segment codes you entered for the
segment. If the segments are all valid, the program adds the item number
to the system.
If you choose to use segment codes, you must enter all the codes you
want the program to allow for a segment in the Segment Codes form
before you add your items.
You can add segment codes as needed, but you can delete segment
codes only if they are not used by any item numbers.

Using More Than One Item Structure
You should set up your item structures to format your item numbers in a
way that meets your needs for sorting and grouping items for inventory
reports and lists.
The following table provides samples of several item structures. Note the
following about the table:
Consecutive Xs denote a segment in an item structure.
Characters appearing between the segments of an item structure or
item number are called separator characters.
A character appearing at the front of an item structure or item
number (such as the # in the fourth example in the following table) is
called a prefix character.
Item Structure

Sample Item Number

XXXX
F605
XXX.X
120.5
XX-XXX/X
K1-501/A
#XXX-XXXXX-XX-X #L31-GT213-8A-0

Using Separator Characters
If you select a separator character for the last segment in an item
structure, the character appears at the end of item numbers using that
item structure. For example, 5046-010-92#.
If your current inventory item numbers already follow the rules for item
numbers listed in the next section, you can create the item structures you
need for entering item numbers into Inventory Control. Otherwise, design
a new item number format before creating your item structures.

Summary of the Rules for Item Numbers
Item numbers in Inventory Control can be up to 24 characters long.
Item numbers are made up of one or more item number sections, called
"segments." You can have item numbers with up to 10 segments. (Note,
however, that Sage ERP Accpac 100 lets you define a maximum of 4
item number segments only.)
A single segment can be up to 24 characters long, including the
optional separator character.
If some of your item numbers have 2 segments,and some have 3
segments, your I/C system has two different item number "structures."
An item structure can be up to 24 characters long (including all
segments, separator characters, and a prefix character), so you
could have no more than one 24-character segment in an item
structure.
Item structures can have from one to ten segments. For example,
you can use a segment to indicate color, model number, or size.
An optional separator character can follow each segment in the item
structure so segments can be distinguished from each other, and an
optional prefix character can be specified to appear at the front of the
item structure.
The following table shows the separator and prefix characters you can
use. (If you do not want a separator or prefix character, select "None" for
the Prefix option and the Segment Separator field for each segment in
the Item Structures form.)
Character Description
None
– Hyphen
/ Slash
\ Backslash
* Asterisk
. Period
( Left parenthesis
) Right parenthesis

# Number sign
Inventory Control ignores separator and prefix characters when
sorting item numbers.
Inventory Control does not use separator and prefix characters to
distinguish item numbers. For example, the program considers the
item numbers #5200-010 and 5200/010 to be identical since the only
difference is the prefix and separator characters, even though the
numbers were formatted using different item structures.
The program does not allow you to enter duplicate item numbers.

Sorting Order for Item Numbers
Inventory Control sorts item numbers for reports and lists from left to right
in the following order:
0123456789ABCDEFGHIJKLMNOPQRSTUVWXY
Z
For example, the program sorts the following sample item numbers in the
order shown:
123
123A
A12
A2
AB1234
Separator and prefix characters do not affect the order.

FIFO/LIFO Buckets
Inventory Control keeps track of the order in which units arrive at a
location by storing their receipt date, receipt number, quantity, and
extended cost in individual "buckets." The program calculates the cost of
units shipped from the costs stored in the buckets.
For FIFO, units from the bucket having the oldest receipt date are
shipped first.
For LIFO, units from the bucket having the most recent receipt date
are shipped first.
There is no limit to the number of buckets Inventory Control can use.

Costing Methods
Using the Account Sets form, you can select a costing method to determine the
value of your goods. For each account set, Inventory Control provides a
choice of eight methods for valuing your inventory and determining the
cost of goods sold:
Weighted moving average
Standard cost
First-in, first-out (FIFO)
Last-in, first-out (LIFO)
Most recent cost
User-specified
Serial Costing
Lot Costing

Using these costing methods, Inventory Control values your inventory
and determines the cost of goods sold for items by location. If you store
the same inventory item at more than one location, the program tracks
and costs the item at each location (rather than costing all the items
together).

Contents Of Account Sets
When you add an account set, you enter a unique code of up to six
characters for the set, and a description (for example, Assembled Items).
Account set codes can contain upper-case letters and numbers.
For each account set, you specify a costing method, and you enter
account numbers for the following general ledger accounts:
Inventory Control. An asset account containing the total value of
the inventory on hand. The account increases when you receive
goods, and decreases when you ship goods.
The word "control" in the account name means that the account
contains only totals, whereas the information stored by Inventory
Control contains details on an item-by-item basis.
When you process all accounting entries correctly, the total value of
the inventory in the Inventory Control system equals the totals in the
Inventory Control accounts in the general ledger.
Payables Clearing. A suspense account to which Inventory Control
posts the "other side" of the accounting entries for inventory you
receive (and for previous receipts you return to suppliers).
Inventory Control normally generates credit entries to this account for
inventory you receive; therefore, the account can be thought of as the
accrued amount payable for goods received into inventory. Inventory
Control debits this account when you enter receipt returns.
In Sage ERP Accpac Accounts Payable. As you post the related
vendor invoices in Accounts Payable, offsetting journal entries (debits)
related to the inventory purchased are generated against the
Payables Clearing account to clear the balance that is left in this
account from posting the inventory receipt.
Adjustment Write-Off. The account to which you post inventory
adjustments and write-offs. Entries to this account are normally
expenses (debits); therefore, the account number you specify should
be in the expenses or cost of goods sold section of your general
ledger.

Assembly Cost Credit. The account to which you post the variable
and fixed costs of assembling items. The program credits this
account with the variable and fixed cost of assembly. You may want
to create manual entries in the general ledger to redistribute the
assembly cost credit to accounts such as labor costs.
Non-stock Clearing. The account which you credit when you ship
non-stock items, and debit when you enter shipment returns for nonstock items.
Using non-stock items. You can use non-stock items to handle
specially ordered items which you do not stock in your inventory, and
to handle service charges that appear on invoices.
Transfer Clearing. The Transfer Clearing account is used to hold
the additional cost incurred during a stock transfer. For example, if
you transfer 10 items from location 1 to location 2, where the original
cost of the items is 50.00, and the additional cost to do the transfer
6.00.
Shipment Clearing. Debited instead of Cost of Goods sold when
shipping goods from Order Entry.
The Shipment Clearing account is required because the shipment and
invoicing functions in Order Entry are separated. The COGS account
is debited when you invoice the shipment.
Disassembly Expense. Used if you specify an expense amount
when you disassemble items that were previously assembled in
Inventory Control.
Physical Inventory Adjustment. The expense account that
balances the change in inventory value when you adjust inventory
quantities after making a physical inventory count.
Credit/Debit Note Clearing. An account that is debited instead of
the I/C Control account or the Damaged Goods account when Order
Entry sends returns to Accounts Receivable. The G/L transaction
credits the clearing account instead of COGS and A/R Control.
The Credit/Debit Note Clearing account is required because the
inventory return and credit note functions in Order Entry are
separated, with one side of the transaction going through the

Accounts Receivable program.

Integration Options — Create G/L Transactions
Specify when to generate general ledger transactions: either during
posting, or when you run day-end processing, or at a later time of your
choosing (using the Create G/L Batch form).
To create a batch or append to an existing batch or transaction file
only when you are ready, use the On Request Using Create G/L
Batch Icon option. When you are ready to create general ledger
transactions, you then use the Create G/L Batch form.
Select this option if you want to be able to consolidate general ledger
transaction details and print Inventory Control’s G/L Transactions
report.
To create a batch or append to an existing batch or transaction file
when you run day-end processing, select the During Day End
Processing option.

Reporting General Ledger Data
The G/L Transactions report is a listing of the general ledger transactions
created by Inventory Control that you might need to print as part of your
audit trail.
If you selected the On Request Using Create G/L Batch Icon option, you
can print the G/L Transactions report from Inventory Control (after you
run day-end processing, unless you create transactions during posting),
but before you create or append to general ledger batches.
You can print this report whether or not you use Sage ERP Accpac
General Ledger with the same database as Inventory Control.
If you selected the During Posting or Day End Processing option for
creating the general ledger batch, you cannot print the G/L Transactions
report from Inventory Control. However, you can print the general ledger
batch from your general ledger if you need this information for your audit
control.

Use this command in the File menu to close the current form.
Shortcut keys: Alt + F4

Customize (File menu)
Administrators can use this command to hide fields and/or buttons in
forms and dialog boxes for specific users or for all users. For example,
when fields are hidden, data that would normally appear in these fields
cannot be printed, and hiding the Add or Delete buttons restricts users
from adding or deleting data.

Export
Use this command to transfer (export) data from Inventory Control to
non-Sage ERP Accpac programs.
For example, you could export sales history data from Inventory Control
for use in a spreadsheet program or database program.
To export data, follow these general steps:
1.Open the appropriate Inventory Control form for the type of data you
want to export. For example, to export item price lists, open the Price
Lists form.
2.If necessary, create the records you wish to export.
3.Choose the Export command from the File menu.
4.In the export form that appears, select the records you want to export,
and the type of information.
5.Specify the file name and file type for the exported data records.

Import
Use this command to transfer (import) data from non-Sage ERP Accpac
programs to Inventory Control.
For example, you could use a spreadsheet program to create price lists
for items, then import the price lists into Inventory Control.
To import data, follow these general steps:
1.Create the file you want to import. For information on the file formats
and file layouts that Sage Accpac accepts, search the online help for
Importing and Exporting Inventory Control Records. (You can create
an import file template by exporting a few records of the type you
want to import.)
2.Open the appropriate Inventory Control form for the type of data you
want to import. For example, to import receipt transactions, open the
Receipts form.
3.Choose the Import command from the File menu.
4.Specify the file name and file type in the import form that appears
next.
5.If you previously created a template for importing, choose the Load
Script button.
6.Choose the fields that you are importing. (You can save your choices
as another template by clicking Save Script for the next time you
import records.)

Use this command to print the report for the open form you are using.
For example:
If you are using a report form, choose the command to print the
report.
If you are using another type of form, choose the Print command to
open corresponding report form, where you can select options (if
applicable), and then print the report.
For more information about reports, see Inventory Control Reports.

Multicurrency Ledgers
If you are using a multicurrency ledger, the following fields will appear:
Receipt Currency
Exchange Rate (the currency of the invoice in which you will enter
unit costs; the rate of exchange between the receipt currency and
the functional currency)
The program displays the Exchange Rate field only if the receipt currency
you specify is not the functional currency.
You can override the receipt currency's exchange rate displayed by the
program. The program warns you if you specify an exchange rate that
exceeds the rate spread your company allows for the receipt currency.
To select a different exchange rate or rate type for the receipt currency,
open the Rate Selection popup by clicking the Zoom button beside the
Exchange Rate field.

Prorate/Leave Additional Cost
For receipt returns, specifies whether the additional cost assigned to the
goods being returned is prorated to the remaining goods on the receipt.
This field appears only when you are entering receipt returns. You can
set the default to Prorate or to Leave on the Processing tab in the
Options form.
Select the Prorate option to have the program prorate the additional cost
to the remaining goods on the receipt when you post the receipt return
then run day-end processing.
Select the Leave option if you do not want the program to prorate the
additional cost to the remaining goods on the receipt. You may then want
to use the Adjustments form to write off the additional cost to a general
ledger write-off account.
If you return all of the items on a receipt, you must use the Adjustments
form if you want to write off the additional cost from the receipt to a
general ledger write-off account.
To determine the additional cost amount assigned to items on receipts,
print the Receipts Posting Journal.

Additional Cost
You can include an additional cost amount on receipts so the goods you
receive into inventory are recorded at their true landed cost. The program
calculates true landed costs by proportionally distributing the additional
cost across all extended costs on receipts. Examples of additional costs
are:
Lump sums included on invoices.
Custom brokerage fees.
An invoice, such as a freight invoice, that is separate from the
invoice listing the inventory items.
When you post a receipt then run day-end processing, the program
apportions the additional cost across all items, based on each item's
extended cost as a percentage of the receipt's total cost.

Require Labels
Turn on the Require Labels option if you want to print exactly one item
label for each item being received.
Turn off the Require Labels option (if it is turned on) if you do not want to
print item labels, or if you want to print more or fewer labels than the
number of items being received on any detail line. To specify that fewer
or more labels be printed, type the desired number of labels on each
item's detail line.
The program automatically generates item labels (that you can later print)
for items on posted receipts when you run Day End Processing.

Total Cost
This value is supplied by the program. It is the sum of all the extended
costs plus the additional cost on the receipt.
This field does not appear when you are entering receipt returns in
Multicurrency ledgers:
If you specify the same currency for the receipt currency and the
additional cost currency, the program displays the total cost in that
currency. For example, if the receipt currency and the additional cost
currency are both in the source currency, the total cost appears in
the source currency.
If you specify different currencies for the receipt currency and the
additional cost currency, the program displays the total cost in the
functional currency. For example, if the receipt currency is the source
currency, and the additional cost currency is the functional currency,
the total cost appears in the functional currency.

Total Return Cost
Supplied by the program for receipt returns, the sum of all the costs for
the goods being returned.
This field appears only when you are entering receipt returns (additional
cost is not included).
In multicurrency ledgers, the program displays this cost in the receipt
currency.

Unit Cost; Extended Cost
When you enter an item number, the program automatically displays the
item's most recent cost in terms of the unit of measure you specify. The
program displays these costs in the receipt currency.
You can override the most recent costs displayed by the program. If you
enter a new unit cost, the program recalculates the extended cost. If you
enter an extended cost, the program recalculates the unit cost.
Multicurrency ledgers — if you use multicurrency accounting, enter costs
in the receipt currency.

Asset Description
Use the Description field to enter the description that you want to use for
the asset in Sage FAS.

Sage FAS Template
If you want to use a different template from the one displayed on the
Fixed Assets form, use the Finder for the Sage FAS Template field to
select a different one. Otherwise, either accept the default template code
that appears or clear the entry from this field. (You do not have to use a
template to create the asset in Sage FAS.)

Sage FAS Quantity
Enter the quantity of asset items you are removing for internal use.
If the quantity is more than one, and you want to create separate asset
records for each item in Sage FAS, select the Separate Assets option.

Sage FAS UOM
Type the unit of measure for the quantity you entered.

Sage FAS Value
Type the value to book for the asset in Sage FAS.

Separate Assets
If the quantity is more than one, and you want to create separate asset
records for each item in Sage FAS, select the Separate Assets option.
The program allocates the Sage FAS value entered on the Fixed Assets
form proportionately to each Sage FAS record it creates. For example, for
a quantity of 10 and a value of $25,000, the program creates 10 asset
records with a value of $2,500 each.

Sage ERP Accpac Order Entry
If you use Order Entry, the prices Order Entry displays for items come
from this price list (if it has a price in the customer’s currency).
Whether the item is a regular stock item that you store in your
inventory, or a non-stock item such as a service charge, kitting item,
or other item which you do not store in your physical inventory.
Whether the item has serial numbers that you track.
(Optional) The item number of an item in your inventory that you
want to be an alternate for the item record you are adding. An
alternate item is an item that you want to ship when the regular item
is out of stock.
The stocking unit of measure (such as each or dozen), which is the
unit Inventory Control uses to report stock levels for the item.
If you did not select the Allow Fractional Quantities option in the
Options form, the stocking unit is the smallest unit of measure you
can specify.
(Optional) Other units of measure for the item (based on the stocking
unit) by which you purchase or sell the item.
(Optional) Tax information, including the taxing authority, and tax
classes for purchases and sales of the item.

Sage ERP Accpac Order Entry and Purchase
Orders
Order Entry and Purchase Orders use this information to calculate tax
amounts. Inventory Control uses tax information for reporting purposes
only.
(Optional) Information about the vendor(s) who supply the item. This
information includes the vendor number (up to 12 characters), the
name of a contact person, your priority rating for the vendor (primary,
secondary, and so on), and the vendor?s number for the item.
Vendor numbers can contain upper-case letters, numbers, blanks,
symbols (such as @ and #, and punctuation marks (such as ? and !).
Information your company wants to include in any optional fields you
created for your item records in the Options form.
Up to 300 characters of additional item information.

Item Number and Description
The item number identifies the item in Inventory Control.
To create a new item record, enter a unique code of up to 24 characters
(including separator and prefix characters) that matches one of the item
number structures you have defined. You can also click the Zoom button
beside the Item Number field to select the item structure and enter the
segment information to use, then have Inventory Control automatically
insert the new number in the Item Number field.
When adding a single-segment item number, you can enter from one
character to the maximum number of characters permitted in your item
numbers. For example, if the segment length you defined for item
numbers allows six characters, you can enter item numbers that contain
one, two, three, four, five, or six characters.
To open an existing item record, enter its number or choose it from the
Finder in the Item Number field.
The description can be up to 60 characters long. Type the description as
you want it to appear in Inventory Control and Order Entry forms and on
reports (for example, generic type, followed by specific item).
In most item number fields, you can enter manufacturers' item numbers
that have been added to Inventory Control. Once you press the Tab key,
the program replaces the field contents with the inventory item number,
and places the manufacturer's item number that you used in the Manuf.
Item No. field (by default the last field in the grid).

Field List

Editing Item Records
Use the Items form to edit item records in Inventory Control.
You can change most of the information in an item record at any time,
with these restrictions:
Once you make an item record inactive, you cannot post receipts,
shipments, adjustments, assemblies, or transfers for that item.
You cannot assign an item to a category or account set that has an
Inactive status.
You cannot directly change an item number. You must first create a
new item record with the new number, copy the item information to
the new record, then delete the old item record.
You cannot select a different item structure code for an existing item.
You cannot change the account set to one that uses the userspecified costing method if the item is a master or component item in
a bill of material.
You cannot change a stock item to a non-stock item unless:
The total cost and quantity for the item is zero at all locations, and
the item is removed from all locations using the Location Details
form or the Locations form.
The account set and category codes for the item are active.
The item is assigned an account set that uses the user-specified
costing method.
You cannot choose an inactive item for an alternate item.
Effects of changes. Once you make an item inactive, you cannot use it
in transactions (receipts, shipments, transfers, assemblies, or
adjustments), unless you make it active again.

Deleting Item Records
Use the Items form to delete item records in Inventory Control.

Before deleting item records
If you plan to delete an item record, you must first make sure that:
The quantity of the item stored at each location is zero.
The total cost of the item at each location is zero.
You have run day-end processing if you have posted any
transactions for the item since the last day-end processing, and have
completed all receipts involving the item.
The item is not a master item or component item for a bill of material.
You can delete an item record if the item has zero quantities and no
outstanding amounts on order.
Before trying to delete an item record, you may prefer to assign the
Inactive status to the record, to ensure that no further transactions are
posted to it. You can then wait until the end of the fiscal or calendar year
to delete it (depending on the method you use to accumulate item
statistics).
You can also use the Delete Inactive Records feature to delete inactive
item records.

To delete an active item record
Use this method to delete an item record:
1.Double-click the Items icon in the Items And Price Lists folder.
2.Enter the code for the item record you want to delete or select it from
the Finder.
3.Select the Inactive option.
4.Click Save to save your changes.
5.At the end of your fiscal year or calendar year, use Delete Inactive
Records (in the Periodic Processing folder) to delete the item record.

To delete an unused item record
Use this method to delete an item record if you added it by accident or if
you have not yet posted any transactions for the item:
1.Double-click the Items icon in the Items And Price Lists folder.
2.Enter the code for the item record you want to delete or select it from
the Finder.
3.Click Delete.
4.If you see a message asking you to confirm that you wish to delete
the record, click Yes.

Journal Entries — Receipts
Assigned source code IC-RC on the G/L Transactions report. Receipt
returns are assigned IC-RR, and receipt adjustments are assigned ICRA.
Receipt transactions debit the general ledger inventory control account,
and credit the item's payables clearing account.
Sage ERP Accpac Accounts Payable. When you enter the related
vendor invoices in Accounts Payable, you will debit the payables clearing
account for the value of the invoice, and credit the vendor's payables
account. The debit to the payables clearing account clears the balance
that is left in this account from posting receipts.
Sage ERP Accpac General Ledger. If you do not enter a vendor invoice
in Accounts Payable (such as when no vendor is specified on the posted
receipt), you enter a cash transaction in the General Ledger that debits
the payables clearing account for the cost of the goods on the receipt,
and credits the cash account. The debit to the payables clearing account
clears the balance that is left in this account from posting receipts.

Journal Entries — Shipments
Assigned source code IC-SH on the G/L Transactions report. Sales
returns are assigned IC-SR.
Shipment transactions debit the item's cost of goods sold account, and
credit the general ledger inventory control account.
If an item's costing method is the standard method or the most recent
cost method, then the item's cost variance account is debited or credited
with the difference between the standard or most recent cost, and the
weighted average cost of the items shipped.
Sage ERP Accpac Accounts Receivable. When you enter the related
customer invoices in Accounts Receivable, you must credit the sales
accounts and the necessary tax accounts, and debit your customer
accounts.

Journal Entries — Adjustments
Assigned source code IC-AD on the G/L Transactions report.
An adjustment cost increase debits the inventory control account and
credits the adjustment write-off account you specify when you enter the
adjustment.
An adjustment cost decrease credits the inventory control account and
debits the adjustment write-off account you specify when you enter the
adjustment.
Quantity adjustments do not create journal entries.

Journal Entries — Transfers
Assigned source code IC-TF on the G/L Transactions report.
Stock transfer transactions both debit and credit the inventory control
account specified in the item's account set, although you can set up
location records in Inventory Control to override general ledger account
segments that appear in the item's inventory control account.
Overriding account segments. For example, an item's general ledger
inventory control account is 1300-00, where the second segment is the
location segment. You set up location1 and location2 to override the
location segment of the account with 01 and 02, respectively.
If you transfer an item from location1 to location2, the program credits
account 1300-01 and debits account 1300-02.
Stock transfers debit the inventory control account for the original location
and credit the inventory control account for the new location.

Optional Fields
If you added optional fields to adjustments and adjustment details, you
can enter optional field information that will be included in any
adjustments that are generated when you post the inventory
reconciliation.
Optional fields in adjustment transactions provide information on the
adjustment posting journal and when you review adjustments in I/C or
drill down to adjustments from G/L transactions.

Internal Usage Form
Inventory Control’s new Internal Usage form lets you record transactions
that take items from inventory for your own company's use.
For example, an office supply store could take a desk from inventory for a
new employee. Or it could take paper, pencils, and pens from inventory
for office supplies. In both cases, you are taking goods for internal usage.
Integration to Sage Fixed Assets (FAS)
If you use Sage Fixed Assets system (FAS) to manage the fixed assets in
your company, you can also mark goods that are taken out of inventory
for internal use as fixed assets, and choose the FAS template that you
want to use for the new asset. Sage ERP Accpac will transfer the asset
information to FAS when you run Create Assets in the FAS Integration
module.

Additional Costing and Transaction Creation
Options
Inventory Control 5.5 provides more options for costing items and
creating subledger transactions and audit information � either during
posting or when you run Day End Processing.
Previously, Inventory Control let you cost inventory items when
transactions were posted or when you ran Day End Processing.
However, if you decided to cost inventory items during posting, the
program would automatically create subledger transactions and audit
information at the same time.
In version 5.5, these two processes have been separated to give you
better control over posting performance and to provide you with up-todate item information.
Note: If you cost inventory during Day End Processing, the program will
also create subledger transactions and audit information when you run
Day End Processing.
For more information, see Create G/L Transactions During Day End Processing.

Item Inquiry and Drilldown from Location Details
Inventory Control lets you view the number of items at each location on
purchase order, on sales order, and committed to orders.
Open the Location Details form, highlight the location you want, and click
the appropriate drilldown button to see purchase order and sales order
details. You can drill down again to specific purchase orders and sales
orders.
For details on the Location Details form, see Location Details.

Drilldown to Project and Job Costing Transactions
You can now drill down to Project and Job Costing transactions from jobrelated inventory shipments and adjustment transactions.
To view job-related transactions entered through Project and Job Costing,
you open Transaction History Inquiry in the Inventory Control module,
specify the item or range of items that you want to view, and then drill
down to the source document for more details.
For more information on using Transaction History Inquiry, see Transaction
History Inquiry.

Start and End Dates for Price Lists
You can now set on the Item Pricing form the period during which a price
list is in effect for a particular item. This lets you bring new price lists into
effect on particular days, and retire old price lists.
If you choose a price list in Order Entry before the start date or after the
end date, the program will display a warning message and enter a 0.00
price.
The price list is always valid if the starting and ending dates are blank.
See Setting Up Price Lists and Item Pricing Form.

Prevent Transfer Slips from Being Reprinted
The I/C Transfer Slips form now includes an Include Transfer Slips
Already Printed option that lets you exclude transfer slips that have
already been printed from the range of transfer slips that you select.

Different Document Dates and Posting Dates for
Transactions
Like other Sage ERP Accpac subledgers, Inventory Control now provides
a Posting Date field on transaction entry forms (in addition to the
document date) that lets you specify the date to use for the transaction
when it�s posted in General Ledger.
The ability to specify posting dates is particularly useful if you need to
post a document to a different year or period from the document date.
Note: The posting date determines the year and period to which a
document is posted. You no longer specify the Year/Period separately.
Default Posting Dates for Transaction Entry
The I/C Options form provides a new option that lets you specify the type
of date to use as the default posting date on transaction entry forms. (You
can select the document date or the session date as the default posting
date.)
You can change the posting date for particular transactions when you
enter or edit them.
For more information, see Default Posting Date.

User-Defined Source Types
As with other Sage ERP Accpac applications, you can now change the
two-letter source type codes used for the different transaction types sent
to the General Ledger.
You change source type codes on the G/L Integration form.

Consolidate G/L Batches
Use this option on the Integration tab of the G/L Integration form to
specify whether to combine transaction details for the same general
ledger account into a single detail, or send unconsolidated Inventory
Control transaction details to General Ledger.
Consolidation reduces the amount of information in the general ledger
batch and results in a shorter G/L Transactions Listing.
Note: Consolidation reduces information and blocks drilldown from G/L
Use the Create G/L Batch icon to consolidate details from separate transactions
Consolidate details within transactions if creating batches during posting or day end processing

Consolidation choices
You can choose:
Do Not Consolidate. All the details posted in Inventory Control will
be included in the General Ledger transaction batch.
Choose this option if you use optional fields and pass optional field
information from I/C transaction details to the G/L transaction details.
Consolidate Transaction Details by Account. All the details within
a transaction with the same general ledger account number are
combined into one detail if the G/L Detail Description and the G/L
Detail Reference are also the same. The program will not
consolidate details that have a different description or reference.
Choose this option if you do not use optional fields, but still want to
associate general ledger transactions with originating documents (for
drilldown or to maintain a manual audit trail).
Consolidate by Account and Fiscal Period. All the details with the
same general ledger account number and fiscal period are combined
into one detail.
This option will consolidate details from different transactions if you
create transaction batches using the G/L Batch form.
Consolidate by Account, Fiscal Period, and Source. All the
details with the same general ledger account number, fiscal period,

and source code are combined into one detail.
This option will consolidate details from different transactions if you
create transaction batches using the G/L Batch form.
Note: The posting date for consolidated entries is the last date of the
fiscal period.

Changing the Item Category or Account Set
We do not recommend that you change the item category or account set
assigned to an item record to which you have posted transactions.

If you change the item category:
The default choices for the new item category will replace existing
choices in the item record, although you can edit the item record to
change the new selections.
You may need to correct statistics for the affected item categories.
The new category may not distribute COGS (cost of goods sold) and
cost variance to the same general ledger accounts as the old
category, invalidating statistical comparisons among reporting
periods.

If you are changing the item's account set:
You may need to transfer the asset amount in the inventory control
account balances to a new control account in the General Ledger
after updating the item record with the new account set code;
otherwise, you may have old balances that are never reconciled.
The new account set may use a different costing method, and all
subsequent transactions posted for the item number will be posted to
the set of general ledger accounts linked to the new account set
code.
Inventory Control will display an error message if you attempt to
change account sets for an item while there are posted transactions
for the item for which Day End Processing has not been run.

Editing an item record
1.Double-click the Items icon in the Items And Price Lists form.
2.Enter the code for the item record you want to edit or select the code
from the Finder.
3.Make the changes you need in the record.
4.When you are finished, click Save to record your changes.

Create G/L Transactions
Use one of the Create G/L Transactions options (on the Integration tab of
the G/L Integration form) to specify when to create general ledger
transactions:
During Posting or During Day End Processing
This option changes depending on the options you chose on the I/C
Options Costing tab.
On Request Using Create G/L Batch Icon
During Posting or During Day End Processing
This option lets you create general ledger transactions during posting or
when you run day end processing — depending on your settings on the
I/C Options Costing tab.
You choose when to create G/L transactions and audit information on the
Costing tab of the I/C Options form. The Create Subledger Transactions
And Audit Info. During option gives you one of two choices on this form:
During Posting (available only if you cost items during posting)
G/L transactions will be created when transactions are posted.
During Day End Processing
G/L transactions will be created when you run the Day End
Processing task.
Note: These choices can have a large impact on the speed of processing
transactions in Inventory Control, Order Entry, and Purchase Orders. If
you need to speed up order processing, switch to costing inventory when
you run Day End Processing (in I/C Options), and create G/L transactions
using the Create G/L Batch icon.
On Request Using Create G/L Batch Icon
This option lets you create general ledger transactions at any time that's
convenient for you.
Once you create the transactions, you cannot print the G/L Transactions
report in Inventory Control. If you wish to print the report, select the On

Request Using G/L Batch Icon for this option. You must then print the
report before you use the Create G/L Batch form to create the
transactions.
You can change your selection any time. If you were using the Create
G/L Batch form to create the transactions, print a copy of the latest G/L
Transactions report, then create any outstanding transactions before
changing your choice for the option.

This option lets you choose which date the program displays by default
for the Posting Date when you enter receipt, shipment, internal usage,
adjustment, transfer, and assembly transactions.
You can choose from two settings:
Document/Transaction Date.
Select this choice if you usually want the posting date and fiscal
period to match the document date.
If you choose this setting, the program will automatically change the
default Posting Date if you change the date in the Receipt Date,
Shipment Date, Transfer Date, Assembly Date, Adjustment Date, or
Internal Usage Date field.
Session Date.
Select this choice if you usually want the posting date and fiscal
period to match the current session date.
If you choose this setting, the program keeps the session date as the
default posting date even if you change the document date.
The Posting Date lets you to specify the date when a
document/transaction is posted to General Ledger. The Fiscal Year and
Period are based on the Posting Date.
If you have a multicurrency system, currency revaluation also uses
posting dates to select open documents for revaluation purposes and
thus, revaluation adjustments are posted to General Ledger in the correct
fiscal year/period.

